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ПРИМЕЧАНИЕ 
Экранные иллюстрации в этой публикации дают лишь примерное представление и не являются точными 
копиями экранных изображений, воспроизводимых программным обеспечением. 
 
Напечатанная инструкция пользователя 
Зарегистрированным владельцам ПО BERNINA Embroidery Software разрешается распечатать 1 (одну) 
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Ограниченная Гарантия 
Фирма BERNINA International AG гарантирует, что в течение 90 дней с даты приобретения Вами 
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возвратить изделия вместе с доказательством покупки фирме BERNINA или уполномоченным торговым 
агентам в течение гарантийного срока для безвозмездной замены. Вы оплачиваете стоимость пересылки 
и страховки  и несете риск в случае повреждения и ошибочной адресации "продуктов ". 
Покупатель полагается на свое собственное умение и знание при выборе программного обеспечения для 
собственного использования и принимает весь риск относительно результатов применения программного 
обеспечения. В соответствии с правовыми условиями гарантии фирма BERNINA International AG не 
принимает на себя все другие гарантии и условия, которые могут быть явно выражены или 
подразумеваемы, включая без ограничения, гарантии и условия пригодности для продажи, соответствия 
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специально не гарантирует, что программное обеспечение будет соответствовать всем требованиям 
покупателя или будет выполняться без прерываний или ошибок, в полном соответствии с описанием в 
сопровождающей документации. 
 

Ограничения Ответственности 
Фирма BERNINA International AG, ее разработчики, менеджеры, служащие или работники филиалов в 
соответствии с применимым законом, ни в коем случае не несут ответственности за любые последующие 
прямые или косвенные убытки (включая убытки от потери деловой прибыли, перерывов в работе, потери 
коммерческой информации и т.п.), возникшие в результате неправильного использования программного 
обеспечения или прилагаемых защитного устройства и кабеля, а также сопровождающей документации, 
независимо от обоснования требования и даже, если фирма BERNINA или ее уполномоченный 
представитель уведомлялся относительно возможности таких убытков. 
В некоторых государствах законодательство или судебная практика не допускают исключения случайных, 
последующих или специальных убытков, так что вышеупомянутое ограничение или исключение не может 
быть применимо к Вам. 
 

Прекращение Действия Лицензионного Соглашения  
Ваша Лицензия на использование программного обеспечения фирмы BERNINA действительна до тех пор, 
пока Вы выполняете условия Лицензионного соглашения. Действие Лицензии завершится автоматически 
без уведомления фирмы BERNINA International AG, если Вы будете не в состоянии выполнять любое из 
условий Лицензионного соглашения. Вы можете прекратить действие этой Лицензии в любое время,  
возвратив программное обеспечение и все его копии этого, аппаратный ключ "донгл" (Dongle), кабель и 
всю сопровождающую документацию фирме BERNINA International AG. 
 

КОНТАКТНЫЕ ТЕЛЕФОНЫ 
Если у Вас возникнут любые вопросы, обращайтесь, пожалуйста, Вашему дистрибьютору фирмы 
BERNINA или  
BERNINA International AG  
CH-8266 Штекборн/Швейцария 
Тел.: (41) 52-762 11 11 
Факс: (41) 52-762 16 11 
 

1-ого мая 2009г.  
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ГЛАВА 1 
 

ВВЕДЕНИЕ 
------------------------------------------- 

Приглашаем Вас ознакомиться с программным обеспечением BERNINA® 
Embroidery Software – ведущим программным 
продуктом для домашнего машинного вышивания. 
Вышивальное программное обеспечение 
BERNINA Embroidery Software является 
программным продуктом, основанным на 
операционной системе Windows, поэтому в нем 
используются многие команды, с которыми 
хорошо знакомо большинство пользователей 
персональных компьютеров. 
 
Программное обеспечение для вышивания 
BERNINA® Embroidery Software уникально в том 
плане, что оно отлично интегрируется с самым популярным среди 
домашних пользователей векторным ПО для рисования CorelDRAW® 
Essentials 4 от Corel Corporation. Сочетание возможностей ПО для 
вышивания BERNINA® Embroidery Software и графических возможностей 
пакета CorelDRAW® обеспечивает наиболее эффективные и удобные для 
пользователя возможности разработки образцов вышивок. Оно позволяет 
пользователям создавать не только образцы для вышивки, но и настоящие 
мультимедийные объекты дизайна. 
ВНИМАНИЕ: CorelDRAW® Essentials 4 и родственный пакет Corel PHOTO-
PAINT® Essentials 4 могут использоваться и как самостоятельные 
приложенния. Полное описание инструментария пакета CorelDRAW® 
Essentials 4  имеется в электронном Руководстве пользователя, которое 
можно найти в разделе меню Windows Start > Programs. Дополнительно, 
программа имеет систему он-лайновой помощи, обратиться к которой 
можно через раздел меню Graphics->Help 
 

Первичным пользователям 
 
Если Вы впервые приобрели 
вышивальное ПО BERNINA, то Вам очень 
понравятся гибкие возможности 
оцифровывания изображений и легкость, 
с которой Вы сможете создавать и 
редактировать образцы вышивк 
и и простота, с которой можно добавлять 
или создавать свои собственные тексты. 
Однако прежде чем Вы начнете работать 
с программами, нужно прочитать главу 
Введение в оцифровывание проектов 
вышивки в отображаемом на экране 
руководстве. В этой главе представлен 
обзор основных концепций 
оцифровывания функциями BERNINA 
Embroidery Software  и даются важные 

указания по использованию программы 
для получения наилучших результатов. 
 
 
Вы должны также ознакомиться с главой 
Основные процедуры в Руководстве 
пользователя. Здесь Вы узнаете, как 
запускать приложение, создавать или 
открывать проект, распечатывать рисунки 
вышивок и как использовать некоторые 
наиболее важные инструментальные 
средства и возможности, которые 
обеспечивает BERNINA Embroidery 
Software. Глава Просмотр проектов  
ознакомит Вас со способами просмотра 
проектов в режимах просмотра BERNINA 
Embroidery Software. 
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Пользователям, обновляющим 
программное обеспечение 
 
Вышивальное ПО BERNINA Embroidery 
Software является усовершенствованной 
версией установленного у Вас ранее 
программного продукта. В нем 
предусмотрено много новых и 
расширенных функциональных 
возможностей. 
Ознакомьтесь с главой Введение в 
оцифровывание проектов вышивки в 
Руководстве пользователя, чтобы быстро 
ознакомиться со всеми модификациями. 
 
Уровни программного продукта 
BERNINA Embroidery Software  
 
 
Имеются два уровня вышивального 
программного обеспечения BERNINA: 
◄ BERNINA EditorPlus  
◄  BERNINA DesignerPlus 
 
Внимание: Уровни программного 
продукта контролируются аппаратным 
(электронным) ключом. Это устройство 
является наиболее важной и ценной 
частью Вашей системы, и с ней нужно 
обращаться осторожно. 
 
Примечание: Пользователи 
вышивального ПО BERNINA могут 
приобрести программы обновления 
непосредственно через Интернет. 
 
Программа BERNINA EditorPlus 
 
Программа BERNINA EditorPlus дает 
возможность редактировать 
существующие проекты и добавлять 
надписи. Вы можете также создавать 
привлекательные вышивки с минимумом 
усилий по отсканированным рисункам. 
Воспользуйтесь мощными средствами 
автоматического оцифровывания, такими 
как Auto Digitizer, Magic Wand и 
PhotoSnap. Эта система также позволяет: 
◄ изменять последовательности цветов 

для улучшения качества вышивки; 
◄ редактировать индивидуальные стежки 

для точной настройки обработки 
мотива. 

◄ использовать функцию Auto Digitizer 
для автоматического создания 
привлекательных  вышивок по 

отсканированным оригиналам; 
◄ использовать инструмент Magic Wand 

("Волшебную палочку") для 
преобразования рисунка в вышивку; 

◄ использовать функцию PhotoSnap, 
чтобы преобразовать фотографии в 
строчечные вышивки.  

 
Программа BERNINA DesignerPlus 
 
Программа Designer Plus обладает 
мощными функциями, позволяющими 
оцифровывание, редактирование и 
создание надписей с использованием как 
автоматических, так и ручных 
инструментальных средств и способов 
оцифровывания. В частности, с этой 
системой можно: 
◄ использовать отсканированные или 

импортированные изображения для 
оцифровывания проектов на экране 
монитора; 

◄ в дополнение к автоматическим 
средствам оцифровывания можно 
использовать специализированные 
инструменты оцифровывания, а также 
большой набор художественных 
декоративных узоров заполнения; 

◄ создавать аппликации функцией Auto 
Applique; 

◄ преобразовывать любой шрифт 
Windows TrueType в вышивальный 
алфавит; 

◄ сохранять все предпочитаемые 
настройки в файле шаблона. 

 
Примечание: Для идентификации 
функций, реализуемых Вашей конкретной 
моделью, и опций, которые могут быть 
Вами выбраны, см. Список функций 
вышивального программного 
обеспечения BERNINA в Руководстве 
пользователя. 
 
 
Документация BERNINA 
Embroidery Software 
 
 
Вышивальное ПО BERNINA 
предоставляет Вам разные способы 
доступа к информации по Вашему 
программному обеспечению и 
пользованию им как в печатном виде, так 
и в экранном отображении через меню 
Help. 
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Внимание: Экранные иллюстрации в 
пользовательской документации дают 
лишь примерное представление и не 
являются точными копиями экранных 
изображений, воспроизводимых 
программным обеспечением. 
Процедурные описания могут слегка 
различаться при разных настройках при 
инсталляции в зависимости от 
принимаемых по умолчанию системных 
установках.  
 
Печатная документация 
 
В зависимости от приобретенного Вами 
уровня программного продукта вместе с 
установочным диском DVD Вы получаете 
следующую печатную документацию: 
 
Краткое справочное руководство 
 
Краткое руководство пользователя 
BERNINA Embroidery Software содержит 
указания по инсталляции, а также  общую 
информацию по Вашему вышивальному 
программному обеспечению BERNINA. 
Там имеется также раздел с кратким 
справочником, содержащим все экранные 
и клавиатурные команды, используемые в 
Вашем программном обеспечении. В 
дополнении здесь же предлагается 
полностью обработанный образец 
проекта вышивки. Дополнительные 
средства обучения предусматриваются в 
отображаемом на экране руководстве. 
Хотя обучающие средства не охватывают 
всех функций, они дают полезную 
информацию для всех уровней 
программного обеспечения. 
 
Совет: Для детального ознакомления со 
всеми функциями вышивального 
программного обеспечения BERNINA (по 
всем уровням программного продукта) и 
приложений BERNINA Portfolio 
обратитесь к отображаемому на экране 
руководству, доступному через меню 
Help. Для идентификации источников 
информации, имеющих отношение к 
Вашей конкретной модели, и опций, 
которые могут быть Вами выбраны, см. 
Список функций вышивального 
программного обеспечения BERNINA в 
Руководстве пользователя. 
 

Отображаемая на экране 
документация (только на 
английском языке) 
 
Документация отображается на экране в 
двух форматах – HTML Help и Adobe 
Acrobat. В зависимости от 
приобретенного Вами уровня 
программного продукта Вы получите 
следующую документацию в полном 
наборе или только часть из них: 
 
Замечания к программному 
обеспечению  
 
Комплект замечаний включается при 
инсталляции программного пакета. В них 
содержится детальная информация о 
новых и модернизированных функциях, а 
также прямые ссылки к соответствующим 
разделам экранного руководства. 
 
Краткое справочное руководство 
 
Краткое справочное руководство 
BERNINA также предоставляется в 
отображаемой на экране форме. В нем 
содержится дополнительная информация 
об обновлении программного продукта, а 
также прямые ссылки к дополнительным 
обучающим указаниям экранного 
руководства. 
 
Отображаемое на экране 
руководство 
 
В отображаемом на экране руководстве 
содержатся детальные процедурные 
описания всех функций вышивального 
программного обеспечения BERNINA, а 
также приложений пакета BERNINA 
Portfolio. Приводятся сотни пошаговых 
инструкций вместе с примерами и 
экранными изображаениями. Приложения 
BERNINA Cross Stitch и BERNINA Quilter 
документированы в отдельных 
дополнительных руководствах, 
описанных ниже. 
 
Онлайновая справка 
 
Онлайновая справка обеспечивает 
быстрый доступ к общей информации о 
функциях вышивального ПО BERNINA и к 
пошаговым инструкциям. 
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Дополнительные руководства 
пользователя 
 
Ваш установочный DVD  BERNINA 
Embroidery Software позволяет также 
установить следующие дополнительные 
отображаемые на экране руководства: 
 
Экранное руководство BERNINA 
Cross Stitch 
 
В этом дополнительном руководстве 
описываются возможности специального 
приложения BERNINA Cross Stitch, 
позволяющего выполнять вышивки 
крестом. Вышивка крестом является 
популярной техникой заполнения 
больших фрагментов малым количеством 
стежков. Такие стежки можно 
использовать также для оконтуривания и 
обрамления. Вышивание в такой технике 
подходит для украшения домашнего 
текстиля, скатертей, детской одежды и 
фольклорных мотивов. Стежок для 
вышивки крестом иногда комбинируют с 
аппликацией. 
 
Экранное руководство BERNINA 
Quilter Onscreen 
 
В этом дополнительном руководстве 
описываются возможности специального 
приложения BERNINA Quilter, 
позволяющего работать в технике 
лоскутного шитья –пэчворка. Пэчворк – 
это популярная техника компоновки и 
сшивания лоскутов ткани в блоки. 
Программа BERNINA Quilter может быть 
использована для размещения лоскутных 
узоров на квилтах по существующим или 
по создаваемым собственноручно 
проектам. Используйте эту программу для 
экспериментирования с лоскутами ткани и 
цветом, чтобы создавать прекрасные 
квилты, отражающие вашу 
индивидуальность. 
 
Условные, обозначения принятые 
в Руководстве 
 
В тексте руководства приняты следующие 
условные обозначения. 
 
Команды 
В этом руководстве команды меню или 
подменю указываются со ссылками на 

имена меню и команды. Например, 
команда ‘Show All’ (‘Показать Все’) из 
меню ‘View’ (‘Вид’) указывается как View > 
Show All. 
 
Диалоговые окна 
Диалоговые окна показываются в 
руководстве только в том случае, когда в 
них отображена важная информация для 
использования ПО BERNINA. Экранные 
иллюстрации дают лишь примерное 
представление и не являются точными 
копиями экранных изображений, 
воспроизводимых программным 
обеспечением. 
 
Команды для действий мышью 
 
Указание Символ Действие 
Щелчок 
мышью 
 

Щелкнуть левой кнопкой 
мыши  

Щелчок 
правой 
кнопкой 
мыши 

Щелкнуть правой кнопкой 
мыши  

Двойной 
щелчок 
 
 
 

Дважды щелкнуть 
кнопкой, не перемещая 
мышь  

Нажмите 
кнопку ОК.  

Щелкнуть мышью по 
кнопке OK диалогового 
окна, или нажать клавишу 
Enter клавиатуры, чтобы 
завершить действие.  

 
Комбинация 
клавиш 

Описание 

[Ctrt] + [S]  Удерживая нажатой клавишу CTRL, нажать 
клавишу буквы "S" в нижнем регистре  

[Clrl] + [Shift] + 
[H]  

Удерживая нажатой клавишу CTRL, нажать 
клавишу SHIFT и клавишу буквы "Н".  

 
Полный перечень клавиатурных команд 
приводится в Кратком справочном руководстве 
 
Просмотр отображаемой на 
экране информации 
 
Выберите Help Topics (из меню Help), чтобы 
просмотреть онлайновую справку. 
Выберите Online Manual (из меню Help), чтобы 
просмотреть онлайновое руководство. 
 
Выберите Bernina International Home Page (из 
меню Help), чтобы просмотреть 
международный сайт Bernina. 
 
Выберите Bernina of America Home Page (из 
меню Help), чтобы просмотреть сайт Bernina 
of America. 
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Выберите Embroidery Onscreen (из меню Help), 
чтобы просмотреть сайт Embroidery Online. 
 
Экранная документация пользователя 
предоставляется в форме экранного 
руководства и экранных справок. 
 
Просмотр онлайновой справки 
 
Онлайновая справка обеспечивает 
быстрый доступ к общей информации о 
функциях вышивального ПО BERNINA и к 
пошаговым инструкциям. 
 
Как просмотреть онлайновую 
справку 
 
1 Выберите Help > Help Topics, чтобы 

открыть главное окно справки  Help. 
2 Нажмите кнопку Contents 

(Содержание), чтобы открыть главный 
список тем справки. Темы 
сгруппированы под заголовками 
высшего уровня со значками "Книга". 

3 Дважды щелкните по значку "Книга", 
чтобы просмотреть список тем, а затем 
дважды щелкните по выбранной теме. 

 
 
Совет: Альтернативно нажмите кнопку 
Find (Найти) и введите ключевое слово, 
чтобы найти интересующий вас ответ.  
 
 
Просмотр экранного руководства 
Вы можете прочитать экраннон 
руководство, используя программу Adobe 
Acrobat™ Reader. Эта программа 
поставлена вам вместе с вышивальным 
ПО BERNINA. В экранном руководстве вы 
можете быстро найти нужную вам 
информацию, используя стандартные 
функции программы Adobe Acrobat™ 
Reader. 
 

Как просмотреть экранное 
руководство 
 
◄ Выберите Help > Onscreen Manual. 
 
Примечание: Если программа BERNINA 
не запущена, вы можете открыть 
экранное руководство непосредственно 
из Windows Explorer (Проводника 
Windows). Для этого найдите папку 
..\Program 
Files\BERNINA\Embroidery Software 
6\bin и дважды щелкните по файлу 
UserManual.pdf. 
 
Соединение с веб-сайтами 
BERNINA®  
Вы можете получить доступ к 
информации о приобретении и поддержке 
программных продуктов непосредственно 
из ПО. 
 
Примечание: Вы должны иметь 
правильно сконфигурированный веб-
браузер в своей системе совместно с 
доступом к Интернету. 
 
 
Как соединиться с сайтом 
BERNINA®  
 
◄ Соединитесь с вашим интернет-

провайдером.  
◄ Выберите Help > BERNINA Web Page. 

Вы непосредственно соединитесь с 
домашней страницей BERNINA® по 
следующим адресам:  
◄ Bernina International -

http://www.bernina.com/ 
◄ Bernina of America - 

http://www.berninausa.com/ 
◄ Embroidery Online - http: / /www. 

embroider yonline. com
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ГЛАВА 2 
 

ВВЕДЕНИЕ В ОЦИФРОВЫВАНИЕ 
ПРОЕКТОВ ВЫШИВКИ 

------------------------------------------- 

 
 

BERNINA Embroidery Software (Вышивальное ПО BERNINA) предоставляет 
возможность быстрым и гибким образом создавать и редактировать 
вышивальные проекты. В этом разделе дается обзор процесса оцифровывания 
мотивов вышивки, используемого в вышивальном ПО BERNINA. 

 
 
Процесс оцифровывания мотивов вышивки 
может состоять из некоторых или всех 
перечисленных ниже этапов: 
◄ проектирование мотивов 
◄ оцифровывание мотивов 
◄ изменение мотивов 
◄ улучшение качества мотива 
◄ добавление текста 
◄ вышивание мотивов 
◄ управление проектом 
 
Примечание: В отображаемом на экране 
руководстве содержатся детальные 
процедурные описания всех функций 
вышивального программного обеспечения 
BERNINA, а также приложений пакета BERNINA 
Portfolio. Для идентификации источников 
информации, имеющих отношение к Вашей 
конкретной модели, и опций, которые могут 
быть Вами выбраны, см. Список функций 
вышивального программного обеспечения 
BERNINA. 

Проектирование мотивов 
Для создания высококачественной вышивки вам 
нужно выбрать подходящий рисунок в качестве 
оригинала для оцифровывания. До тех пор, пока 
вы не станете достаточно опытным 
пользователем, не используйте сложные 
образцы. Изображения, имеющиеся в 
нецифровом формате, требуют сканирования. 
Возможными источниками для получения 
хороших изображений для вышивки являются: 
◄ книги 
◄ Интернет или компакт-диски с графическими 

файлами 
◄ оригинальные рисунки 
 
 
 
 

 

 
Хорошее качество вышивки 
Хорошее качество вышивки должно быть 
заложено еще на стадии проектирования. Вам 
нужна хорошая машина для вышивания. Но 
этого недостаточно, если вы не будете 
использовать надлежащие материалы, нитки, 
прокладки и т.п. Придерживайтесь следующих 
положений при проектировании мотива вышивки: 
◄ мотив выглядит красиво – по форме, цвету, 

балансу 
◄ стежки четкие, гладкие и ровные 
◄ контуры правильно заполнены подходящими 

стежками. 
◄ направление стежков соответствует 

контурам 
◄ контуры вышиты правильно – без 

неожиданных пробелов 
◄ детали четко определены 
◄ надписи четкие и легко читаются 
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мотив выглядит 
красиво – по форме, 

цвету, балансу 
 

направление 
стежков 

соответствует 
контурам 

 
контуры вышиты 
правильно – без 

неожиданных 
пробелов 

 
надписи четкие и 
легко читаются 

 
 

 
 

 
Вышитый мотив должен также обладать 
следующими характеристиками: 
◄ Мотив безупречно вышит машиной. 
◄ Ткань не должна сморщиваться вокруг зоны 

вышивки. 
◄ Мотив не должен иметь рыхлых концов. 
 
Подготовка к оцифровыванию 
 
Прежде чем приступить к оцифровыванию, 
необходимо проанализировать и тщательно 
спроектировать контуры и последовательность 
вышивания. 
Контуры вышивания должны быть тщательно 
определены, чтобы их можно было проще 
вышить. Наиболее простые для вышивания 
контуры имеют относительно постоянную 
ширину, сглаженные кромки, без резких изгибов 
и мелких выступающих деталей. 
 

 
Упрощение контура изображения до или во время 
оцифровывания 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
Последовательность 
оцифровывания 
Последовательность оцифровывания 
определяет порядок в котором создаются 
объекты вышивки и в котором они будут 
вышиваться. Вы можете изменить 
последовательность вышивания объектов в 
проекте, чтобы облегчить вышивания, например, 
свести к минимуму число переходов от одного 
цвета к другому. Детали необходимо вышивать в 
последнюю очередь. Подробнее см. в разделе 
Установление последовательности 
объектов. 
 
 
 
 

 
 
 
 
 
 

последняя деталь 
 
Типы стежков 
 
 
Примите решение, какого типа стежки вы хотите 
использовать для каждого контура проекта. Если 
вы в нормальном случае определите тип стежка 
перед оцифровыванием каждого контура,  
вышивальное ПО BERNINA позволит вам внести 
изменения на любой стадии. Подробнее см. в 
разделе Оконтуривающие и заполняющие 
стежки. 
 
         

 
  Заполняющие стежки  Оконтуривающие стежки 

 
 
детали четко определены 
 
 
 
стежки четкие, гладкие и 
ровные 
 
 
 
контуры правильно заполнены 
подходящими стежками 
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Оцифровывание мотивов 
 
Процесс оцифровывания позволяет вам 
создавать проекты вышивки по основным 
контурами. Для создания различных контуров 
имеются различные инструментальные 
средства. При ручном оцифровывании 
отмечаются базисные точки по очертанию 
контура, при использовании автоматических 
инструментов контуры создаются автоматически. 
 
Проекты, создаваемые  вышивальным ПО 
BERNINA, составляются из вышивальных 
"объектов", обладающих собственным 
уникальным набором "свойств". Наиболее 
важным свойством объекта вышивки является 
тип стежка. 
 
Просмотр мотивов  
 
Во время создания проекта вы можете видеть 
проект в различных режимах. 
В зависимости от уровня Вашего программного 
продукта, вышивальное ПО BERNINA 
предлагает различные режимы просмотра, 
которые можно выбрать на Панели режима 
простмотра.  
 
 

 
У этого приложения имеется одна рабочая среда 
или «Окно проекта», но Вы будете 
взаимодействовать  с ним в отдельных режимах. 
Подробнее см. в разделе Режимы просмотра 
вышивального  ПО BERNINA. 

 
Используйте линии сетки и изображение пялец, 
чтобы точно совместить или установить 
требуемые размеры объекта вышивки. Вы 
можете показывать и скрывать сетку и пяльцы.  
Имеются пяльцы нескольких размеров, чтобы 
правильно выбрать размеры проекта. 
См. Отображение сетки и Отображение 
пялец. 
 
 
 
 
 
 
 
 
 

Используйте функции Overview Window и Zoom 
для быстрой проверки вашего проекта при 
разных ступенях увеличения. Подробнее см. в 
разделе Изменение масштаба и 
панорамирование. 
 
 

При работе с проектами вышивки вам 
необходимо разобраться с 
последовательностью вышивания. Вы можете 
проверить последовательность вышивания 
проекта путем ‘обхода’ по стежкам, цветам или 
объектам. Вы можете также проверить 
последовательность  
медленным перерисовыванием проекта на 
экране. Подробнее см. в разделе  
Просмотр последовательности 
вышивания. 
 
 
Вышивальное ПО BERNINA  дает возможность 
выбирать цвет фона в окне проекта, чтобы 
согласовать его с цветом вашей ткани. Или же 
можно выбрать фон ткани для более 
реалистичного вида и воспроизведения. 
Подробнее см. в разделе Изменение фона. 
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Выбор объектов 
 
BERNINA 
Embroidery Software 
предоставляет 
различные меню 
для выбора 
объектов, из 
которых состоит 
вышивальный 
проект. 
В них входят такие 
средства, как 
"указать и 
щелкнуть", выбор методом ограничивающего 
прямоугольника и многие способы выделения 
объекта. Вы можете выбрать все объекты в 
проекте или индивидуальный объект для 
прецизионной модификации. BERNINA 
Embroidery Software позволяет выбрать объект 
для оконтуривания или заполнения. Подробнее 
см. в разделе Выбор объектов. 
 
 
 
 
Закрепление проектов в пяльцах 
 
Перед вышиванием на 
машине материал 
должен быть растянут в 
пяльцах. Программный 
пакет BERNINA 
Embroidery Software 
предлагает вам на 
выбор широкий 
диапазон стандартных 
пялец. Если в ваш 
проект входит крупный 
объект или большое 
количество небольших 
объектов, вам может 
потребоваться 
использовать технику перезаправки пялец.  Если 
у вас есть пяльцы, которых нет в списке, вы 
можете определить собственные пяльцы по 
своему эскизу или на основе стандартных пялец. 
Подробнее см. в разделе Закрепление 
проектов в пяльцах. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Методы оцифровывания 
 
В BERNINA Embroidery 
Software вы составляете  
проекты из базовых форм, 
или "вышивальных 
объектов".  
Процесс создания 
вышивальных объектов на 
экране называется 
"оцифровыванием". Как и 
при создании проектов в 
графических программах, 
используются различные 
инструменты и способы 
оцифровывания. Для 
создания вышивальных 
объектов они применяются совместно с 
различными типами стежков. Инструментальные 
средства оцифровывания в BERNINA подобны 
инструментам рисования с той лишь разницей, 
что конечным результатом является 
вышивальный, а не рисованный объект. 
Подробнее см. в разделе Методы 
оцифровывания. 
 
 
 
Оконтуривающие и заполняющие 
стежки 
 
Всем вышивальным 
объектам BERNINA 
назначаются настройки 
или "свойства", наиболее 
важным из них является 
тип стежков. Каждый раз, 
когда вы создаете или 
модифицируете объект, 
стежки генерируются в 
соответствии с 
выбранным типом стежка. 
Настройки стежка, такие 
как выбор шага и длины 
стежка, выбираются до 
или после 
оцифровывания. Типы 
стежков. подразделяются 
на две большие категории – "оконтуривающие" и 
"заполняющие". Оконтуривающие стежки, как 
следует из их названия, служат для 
оконтуривания или обрамления и для 
прорисовки деталей. Заполняющие стежки 
применяются для заполнения крупных форм и 
"цветных блоков" проекта. Типы оконтуривающих 
и заполняющих стежков определяются во время 
создания вышивальных форм, но вы можете 
изменять их на любой стадии. Подробнее см. в 
разделе Оконтуривающие и заполняющие 
стежки. 
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Цвета ниток и таблицы ниток 
 
При 
оцифровывании 
вы выбираете в 
окне проекта 
цвета ниток из 
палитры цветов 
для каждого 
создаваемого 
объекта. Цветовая 
палитра содержит 
набор цветов 
ниток, 
выбираемый для 
каждого проекта. Эта цветовая схема 
представляет собой фактические цвета ниток, 
которыми будет вышит проект. Вы можете 
выбирать цвета по фирменным таблицам ниток, 
содержащим широкий диапазон цветов, 
предлагаемых различными производителями. 
Для экономии времени при настройке новых 
цветовых схем вы можете создать и распечатать 
собственные таблицы ниток, используя 
предпочитаемые вами или наиболее часто 
применяемые цвета. В BERNINA вы можете 
искать нужные вам нитки по различным 
критериям. Можно также подбирать нитки к 
цветам вашего проекта автоматически из 
выбранной таблицы. Подробнее см. в разделе 
Цвета ниток и таблицы ниток. 
 
 
Свойства объекта и шаблоны 
 
Свойствами объектов 
вышивания 
определяются общие 
характеристики, такие как 
размер и положение, а 
также специфические 
вышивальные 
характеристики, такие как 
тип и плотность стежков. 
Специфичные настройки 
стежка определяют. 
каким образом будут 
воспроизводиться стежки 
при изменение формы, 
преобразовании или 
изменении размеров 
объекта. 
При создании объекта вышивки вы можете 
принять предлагаемые по умолчанию настройки 
для отдельного метода оцифровывания или же 
применить другие настройки. Принимаемые по 
умолчанию стандартные настройки хранятся в 
шаблоне проекта. Вы можете также определить 
"текущие" свойства, которые будут влиять на все 
объекты, создаваемые в текущем проекте. 
Подробнее см. в разделе Свойства объекта и 
шаблоны. 
 
 
 
 
 

Повышение качества вышивания 
 
BERNINA Embroidery Software 
предлагает большое число 
настроек, позволяющих 
улучшить качество и внешний 
вид вышивки в окончательном 
виде.  Используйте настройки 
ткани, так что машина будет 
учитывать тип ткани, на которой 
выполняется вышивка. 
Используйте функцию 
автоматической стабилизации 
ткани для сокращения опасности 
искажения вышивки вследствие 
стягивания материала. 
Настройте требуемую вам величину перекрытия 
путем изменения установок компенсации 
стягивания. Это особенно удобно, если вы 
вышиваете проект на материалах с различной 
степенью растяжения. 
При применении функции Auto Jump 
(Автоматический переход) вы можете 
сохранить длинные стежки в объектах, 
превратив их в серии переходов. По умолчанию 
начальные закрепляющие стежки автоматически 
вставляются в начале объектов, чтобы 
предотвратить распускание стежков. Вы можете 
выбирать или отменять функцию закрепляющих 
стежков для всего проекта или отдельных 
объектов. Используйте команду Auto Start and 
End, чтобы установить положение первого и 
конечного стежков проекта. Все эти функции 
входят в "свойства объекта" и могут быть 
применены, отменены или модифицированы в 
любое время. Подробнее см. в разделе 
Улучшение качества стежка. 
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Оцифровывание по 
художественному оригиналу 
 
Не забывайте, что для создания 
высококачественной вышивки вам нужно 
выбрать подходящий рисунок в качестве 
оригинала для оцифровывания. Возможными 
источниками могут быть книги, рисунки из 
Интернета, компакт-диски с графическими 
файлами или собственные рисунки. После 
импортирования в среду BERNINA Embroidery 
Software используйте их как "оригинал" для 
ручного оцифровывания или автоматически 
преобразуйте формы или целые проекты в 
вышивальные объекты. 
 
Оцифровывание с оригиналом 
 
Файл рисунка в 
растровом или векторном 
формате может быть 
загружен, скопирован или 
отсканирован в BERNINA 
для использования в 
качестве 
оцифровываемого 
оригинала или 
трафарета. Можно импортировать также 
текстурированный фон, чтобы увидеть, как будет 
выглядеть вышивка на реальной ткани. Может 
быть использован почти любой рисунок – 
фотография, журнальные иллюстрации, 
графические файлы и даже образцы ткани. 
Подробнее см. в разделе Оцифровывание с 
оригиналом. 
 
 
Подготовка изображений для 
автоматического оцифровывания. 
 
BERNINA Embroidery 
Software 
поддерживает 
автоматическое и 
полуавтоматическое 
оцифровывание 
растровых 
изображений. 
Качество 
окончательного 
проекта в 
значительной мере зависит от типа и качества 
оригинального изображения. Чтобы сделать 
растровые изображения более пригодными для 
автоматического оцифровывания, BERNINA 
обладает также возможностями обработки 
изображений и связи с графическими 
программами. Подробнее см. в разделе 
Обработка изображений для 
автоматического оцифровывания. 
 
 
 
 
 
 
 

Автоматическое оцифровывание 
 
BERNINA Embroidery Software 
предоставляет возможность 
пользоваться  
инструментом Magic Wand 
(Волшебная палочка) для 
быстрого создания проектов 
вышивки, которые не требуют 
особых художественных 
эффектов или специфичных 
знаний в области вышивания 
Это, в свою очередь, поможет 
вам сохранить больше времени 
на обработку в 
действительности сложных зон вашего проекта. 
Инструмент Auto Digitizer автоматически 
преобразует изображение в полностью 
оцифрованную форму с небольшими вашим 
вмешательством или совсем без 
вмешательства. Применяя Auto Digitizer, 
начинающие пользователи могут легко и быстро 
создавать несложные проекты. Равным образом, 
опытным пользователям он позволяет быстрее 
работать с простыми проектами. Программа 
PhotoSnap используется для создания проектов 
вышивки по фотографиям и другим 
изображениям.  Подробнее см. в разделе 
Автоматическое оцифровывание.  
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Изменение проектов 
 
После оцифровывания проекта вы можете 
изменять его в целом,  
редактировать индивидуальные объекты или 
даже индивидуальные стежки. 
 
 
Комбинирование и 
последовательность объектов 
 
BERNINA Embroidery 
Software позволяет 
легко создавать 
комбинации проектов и 
элементов проекта 
путем вставки 
содержания одного 
файла в другой. Вы 
можете также быстро 
добавлять к проектам 
существующие объекты 
путем их копирования 
или дублирования. 
Объединение в группу выделенных объектов или 
целых проектов используется для совместного 
перемещения, изменения размеров или 
трансформирования.  Подробнее см. в разделе 
Комбинирование и последовательность 
объектов. 
Объекты вышивки в проекте образуют 
"последовательность вышивания". 
Первоначально объекты вышиваются в том 
порядке, в котором они были созданы. 
Однако имеется много способов изменения 
последовательности вышивания. Например, 
можно изменить положение выделенного 
объекта, вырезав его и вставив в другое место 
последовательности. Имеются также 
возможности выбора последовательности 
объектов способом "As Selected" 
("Последовательность в порядке выделения") 
или как "Color Blocks" ("Цветные блоки"). Вы 
можете также изменить последовательность 
объектов, используя инструмент Color Film. 
Подробнее см. в разделе Установление 
последовательности объектов. 
Функция Stitch Sequence (Последовательность 
вышивания) улучшает качество и 
эффективность вышивания, сводя к минимуму 
количество перезаправки пялец, замены 
цветных ниток и обрезки ниток.  Все 
существующие перекрытия сохраняются при 
этой операции. Подробнее см. в разделе 
Автоматическая последовательность 
вышивания всего проекта. 
 
 
 
 
 
 
 
 
 
 

Расположение и трансформация 
объектов 
 
BERNINA Embroidery Software 
позволяет располагать и 
трансформировать объекты 
различными способами, как 
интерактивной, так и 
цифровой техникой. 
Позиционировать объекты 
можно перетаскиванием 
мышью, клавишами со 
стрелками или изменением 
свойств объекта. Для выравнивания объектов 
относительно друг друга имеются различные 
специальные инструменты. Изменять размеры 
объектов можно непосредственно на экране или 
заданием точных размеров или процентного 
изменения. Поворот, изменение наклона и 
зеркальное отображение объектов производится 
такими же средствами. Специальные 
инструменты позволяют дублировать и 
трансформировать вышивальные объекты, а 
также переводить их в зеркальное отображение 
и поворачивать по центральным осям.  
Подробнее см. в разделе Расположение и 
трансформация объектов. 
 
 
Изменение формы и правка 
объектов 
 
BERNINA Embroidery Software 
позволяет изменять форму 
объекта, угла стежков точки 
входа и выхода с помощью 
контрольных точек. Линии 
наклона стежков маркеры 
входа и выхода появляются 
вокруг выбранных объектов. 
Контрольные точки слегка 
различаются в зависимости от 
типа объекта. Подробнее см. 
в разделе Изменение формы 
и правка объектов.  
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Редактирование стежков 
 
BERNINA 
автоматически 
генерирует стежки в 
соответствии с 
контуром проекта и 
свойствами. Это 
означает, что вы 
можете 
преобразовывать 
проекты и изменять их формы без изменения 
плотности или качества стежков. Но BERNINA 
Embroidery Software позволяет также 
редактировать индивидуальные стежки. Вам 
просто нужно выделить стежок и 
манипулировать с ним, как и с другим объектом. 
Например, вы можете вставить стежки в объект, 
чтобы заполнить пробел, или переместить и 
удалить индивидуальные стежки или группы 
выбранных стежков. Например, это может 
потребоваться при работе с файлами стежков, 
которые не содержат данных о контуре проекта. 
Однако, если это возможно, лучше  
редактировать свойства объекта,  
чем индивидуальные стежки. Подробнее см. в 
разделе Редактирование стежков. 
 
 
Указания для опытных 
пользователей 
BERNINA Embroidery Software предоставляет 
для опытных пользователей  
ряд мощных производительных функций, а также 
специальные эффекты  
и способы оцифровывания  
 
Специальная техника 
оцифровывания 
 
BERNINA Embroidery Software предлагает 
пользоваться специальными экономящими 
время способами оцифровывания. Подробнее 
см. в разделе Специальная техника 
оцифровывания.  
 

 
 
 
 
 
 
 
 
 
 
 

 
Имеются инструменты для 
упрочнения контуров, 
вырезки отверстий в 
объектах, удаления 
подстилающих стежков, а 
также заполнения 
отверстий. Имеются также 
специальные инструменты 

для простого и быстрого создания  
пуговичных петель. Подробнее см. в разделе  
Создание пуговичных петель. 
 
 
 
Эффекты художественного 
вышивания 

BERNINA Embroidery 
Software предлагает 
большое количество 
художественных эффектов 
и типов стежков для 
создания текстурированных 
и узорных форм 
заполнения объектов. 
Орнаментное заполнение 

Fancy fill подобно заполнению простегивающими 
стежками, но при этом стежки располагаются в 
виде регулярно повторяющихся узоров. 
Подробнее см. в разделе Создание заполнения 
орнаментным стежком. 
 
 
 
 
Используйте функцию 
Textured Edge 
(Текстурированный 
край) для создания 
теневых эффектов или для 
имитации меха или других 
пушистых структур в вашем 
проекте. Подробнее см. в 
разделе Создание 
текстурированных краев. 
 
 

 
 
Эффект волнистости 
(Wave Effect) является 
функцией, позволяющей 
искривлять линии строчек 
стежков заполнения. 
Стежки следуют 

оцифрованной линии, но сохраняют однородную 
плотность и порядок проколов иглой материала. 
Подробнее см. в разделе Создание эффекта 
волнистости. 
 
 



Глава 2: Введение в оцифровывание проектов вышивки 
 

BERNINA® Вышивальное ПО Версия 6  14

 
Функция Gradient Fill (Заполнение с плавным 
тоновым переходом) 
изменяет плотность 
рядов строчек 
заполнения от весьма 
плотного до весьма 
редкого, создавая 
теневые и цветовые 
эффекты, которые трудно 
было бы получить 
вручную. Подробнее см. в разделе Создание 
заполнения с плавным тоновым переходом. 
 
 
 

Используйте эффект Travel 
on Edges (Перемещение 
по краям), чтобы 
подстилающие стежки 
сместились к краям 
объекта и не были заметны 
через открытую часть 
вышивки. Подробнее см. в 

разделе Создание открытого заполнения. 
 
 
 
Эффект Color Blending 
(Смешивание цветов) 
автоматически создает 
различные теневые, 
перспективные и 
трехмерные эффекты путем 
смешивания двух цветных 
слоев в одном объекте 
вышивки. Подробнее см. в разделе Создание 
эффекта смешивания цветов.  
 
Оконтуривание и заполнение 
узорами 
Узоры – это 
предварительно 
определенные 
элементы 
дизайна, такие 
как сердечки, 
листья или узоры 
бордюра, 
которые могут 
быть быстро 
вставлены в 
проект. Они 
обычно состоят 
из одного или нескольких простых объектов и 
сохраняются в специальном комплекте узоров. 
 
 
Используйте узоры, входящие в комплект 
программного обеспечения или создайте 
собственные. Узоры можно изменять по 
размеру, поворачивать и переводить в 
зеркальное отображение таким же образом, как 
и другие объекты. 
Вы можете использовать узоры, расположенные 
вдоль оцифрованной линии. Можно также 
заполнять формы рядами повторяющихся 
узоров и применять специальные эффекты. 

Подробнее см. в разделе Узорные штампы,  
контуры и заполнения.  
 
Оконтуривание и заполнение 
рукодельными стежками 
BERNINA Embroidery Software предлагает ряд 
"рукодельных" стежков, которые вы можете 
использовать в своих проектах для имитации 
некоторых традиционных ручных вышивок. Сюда 
входит большой выбор черно-белых узоров 
"blackwork" и узелковых узоров "candlewicking", 
подходящих как для оконтуривания, так и для 
заполнения объектов.  

 
 
 
 
Стежок "назад в иголку" (Backstitch) и 
стебельчатый стежок (Stemstich) являются двумя 
разными оконтуривающими стежками. Стежок 
"назад в иголку" образует непрерывную тонкую 
линию, подобную машинной строчке, в то время 
как стебельчатый стежок образует 
шнурообразную строчку, толщину которой можно 
изменять в зависимости от угла наклона 
стежков. Оба стежка могут быть использованы 
для создания ровных рядов стежков, пригодных 
для оконтуривания и образования черно-белых 
узоров blackwork. Стежки кружевного 
переплетения (Lacework) и пунктирные стежки 
(Stipple) используются для декоративного 
заполнения. Кружевное переплетение можно 
использовать для придания таким объектам, как 
цветы, вид кружева. 
Строчки пунктирного простегивания, известные 
также, как "вермишель", образуют плавные 
произвольные линии, используемые для 
декоративных эффектов или для стежки квилтов. 
Подробнее см. в разделе Оконтуривание и 
заполнение рукодельными стежками. 
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Оцифровывание для аппликаций 
 
Техника 
аппликации 
занимает важное 
место в домашнем 
рукоделии, и 
функция Auto 
Applique облегчает 
достижение 
высокого качества 
работы. 
Используйте функцию Auto Applique для 
получения стежков, которые требуются для 
объектов аппликации. Генерируется до четырех 
слоев вышивки – линия размещения, линия 
обрезки, закрепляющие и покрывающие стежки. 
Используя инструмент Partial Applique, вы 
можете создавать объекты аппликации с 
частичным покрытием вышивкой для 
образования эффекта нахлестки без 
дублирования обрамления Подробнее см. в 
разделе Оцифровывание для аппликаций.  

Иногда может 
потребоваться 
дополнительная 
гибкость для 
расширения 
диапазона 
проектов, 
которые вы 
можете 

вышивать.  
Например, проекты, содержащие открытые 
объекты, не могут обрабатываться функцией 
Auto Applique. В таком случае специальный 
инструмент Advanced Applique позволит 
создавать "объект открытой аппликации" из 
одного или нескольких "первичных" объектов. 
Подробнее см. в разделе Создание 
открытого объекта аппликации. 
 
Вышивание текстов 
Можно легко и просто создавать 
высококачественные текстовые вышивки. 
BERNINA Embroidery Software предоставляет 
широкий выбор масштабируемых шрифтов, а 
также многоцветных алфавитов, вышиваемых 
орнаментными стежками. В буквы для 
вышивания можно выбирать из входящих в 
комплект поставки алфавитов или из обычных 
шрифтов TrueType. Подробнее см. в разделе 
Примеры алфавитов. 
 
 
 
 
 
 
 
 
 
 
 
 

Основные сведения о текстовых 
объектах 
 
Текстовые объекты 
добавляются к проекту 
быстро и легко или на 
экране с использованием 
текущих настроек, или 
через диалоговое окно 
свойств объекта. Вы 
можете поместить текст 
на прямой 
горизонтальной или 
вертикальной линии, по окружности или по дуге 
или же создать собственную базовую линию 
произвольной формы. Вы можете применять 
форматирование текстовых объектов таким же 
образом, как при работе в текстовом редакторе, 
включая придание тексту курсивного или 
полужирного начертания или выравнивание по 
левому или правому краю. Интервалы между 
буквами, словами и строчками могут быть 
определены до или после создания текстовых 
объектов и размещения их в вашем проекте. 
Подробнее см. в разделе Основные сведения о 
текстовых объектах.  
 
Правка вышиваемых текстов 
 
BERNINA Embroidery 
Software предоставляет 
возможность как 
диалогового, так и точного 
цифрового управления 
многими атрибутами, 
воздействующими на 
текстовые объекты. Вы 
можете настраивать 
текстовые объекты как в 
целом, так и по отдельным 
буквам. Текст можно 
изменять непосредственно на экране или через 
свойства объекта. Вначале при создании текста 
он может быть слишком большим или слишком 
малым. Размер можно изменять в диалоговом 
режиме или вводом соответствующих цифр. Для 
мелких, узких букв стабилизирующие стежки 
могут не потребоваться, в зависимости от 
размеров букв и вида материала, на которых они 
будут вышиты. Используйте соответствующие 
инструменты, чтобы изменять угол наклона и 
поворачивать текстовые объекты. Отдельные 
буквы настраиваются так же, как и другие 
объекты  
вышивки. Изменение формы текста, настройка 
угла наклона стежков и  
изменение цвета производятся индивидуально. 
Базовые линии могут быть  
назначены после размещения текста 
непосредственно на экране или  
через свойства объекта. Подробнее см. в 
разделе Правка вышиваемых текстов. 
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Специальные текстовые эффекты 
 
Все шрифты 
TrueType, 
установленные в 
вашем компьютере, 
также могут быть 
использованы для 
вышивания текста в 
вашем проекте. 
BERNINA 
Embroidery Software 
позволяет добавлять к тексту специальные 
символы, которых нет на клавиатуре. BERNINA 
предоставляет также несколько специальных 
алфавитов с орнаментными буквами, а также 
буквами для монограмм. Как и все объекты 
вышивания, каждый текстовый объект имеет 
свои собственные свойства. Вы можете 
настраивать их до или после создания 
текстового объекта. BERNINA Embroidery 
Software, кроме того, дает возможность точно 
контролировать углы стежков отдельных букв. 
Применяйте функцию Elastic Lettering (Гибкий 
текстовый объект) к текстовым объектам, 
чтобы сделать текст выпуклым или 
дугообразным,  
растянутым или сжатым. Подробнее см. в 
разделе Специальные  
текстовые эффекты. 
 
 
Создание монограмм 
 
Монограмма 
состоит из 
одной или 
нескольких 
букв, обычно 
инициалов 
имени, и 
используется 
как 

идентификационная метка. Функция 
Monogramming (Создание монограмм) 
предоставляет простой способ создания 
персонализированных монограмм с выбором 
стандартных стилей монограмм, форм 
обрамления и орнаментов вместе с набором 
инструментов, помогающих творчески 
размещать эти элементы наиболее 
декоративным образом.  Подробнее см. в 
разделе Создание монограмм. 
 
 
 
 
 
 
 

Обработка проекта 
 
На определенной стадии вы захотите передать 
свои проекты на принтер, в машину или 
запоминающее устройство. Для этого вам 
потребуются знания о различных опциях 
принтера, типах вышивальных файлов и 
подходящих средствах записи и хранения 
информации. 
 
Вывод проектов 
Вы можете выводить 
проекты вышивок 
различными способами 
– распечаткой в виде 
рабочих документов, в 
виде выкроек 
аппликаций, цветных 
слайдов или таблиц 
ниток. BERNINA Embroidery Software позволяет 
также сохранять проекты как изображения с 
тканью и деталями одежды. Вы можете также 
непосредственно направить проект в машину. 
При работе с проектами, размер которых больше 
размеров пялец вы можете расчленить проект 
на несколько частей с одним или несколькими 
объектами.  Программное обеспечение 
автоматически рассчитает, какие файлы должны 
быть направлены в машины и покажет как они 
будут выглядеть. Подробнее см. в разделе 
Вывод проектов. 
 
Сохранение и вызов проектов 
 
По умолчанию BERNINA 
Embroidery Software 
сохраняет проекты в 
собственном ["родном"] 
формате файла .ART. 
Этот формат содержит 
всю информацию, 
требуемую как для 
вышивания проекта, так и 
для последующих 
изменений. Однако 
BERNINA может также открывать проекты в 
других форматах. В таких случаях BERNINA 
преобразует данные проекта таким образом, что 
их можно обрабатывать, используя весь 
диапазон функций программного обеспечения. 
Если вы отправили проекты непосредственно в 
машину, они могут быть потеряны после 
отключения машины. Помимо сохранения на 
жестком диске, на дискете или компакт-диске, вы 
можете также сохранять проекты в памяти 
вышивальной машины, карте памяти или на USB 
memory Stick. Если у вас имеется прибор Magic 
Box, вы можете считать и записать проект также 
и на другие карты памяти. Подробнее см. в 
разделе Считывание и запись файлов 
проектов. 
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Управление проектом 
 
Программа BERNINA Portfolio обеспечивает 
эффективный способ управления проектами 
вышивки. Этот инструмент управления 
проектами может обеспечить доступ к файлам, 
сохраняемым на жестком диске компьютера, 
компакт-диске или дискете. Программа Portfolio 
позволяет даже архивировать и просматривать 
файлы в папках, которые были архивированы с 
помощью популярного архиватора WinZip. Она 
распознает все форматы файлов проектов, 
используемые в BERNINA Embroidery Software. 
Подробнее см. в разделе Основные сведения о 
программе Portfolio. 
 

 
 
Проекты в папках BERNINA Portfolio можно 
сортировать тремя способами. Это удобно для 
тех случаев, когда вы хотите выбирать проекты 
для вышивания, распечатки, архивирования и 
т.п. Проект, выбранный в папке BERNINA 
Portfolio, может быть непосредственно передан в 
вышивальную машину. Вы можете также 
конвертировать ART-файлы и другие файлы 
проектов в файлы других форматов. Каталоги 
проектов в папке содержат пиктограммы и/или 
краткое описание. Они могут быть направлены в 
принтер и распечатаны в различных форматах. 
Программа BERNINA Portfolio позволяет 
архивировать и просматривать файлы в папках, 
которые были архивированы с помощью 
популярного архиватора WinZip. Это может быть 
удобным для пересылки или получения файлов 
по электронной почте. Подробнее см. в разделе 
Программа BERNINA Portfolio для опытных 
пользователей. 
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ЧАСТЬ I 

 

ОСНОВЫ 
------------------------------------------- 
 
 
 
Проекты, создаваемые вышивальным ПО BERNINA Embroidery Software составляются из 
"вышивальных объектов". Они называются "объектами", так как они являются дискретными 
блоками, которые можно обрабатывать независимо друг от друга. Каждый объект обладает 
определенными характеристиками, или "свойствами", такими как цвет, размеры, 
положение и т.п. Наиболее важным свойством объекта вышивки является тип стежка. 
 
 
Введение в оцифровывание проектов вышивки 
 
Программное обеспечение BERNINA Embroidery Software предоставляет возможность 
быстрым и гибким образом создавать и редактировать вышивальные проекты. В этом 
разделе дается обзор процесса оцифровывания мотивов вышивки, используемого в ПО 
BERNINA. Подробнее см. в главе Введение в оцифровывание проектов вышивки в 
экранном руководстве  
 
 
Основные процедуры 
 
В этом разделе описывается, как запустить приложения BERNINA Embroidery Software и 
соответствующие команды и инструменты. Они требуются для открытия, создания и 
сохранения файлов с проектами. Объясняется, как активировать пяльцы и линии сетки и 
получать доступ к свойствам объектов. Подробнее см. в главе Основные процедуры. 
 
 
Просмотр проектов 
 
В этом разделе разъясняются режимы просмотра проекта, предоставляемые BERNINA 
Embroidery Software, а также различные настройки просмотра проекта. Описываются 
функции изменения масштаба и панорамирования, а также просмотра последовательности 
вышивания. Объясняется, как отображать на экране оригиналы проектов и изменять фон. 
Также объясняется, как получать информацию о ваших проектах. Подробнее см. в главе 
Просмотр проектов. 
 
 
Выбор объектов 
 
В этом разделе описывается, как выбирать объекты, используя инструменты выбора и 
клавиатуру. Также объясняется, как выбирать цветные блоки или индивидуальные 
объекты, используя функцию Color Film. Подробнее см. в главе Выбор объектов. 
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Закрепление проектов в пяльцах 
 
В этом разделе описывается, как выбирать и отображать пяльцы в ПО BERNINA 
Embroidery Software. Объясняется, как создавать и модифицировать пользовательские 
пяльцы. Также даются указания, как закреплять в пяльцах крупные проекты. Подробнее см. 
в разделе Закрепление проектов в пяльцах руководства. 
 
 
Настройка аппаратных и программных средств 
 
В этом разделе описывается, как настраивать вышивальные машины и сканеры и как 
калибровать монитор. Кроме того, объясняется, как изменять интервал сетки и опции 
пялец. Также рассматриваются настройки общих опций, таких как автосохранение, 
отображение положения указателя мыши и т.п.  
Подробнее см. в разделе Настройка аппаратных и программных средств 
руководства. 
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ГЛАВА 3 
 

ОСНОВНЫЕ ПРОЦЕДУРЫ 
------------------------------------------- 
 
 
 
 
 
Для работы с программным обеспечением BERNINA 
Embroidery Software вам требуется знать основные 
процедуры, такие как запуск программ, открытие и 
создание проектов и сохранение. После запуска BERNINA 
Embroidery Software вы должны пользоваться командами 
или пиктограммами и диалоговыми окнами, чтобы 
выполнять соответствующие задачи. Команды 
выбираются таким же образом, как и в других 
приложениях Windows, – из меню или панелей 
инструментов. 
 
В приложениях BERNINA Embroidery Software открываются файлы в "родном" формате .ART, а 
также файлы других вышивальных форматов, хранящиеся на жестком диске компьютера, 
дискете или компакт-диске. 
 
Программный пакет BERNINA Embroidery Software предлагает вам на выбор широкий диапазон 
стандартных пялец. Используйте линии сетки, чтобы точно совместить или установить 
требуемые размеры объекта вышивки. Наиболее важным диалоговым окном в BERNINA 
Embroidery Software является диалоговое окно Object Properties (Свойства объекта). Это и 
диалоговое окно Effects (Эффекты) являются "немодальными" диалоговыми окнами, это 
означает, что в окне Design они остаются открытыми до тех пор, пока они нужны. 
 
В этом разделе описывается, как запустить приложения BERNINA Embroidery Software и 
соответствующие команды и инструменты. Они требуются для открытия, создания и 
сохранения файлов с проектами. Объясняется, как активировать пяльцы и линии сетки и 
получать доступ к свойствам объектов. 
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Интерфейс программы BERNINA Embroidery 
Software 
Программа BERNINA Embroidery Software 
интегрируется с программой CorelDRAW® 
Essentials 4 , образуя единое приложение. Оно 
позволяет пользователям создавать не только 
образцы для вышивки, но и настоящие 
мультимедийные объекты дизайна. Приложение 
имеет общее рабочее пространство (‘Design 
Window’), но работать в этом пространстве 
можно в двух разных режимах: Art Canvas (для 
дизайнерской работы) и Embroidery Canvas 
(для вышивок). Третий режим, Hoop Layout, 
предназначен для работы с большими 
проектами, не помещающимися в пяльцах. См. 
также раздел Режимы просмотра в 
Руководстве пользователя.  
 

 
 
Запуск вышивального программного 
обеспечения BERNINA Embroidery Software  

 
Для запуска BERNINA Embroidery 
Software щелкните дважды мышью 
по этому ярлыку. 
 

Программа BERNINA Embroidery Software может 
быть открыта через ярлык на рабочем столе или 
меню кнопки Пуск.  
По умолчанию включается режим Embroidery 
Canvas. В этом режиме можно создавать и 
редактировать объекты вышивания, 
используя инструментарий оцифровывания 
вышивок 
 
 
 
Как запустить BERNINA Embroidery Software  
 
◄ Щелкните дважды мышью по ярлыку 

BERNINA Embroidery Software на рабочем 
столе Windows или  выберите в меню кнопки 
Пуск > Все программы > BERNINA 
Embroidery Software > BERNINA Embroidery 
Software. 

 
BERNINA Embroidery Software открывается в 
режиме Embroidery Canvas с новым, пустым 
проектом (Design1). На показанном внизу экране 
отображены в развернутом виде все панели 
инструментов приложения BERNINA 
DesignerPlus. В зависимости от уровня вашего 
программного продукта вы получите доступ к 
некоторым или всем этим опциям.
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Title bar – 
Menu bar – 

General toolbar –  
Stitch and Color Bar – 

Edit Toolbar –  
 

Строка заголовка  
Строка меню 
Общая панель инструментов 
Панель Стежок и Цвет 
Панель инструментов правки 
 

Edit Toolbar – 
Digitize Toolbar - 
Arrange Toolbar- 

Craft Stitch Toolbar– 
View  Mode Toolbar- 

Status bar - 

Панель инструментов правки 
Панель оцифровки  
Панель размещения 
Панель рукодельных стежков 
Панель режима просмотра   
Строка состояния 

 
 
Примечание: Панели являются плавающими, их 
можно размещать справа, слева, сверху или 
снизу и "перетаскивать" в любое место окна 
проекта. Панель Стежок и Цвет и может быть 
расположена вертикально, но в этом случае 
списки оконтуривающих и заполняющих стежков 
не открываются. Поэтому рекомендуется 
размещать эту панель только горизонтально. 
См. также Краткий справочник в Руководстве 
пользователя. 
 

◄ Измените окно проекта по своему желанию, при 
этом можно отобразить или скрыть сетку, 
изменить размеры сетки, отобразить или скрыть 
панели инструментов. Подробнее см. в разделе 
Отображение сетки. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Портативные закладки 
 
Программа BERNINA Embroidery Software 
использует портативные закладки (‘dockers’) для 
вызова основных функций. Режим Embroidery 
Canvas имеет следующие закладки: Color Film 
(цветной фильм), Carving Stamps (резьба и 
тиснение) , Morphing Effects (эффекты плавного 
преобразования) и Overview Window (обзорный 
диалог). Все закладки группируются в правой 
стороне рабочего экрана Design Window. 
 
 
 
 
 
 
 
 
 
 
 
 

Окно проекта 



Глава 3: Основные процедуры 
 

BERNINA® Вышивальное ПО Версия 6  23

 
Закладки группируются для увеличения размера 
рабочей области экрана.  При этом они 
разворачиваются вертикально для компактности. 
Размер закладок можно зафиксировать или 
минимизировать. При установке курсора мыши 
на закладку, всплывает минимизированный по 
размерам «docker», позволяющий обращаться к 
соответствующей функции. Если закладка не 
используется, она автоматически 
минимизируется. 
Панель закладок можно “перетащить” с 
помощью мышки в рабочую область ‘Design 
Window’ или двойным щелчком мыши при 
закреплении их на месте. 
 
Строка текущего состояния (Status bar) 
 
Строка текущего состояния в нижней части 
рабочей области экрана Embroidery Canvas 
отображает состояние текущего положения 
курсора и инструкции по использованию 
выбранных инструментов.  
 

 
Отображаемая информация включает: 

• Сообщения - подсказки: они помогают 
работать с выбранными функциями 

• Ширину и высоту образца 
• Координаты текущего положения иглы 

(X/Y), длину (L) и угол (A) текущего 
стежка. См. также раздел Измерение 
расстояний на экране. 

• Счетчик стежков: общее количество 
стежков в образце 

• Степень увеличения / уменьшения (Zoom 
factor) 

• Тип файла: указывает тип файла ART 
образца. Собственные образцы в 
программе BERNINA Embroidery Software 
классифицируются по четырем типам, в 
зависимости от того, как был создан 
образец. См. раздел Форматы 
образцов вышивки в руководстве 
пользователя. 

 
Работа с файлами проектов 
 
 
По умолчанию BERNINA Embroidery Software 
сохраняет проекты в собственном ["родном"] 
формате файла .ART. Этот формат содержит 
всю информацию, требуемую как для 
вышивания проекта, так и для последующих 
изменений. В приложениях BERNINA Embroidery 
Software открываются файлы в "родном" 

формате .ART, а также файлы других 
вышивальных форматов, хранящиеся на 
жестком диске компьютера, дискете или компакт-
диске. Вы можете сохранять проекты в формате 
ART, как и файлы других форматов. Подробнее 
см. в разделе Считывание и запись файлов 
проектов  руководства. 
 
Внимание: Вы не сможете открыть файлы ART, 
созданные более поздней версией программного 
обеспечения, если у вас запущена предыдущая 
версия. Если вы попытаетесь это сделать, 
появится указание о необходимости обновить 
систему до текущей версии. 

 
  
Открытие проектов 

 
Нажмите кнопку Open (панель 
General), чтобы открыть 
существующий проект. 
 

 
BERNINA Embroidery Software открывает ряд 
вышивальных файлов не только в "родном" 
формате ART. "Родные" проекты формата ART 
классифицированы на четыре группы в 
зависимости от способа создания файла. См. 
также Запуск вышивального программного 
обеспечения BERNINA Embroidery Software. 
 
Примечание: По умолчанию проекты 
автоматически группируются при открытии или 
вставке в другой проект. Подробнее см. в 
разделе Настройка других общих опций. 
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Как открыть проект 
1   Нажмите кнопку Open (Открыть). Откроется  
     диалоговое окно Open. 

 
 
2    Выберите папку из списка Look In. 
 

Примечание: Вы можете считывать проекты, 
сохраняемые на дискете, компакт-диске или 
на жестком диске компьютера. 

3 Если проект не в формате ART, то выберите 
тип файла из списка Files of Type (Тип 
файлов). 

4 Выберите проект или проекты.  
◄ Для выбора нескольких идущих подряд 

проектов удерживайте нажатой клавишу 
Shift.  

◄ Для выбора нескольких файлов 
удерживайте нажатой клавишу Ctrl. 

5  Проставьте "галочку" в окошке Preview, чтобы 
просмотреть проект (для поддерживаемых 
форматов) вместе с данными о проекте. В 
эти данные входят количество стежков (S:) и 
цветов (C:), высота (H:) и ширина (W:) 
проекта и номер версии ПО (V:). 

6 Нажмите кнопку Open (Открыть). 
 

Примечание: Вы можете также считывать 
проекты из памяти вашей вышивальной 
машине или с карты памяти BERNINA. Если у 
вас имеется прибор Magic Box, вы можете 
записать проект также и на другие карты 
памяти. Подробнее см. в разделе 
Считывание и запись файлов проектов. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Запуск новых проектов 

 
Нажмите кнопку New (панель 
General) для создания нового 
проекта с шаблоном NORMAL  
 

При запуске BERNINA Embroidery Software 
автоматически создается новый файл - Design1, 
- готовый для начала оцифровывания. По 
умолчанию Design1 создается на основе 
шаблона NORMAL. Шаблоны содержат 
предварительно установленные стили, 
настройки по умолчанию или объекты, что 
ускоряет и облегчает оцифровывание. Если вы 
создаете файл, основанный на одном из 
шаблонов, то параметры шаблона копируются в 
новый проект. Вы можете также выбрать шаблон 
пользователя в качестве основы нового проекта. 
См. также Свойства объекта и шаблоны  в 
Руководстве пользователя.  
 
 
Как запустить новый проект  
 
◄ Нажмите кнопку New (Создать). 

В окне проекта откроется новый пустой 
проект, основанный на шаблоне NORMAL.  

◄ Для использования шаблона пользователя 
выберите File > New. 
Откроется диалоговое окно New. 

    Если имеется еще другие шаблоны,  
    диалоговое окно New  появиться. 

 
   

В 

Выберите шаблон из списка и щелкните по OK. 
См. также Свойства объекта и шаблоны  в 
Руководстве пользователя.  
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Сохранение проектов 
 
Нажмите кнопку Save (панель 
General), чтобы сохранить текущий 
проект. 

 
Проекты BERNINA Embroidery Software могут 
быть сохранены в чистом ART-формате, а также 
в ряде других "неродных" форматов. При 
сохранении проекта сохраняется имя файла, его 
расположение и формат и происходит его 
обновление в соответствии с выполненными 
изменениями.  Если вы сохраняете 
существующий проект под новым именем, в 
другом месте или в другом формате, вы 
создаете копию оригинального проекта. См. 
также раздел Считывание и запись файлов 
проектов в Руководстве пользователя.  
 
Совет: Сохраняйте свои проекты во время 
работы, как можно чаще. Не ждите полного 
завершения работы. Чтобы сохранить 
изменения в существующем файле, но оставить 
без изменений оригинал, воспользуйтесь 
командой Save As. Каждый раз, когда вы 
сохраняете проект кнопкой Save на общей 
панели инструментов, происходит обновление 
файла.  
 
 
 
Как сохранить проект 
 
1 Нажмите кнопку Save (Сохранить). 

Если вы сохраняете проект в первый раз, 
откроется диалоговое окно Save As 
(Сохранить как …). 

 

 
 

 
2 Из списка Save In выберите папку, в которой 

вы хотите сохранить проект. 
3 Введите имя проекта в поле File name. 
4 Выберите формат файла из списка Save as 

type.  См. также Поддерживаемые форматы 
вышивальных файлов в экранном 
руководстве. 

5  Нажмите кнопку Save (Сохранить). 
 
 

 
 

Примечание: Вы можете также записывать 
проекты в память вашей вышивальной 
машине или на карту памяти BERNINA. Если 
у вас имеется прибор Magic Box, вы можете 
записать проект также и на другие карты 
памяти. Подробнее см. в разделе 
Считывание и запись файлов проектов в 
Руководстве пользователя.  

 

 
 
Готовые образцы вышивок  
 
 
Программа BERNINA Embroidery Software 
содержит сотни готовых для вышивания 
образцов, включая множество новых 
привлекательных орнаментов, изображений и 
фоновых рисунков. Файлы образцов (ART files) и 
изображений (BMP, JPG, и WMF файлы) можно 
найти в папке My Designs - Embroidery  
Software 6. См. также разделы Оцифровка с 
помощью фоновых рисунков  и Просмотр 
информации по образцам  в Руководстве 
пользователя.  
 
 
 
 
 
 
 

Папка,содержащая 
проект 

Имя проекта 

Список форматов 
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Функция BERNINA Portfolio отображает 
пиктограммы образцов вышивок с короткой 
информацией. Можно отфильтровать 
содержимое экрана так, чтобы отображались 
только файлы вышивок определенного типа. См. 
раздел Поиск образцов в папках  в 
Руководстве пользователя 
 

Программа CorelDRAW® Essentials 4 тоже 
содержит набор графических заготовок, которые 
можно использовать как фоновые рисунки или 
непосредственно конвертировать в образцы 
вышивки. См. также раздел Поиск графических 
заготовок  в Руководстве пользователя. 
 

 
 
ПРЕДУПРЕЖДЕНИЕ: Все имеющиеся в 
программах заготовки и образцы вышивок 
предназначены только для личного пользования. 
Их нельзя  ни в какой форме продавать или 
использовать в коммерческих целях. Изменение 
формата – например, графической заготовки в 
образец вышивки или наоборот – не отменяет 
защиты авторского права. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Пяльцы и сетки 
 
 
Перед вышиванием на машине материал 
должен быть растянут в пяльцах. Программный 
пакет BERNINA Embroidery Software предлагает 
вам на выбор широкий диапазон стандартных 
пялец. Используйте линии сетки, чтобы точно 
совместить или установить требуемые размеры 
объекта вышивки. 
 
Отображение пялец 

Для отображения пялец нажмите 
кнопку Show Hoop (панель 
General). Щелчок правой кнопкой 
мыши позволяет изменить 
настройки. 

 
Каждый раз, когда вы создаете новый проект, по 
умолчанию в окне проекта появляются одни из 
пялец из тех, которые вы можете установить на 
вышивальной машине. Когда вы позиционируете 
объекты, положение пялец подгоняется 
автоматически, так что объекты всегда 
находятся в центре пялец. См. также раздел 
Закрепление проектов в пяльцах. 
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Как показать пяльцы на экране 
 
◄ Нажмите кнопку Show Hoop (Показать 

пяльцы), чтобы отобразить пяльцы. 
 

◄ Нажмите еще раз кнопку Show Hoop, чтобы 
скрыть пяльцы. 

 
 
Отображение сетки 
 

Нажимайте кнопку Show Grid 
(панель General) для отображения 
на экране или скрытия сетки. 
Щелчок правой кнопкой мыши 

позволяет изменить настройки сетки. 
 
Используйте линии сетки, чтобы точно 
совместить или установить требуемые размеры 
объекта вышивки. Вы можете показывать или 
скрывать сетку. 
 
Совет: Вы можете изменить интервал сетки, 
выбрать базисную точку и включить или 
выключить функцию Snap to Grid (Выровнять по 
сетке) в диалоговом окне Options. Подробнее 
см. в разделе Настройка опций сетки в 
Руководстве пользователя.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Как показать сетку на экране 
 
◄ Нажмите кнопку Show Grid (Показать 

сетку), чтобы отобразить сетку. 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Нажмите кнопку Show Grid еще раз, чтобы 

скрыть сетку 
 
 
 
Измерение расстояний на экране 
 
Используйте команду Measure (меню View), 
чтобы измерить расстояние на экране. 
 
Для измерения расстояния между двумя точками 
на экране используйте команду Measure 
(Измерить). Эта команда отображает 
координаты, расстояние и угол линии от 
указателя мыши до точки, соответствующей 
центру пялец в пустом проекте. Результаты 
измерения можно видеть в строке состояния или 
в подсказке. Подробнее см. в разделе 
Интерпретация положения указателя 
мыши в Руководстве пользователя.  
 
Совет: Для получения более точных 
результатов перед измерением увеличьте 
изображение на экране. Измеряется всегда 
действительный размер независимо от 
масштаба изображения. 
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Как измерить расстояние на экране 
 
1   Выберите View > Measure или нажмите  M. 
2   Щелкните мышью по начальной точке. 
3   Удерживая кнопку мыши нажатой,  
     переместите указатель мыши в конечную  
     точку. 

В строке состояния появится следующая 
информация: 
◄ Координаты положения конечной точки 

(X=, Y=). 
◄ Длина измеренной линии (L=). 
◄ Угол наклона линии по отношении к 

горизонтали (A=). 
Результаты измерений показываются в 
миллиметрах или дюймах, в зависимости ль 
выбранной системы измерения в Панели 
управления MS Windows®. Подробнее см. в 
документации по операционной системе MS 
Windows®. 

 
Результаты изменения появляются как подсказка 
или в строке состояния 
 

Совет: Если активировано измерение длины 
и угла, результаты появляются также и в 
подсказке. Подробнее см. в разделе 
Настройка других общих опций экранного 
руководства.  

4 Нажмите Esc для завершения. 
 
Использование команд и инструментов 
 
 
После запуска BERNINA Embroidery Software вы 
должны пользоваться командами или ярлыками 
и диалоговыми окнами, чтобы выполнять 
соответствующие задачи. Команды выбираются 
таким же образом, как и в других приложениях 
Windows®, – из меню или панелей инструментов. 
Для наиболее часто используемых команд 
имеются также клавишные комбинации быстрого 
вызова – клавиатурные команды. Подробнее см. 
в разделе Клавиатурные команды. 
 

 
Выбор команд с панелей инструментов 
 
Панели инструментов обеспечивают быстрый и 
простой доступ к командам BERNINA. Щелкните 
на кнопке инструмента, чтобы активировать 
команду, или, там, где это применимо, щелкните 
правой кнопкой мыши, чтобы изменить ее 
свойства. 
 
 
 
 
 
Как выбирать команды с панелей 
инструментов 
 
◄ Задержите указатель мыши на значке 

инструмента, чтобы увидеть его название во 
всплывающей подсказке.  

◄ Щелкните по значку, чтобы активировать 
команду. 

◄ Правой кнопкой, чтобы отрегулировать 
настройки или активировать вторичную 
команду. 
◄ Если для значка предусмотрены команды 

как от левой, так и от правой кнопки 
мыши, то ее название разделено косой 
чертой (/). Например, значок Scale by 20% 
Down/Up позволяет уменьшить размер 
объекта на 20 %, если щелкнуть левой 
кнопкой мыши, или увеличить размер на 
20 %, если щелкнуть правой кнопкой. 

◄ Для многих инструментов щелчок правой 
кнопкой мыши дает возможность 
настроить текущую команду. Например, 
щелчок левой кнопкой по Lettering/Values 
(Текст/Значения) выбирает Lettering в 
качестве метода ввода, а щелчок правой 
дает доступ к диалоговому окну Object 
Properties (Свойства объекта).  

 
Примечание: Свойства объекта могут быть 
изменены с выбором или без выделения 
объекта. В первом случае изменения относятся 
только к выбранному объекту. Во втором случае 
изменяются текущие настройки. 
 
Отмена и повторение отмененных 
команд 

 
 
Используйте кнопку Undo (панель 
General) для отмены команды. 
 
Используйте кнопку Redo (панель 
General) для повторения команды, 
которая была отменена. 

 
Вы можете отменить действие большинства 
команд. Если вы передумали, то можно снова 
повторить выполнение отмененной команды. 
BERNINA Embroidery Software помнит несколько 
последних команд, которые вы назначали. 
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Как отменить команду и снова восстановить 
ее действие 
◄ Для отмены команды щелкните по значку 

Undo. Если BERNINA больше не помнит 
выполненных команд, кнопка Undo 
становится блеклой.  

◄ Щелкните по значку Redo, чтобы повторить 
выполнение отмеченной команды. 

 
Перемещение и установка панелей 
инструментов 
 
Панели инструментов обеспечивают быстрый и 
простой доступ к командам BERNINA Embroidery 
Software. Панели инструментов являются 
"плавающими". Это означает, что их можно 
перемещать по всему окну проекта. 
 
Как перемещать панель инструментов 
 
◄ Для перемещения панели инструментов в 

более удобное место нужно перетащить ее 
мышью: 
◄ Панели инструментов можно перемещать 

влево, вправо, вверх и вниз. 
◄ Они могут "плавать" в любом месте окна. 

 

◄ Для помещения панели в нормальное 
положение дважды щелкните мышью по 
заголовку. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Доступ к свойствам объекта 
 
 

Используйте кнопку Object Properties 
(Свойства объекта), чтобы 
настроить текущие  

                свойства или свойства  
                выделенных объектов. 
 
Образцы, представленные в программе 
BERNINA Embroidery Software, состоят из 
‘объектов вышивания”. Название “объекты” 
выбрано по тому, что это дискретные сущности, 
которыми можно оперировать, независимо один 
от другого. Каждый объект имеет свои 
характеристики или свойства, такие, как цвет, 
размер, положение и т.п. Самый главный диалог 
в программе BERNINA Embroidery Software  - это 
диалог свойств объекта (Object Properties). См. 
также раздел Применение свойств объекта и 
управление ими. 
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Как настраивать свойства объекта  
• Откройте диалоговое окно Object Properties 

(Свойства объекта) одним из следующих 
способов: 
◄ Щелкните по значку Object Properties 
◄ Выберите Settings  > Object Properties . 
◄ Двойной щелчок или щелчок правой 

кнопкой по любому объекту в окне 
проекта. 

 
◄ Выберите закладку, чтобы открыть то 

свойство объекта, которое вы хотите 
настроить.  

◄ Используйте поля, выпадающие списки, 
кнопки переключения и ползунки, чтобы 
ввести с клавиатуры или изменить 
настройки. 

◄ Щелкните по кнопке Effects, чтобы 
получить доступ к отдельному набору 
специфичных настроек свойств объекта, 
таких как Underlay (Стабилизация ткани), 
Textured Edge (Текстурированный край), 
Gradient Fill (Заполнение с плавным 
тоновым переходом) и др. 

 

 
 
 
 
 
 
 

 
Примечание: В этом диалоговом окне, в свою 
очередь, имеется кнопка Properties, которой 
открывается диалоговое окно Object Properties. 
Вы можете выбрать автоматическое закрытия 
окна Object Properties при открытии 
диалогового окна Effects и наоборот. Подробнее 
см. в разделе Настройка других общих 
опций. 
 

Совет: В диалоговое окно Object Properties 
встроены графические элементы для 
визуального слежения за изменением настроек.  
Они появляются, когда вы наводите указатель 
мыши на элемент управления. Например, если 
указатель мыши наведен на опцию Stitch 
Spacing (Шаг стежка), сбоку появляется 
иллюстрация. 
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• Для применения настроек нужно щелкнуть 

по кнопке Apply в нижней части диалогового 
окна или нажать клавишу Enter. 
◄ Если вы выделили один или несколько 

объектов, изменения будут применены ко 
всем выделенным объектам. 

◄ Если не выделен ни один объект, 
изменения будут отнесены к текущим 
настройкам – они будут использованы при 
создании новых объектов. 

◄ Если вы изменили настройки на 
нескольких вкладках диалогового окна, 
все изменения, которые могут быть 
применены, будут применены. 
 

• Щелкните по кнопке Save to Template 
(Сохранить в шаблоне), чтобы сохранить 
настройки в текущем шаблоне. Они будут 
приниматься по умолчанию при создании 
новых файлов, основанных на этом 
шаблоне.  
Подробнее см. в разделе Управление 
шаблонами проекта. 
 

• Щелкните по кнопке Discard (Отменить) или 
нажмите клавишу Esc, чтобы отказаться от 
изменений.  
 

Щелкните по кнопке Close (Закрыть), чтобы 
закрыть диалоговое окно и отказаться от 
изменений 
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ГЛАВА 4 
 

ПРОСМОТР ПРОЕКТОВ 
------------------------------------------- 
 

BERNINA Embroidery Software предоставляет несколько возможностей 
просматривать проекты вышивки, чтобы облегчить работу с ними. Zoom in on an 
area to see more detail or view the design at actual size. Show or hide various 
design elements with the available display settings. Preview an existing design in 
different colors on different fabrics. 
 

 
 
При работе с проектами вышивки вам необходимо разобраться с 
последовательностью вышивания. Вы можете проверить последовательность 
вышивания проекта путем ‘обхода’ по стежкам. Вы можете также проверить 
последовательность медленным перерисовыванием проекта на экране. 
BERNINA Embroidery Software также предоставляет информацию о проектах 
разнообразными способами и в разных форматах. Еще перед открытием 
BERNINA Embroidery Software или своего проекта вы можете проверить 
некоторую информацию о файлах формата ART непосредственно из MS 
Windows® Explorer. Вы можете просмотреть детали вышивания проекта в 
диалоговом окне Design Properties (Свойства проекта). Важную информацию о 
проекте дает также функция Print Preview (Предварительный просмотр), 
включая просмотр проекта в целом, размеры проекта, последовательность 
цветов и специальные указания. 
В этом разделе разъясняются режимы просмотра проекта, предоставляемые 
BERNINA Embroidery Software, а также различные настройки просмотра 
проекта. Описываются функции изменения масштаба и панорамирования, а 
также просмотра последовательности вышивания. Объясняется, как 
отображать на экране оригиналы проектов и изменять фон. Также объясняется, 
как получать информацию о ваших проектах. 
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Режимы просмотра 
 
При оцифровке, для разных целях 
доступны разные режимы просмотра. В 
зависимости от версии вашей программы, 
BERNINA Embroidery Software 
предоставляет разное количество 
режимов просмотра, которые можно 
активизировать с помощью функций 
панели режимов просмотра (View Mode). 
 

 
Приложение имеет одно рабочее 
пространство ‘Design Window’, но 
работать с ним можно в разных режимах. 
 
Режим дизайна - Art Canvas 

Загружайте, 
редактируйте, 
сохраняйте в качестве 
фона для оцифровки 
вышивок любую графику. 
Это включает весь 
набор, предоставляемый 
программами 
CorelDRAW® Essentials 4. 
Дополнительно, 
предоставляется 
возможность 
конвертировать 
векторные рисунки и 

тексты непосредственно в объекты 
вышивания. 
В режиме Art Canvas, панель инструментов 
View Mode содержит кнопку Show Embroidery 
для включения/выключения дисплея вышивок. 
 
Ниже на рисунке показан вид рабочего 
экрана в режиме Art Canvas,  доступ к 
которому осуществляется через панель 
инструментов View Mode. Этот режим 
работы позволяет создавать и изменять 
векторную графику, используя 
инструментарий CorelDRAW® Essentials 
4,  позволяющий использовать различные 
продвинутые техники для создания 
набросков и рисунков прямо с экрана. 
 

 

Дополнительно к инструментарию 
CorelDRAW® Essentials 4, режим Art 
Canvas предоставляет возможность 
конвертировать векторную графику и 
тексты непосредственно в объекты 
вышивки. Векторная графика и тексты, 
созданные или импортированные в 
режиме Art Canvas можно 
непосредственно конвертировать в 
объекты вышивки. Можно использовать 
режим Art Canvas, чтобы вставлять 
векторную графику других 
производителей, например заготовочные 
рисунки для образцов вышивки. 
Дополнительно можно использовать 
растровые образцы для использования в 
качестве оцифровывающего фона. См. 
раздел Загрузка рисунков в Руководстве 
пользователя.  
 
ВНИМАНИЕ: Полное описание 
инструментария программы CorelDRAW® 
Essentials 4 приводится в электронном 
Руководстве пользователя, которое 
можно найти в разделе меню Windows 
Start > Programs. Можно использовать 
экранную систему помощи с помощью 
меню Help в режиме Graphics. 
 
Режим вышивания - Embroidery 
Canvas 

 
 
 
 
 

Режим позволяет оцифровывать и 
редактировать образцы вышивки. 
Показывает как образцы вышивки, так и 
графические заготовки. Дает 
возможность просматривать образцы 
реалистически в трехмерной графике 3D 
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Ниже на рисунке показан вид рабочего 
экрана в режиме Embroidery Canvas,  
доступ к которому осуществляется через 
панель инструментов View Mode. Этот 
режим работы позволяет создавать и 
изменять объекты вышивки, используя 
инструментарий оцифровки вышивок. См. 
также раздел Интерфейс программы 
BERNINA Embroidery Software. 

 
Используйте этот режим, если собираетесь 
разработать образец вышивки, начиная от 
оцифровывающего фона.  Разные типы 
файлов с изображениями можно загружать 
в программу BERNINA Embroidery Software. 
См. также онлайновое руководство 
Оцифровка с помощью фоновых 
рисунков. 
 
Режим Embroidery Canvas позволяет 
увидеть изображение того, каким рисунок 
получится в итоге. С помощью функции 
просмотра образцов (Show Artistic View), а 
также с учетом ткани подложки можно 
увидеть, как будет выглядеть ваша. См. 
также раздел Изменение фона. 

 

Режим Hoop Layout 
 
 
 
 
 

Позволяет просматривать и 
редактировать проекты, не помещающиеся 
в пяльцах. Если ваша вышивка слишком 
велика, или содержит много образцов, 
расположенных на пространстве, разбитом 
для вышивки на многих пяльцах. 
 
 
 
 

Ниже на рисунке показан вид рабочего 
экрана в режиме View Mode,  доступ к 
которому осуществляется через панель 
инструментов View Mode. Если ваша 
вышивка слишком велика, или содержит 
много образцов, можно разбить ее на 
несколько пяльцев. Это позволяет вам 
создавать и работать с образцами, размер 
которых превышает размер любых 
отдельных пялец. Режим Hoop Layout 
позволяет установить положение и 
последовательность использования каждых 
пялец. См. раздел Закрепление в пяльцах 
крупных проектов 

 
Настройки просмотра проекта 
 
Вы можете показывать или скрывать 
элементы проекта в режиме Embroidery 
Canvas разнообразными настройками 
отображения. Вы можете показывать 
графическое изображение вышивки в 
готовом виде , показывать точки прокола 
иглой, соединительные и обычные 
стежки, а также показывать или скрывать 
выбранные цвета. 
 
Просмотр вида вышивки 

 
С помощью кнопки просмотра 
вида вышивки (Show Artistic 
View) на общей панели 
инструментов (General toolbar) 

можно включать/выключать просмотр 
вида вышивки. 
 
 
С помощью функции Artistic View, можно 
просмотреть, как будет окончательно 
выглядеть  ваша вышивка. 
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Чтобы просмотреть вид вышивки: 

• Чтобы просмотреть вид вышивки 
(Artistic View), включите режим 
Show Artistic View , нажав на 
иконку. 
 

 
 
 
 
 
 
 
 
 

• Для просмотра вышиваемых 
стежков (Stitch View), отключите 
режим Show Artistic View , отжав 
иконку. 

 
 
 
 
 
 
 
 
 

 
 
Просмотр точек прокола иглы 
 
Выберите Needle Points в меню View, чтобы 
показать или скрыть точки прокола иглы. 
 
В режиме Embroidery Canvas вы можете 
отображать или скрывать точки прокола 
иглы. Например, вы можете захотеть 
просмотреть точки прокола иглы, чтобы 
выбрать стежки для редактирования. См. 
также раздел Редактирование стежков 
в Руководстве пользователя.  
 
Как просмотреть точки прокола 
иглы 
 
◄ Для просмотра точек прокола иглы 

выберите View (Вид) > Needle Points 
(Точки прокола иглы). 

 

 
                             Функция 
Needle Points включена 

 
 
Просмотр стежков и контуров 

 
Щелкните по Show Stitches (панель 
General), чтобы включить или 
отключить показ стежков. 

 
Вы можете отображать или скрывать стежки 
и контуры объекта при работе в любом 
режиме просмотра. Скройте стежки, чтобы 
более четко видеть контуры при изменении 
формы. Подробнее см. в разделе 
Изменение формы и правка объектов в 
Руководстве пользователя.  
 
Как просматривать стежки и 
контуры 
 
◄ Нажимайте кнопку Show Stitches 

(Показать стежки), чтобы показать 
или скрыть стежки. 
 

 
                    Стежки показаны     Стежки скрыты 

 
Просмотр объектов в цвете 
 
Выберите By Color (меню View), чтобы обособить 
элементы проекта по цвету. 
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Чтобы выделить индивидуальные 
элементы для контроля или манипуляций, 
функция View By Color (Просмотр по 
цвету) позволяет просматривать проект в 
цвете. Это, в частности, полезно, когда 
вы изменяете последовательность 
вышивания в цвете. См. также 
Изменение последовательности 
объектов по цвету в Руководстве 
пользователя.  
 
Примечание: Вам потребуется 
перегруппировать проект, прежде чем вы 
сможете просмотреть объект в цвете. 
 
 
Как просматривать объекты по 
цвету 
 
1 Создайте или откройте проект.  

 
 
 
 
 
 
2

 Выберите View > By Color. 
Откроется диалоговое окно Select By 
Color (Выбор по цвету). 

 

 
 
3 Выберите цвета, которые вы хотите 
просмотреть. 

◄ Для выбора нескольких идущих 
подряд цветов удерживайте 
нажатой клавишу Shift. 

◄ Для выбора нескольких цветов 
удерживайте нажатой клавишу Ctrl. 
 

4 Нажмите кнопку ОК. 
 
 
 
 

Проект появится только с теми 
цветами, которые вы выбрали для 
просмотра. 

 
 

Выбраны два цвета 
 
 
5 Для просмотра всех цветов выберите 
опять View > By Color и щелкните по All 
Colors. 
6 Нажмите кнопку OK. 
 

Совет: Функция Color Film 
предоставляет другой путь просмотра 
объектов.  Подробнее см. в разделе 
Просмотр и выделение цветных 
блоков в Руководстве пользователя. 

 
Изменение масштаба и 
панорамирование 
 
Используйте функции Overview Window и 
Zoom для быстрой проверки вашего 
проекта при разных ступенях увеличения. 
 
Совет: В строке состояния показывается 
текущий "коэффициент 
масштабирования". Подробнее см. 
Запуск вышивального программного 
обеспечения BERNINA Embroidery 
Software в Руководстве пользователя. 
 
Просмотр проектов в обзорном 
окне 
 
Используйте Overview Window (Обзорное 
окно) для просмотра проектов в виде 
свернутых в пиктограммы изображений. 
Это окно обновляется, как только вы 
проведете изменения и может быть 
использовано для увеличения масштаба 
или панорамирования в окне проекта. 
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Как просматривать проекты в 
обзорном окне   
 
1 Выберите View > Overview Window.  

Откроется Overview Window (Обзорное 
окно).. 

 
 
 
 
 
 
 
 
 

Щелкните, чтобы 
активировать функцию 
масштабирования 

 
2 Чтобы увеличить или уменьшить 

масштаб, щелкните по кнопке Zoom в 
обзорном окне и обведите вокруг 
увеличиваемой детали 
ограничивающий прямоугольник и 
перетащите его. 

 
Перетащите 
прямоугольник, 
ограничивающий 
увеличиваемую 
деталь 
изображения 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3 Для панорамирования по проекту 
переместите указатель мыши за 
пределы выделения – он примет вид 
четырех разнонаправленных стрелок – 
и перетащите.  

Перетащите квадратик для 
панорамирования 

 
 
 

Увеличение и уменьшение 
изображения 

Щелкните по Zoom Box (панель 
General) для увеличения и 
уменьшения изображения в окне 
проекта.  
Используйте этот инструмент также в 
оконтуренных областях экрана. 
Щелкните по Show All (панель 
General), чтобы показать весь проект. 
 
Щелкните по Show 1:1 (панель 
General), чтобы показать проект в 
натуральную величину. 

 
Увеличьте изображение проекта 
вышивки, чтобы рассматривать 
индивидуальные стежки или детали, или 
уменьшите его, чтобы отобразить в окне 
большее количество деталей проекта. 
Текущий масштабный коэффициент 
показывается в нижнем правом углу 
экрана. См. также Клавиатурные 
команды в Руководстве пользователя. 
 

 
Примечание: Чтобы быть уверенным в 
том, что проект отображается на экране в 
правильных размерах, необходимо 
калибровать монитор. Подробнее см. в 
разделе Калибровка монитора в 
Руководстве пользователя.  
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Как увеличить и уменьшить 
изображение на экране 
 
◄ Щелкните по значку Zoom Box или 

нажмите клавишу B.Указатель мыши 
примет вид лупы. 

◄ Щелкните правой кнопкой в окне 
проекта – изображение уменьшится 
наполовину от предыдущего размера, 
его центр будет находиться в точке 
щелчка.  

 
Щелчок правой кнопкой 
мыши 

 
Совет: В строке состояния 
показывается текущий "коэффициент 
масштабирования". Подробнее см. 
Запуск вышивального 
программного обеспечения 
BERNINA Embroidery Software в 
Руководстве пользователя. 

◄ Щелкните левой кнопкой в окне 
проекта – изображение увеличится 
вдовое по сравнению с предыдущим 
размером, его центр будет находиться 
в точке щелчка.  
 

 
◄ Щелкните левой или правой кнопкой и 

перетащите ограничивающий 
прямоугольник вокруг 
масштабированной зоны. Отпустите 
кнопку мыши, чтобы увидеть всю 
масштабированную зону на экране. 

                               
Выбрать и перетащить 

 
 

Примечание: Все растровые 
изображения, независимо от 
контекста, сохраняют тот же масштаб, 
что и вышивка. Растровые 
изображения используются в большом 
количестве контекстов:  
◄ В качестве оригинала или 

направляющего рисунка для 
оцифровки. Подробнее см. в 
разделе Оцифровывание с 
оригиналом в Руководстве 
пользователя.  
 

◄ В качестве фона для имитации 
материала, на котором выполняется 
вышивка. Подробнее см. в разделе 
Изменение фона в Руководстве 
пользователя. 
 

◄ В качестве лоскута ткани для 
аппликации. Подробнее см. в 
разделе Оцифровывание для 
аппликаций в Руководстве 
пользователя.  
 

◄ Чтобы отобразить весь проект, 
нажмите кнопку Show All. 
 

◄ Альтернативно выберите View > Show 
All, или нажмите 0.  
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◄ Чтобы отобразить проект в 
натуральную величину, нажмите 
кнопку Zoom 1:1.  

 
◄ Для отображения стежков в частичном 

масштабе нажмите клавишу F на 
клавиатуре. Введите величину 
масштабирования в процентах и 
щелкните по OK. 

 
 

Введите масштаб 
 
◄ Нажмите клавишу Esc, Enter или 

Клавишу пробела, чтобы выйти из 
режима Zoom. 

 
Просмотр последовательности 
вышивания отдельных 
фрагментов 
 
При работе с проектами вышивки вам 
необходимо разобраться с 
последовательностью вышивания. Вы 
можете проверить последовательность 
вышивания проекта путем ‘обхода’ по 
стежкам, цветам или объектам. Вы можете 
также проверить последовательность 
медленным перерисовыванием проекта на 
экране. BERNINA имитирует вышивание 
при изменении стежков от черного до 
назначенного цвета нитки, как это 
происходит при вышивании. См. также 
раздел Просмотр и выделение цветных 
блоков  
 

 
Обход проекта по объектам и 
цветным блокам 
 
Используйте клавиатурные команды для 
обхода проекта по объектам или по 
цветным блокам. Этот технический прием 
полезен в том случае, если вам нужно 
найти конкретный объект, чтобы удалить 

его или вставить другой объект в этой точке 
последовательности вышивания.  См. также 
раздел Клавиатурные команды 
Как обходить проект по объектам 
или цветным блокам 
• Для перехода к конечной точке проекта 

нажмите клавишу End.  
Белый крест установится на конечном 
стежке, а весь проект отображается с 
выбранными цветами ниток. 
 

Start point = Начальная точка 
End point = Конечная точка 
White cross – current needle position marker = 
Белый крест – маркер текущего положения 
иглы 
 
 
• Для перехода к начальной точке 

проекта нажмите клавишу Home. 
Белый крест установится на первом 
стежке, а весь проект отображается 
темно-серым цветом.  
 

 
 

 
 
 
 
 
 

 
• Для перехода к следующему объекту, 

нажмите  
Ctrl + T. 
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• Для перехода к предыдущему объекту, 

нажмите Ctrl + T. 
• Для перехода к следующему цвету, нажмите 

клавишу Page Down.  
 

• Для перехода к предыдущему цвету, 
нажмите клавишу Page Up. 

 
 
Совет: Активированным инструментом 
Select Object (Выбор объекта) вы можете 
выбирать объекты при обходе 
последовательности вышивания. 
Подробнее см в разделе Выбор объектов 
клавишей Tab. 
 
 
Обход по стежкам 
Используйте соответствующие инструменты 
или клавиатурные команды для обхода 
проекта по одному или по нескольким 
стежкам. Текущее положение иглы 
отмечается большим белым крестом, или 
"маркером положения иглы". Вначале он 
располагается в конечной точке проекта. 
При обходе по стежкам, маркер положения 
иглы соответственно перемещается. 
Текущий номер стежка появляется в Строке 
состояния. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Как обойти проект по стежкам 
1 В режиме просмотра проекта выберите 
Edit > Stitch Edit или нажмите клавишу Esc. 
 
2 Убедитесь в том, что функция Select 

Object (Выбрать объект) не выбрана, 
затем нажимайте клавиши со стрелками, 
чтобы обходить проект по одному или по 
десять стежков. 
  
  
  
  

◄ Нажимайте левую или правую 
клавишу со стрелкой, чтобы обойти 
проект по одному стежку в обратном 
или прямом направлении. 

◄ Нажимайте верхнюю или нижнюю 
клавишу со стрелкой, чтобы обойти 
проект по десять стежков в обратном 
или прямом направлении. 
 

3 Нажимайте клавишу "+" или "-" на малой 
клавиатуре, чтобы обойти проект шагами 
по 100 стежков. Клавишей "+" маркер 
перемещается в прямом направлении, 
клавишей "-" в обратном направлении. 

                                Переход назад 
                                на один стежок 
 
Совет: Если вы вышли за пределы видимой 
области, нажмите клавишу C, чтобы 
текущий стежок оказался в центре экрана. 
 
Моделирование образцов 
вышивки 
 
Инструмент Slow Redraw (Медленное 
перерисовывание)   позволяет 
моделировать образцы вышивок прямо на 
экране. Этот инструмент можно 
исполдьзовать для просмотра хода 
вышивки образца и последовательности 
цветов ниток в замедленном темпе. 
Начиная с любого стежка вышивки можно 
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начать его перерисовывать. Ранее 
вышитые части образца можно скрыть, если 
требуется. Работая с большими образцами 
вышивок, можно использовать функцию 
автоматического перемещения по образцу, 
так что область, вышиваемая в данный 
момент, всегда будет на экране. 

 
 
Поскольку функция Slow Redraw имитирует 
движение вышивальной машины, вы 
имеете возможность оптимизировать свой 
проект, чтобы снизить нагрузку на машину. 
Это особенно важно, если вы намерены 
выполнить несколько вышивок в одном 
проекте. По этой причине рекомендуется 
использовать функцию Slow Redraw на 
завершенных проектах. 
 
Для моделирования образца 
вышивки 
 
1 Перейдите в режим просмотра стежков 
Stitch View. 
 
Примечание: Функция Slow Redraw не 
может быть использована в режиме  
просмотра Artistic View. 
 
2 Выберите View > Slow Redraw или 
нажмите Shift+R. 
 
   
 
 
 
 
 
 
 

  Откроется диалоговое окно Slow Redraw  

 
3 Чтобы перерисовать только часть 

образца,  укажите начальный и 
конечный стежок этой части в поле 
Stitch Range. 

 
4 Используйте ползунок для установки 

скорости перерисовывания. 
 
5 Нажмите кнопку Play. 
 Проект будет перерисован на экране в 

соответствии с последовательностью 
вышивания. 

 
6 Настройте управляющие кнопки: 
 
Кнопка Функция 
Скорость (Speed) 
 

Используйте ползунок 
для настройки скорости 
перерисовки в режиме 
“реального времени”. 

Пауза (Pause) 
 

Приостанавливает 
перерисовку, позволяя 
вам решить, где вы 
хотите остановиться. 
 

Остановка (Stop) 
 

Прекращает перерисовку 
и возвращает к началу 
образца. 
 

Начать с начала 
(Back to Start) 
 

Начинает перерисовку от 
начала образца. 
 
 

 
 
Отображение оригинала проекта и 
фона 
 
Во время оцифровывания вы можете 
отобразить оригинал проекта. Его 
изображение можно временно скрыть или 
сделать блеклым, чтобы лучше 
просматривались стежки. 
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Отображение или скрытие оригинала 
 
 Используйте функцию показа 

рисунка Show Picture (общая 
панель инструментов General), 
чтобы  включать/отключать 
показ оригинала рисунка. 
 

 Используйте функцию Dim 
Artwork (общая панель 
инструментов General) для того, 
чтобы сделать фон более 
блеклым, для более отчетливого 
просмотра стежков при 
оцифровке. 
 

 Используйте функцию Show 
Vectors (общая панель 
инструментов General) для того, 
чтобы включать/выключать 
функцию просмотра векторной 
графики. 
 

 

Используйте функцию Show 
AppliquéFabric (общая панель 
инструментов General), чтобы 
включать/отключать показ 
ткани/цвета аппликации. 
 

 
 
Можно отображать фон, растровую или 
векторную графику при оцифровке, а можно 
их временно скрыть. Если фон скрыт – он 
не удаляется из образца. Можно сделать 
фон более блеклым, чтобы отчетливее 
видеть стежки. См. также раздел  
Оцифровывание с оригиналом. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Как просматривать оригиналы 
 

• Чтобы включать/отключать растровую и 
векторную графику – используйте 
иконку показа рисунков Show Pictures. 
См. также раздел Импорт 
изображений в программу 
BERNINA Embroidery Software. 

 
Примечание: Изображение становится 
блеклым, если выбрана функция Dim 
Picture (Затенить рисунок). 
 
 
• Чтобы сделать фон блеклым, нажмите 

Dim Artwork. 

 
Внимание: Для возвращение к 
полноцветному изображению, нажмите Dim 
Picture еще раз. 
 
• Чтобы включать/отключать растровую и 

векторную графику – используйте 
иконку Show Vectors. 
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Щелкните по кнопке Show Appliqué Fabric 
(Показать ткань апплицкции), чтобы 
показать материал/цвет аппликации. См. 
также раздел  
Оцифровывание для аппликаций. 

 
 
● Чтобы скрыть материал/цвет 

аппликации, нажмите кнопку Show 
Appliqué Fabric еще раз.  

 
 
Изменение фона 
 
Для изменения цвета фона или ткани выберите 
функцию Fabric Display (меню Settings). 
 

Используйте функцию Show 
AppliquéFabric (панель General), чтобы 
включать/отключать показ ткани/цвета 
аппликации. 

 
BERNINA Embroidery Software дает 
возможность выбирать цвет фона в окне 
проекта, чтобы согласовать его с цветом 
вашей ткани. Или же можно выбрать фон 
ткани для более реалистичного вида и 
воспроизведения. Фон сохраняется 
вместе с проектом. 
 
Совет: Используйте переключатель Show 
Appliqué fabric (Показать ткань 
аппликации), чтобы включить или 
выключить отображение цвета ткани 
аппликации. См. раздел Размещение 
тканей в проекты Auto Applique в 
Руководстве пользователя.  
 
 
 
 
 
 
 
 

Как изменить цвет фона или ткань 
 
1 Выберите Settings (Настройки) > 
Fabric Display (Отображение ткани)..  

Откроется диалоговое окно Display 
(Отобразить). 

 
 
 

 
 

Выбор цвета фона или ткани  
 
Совет: Вы можете также получить доступ 
к этому окну, использовав Settings > 
Thread Colors, или щелкнув по ссылке 
диалогового окна ColorPalette. Дважды 
щелкните по BKG в таблице Thread 
Colors (Цвета ниток). Подробнее см. в 
разделе Цвета ниток и таблицы 
ниток в Руководстве пользователя.  

 
Щелкните для доступа    

Дважды щелкните,    
чтобы изменить фон 
к цветам ниток 

 
2 Выберите тип фона, который вам 
нужен: 

◄ Color (Цвет). Выбор цвета фона  
◄ Fabric (Ткань). Выбор ткани фона. 

 
3 Введите цвет ткани, который вы хотите 
использовать. 
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◄ Для выбора цвета фона, щелкните 
по Edit и выберите цвет из 
диалогового окна Color (Цвет). 

 
 
 
 
 
 
 
 
 

◄ Для выбора ткани щелкните по 
Browse и выберите ткань в 
диалоговом окне Load 
Picture(Загрузить рисунок). Ткани 
расположены в папке ..\Program 
Files\BERNINA\Embroidery Software 
6\fabrics. 

 
 
Совет: Если вы выбрали ткань, вы 
можете расположить изображение по 
центру окна проекта или образовать 
мозаичную структуру. Если растровый 
рисунок достаточно большой, чтобы 
заполнить все окно, выберите Center. В 
противном случае выберите Tile 
(Плиточная кладка). 
 

 
 

Выберите мозаику или центровку  

 
 
 
 
 
 
 
 
 

4 Нажмите кнопку ОК. 
 

 
 
 
 
 
 
 
 

желтый фон фон    джинсовой ткани 
 

Примечание: Фон сохраняется вместе с 
проектом. 
 
Просмотр информации о проекте 
 
BERNINA Embroidery Software 
предоставляет информацию о проектах 
разнообразными способами и в разных 
форматах. Еще перед открытием 
BERNINA или своего проекта вы можете 
проверить некоторую информацию о 
файлах формата ART непосредственно 
из MS Windows® Explorer. Вы можете 
просмотреть детали вышивания в 
диалоговом окне Design Properties 
(Свойства проекта). Важную 
информацию о проекте дает функция 
Print Preview (Предварительный 
просмотр), включая просмотр проекта в 
целом, размеры проекта, 
последовательность цветов и 
специальные указания. 
 
Просмотр свойств проекта 
 
Используйте функцию Design Properties (меню 
File), чтобы увидеть детали вышивания проекта. 
 
В диалоговом окне Design Properties 
(Свойства проекта) вы можете 
проверить номер версии программного 
обеспечения и другую информацию. 
Приводятся также детали вышивания. 
Большинство данных в этих полях не 
подлежат непосредственному изменению. 
 



Глава 4: Просмотр проектов 

BERNINA® Вышивальное ПО Версия 6 45

Как просмотреть свойства 
проекта 
 
1 Выберите File > Design Properties. 

Откроется вкладка Design диалогового 
окна Design Properties . 

 
На этой вкладке содержится 
информация о высоте и ширине 
проекта, количестве стежков и цветов. 
Эти данные извлечены из проекта и не 
могут быть изменены.  

 
 

2 Выберите закладку Summary, чтобы 
увидеть или ввести информацию о 
проекте. 

 

 
3 Щелкните на поле и введите любой 

текст, который поможет вам 
впоследствии идентифицировать 
проект. 

 
Примечание: Информация из этой 
вкладки включена в окно 
Предварительного просмотра, а также 
во вкладку Summary диалогового окна 
Windows Properties. Подробнее см. в 

разделах Просмотр информации о 
проекте в Проводнике Windows в 
Руководстве пользователя и 
Предварительный просмотр 
проектов в Руководстве 
пользователя.  
 
4 Нажмите кнопку OK. 
 

Просмотр информации о проекте 
в Проводнике Windows  
 
Перед открытием файлов ART вы можете 
посмотреть пиктограмму проекта и его 
данные через Проводник Windows. 
Диалоговое окно Properties (Свойства) 
позволяет просмотреть проект совместно 
с информацией о проекте, такой как 
количество стежков и количество 
остановок для замены цветных ниток. 
Приводится также общая информация о 
файле – размерфайла и дата последнего 
изменения. Подробнее см. в разделе 
Управление проектом в Руководстве 
пользователя. “  
 
Примечание: Эти же данные появляются 
в диалоговом окне Open (Открыть) в ПО 
BERNINA. См. также раздел Открытие 
проектов в Руководстве пользователя. 
 
Как просмотреть информацию о 
проекте в Проводнике Windows  
 
1 Выберите файл в Проводнике 
     Windows. 
      Проекты показываются в  
      виде пиктограмм.  

2 Щелкните правой кнопкой мыши по 
файлу и выберите Properties (Свойства) 
из всплывающего меню. 
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Откроется диалоговое окно Properties 
(Свойства). 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
3 Проверьте информацию о проекте или 
нажмите другую закладку для 
ознакомления с общей информацией о 
файле. 
 

Совет: Закладка Summary позволяет 
получить ту же информацию, которая 
была введена в закладке Design 
Properties > Summary программы 
BERNINA Embroidery Software. 
Подробнее см. в главе Просмотр 
свойств проектов в Руководстве 
пользователя.  

4 Нажмите кнопку OK. 
 
Предварительный просмотр 
проектов 

Нажмите кнопку Print Preview (панель 
General), чтобы увидеть на экране 
проект в том виде, в котором он может  

                  быть распечатан. 
 

Функция Print Preview 
(Предварительный просмотр) 
позволяет получить важную 
информацию о проекте, включая 
просмотр проекта в целом, размеры 
проекта, последовательность цветов и 
специальные указания. См. также 
раздел Распечатка проектов в 
Руководстве пользователя.  

 
 

 
 
Как предварительно просмотреть 
проект 
1 Нажмите кнопку Print Preview 
(Предварительный просмотр). 

В окне предварительного просмотра 
появится изображение проекта. 

 
Щелкните, чтобы    Нажмите, чтобы  
распечатать проект              показать одну или  
                                              две страницы 
 

 
 

  
 

о 
 

Настройте требуемый вид изображения: 
 

◄ Для изменения ориентации на 
бумаге выберите Landscape 
(Альбомная) или Portrait 
(Портрет).  

◄ Для изменения отображаемой 
информации и установки требуемых 
опций печати выберите Options. 
См. также Настройка опций 
печати вышивальных файлов в 
Руководстве пользователя.  

◄ Нажмите Zoom In, чтобы прочитать 
информацию о проекте или более 
подробно просмотреть проект. 
Большие проекты могут быть 
отображены на нескольких 
страницах. 

◄ Чтобы распечатать проект, нажмите 
Print.  

◄ Чтобы закрыть окно 
предварительного просмотра, 
нажмите Close.

 

Щелкните, чтобы  
настроить опции печати 
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ГЛАВА 5 
 

ВЫБОР ОБЪЕКТОВ 
------------------------------------------- 
 

 
 

BERNINA Embroidery Software 
предоставляет различные меню для 
выбора объектов, из которых состоит 
вышивальный проект. В них входят такие 
средства, как указать и щелкнуть, выбор 
методом ограничивающего прямоугольника 
и многие способы выделения объекта. Вы 
можете выбрать все объекты в проекте или 
индивидуальный объект для прецизионной 
модификации. BERNINA Embroidery 
Software позволяет выбрать объект для 
оконтуривания или заполнения. 
 
Примечание: Перед выделением объектов 
проект должен быть разгруппирован. 
Подробнее см. в разделе Разгруппирование объектов экранного руководства. 
 
В этом разделе описывается, как выбирать объекты, используя инструменты 
выбора и клавиатуру. Также объясняется, как выбирать цветные блоки или 
индивидуальные объекты, используя функцию Color Film. 

 
 
 
 
Выбор объектов методом 
"указать и щелкнуть" 

 
Щелкните по Select Object (панель Edit), 
если необходимо (эта кнопка 
активирована по умолчанию) и 

щелкните по объектам для выделения. 
 
Наиболее просто можно выделить 
объект, если при активированном 
инструменте Select Object переместить на 
него указатель мыши и нажать левую 
кнопку. Удерживая нажатыми клавиши 
Shift и Ctrl, можно выбрать несколько 
объектов. Могут быть выбраны как 
оконтуренные, так и заполненные 
объекты. Щелчком по контуру объект 
выбирается даже в том случае, если над 
ним находится другой объект. Если вы  

 
 
 
выбираете смешанные или замкнутые 
объекты, вы можете выбрать контуры или 
заполняющие стежки. 
 
Примечание: При малой плотности 
стежков или при большом увеличении 
изображения может случиться, что 
указатель мыши установится между 
стежками, и объект не будет выделен.  
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Как выбирать объекты методом 
"указать и щелкнуть" 
◄ Щелкните по Select Object (Выбрать 

объект).  
◄ Щелкните мышью по контуру, чтобы 

выделить объект. 
 
 
 
 
 
 
 
 
 
 
◄ Щелкните по заполняющим стежкам, 

чтобы выделить заполненный объект. 
 
 
 
 
 
 
 
 

 
◄ Щелкните по заполнению, чтобы 

выделить объект даже в том случае, 
если он находится в контурах 
большого объекта. 

 
 
 
 
 
 
 
 
 

Совет: Чтобы выбрать объект, 
находящийся за другим объектом, 
увеличьте масштаб изображения и 
щелкните по контуру. Альтернативно 
расположите указатель мыши над 
объектом, удерживайте нажатой 
клавишу 2 и щелкайте мышью до тех 
пор, пока объект не будет выделен. С 
каждым щелчком будет выделяться 
следующий перекрывающий объект. 
 
 
 

◄ Для выбора нескольких цветов 
удерживайте нажатой клавишу Ctrl. 

 

 
Щелкните по объекту 
 Удерживая нажатой клавишу 
Ctrl, щелкните по другому объекту 

 
◄ Выделите несколько последовательно 

расположенных объектов, удерживая 
нажатой клавишу Shift и щелкая мышью 
по первому и последнему объектам 
выделяемого диапазона. 

Щелкните по первому объекту   Удерживая  
                                                            нажатой  
                                                            клавишу Shift, 
                                                            щелкните по  
                                                            последнему  
                                                            объекту 
 
Выбор объектов ограничивающим 
прямоугольником 
 

Выберите инструмент Select 
Object (меню Edit) и очертите  
указателем мыши  
ограничивающий прямоугольник   

   вокруг выделяемого объекта. 
 
При активированном инструменте Select 
Object (Выбрать объект) вы можете 
выделять объекты, очерчивая вокруг них 
указателем мыши ограничивающий 
прямоугольник. 
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Как выбирать объекты 
ограничивающим 
прямоугольником 
 
1 Щелкните по кнопке Select Object 

(Выбрать объект). 
2  Очертите указателем мыши 

ограничивающий прямоугольник вокруг 
выделяемых объектов. 
Объекты будут выделены, как только 
вы отпустите кнопку мыши. 

 
Очертите ограничивающий   Объекты выделены 
прямоугольник 
вокруг объектов  
 
 
Примечание: До тех пор, пока объекты 
не будут сгруппированы, после 
отпускания кнопки мыши выделяться 
будут только те объекты, которые 
полностью охватываются 
ограничивающим прямоугольником. См. 
также раздел Группировка объектов в 
Руководстве пользователя.  
 
Выбор объектов инструментом 
Polygon Select 

 
Используйте инструмент 
Polygon Select (панель Edit), 
чтобы выделить объекты 
ограничивающим  

                многоугольником. 
 
 
Используйте инструмент Polygon Select 
(Выбор многоугольником), чтобы 
выделить объекты ограничивающим 
многоугольником. 
 
Как выбирать объекты 
инструментом Polygon Select 
 
1 Щелкните по кнопке Polygon Select. 

2 Наметьте базисные точки вокруг 
объекта или объектов, которые нужно 
выделить. 
Выделяемые объекты должны 

полностью находиться внутри 
контурной линии. 

3 Нажмите Enter для выделения. 
 

Наметьте базисные точки вокруг 
выделяемых объектов для выбора  

 
Выбор объектов клавишей Tab  
 

Щелкните по кнопке Select Object 
(панель Edit) и нажимайте Tab или 
Shift + Tab для перехода между  

           объектами. 
 
При активированном инструменте Select 
Object вы можете выделить первый или 
последний объект в последовательности 
проекта, используя клавишу Tab. Если 
один из объектов выделен, вы можете 
выбрать предыдущий или следующий 
объект в последовательности вышивания. 
См. также раздел Изменение формы 
следующего или предыдущего 
объекта в Руководстве пользователя.  
 
Как выбирать объекты клавишей 
Tab  
 

◄ Щелкните по значку Select Object 
(Выбрать объект). 

◄ Если уже выбран один из объектов, 
выполните одну из следующих 
операций: 
◄ Нажмите клавишу Tab, чтобы 

выделить следующий объект в 
последовательности вышивания.  

◄ Нажмите Shift+Tab, чтобы 
выделить предыдущий объект. 
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◄ Если еще не выбран ни один из 

объектов, выполните одну из 
следующих операций:  
◄ Нажмите клавишу Tab, чтобы 

выделить первый объект в 
последовательности вышивания.  

◄ Нажмите Shift+Tab, чтобы 
выделить последний объект. 

 
Совет: Удерживайте нажатой клавишу 
Ctrl, чтобы выделить несколько 
объектов между уже выбранными. 

 
Выбор всех объектов в проекте 
 
Выберите все объекты для 
одновременных изменений во всем 
проекте. См. также Клавиатурные 
команды в Руководстве пользователя. 
 
Как выбрать все объекты в 
проекте 
 
◄ Выберите Edit > Select All (Выделить 

все) или нажмите Ctrl + A. 
Вокруг всего проекта появятся 
маркеры размера. 

 
 
 
 

Чтобы отменить выделение, выберите 
Edit > Deselect All (Отменить 
выделение всех объектов), или 
нажмите X или Esc.  
 
 
 

Отмена выделения и удаление 
объектов 
 
Отмена выделения и удаление являются 
основными операциями, которые быстро 
приобретают второе свойство. См. также 
раздел Комбинирование объектов в 
Руководстве пользователя.  
 
Отмена выделения объектов 
 
Вы можете отменять все выделения в 
проекте или удалять отдельные объекты 
из группы выделенных объектов. 
 
Как отменить выделение 
объектов 
 
◄ Отменяйте выделения одним из 

следующих способов: 
◄ Нажмите Esc. 
◄ Выделите другой объект. 
◄ Щелкните мышью на пустом месте 

фона. 
◄ Выберите Edit > Deselect All.  

◄ Удалите объект из выделения, 
удерживая нажатой клавишу Ctrl и 
щелкнув мышью по объекту, 
выделение которого нужно отменить. 

 
Удаление объектов 
 
Выберите команду Delete (меню Edit), чтобы 
удалить выделенные объекты. 
 
Удалять объекты можно различными 
методами. См. также Назначение 
последовательности объектов 
инструментом Color Film в 
Руководстве пользователя.  
 
Как удалять объекты 
 
◄ Выделите объект (или объекты) для 

удаления и выполните одну из 
следующих операций: 
◄ Нажмите Delete  
◄ Выберите Edit > Delete. 
◄ Щелкните правой кнопкой мыши по 

Color Film и выберите Delete  из 
всплывающего меню. Подробнее 
см. в следующем разделе 
Просмотр и выделение цветных 
блоков. 

 

Не выделен          Выделены все 
 ни один объект     объекты 
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Просмотр и выделение цветных 
блоков 

 
Щелкните по кнопке Color Film 
(панель General), чтобы  

              просмотреть все цветные блоки и  
              объекты в проекте. 

  
Щелкните по кнопке Show 
Individual Objects (панель Color 
Film), чтобы просмотреть  

             индивидуальные объекты в  
             порядке последовательности  
            вышивания.  
Функция Color Film выводит список 
последовательности вышивания 
объектов, сгруппированных по цвету. 
Используйте ее для выбора и обработки 
"цветных блоков" – непрерывно 
следующих друг за другом объектов 
одного и того же цвета. Кроме того, вы 
можете отображать, выделять, изменять 
и изменять последовательность 
индивидуальных объектов. Функция Color 
Film синхронизирована с окном проекта. 
Она динамически обновляется в то 
время, когда вы выбираете, изменяете 
или удаляете объекты или создаете 
новый объект. См. также Назначение 
последовательности объектов 
инструментом Color Film в 
Руководстве пользователя.  
 
Как просматривать и выделять 
цветные блоки 
 
◄ Щелкните по кнопке Color Film. 

Откроется панель Color Film, 
отображающая все цветные блоки в 
проекте в порядке последовательности 
вышивания. 

 
 
 
 

 

 
◄ Щелкните по переключающей кнопке 

Show Individual Objects (Показать 
индивидуальные объекты), чтобы 
просмотреть индивидуальные 
объекты. 
Все объекты в пределах цветного 
блока показываются в 
последовательности вышивания. 

◄ Щелкните по значку, чтобы выбрать 
цветной блок или объект.  
◄ Для выбора нескольких идущих 

подряд объектов удерживайте 
нажатой клавишу Shift.  

◄ Для выбора нескольких объектов 
удерживайте нажатой клавишу Ctrl. 

 
Выбор цветного блока или объекта 
в панели Color Film 

 
Манипулируйте цветными блоками при 
необходимости. См. также Назначение 
последовательности объектов 
инструментом Color Film в 
Руководстве пользователя.  

◄ Вы можете получить быстрый доступ к 
командам всплывающего меню для 
манипуляции цветными блоками и 
объектами, щелкнув правой кнопкой 
мыши по значку цветного блока. См. 
также раздел Комбинирование 
объектов в Руководстве 
пользователя.  

Все объекты, 
составляющие 
цветной блок, 
показываются в 
последователь-
ности 
вышивания. 

Непрерывно 
следующие друг за 
другом объекты 
одного и того же 
цвета образуют 
единый "цветной 
блок". 



Глава 5: Выбор объектов 

BERNINA® Вышивальное ПО Версия 6  52

 
 

 
Подсказка: Чтобы увеличить изображения 
на пиктограмах, или чтобы выделить 
цветом блоки объектов, нажмите на кнопку 
мыши и “потяните” за край диалогового 
окна. 

 

 

Используйте 
всплывающее меню
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ГЛАВА 6 
 

 
ЗАКРЕПЛЕНИЕ ПРОЕКТОВ В 

ПЯЛЬЦАХ 
------------------------------------------- 
 
 

Перед вышиванием на машине материал должен быть растянут в пяльцах. 
Программный пакет BERNINA Embroidery Software предлагает вам на выбор 
широкий диапазон стандартных пялец. Если в ваш проект входит крупный объект 
или большое количество небольших объектов, вам может потребоваться 
использовать технику перезаправки пялец.  Если у вас есть пяльцы, которых нет 
в списке, вы можете определить собственные пяльцы по своему эскизу или на 
основе стандартных пялец. См. также Отображение пялец. 

 

 
 

 
 
В этом разделе описывается, как выбирать и отображать пяльцы в программах 
BERNINA Embroidery Software. Объясняется, как создавать и модифицировать 
пользовательские пяльцы. Также даются указания, как закреплять в пяльцах 
крупные проекты.
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Выбор пялец 
 
Каждый раз, когда вы создаете новый 
проект, по умолчанию в середине окна 
проекта появляются пяльцы, которые вы 
установили на вышивальной машине. Когда 
вы позиционируете объекты, положение 
пялец подгоняется автоматически, так что 
объекты всегда находятся в центре пялец. 
Инструмент Show Hoop позволяет 
отображать или скрывать пяльцы. Диапазон 
размеров пялец дает возможность 
широкого выбора типов проекта. Вы можете 
изменить ориентацию пялец на экране, 
если это нужно, чтобы облегчить 
оцифровывание.  См. также 
Автоматическое установление всего 
проекта. 
 
Изменение пялец 
 

Щелкайте по кнопке Show Hoop 
(панель General), чтобы 
включить или отключить показ 
пялец. Щелчок правой кнопкой  

       мыши позволяет изменить  
       настройки пялец. 

 
Из предоставляемого вам списка пялец с 
разными размерами выберите наименьшие 
пяльцы, которые подходят к вашему 
проекту.  Благодаря этому ткань в время 
вышивания будет оставаться плотно 
натянутой. См. также Закрепление в 
пяльцах крупных проектов.  

 
 
 
 
 
 
 
 
 
 
 
 
 

Примечание: Когда вы выбираете новые 
пяльцы, они становятся "текущими" до тех 
пор, пока не будут изменены в текущей или 
последующей сессии. 
 
 
 
 
 
 

Как изменять пяльцы 
 
1.  Щелкните правой кнопкой по значку 

Show Hoop или выберите  View > Hoop. 
 Появится диалоговое окно Options> 

Hoop.  

 
 
Выберите требуемый размер пялец 

 
2.  Выберите пяльцы из списка Hoop. 
3.  Если требуется поместить важную часть 

проекта в определенной части пялец, 
выберите опцию Manual и опцию Set 
Hoop Center (Установить центр пялец). 

4.  Щелкните по OK. 
 Если вы выбрали опцию Set Hoop 

Center, щелкните в окне проекта, в том 
месте, где вы хотите поместить центр 
пялец. 

 
Настройка центра пялец 

 
Щелкайте по кнопке Show Hoop 
(панель General), чтобы включить или 
отключить показ пялец. Щелчок правой  

     кнопкой мыши позволяет изменить  
     настройки пялец. 

 
По умолчанию BERNINA всегда размещает 
проект в центре пялец. Однако вы можете 
выбрать опцию Manual (ручную), чтобы 
изображение дисплея с исходного 
положения не смещалось. Это означает, 
что при оцифровке пяльцы не будут 
автоматически центрироваться. Если вы 
разрабатываете образец под одни пяльцы, 
вы, тем не менее, должны всякий раз 
включать функцию автоматического 
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центрирования, чтобы убедиться, что 
образец впишется в рамки пялец, когда 
машина будет вышивать его. 
 

Автоматическая центровка Вручную 
 
ВНИМАНИЕ: Эти установки выполняют 
функцию оцифровки только тогда,  когда 
вышивальная машина центрует образец. 
См. также Автоматическая установка 
начальной и конечной позиций. 
 
 
Как настроить центр пялец 
 
1 Щелкните правой кнопкой по значку 

Show Hoop или выберите  View > Hoop.  
 Появится диалоговое окно Options> 

Hoop.  

 
 
2 На настроечной панели Position 

выберите способ центровки пялец. 
 
◄  Automatic Centering (Автоматическая 
центровка): пяльцы перемещаются таким 
образом, что проект всегда находится в 
центре. 
 
 
 
◄  Manual (Ручная): пяльцы остаются в 

своем первоначальном положении. 
 Выберите Set Hoop Center (Установить 

центр пялец), чтобы изменить 
положение пялец. 

 

 
3 Щелкните по OK. 
 Если вы выбрали опцию Set Hoop 

Center, щелкните в окне проекта, в том 
месте, где вы хотите поместить центр 
пялец. 

 
Закрепление в пяльцах 
крупных проектов 
 

 
 
 
 
 

Позволяет просматривать и 
редактировать проекты, не помещающиеся 
в пяльцах. Если ваша вышивка слишком 
велика, или содержит много образцов, 
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расположенных на пространстве, 
разбитом для вышивки на многих пяльцах. 
 
Если ваша вышивка слишком крупная или 
содержит несколько проектов, 
расположенных кругом на предмете 
одежды, вы можете разделить ее, 
используя технику перезаправки пялец. 
Каждая часть содержит объект или группу 
объектов, которые можно вышить в одних 
пяльцах. Они могут быть вышиты 
последовательно в виде целого проекта. 
Отдельные части могут быть переданы 
непосредственно в машину или сохранены 
в файле. См. также Автоматическая 
последовательность вышивания всего 
проекта. 
 
 
 
 
 
 

 
Совет: В каждом проекте можно 
использовать пяльцы только одного 
размера, так что нужно выбирать такие 
пяльцы, в которых разместится самый 
крупный объект проекта. 
 
Вышивание с перезаправкой 
пялец 
 
Когда программа BERNINA Embroidery 
Software просчитывает последовательность 
вышивки, она старается разбить все 
объекты на ряд последовательных стадий с 
перезаправкой пялец. Если один объект 
вышивки перекрывает другой, то объект 
заднего плана должен вышиваться 
раньше, чем объект переднего плана.   
 

 
Проверьте последовательность вышивки 
объектов перед расчетом последовательности 
перезаправки пялец. 
 
Заметьте: при трех позициях пялец будет 5 
перезаправок. 
 
Держа это в уме, постарайтесь добиться 
того, чтобы: 
• Каждая следующая позиция пялец 

перекрывала вышивку, прошитую при 
предшествующем положении пялец. 

• Положения пялец максимально 
соответствовали последовательности 
расположения объектов вышивки. Это 
сократит  число возможных 
перезаправок. 

 
Отметим: Перезаправка (‘Hooping’) – это не то 
же самое, что «позиция пялец». Может 
оказаться, что перезаправок будет больше, чем 
позиций пялец.  Однако, никогда их не может 
быть меньше. Другими словами, для 
обеспечения нужной последовательности 
вышивки, одной позиции пялец может 
соответствовать более чем одна перезаправка 
пялец ( hoping). 
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Последовательность заправки 
пялец 
 
Если крупный проект требует 
использования техники перезаправки 
пялец, важно установить такую 
последовательность вышивания, чтобы 
объекты переднего плана вышивались 
после объектов заднего плана. Программы 
BERNINA Embroidery Software позволяет 
настраивать положение и 
последовательность пялец. Пяльцы 
кодируются цветом в соответствии с 
положением в последовательности 
вышивания: 
 
Пяльцы Цвет 

1 Темно-зеленый
2 Синий 
3 Красный 
4 Коричневый 
5 Оранжевый 
6 Фиолетовый 
7 Бирюзовый 
8 Голубой 

 
В маловероятном случае, когда 
потребуется более восьми перезаправок 
пялец, эта последовательность 
повторяется, как только будут удалены 
предыдущие позиции пялец.   
 

 
 
Проверка последовательности вышивки 
образца 
 
Знание последовательности объектов 
образца  поможет вам сконструировать 
оптимальную последовательность 
перезаправки и положений пялец.  Удобно 
воспользоваться инструментом Color Film в 
объектном режиме, как показано на рисунке 
выше.  По мере выбора объектов из списка, 
они выделяются на экране с изображением 
образца. Это помогает понять порядок 

вышивания объектов, а следовательно и 
последовательность перезаправки пялец.  
См. также раздел Просмотр и выделение 
цветных блоков. 
 

 
Проверьте последовательность вышивания 
объектов с перекрывающимися 
положениями пялец. 
 
Другой полезный инструмент -  Slow 
Redraw. Запуская программу Slow Redraw, 
вы можете проверить, каким образом 
начальные и конечные точки определенных 
объектов влияют на число перезаправок 
пялец. Например, если вы разделите 
большой объект на две части так, что его 
первая часть попадает на вторую позицию 
пялец, это может привести к необходимости 
дополнительной перезаправки пялец. С 
помощью функции Slow Redraw, вы можете 
добиться того, чтобы разделяемые объекты 
разделялись между соседними 
положениями пялец (как в смысле позиции 
пялец, так и в смысле последовательности 
вышивания). Объект начинает вышиваться 
при более ранним положении пялец. См. 
также раздел Моделирование образцов 
вышивки. 
 
Настройка последовательности 
объектов образца 
 
Правильно выбранные позиции пялец 
уменьшают число необходимых 
перезаправок пялец. Иногда 
последовательность объектов образца 
может оказаться неоптимальной для 
вышивки с перезаправкой пялец.  В таком 
случае для уменьшения числа 
перезаправок пялец может потребоваться 
изменить саму последовательность 
объектов образца. Общие рекомендации  
таковы: 
 
• Промышленные образцы, 

разработанные под одну позицию 
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пялец, обычно вышиваются в порядке 
цветов ниток, чтобы сократить число 
замен катушек разных цветов. Это 
важно для машин с одной иглой. 

• Увеличение промышленного образца до 
размеров, требующих перезаправки 
пялец может потребовать изменения 
последовательности объектов с целью 
уменьшения числа перезаправок. 

• Поскольку все части вышивки должны 
изготавливаться на пяльцах одного 
размера, выберите такие пяльцы, 
которые вмещают самый большой из 
объектов вашего образца. 

• Всегда старайтесь максимально 
согласовать последовательность 
позиций пялец и последовательность 
объектов вышивки.   

 
Расчет числа перезаправок пялец 
 
Поскольку программа BERNINA Embroidery 
Software всегда сохраняет исходную 
последовательность вышивания, для 
уменьшения числа перезаправок пялец 
нужно, чтобы последовательность позиций 
пялец соответствовала 
последовательности объектов образца. 
 
Время, необходимое для расчета 
последовательности перезаправок пялец, 
зависит больше от числа объектов вышивки 
и числа позиций пялец, чем от количества 
стежков.  Образцы, преобразованные из 
форматов EXP, PES, HUS, и т.п., в общем 
случае разбиваются на большее число 
объектов, чем «родные» образцы 
программы BERNINA Embroidery Software. 
Поэтому время расчета для таких объектов 
больше. Но даже и для образцов формата 
ART, если образец сложен, велик и требует 
применения большого числа разных 
позиций пялец, расчет последовательности 
перезаправок может потребовать заметного 
времени.  
 
Создание проектов, не 
помещающихся в одних пяльцах 

 

Используйте кнопку Select Hoop 
(панель Multi-Hooping), чтобы 
выбрать пяльцы в окне 
проекта. 

 

Используйте функцию Reshape 
Splitting Guide (панель Multi-
Hooping) для перерисовки 
разделительных линий в окне 
проекта Design Window. 

Используйте кнопку Add Hoop 
(панель Multi-Hooping), чтобы 
центровать новые пяльцы в 
окне проекта в вертикальной 
ориентации.  

Используйте кнопку Add Hoop 
Right (панель Multi-Hooping), 
чтобы поместить новые 
пяльцы непосредственно 
справа от выбранных пялец с 
10-мм перекрытием полей 
вышивания.  

 

Используйте кнопку Add Hoop 
Up (панель Multi-Hooping), 
чтобы поместить новые 
пяльцы непосредственно над 
выбранными пяльцами.  

 

Используйте кнопку Add Four 
Adjacent Hoops (панель Multi-
Hooping), чтобы 
автоматически добавить 
четыре новых положения 
пялец по периметру 
выбранной позиции пялец. 

 

Используйте кнопку Add Eight 
Adjacent Hoops (панель Multi-
Hooping) чтобы 
автоматически добавить 
восемь новых положения пялец 
по периметру выбранной 
позиции пялец. 

 

Используйте кнопку Splitting 
Guide (панель Multi-Hooping) 
для оцифровки 
разделительных линий 
большого образца перед тем, 
как передать информацию в 
файл, на машину или на карту 
памяти.  

 

Используйте кнопку Delete 
Hoop (панель Multi-Hooping), 
чтобы удалить пяльцы из 
окна проекта.  

 

Щелкните по кнопке Rotate 
Hoop (панель Multi-Hooping) 
левой или правой кнопкой 
мыши, чтобы повернуть 
выбранные пяльцы на 45° по 
или против часовой стрелки.   

 

Используйте кнопку Calculate 
Hoopings (панель Multi-
Hooping), чтобы определить 
количество перезаправок 
пялец на основе текущей 
компоновки пялец.  
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Программа BERNINA Embroidery Software 
имеет специальный режим Hoop Layout, 
который позволяет работать с 
перезаправкой пялец. Вы сможете делать 
большие вышивки, не помещающиеся в 
одни пяльцы Режим Hoop Layout позволяет 
определить последовательность смены 
позиций и перезаправки пялец. Цель 
состоит в том, чтобы разработать 
последовательность вышивки образцов, 
при которой число перезаправок пялец 
будет минимальным. См. также раздел  
Вывод проектов, не помещающихся в 
пяльцах. 
 
Подсказка: Знание последовательности 
объектов образца  поможет вам 
сконструировать оптимальную 
последовательность перезаправки и 
положений пялец.  Удобно воспользоваться 
инструментом Color Film в объектном 
режиме.  По мере выбора объектов из 
списка, они выделяются на экране с 
изображением образца. Другой полезный 
инструмент для этой задачи -  Slow 
Redraw. 
См. также раздел Вывод проектов, не 
помещающихся в пяльцах. 
 
Как создать проект, не 
помещающийся в одних пяльцах  
 
1 В окне Embroidery Canvas выберите 

пяльцы, которые вы хотите 
использовать. Подробнее см. в разделе  
Изменение пялец. 

 
 
Подсказка: Поскольку все части вышивки 
должны изготавливаться на пяльцах одного 
размера, выберите такие пяльцы, которые 
вмещают самый большой из объектов 
вашего образца 

 
 
2 Переключитесь на Hoop Layout. 

Подробнее см. в разделе  Режимы 
просмотра. 

 Если вы введете в окно Hoop Layout 
объекты, которые полностью 
помещаются в пяльцах, они 
окрашиваются зеленым цветом. 
Объекты, которые вышли за контуры 
пялец, окрашиваются черным. 

 
 

 
Примечание: В окне Hoop Layout нельзя 
выбирать вышивальные объекты или 
манипулировать ими. 
 
 
3 Щелкните Selection On, щелкните по 

контуру пялец и перетащите их, чтобы в 
контуры пялец поместился самый 
крупный объект проекта. 

 
 
 
 
 
 
 
 
 
 
 
 

Проект не помещается 
в контурах пялец, 
требуются еще одни 
пяльцы 

 
4  Используйте инструмент Add Hoop, 

чтобы добавить дополнительные 
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позиции пялец. Файл будет разделен на 
несколько файлов по числу добавленных 
пялец. 

 
Примечание: Как только пяльцы будут 
перемещены или подведены к другим 
пяльцам, отменяется функция 
автоматической центровки, т.е. объекты не 
будут автоматически устанавливаться по 
центру пялец.  
 

◄ Щелкните по значку Add Hoop, чтобы 
добавить новые пяльцы в окне Design 
в вертикальной ориентации. 

◄  Используйте кнопку Add Hoop Right, 
чтобы поместить новые пяльцы 
непосредственно справа от 
выбранных пялец с 10-мм 
перекрытием полей вышивания.  

 

 
Добавлены новые пяльцы 

 
◄ Подобным же образом используйте 

кнопку Add Hoop Up, чтобы 
поместить новые пяльцы 
непосредственно над выбранными 
пяльцами. 

 
Кнопки Add Four Adjacent Hoops (Добавить 
четыре соседние позиции пялец)и Add 
Eight Hoops Around (Добавить восемь 
соседних позиций пялец)становятся 
доступными, когда в окне проекта Design 
Window выбраны одни пяльцы. Щелчок по 
соответствующей кнопке добавляет на 
экране по периметру пялец соответственно 
4 или 8 новых позиций пялец, нумеруемых 
начиная от верхней точки и далее по 
часовой стрелке с 10-мм перекрытиями 
вышивальных полей. 

 

 
Добавить четыре соседние позиции пялец 
 
 

 
Добавить восемь соседних позиций пялец 
 
5 Щелкните по кнопке Delete Hoop или на 

клавишу Delete, если необходимо 
удалить выделенные пяльцы из окна 
Design. Удаление одних пялец не 
приведет к изменению цвета оставшихся 
пялец. 

 
Примечание: Если вы удалите все пяльцы 
в проекте и создадите новый проект, то 
будет снова активирована функция 
автоматической центровки. 
 
Совет: Для одновременного выделения 
больше чем одних пялец используйте один 
из следующих способов: 
 

◄  Для выделения или отмены 
выделения щелкайте по контурам 
пялец, удерживания нажатой клавишу 
Ctrl.
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◄ Для выделения нескольких пялец 

щелкайте по контурам пялец, 
удерживания нажатой клавишу Shift. 

◄  Щелкните и протащите указателем 
мыши рамку выделения для 
выделения пялец, входящих в 
контуры рамки. 

6 Измените положение дополнительных 
пялец и, если необходимо, поверните их, 
чтобы в них вошли все объекты проекта. 
◄  Щелкните по кнопке Rotate Hoop 

левой или правой кнопкой мыши, 
чтобы повернуть выбранные пяльцы 
на 45° по или против часовой стрелки.  

◄  Как вариант, щелкните по пяльцам 
опять и поверните пяльцы с помощью 
маркеров вращения и поворота 
центральной точки. 

Изменение положения центральной точки 
 

Маркер вращения  
 
Внимание: Пяльцы в режиме Hoop Layout 
можно поворачивать на любой угол. При 
повороте пялец в режиме Hoop Layout, их 
«верхняя точка» тоже поворачивается. 
 
• Перемещайте выбранные пяльцы 

малыми шагами, используя клавиши со 
стрелками. 

 
 
 
 
 
 
 
 
 

 
 
 
 
 

Все объекты перекрыты пяльцами 

 
Внимание:  Даже когда разные позиции 
пялец перекрывают весь образец, 
некоторые его объекты могут оказаться не 
учтенными, что отображается на экране 
черными стежками. Если на этом этапе вы 
попробуете сохранить проект в файл или 
вывести на машину, вы получите 
сообщение от программы о том, что не все 
объекты вышивки учтены. Инструмент 
Splitting Guide позволяет разделять 
отдельные объекты, которые иначе не 
влезают ни в какие пяльцы. См. раздел 
Разбиение объектов по разным 
позициям пялец. 
 
 
7 После этого используйте кнопку 
Calculate Hoopings, чтобы определить 
количество перезаправок пялец на основе 
текущей компоновки пялец. 
 

 
В зависимости от того, делили ли вы 
отдельные объекты между разными 
позициями пялец или нет, файл 
разбивается на столько файлов, сколько 
требуется перезаправок пялец. 
 
 Вы теперь готовы к тому, чтобы 

сохранить проект в одном или 
нескольких файлах иди передать их в 
машину. Подробнее см. в разделе  
Вывод проектов, не помещающихся 
в пяльцах. 

 
Совет: Распечатайте копию проекта, 
показывающую положение пялец, чтобы 
при вышивании иметь представление о 
порядке перезаправки пялец. Подробнее 
см. в разделе Печать проектов. 
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Разбиение объектов по разным 
позициям пялец 

 
 Используйте кнопку Splitting Guide 
(панель Multi-Hooping) для оцифровки 
разделительных линий большого 
образца перед тем, как передать 
информацию в файл, на машину или 
на карту памяти. 
 
Используйте функцию Reshape 
Splitting Guide (панель Multi-Hooping) 
для перерисовки разделительных  

                  линий в окне проекта Design Window. 
 
Инструмент Splitting Guide позволяет 
разделять отдельные объекты, которые 
иначе не влезают в пяльцы. Фактически, вы 
можете нарисовать и оцифровать на вашем 
большом проекте одну или несколько 
разделительных линий перед тем, как 
вывести проект в файл, в машину или на 
карту памяти. Хотя разделительные линии 
отображаются на экране только в режиме 
Hoop Layout, в других режимах они тоже 
учитываются. Разделительные линии не 
нарушают целостности объектов и вы по-
прежнему можете их преобразовывать и 
трансформировать.  
 

 
 
Для того, чтобы выполнить разбиение 
объектов по разным позициям пялец 
1 Выберите режим Hoop Layout. 
Ваш проект отображается в окне проекта 
Design Window с указанием позиций пялец и 
неучтенных объектов. 
 

 
 
 
2 Выберите инструмент Splitting Guide. 
На перекрытиях вышиваемых полей вам 
надо указать начальную точку 
разделительной линии. 
 

 
Оцифровка разделительных линий 
производится также, как для незамкнутых 
кривых линий. 
 
3 Оцифровка разделительных линий 
производится также, как для незамкнутых 
кривых линий. Для кривых используется 
правая клавиша мыши. Для угловых точек – 
левая. Поскольку разделение производится 
в пределах зоны перекрытия соседних 
положений пялец, разделенные части 
объекта покрываются одними пяльцами и 
помечаются на экране зеленым цветом.  
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Линии, полностью пересекающие 
неучтенный пока объект, при сохранении 
(выводе) проекта станут разделительными. 
Разделение не обязательно будет сделано 
строго по оцифрованным линиями. 
Программа постарается сделать 
разделительные линии максимально  
незаметными. Объекты при этом сохраняют 
свой тип, угол вышивки стежков, параметры 
и цвет.   
 
4 Повторите прежние действия или 
нажмите Enter для завершения работы. 

 

 
Внимание: Разделительные линии можно 
исправить или перерисовать с помощью 
инструмента Reshape Splitting Guide. 
Контрольные точки разделительных линий 
соответственно выделяются и с ними 
можно свободно манипулировать. 

 
  
Corner point 
 
 
Selected point 
 
 
Curve point 
 
 
 
 
 

 
Внимание: Разделительные линии, не 
пересекающие объект полностью, или 
пересекающие объект уже учтенный, 
игнорируются.   
 
 
Создание проектов в раздвижных 
пяльцах 
 
 

Используйте кнопку Select Hoop 
(панель Multi-Hooping), чтобы выбрать 
пяльцы в окне Design. 

Используйте кнопку Add Hoop (панель 
Multi-Hooping), чтобы центровать новые 
пяльцы в окне Design в вертикальной 
ориентации.  

Используйте кнопку Delete Hoop 
(панель Multi-Hooping), чтобы удалить 
пяльцы из окна Design.  

 
Раздвижные пяльцы являются 
специальными пяльцами с регулируемыми 
рамками для приспособления к большим 
размерам проекта. Вы можете 
адаптировать положение поля вышивания в 
соответствии с объектами проекта. Вы 
можете даже определить увеличенное поле 
вышивания по своему выбору. Однако весь 
проект должен находиться в пределах 
контура пялец. 
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Поле вышивания     Ширина           Общая высота 
 
Примечание: Вы можете назначить 
собственные раздвижные пяльцы, 
подходящие к вашему проекту.  Подробнее 
см. в разделе Определение раздвижных 
пялец. 
 
Как создать проект для раздвижных 
пялец 
 
1  В окне Embroidery Canvas выберите 

раздвижные пяльцы, которые вы хотите 
использовать. Подробнее см. в разделе 
Изменение пялец. 
 

 

Весь контур изображается сплошной черной 
линией. 

 
 
 
 
Раздвижные 
пяльцы 
 
 
 
 
 
 
 

Примечание: Для проекта могут быть 
использованы только одни раздвижные 
пяльцы, так что вам нужно выбрать 
такие пяльцы, которые подходят для 
всего проекта. Поле вышивания также 
должно соответствовать наиболее 
крупному объекту проекта. 
 
 
 

2 Переключитесь на окно Hoop Layout. 
Подробнее см. в разделе  Режимы 
просмотра. 

 
Если вы введете в окно Hoop Layout 
объекты, которые полностью 
помещаются в поле вышивания, они 
окрашиваются зеленым цветом.  
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Объекты, которые вышли за контуры 
пялец, окрашиваются черным. 
 

 
 
Раздвижные 
пяльцы 
 
 
 
 
Позиция 
поля 
вышивания 
 
 
 
 
 
 
 
 

Примечание: В окне Hoop Layout нельзя 
выбирать вышивальные объекты или 
манипулировать ими. 

 
3 Щелкните по Selection On, щелкните по 

пунктирному контуру пялец и 
перетащите их, чтобы в контуры пялец 
поместился самый крупный объект 
проекта. 

4 Щелкните по Add Hoop. К центру пялец 
добавится новая позиция поля 
вышивания, отображаемое как 
пунктирный контур другого цвета. 

 
Примечание: Функции Add Hoop Right и 
Add Hoop Up в этом случае не 
доступны. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5 Перетащите мышью и при 
необходимости расширьте новую 
позицию поля вышивания. 

 
 
 
 
 
 
 
Вторая 
позиция поля 
вышивания 
 
 
 
 
 
 
 
 
 
 
 
 
 

6 Щелкните по контуру пялец, чтобы 
выделить пяльцы и все находящиеся в 
них позиции и при необходимости 
повернуть или переместить. Подробнее 
см. в разделе  
Создание проектов, не 
помещающихся в пяльцах 
 

7 При необходимости удалите позицию 
поля вышивания, щелкнув по 
пунктирному контуру и нажав кнопку 
Delete Hoop. 

 
Совет: Высоту поля вышивания и 
размер пялец можно подгонять в любое 
время к тем пяльцам, с которыми вы 
работаете в настоящее время. 
Подробнее см. в разделе Настройка 
собственных пялец. 

 
 
Создание проектов для 3-
позиционных пялец 
  

 Используйте кнопку Selection On 
(панель Multi-Hooping), чтобы выбрать 
пяльцы в окне Design. 
  
Используйте кнопку Add Hoop (панель 
Multi-Hooping), чтобы центровать 
новые пяльцы в окне  Design в  

      вертикальной ориентации. 
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Используйте кнопку Add Hoop Right  
(панель Multi-Hooping), чтобы 
поместить новые пяльцы 
непосредственно справа от 
выбранных пялец с 10-мм 
перекрытием полей вышивания. 
Используйте кнопку Add Hoop Up 
(панель Multi-Hooping), чтобы 
поместить новые пяльцы 
непосредственно над выбранными 
пяльцами. 
Используйте кнопку Delete Hoop 
(панель Multi-Hooping), чтобы  

         удалить пяльцы из окна Design. 
 

3-позиционные пяльцы позволяют вручную 
разделять крупные проекты и вышивать без 
обычных проблем регистрации. В отличие 
от раздвижных пялец поля вышивания 
находятся в фиксированной позиции с 
известными размерами, что облегчает 
регистрацию объектов, вышиваемых в 
каждой позиции. Три зоны вышивания по 
очереди размещаются в вышивальной 
машине без необходимости перезаправлять 
пяльцы. На экране они отображаются в 
виде трех оконтуренных пунктиром 
прямоугольников. Верхний прямоугольник 
зеленый, средний синий и нижний красный. 
 

                                                        
Высота 1-й позиции                    Общая высота 
Высота 2-й позиции 
Высота 3-й позиции 

 
Примечание: Вы можете назначить 
собственные 3-позиционные пяльцы, 
подходящие к вашему проекту.  Подробнее 
см. в разделе Определение 3-
позиционных пялец. 
 
 
 
 
 
 

Как создать проект для 3-
позиционных пялец 
 
1  В окне Embroidery Canvas выберите 3-

позиционные пяльцы, которые вы хотите 
использовать. Подробнее см. в разделе  
Изменение пялец. 
Общий контур очерчивается сплошной 
черной линией, а каждое поле 
вышивания – пунктирными линиями. 

 

Примечание: Для очень больших проектов 
можно использовать 3-позиционные пяльцы 
в технике перезаправки. Однако поле 
вышивания должно соответствовать 
наиболее крупному объекту проекта. 
 
2 Переключитесь на Hoop-Layout. 

Подробнее см. в разделе  Режимы 
просмотра. 

 Если вы введете в окно Hoop Layout 
объекты, которые полностью 
помещаются в пяльцах, они 
окрашиваются зеленым цветом. 
Объекты, которые вышли за контуры 
пялец, окрашиваются черным. 
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Примечание: В окне Hoop Layout 
нельзя выбирать вышивальные объекты 
или манипулировать ими. 

 
3 Щелкните по Selection On, щелкните по 

контуру пялец и перетащите их, чтобы в 
контуры пялец поместился самый 
крупный объект проекта. 

 
Примечание: С 3-позиционными 
пяльцами вы можете выделять пяльцы 
целиком, но не внутренние 
индивидуальные позиции пялец. 

 
4 Используйте инструмент Add Hoop, 

чтобы добавить, если требуется, 
дополнительные пяльцы. Подробнее см. 
в разделе Создание проектов, не 
помещающихся в пяльцах. 

 

 
 
5 Переместите или поверните пяльцы, 

если требуется. Подробнее см. в 
разделе Создание проектов, не 
помещающихся в пяльцах. 

 
Примечание: Перемещение или 
вращение воздействует на пяльцы 
целиком и все внутренние позиции. 

6 При необходимости удалите пяльцы. 
Подробнее см. в разделе Создание 
проектов, не помещающихся в 
пяльцах. 
 
Совет: Высоту полей вышивания и 
размер пялец целиком можно изменять в 
любое время. Подробнее см. в разделе 
Настройка собственных пялец. 

 
 
 

Определение 
пользовательских пялец  
 
 
Если вы используете пяльцы с 
отсутствующими в списке размерами, вы 
можете назначить свои собственные 
пяльцы и сохранить их для последующего 
использования. Вы можете создавать или 
редактировать четыре типа пялец – 
прямоугольные, овальные, раздвижные и 3-
позиционные. 
 
Назначение прямоугольных пялец 
 

Щелкайте по кнопке Show Hoop 
(панель General), чтобы включить или 
отключить показ пялец. Щелчок правой 
кнопкой – создание пялец. 

 
Прямоугольные пяльцы отображаются 
черными пунктирными линиями. Вы можете 
назначить высоту и ширину прямоугольника 
в соответствии с размерами пялец. 
 

 
 
 
 
 
 
 
Высота 
 
 
 
 
 
 
 

  Ширина 
 
Как назначить прямоугольные 
пяльцы 
 
1 Щелкните правой кнопкой по значку 

Show Hoop или выберите  View > Hoop. 
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Появится диалоговое окно Options> Hoop.  
 

 
 
2   Нажмите кнопку New Hoop. 

Откроется диалоговое окно Create/Edit 
Hoop (Создать/Редактировать 
пяльцы). 

 
 
3 В списке Format выберите Rectangle. 
 
4  В панели Dimensions (Размеры) 

введите высоту (Height) и ширину 
(Width) прямоугольных  

пялец. 
 
5  Нажмите кнопку Save Hoop As 

(Сохранить пяльцы как) Откроется 
диалоговое окно Save Hoop As. 

6 Введите название пялец. 
 

 
 
 

7 Щелкните по OK и Save Hoop. 
 
 
Назначение овальных пялец 

 
 Щелкайте по кнопке Show Hoop 
(панель General), чтобы включить или 
отключить показ пялец. Щелчок правой 
кнопкой – создание пялец. 

 
Овальные пяльцы отображаются черным 
пунктирным контуром. Вы можете назначить 
высоту и ширину овала в соответствии с 
размерами пялец. 

        

                                Ширина 
 
Как назначить овальные пяльцы 
 
1 Щелкните правой кнопкой по значку 

Show Hoop или выберите  View > Hoop.  
 Появится диалоговое окно Options> 

Hoop.  
 

 
 
 
 
 
 
 

Общая  
высота 

Высота     
прямоугольника 
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2  Нажмите кнопку New Hoop. 
 

Откроется диалоговое окно Create/Edit 
Hoop (Создать/Редактировать 
пяльцы). 
 

 
 
 

3 В списке Format выберите Oval. 
4 На панели Dimensions введите высоту 

прямоугольника (Rectangle Height), 
общую высоту (Total Height) и ширину 
(Width) овальных пялец. 

5 Нажмите кнопку Save Hoop As 
(Сохранить пяльцы как)  

 Откроется диалоговое окно Save Hoop 
As. 

6 Введите название пялец. 
 
7 Щелкните по OK и Save Hoop. 

 

 
 
Назначение раздвижных пялец 
 

Щелкайте по кнопке Show Hoop 
(панель General), чтобы включить или 
отключить показ пялец. Щелчок правой 
кнопкой – создание пялец. 

 
Раздвижные пяльцы являются 
специальными пяльцами с регулируемыми 
рамками для приспособления к необычным 
размерам проекта.  
 
 
 

Вы можете назначить высоту и ширину 
пялец, а также поля вышивания в 
соответствии с размерами используемых 
пялец. 
 
 
 
 
 
 
Поле  
вышивания 

                                
 
 
 
 
 
 
 
 
       Ширина 

 
Как назначить раздвижные пяльцы 
 
1 Щелкните правой кнопкой по значку 

Show Hoop или выберите  View > Hoop.  
Появится диалоговое окно Options > 
Hoop.  

 

 
2 Нажмите кнопку New Hoop. 

Общая  
высота 
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Откроется диалоговое окно Create/Edit 
Hoop.  

 
 

3  В списке Format выберите Sliding 
(Раздвижные). 

4 В панели Dimensions (Размеры) 
введите высоту поля вышивания 
(Sewing Field), общую высоту (Total 
Height) и ширину (Width) пялец. 

 
Примечание: Лучше всего вводить в 
первую очередь общую высоту. Если 
поле вышивания больше принятой по 
умолчанию общей высоты, то 
установленный размер уменьшается. 

5 Нажмите кнопку Save Hoop As 
(Сохранить пяльцы как). Откроется 
диалоговое окно Save Hoop As. 

6  Введите название пялец. 
 

 
 
7 Щелкните по OK и Save Hoop. 
 
Назначение 3-позиционных 
пялец 

 
Щелкайте по кнопке Show Hoop 
(панель General), чтобы включить или 
отключить показ пялец. Щелчок  

        правой кнопкой – создание пялец. 
 
3-позиционные пяльцы позволяют вручную 
разделять крупные проекты и вышивать без 
обычных проблем регистрации. 

 В отличие от раздвижных пялец поля 
вышивания находятся в фиксированной 
позиции с известными размерами, что 
облегчает регистрацию объектов, 
вышиваемых в каждой позиции. На экране 
они отображаются в виде трех 
оконтуренных пунктиром прямоугольников. 
Верхний прямоугольник зеленый, средний 
синий и нижний красный. Вы можете 
назначить собственные 3-позиционные 
пяльцы в соответствии с размерами 
используемых вами пялец. 
 
 
Высота 1-й 
позиции 
 
 
 
Высота 2-й 
позиции 
 
 
 
 
Высота 3-й 
позиции 

  
 
 
 
 
                                                                                              
  Ширина 

 
Как назначить 3-позиционные 
пяльцы 
1 Щелкните правой кнопкой по значку 

Show Hoop или выберите  View > Hoop.  
 Появится диалоговое окно Options> 

Hoop.  
 

 
2  Нажмите кнопку New Hoop. 
 

Общая  
высота 
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Откроется диалоговое окно Create/Edit 
Hoop (Создать/Редактировать пяльцы). 
 

 
3  В списке Format выберите 3-Position (3-

позиционные). 
4 В панели Dimensions (Размеры) 

введите общую высоту (Total Height), 
значения высоты для позиций 1, 2 и 3, а 
затем ширину пялец (Width). 

 
Примечание: Лучше всего вводить в 
первую очередь общую высоту. Если 
поле вышивания больше принятой по 
умолчанию общей высоты, то 
установленный размер уменьшается. 

5  Нажмите кнопку Save Hoop As 
(Сохранить пяльцы как). Откроется 
диалоговое окно Save Hoop As. 

6 Введите название пялец. 

 
7 Щелкните по OK и Save Hoop. 
 
 
 
 
 
 
 
 
 
 
 

Настройка собственных пялец 
 
Вы можете при необходимости изменять и 
удалять пользовательские пяльцы. Можно 
изменять настройки только 
пользовательских пялец. 
 
Изменение настроек пялец 

 
Щелкайте по кнопке Show Hoop (панель 
General), чтобы включить или отключить 
показ пялец. Щелчок правой кнопкой –  

    редактирование пялец. 
 
При необходимости можно изменять высоту 
и ширину новых пялец. 
 
Как изменять настройки пялец 
1 Щелкните правой кнопкой по значку 

Show Hoop или выберите  View > Hoop.  
Появится диалоговое окно Options > 
Hoop.  

 

 
 
2 В списке Hoop (Пяльцы) выберите 

пяльцы. 
3 Нажмите кнопку Edit Hoop 

(Редактировать пяльцы).  
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Откроется диалоговое окно Create/Edit 
Hoop. 

  
 
4 Введите новые размеры. 
 
 
5  Нажмите кнопку Save Hoop (Сохранить 

пяльцы). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Удаление пялец 
 

 Щелкайте по кнопке Show Hoop 
(панель General), чтобы включить или 
отключить показ пялец. Щелчок 
правой кнопкой – удаление пялец. 

 
Если вы удаляете тип пялец, он удаляется 
навсегда. Можно удалять только 
собственноручно созданные пяльцы. 
 
Как удалить пяльцы 
 
1 Щелкните правой кнопкой по значку 

Show Hoop или выберите  View > Hoop.  
Появится диалоговое окно Options > 
Hoop.  

2 Выберите созданные вами пяльцы, 
которые вы хотите удалить. 

 

 
 
3 Нажмите кнопку Delete Hoop (Удалить 

пяльцы), а затем для подтверждения  
кнопку OK.  
 
Пяльцы будут безвозвратно удалены.
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ГЛАВА 7 
 

 
УСТАНОВКА АППАРАТНЫХ СРЕДСТВ 

И НАСТРОЙКА СИСТЕМЫ 
------------------------------------------- 
 

 
 

Для работы с BERNINA Embroidery Software вам 
необходимо подсоединить периферийные 
устройства. К ним относятся, например, принтеры, 
сканеры и вышивальные машины. 
BERNINA Embroidery Software  позволяет 
настраивать различные установки системы, 
управляющие внешним видом проектов на экране, 
отображением информации о проекте, поведением 
окна проекта, и другие установки. 
В этом разделе описывается, как настраивать 
вышивальные машины и сканеры и как калибровать 
монитор. Кроме того, объясняется, как изменять 
интервал сетки и опции позиционирования и 
изменять опции пялец. Имеется также информация о 
том, как настраивать отображение указателя мыши и 
как установить опцию автосохранения. 
 

Установка аппаратных средств 
 
Различные устройства устанавливаются 
различными способами – некоторые в ОС 
Windows через Панель управления, другие в 
самой программе BERNINA Embroidery Software  
itself. За указаниями по подключению устройств к 
компьютеру и их настройке в системе Windows 
обратитесь к прилагаемым к устройствам 
инструкциям, а также к документации по 
Microsoft Windows. 
 
Настройка подсоединения 
периферийного устройства 
Периферийные устройства, такие как принтеры, 
подсоединяются к имеющемуся порту на 
передней или задней стороне компьютера. Это 
может быть последовательный, параллельный 
или USB порт. Конфигурацию программного 
обеспечения нужно выбирать через Панель 
управления системы Windows. 
 

 
Настройка последовательного порта 
Последовательные COM-порты компьютера 
имеют ответные 9- или 25-штырьковые разъемы. 
Они называются COM1, COM2 и т.д.  Количество 
имеющихся портов ограничивает количество 
подключаемых устройств. Если требуются 
дополнительные порты, вы можете их добавить. 
BERNINA Embroidery Software  дает возможность 
иметь до 4 последовательных портов. 
 
Примечание: Вы должны уметь 
идентифицировать порты вашего компьютера. 
При возникновении сомнений 
проконсультируйтесь со специалистом. 
 
Настройка параллельного порта 
Параллельные порты используются для 
подсоединения принтера и сканера. Они 
называются LPT1, LPT2 и т.д.  
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Настройка USB-порта 
Порты USB (Universal Serial Bus) используются 
для подсоединения вашего аппаратного ключа 
dongle. Они могут быть также использованы для 
подсоединения принтера или сканера. 
Дополнительные USB-порты могут использовать 
устройство для подпитки. 
 
Настройка вышивальных машин 
Ваша вышивальная машина BERNINA должен 
быть подключена к порту COM1, COM2, COM3, 
COM4 или USB вашего компьютера. Подробно о 
подключении машины к компьютеру можно 
узнать в Руководстве по эксплуатации вашей 
вышивальной машины. 
 
Настройка принтеров 
Ваш принтер подключен к USB- или 
параллельному порту. Некоторые принтеры 
могут быть подключены к любому типу порта. 
BERNINA Embroidery Software  использует 
выбираемый по умолчанию принтер, 
назначенный в парке Printer (Принтер) в Панели 
управления Windows. Руководствуйтесь 
инструкцией по принтеру, чтобы обеспечить 
правильную настройку. Воспользуйтесь 
Справкой Windows (Пуск > Справка > Указатель, 
затем выберите Принтер по умолчанию), чтобы 
получить указания по установке принтера по 
умолчанию. 
 
Настройка сканеров 
 
Используйте команду Scanner Setup (меню 
Settings) для установки сканера. 
BERNINA Embroidery Softwar поддерживает 
сканеры, совместимые с протоколом TWAIN. 
 
Примечание: Некоторые сканеры не могут 
работать с BERNINA Embroidery Software , так 
как им требуется собственное программное 
обеспечение. В таком случае для сканирования 
используйте программу сканера, сохраните 
изображение на жестком диске и затем загрузите 
изображение в программу BERNINA Embroidery 
Software. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Как настраивать сканеры 
1 Подсоедините сканер, руководствуясь 
прилагаемой инструкцией. 
2 Установите сканер в системе Windows, 

руководствуясь прилагаемой инструкцией 
и/или документацией по Microsoft Windows. 

3 Запустите BERNINA Embroidery Software . 
4 Выберите Settings (Настройки) > Scanner 
Setup (Настройка сканера). 
 Откроется диалоговое окно Select Source 

(Выбор источника) со списком драйверов 
сканеров, загруженных в вашем компьютере. 

 
 
Выберите драйвер  
сканера 
 
 
5 Выберите драйвер сканера, затем нажмите 
Select. 
 

Примечание: Если возникнут проблемы со 
сканированием после перезапуска BERNINA 
Embroidery Software , то речь может идти о 
конфликте с ранее установленными 
драйверами сканера. Переустановите 
BERNINA Embroidery Software  и испытайте 
повторно сканер. Если выбранный драйвер 
сканер не работает в BERNINA Embroidery 
Software, выберите из списка другой драйвер 
сканера. Для каждого сканера обычно 
установлено два драйвера.  

Калибровка монитора 
 
Используйте команду Display Setup (меню 
Settings) для калибровки монитора.  
 
Вам потребуется откалибровать монитор, так 
чтобы проект отображался в масштабе 1:1 в 
натуральную величину. Это необходимо в том 
случае, когда вы впервые устанавливаете 
BERNINA Embroidery Software  или по какой-либо 
причине меняете монитор.  
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Как калибровать монитор 
1 Выберите Settings (Настройки) > Scanner 
Setup (Настройка монитора). 
 Откроется диалоговое окно Screen Calibration 
(Калибровка экрана). 
 
           

Измеренная ширина 
 
2 Измерьте высоту и ширину диалогового окна. 
3 Введите измеренные значения в поля Width 
(Ширина) и Height (Вымота). 
4 Нажмите кнопку ОК. 

Настройка опций сетки 
 
 Щелкните правой кнопкой мыши по 
кнопке Show Grid (панель General) для 
установки базисной точки сетки и 
интервала. 

 
Вы можете включить или выключить показ сетки, 
изменить интервал сетки или установить 
базисную точку. Вы можете также включить или 
выключить опцию Snap to Grid (Выровнять по 
сетке) в диалоговом окне Options.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Выровняйте сетку со специфичной точкой в 
проекте путем установки базисной точки, 
например, если вы хотите, чтобы линии сетки 
пересекали центральную точку проекта или 
чтобы горизонтальная линия сетки находилась 
под определенным объектом. 
Используйте опцию Snap to Grid для 
выравнивания объектов вашего проекта по 
ближайшей линии сетки.  Вы можете выровнять 
объект по горизонтальной (X) или вертикальной 
(Y) оси или по обеим осям. Новые базисные 
точки будут совпадать с ближайшей линией 
сетки во время оцифровывания. Существующие 
объекты будут выровнены по сетке, когда вы 
выбираете и перемещаете их. 
 
Как настраивать опции сетки 
1 Щелкните правой кнопкой мыши по значку 
Show Grid (Показать сетку). 
 Откроется диалоговое окно Options (Опции) с 
открытой закладкой Grid (Сетка). 
 
 

Выберите для  
отображения 

сетки 
 

Выберите для 
выравнивания 
сетки по точке 

 
Введите 

горизонтальный  
и вертикальный 

интервалы 
Выберите  

"Выровнять по 
сетке" 

 
2 Проставьте флажок в окошке Show Grid, 
чтобы отобразить сетку. 

Измеренная  
высота 
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3 Проставьте флажок в окошко Set Reference 
Point (Установить базисную точку). 
 

Например, вы можете установить базисную 
точку сетки в центре проекта. Это более 
простая и быстрая операция, чем 
перемещение всего проекта. 

4 Введите значения интервала сетки (Grid 
Spacing) для горизонтальных и вертикальных 
линий. 
5 Проставьте флажок в окошке Snap to Grid 
(Выровнять по сетке). 

Совет: Для временной отмены опции Snap to 
Grid во время оцифровывания удерживайте 
нажатой клавишу Alt. 

6 Нажмите кнопку ОК. 
Если вы выбрали опцию Set Reference Point, 
наметьте базисную точку на вашем проекте. 
Сетка будет выровнена, так что 
горизонтальные и вертикальные линии сетки 
пересекались в этой точке. 

 
Настройка опций 
автоматической прокрутки 
 
При выполнение оцифровки, вы можете 
использовать функцию Auto Scroll для 
автоматического перемещения изображения 
проекта («прокрутка»). Это может быть более 
удобным, чем использование функций 
панорамирования или полос прокрутки. 
 
Для настройки опций автоматической 
прокрутки: 
1 Выберите позиции меню  Settings > Options и 
далее закладку Auto Scroll. 
 

 
 
2 Поставьте галочку в окошко метки Auto Scroll. 
 
3 Поставьте галочку в окошко метки Move 
Pointer After Scroll. Позиция пойнтера после 
каждого смещения изображения тоже будет 
смещаться. 
 
4 Укажите требуемое число в поле Autoscroll 
Response. Чем меньше число – тем выше 
скорость «прокрутки». 
 
 
 
 

 
 
5 Выберите положение пойнтера после сдвига из 
списка Move Input Point To: 
 
 
Option 
Положение 

Purpose 
Когда использовать 

В центре Пойнтер помещается в центре 
окна. Эту опцию удобно 
использовать при больших 
перемещениях. 
 

На пол-
пути 

Пойнтер помещается на пол-пути 
между его текущим положением и 
центром окна. 
Эту опцию удобно использовать 
при небольших перемещениях – 
например при масштабировании 
для работы с маленькой областью 
образца. 
 

В углу Пойнтер помещается на краю 
экрана. Эту опцию удобно 
использовать при медленном 
перемещении. 
 

 
 
6 Нажмите OK. 
Настройки будут применены только тогда, когда 
вы начнете выполнять оцифровку.  Экран 
проекта Design Window автоматически 
смещается в след за текущим положением 
курсора. 
 
Подсказка: Удерживая в нажатом положении 
клавишу Shift, можно временно отключить 
функцию Auto Scroll. 
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Настройка опций пялец 
 

Щелкните правой кнопкой мыши 
инструмент Show Hoop (панель General) 
для изменения настроек пялец. 

 
Имеется определенный диапазон размеров 
подбора к размеру проекта, а также к числу 
вышивальных машин. Рекомендуется выбирать 
наименьший размер пялец, который будет 
соответствовать размеру проекта. Благодаря 
этому ткань в время вышивания будет 
оставаться плотно натянутой. 
       

      
 
Как настраивать опции пялец 
 
1 Щелкните правой кнопкой мыши по значку 

Show Hoop (Показать пяльцы). 
       Появится диалоговое окно Options с  
       открытой закладкой Hoop (Пяльцы).  
       

 
 

Совет: Для скрытия пялец уберите флажок 
из окошка Display Hoops (Показать пяльцы). 
 

2 Выберите пяльцы из списка Hoop. 
3 Выберите положение пялец на панели  
      Position. 

Подробнее см. в разделе Настройка 
центра пялец. 
 

4 Нажмите кнопку New Hoop (Новые  
     пяльцы) для создания собственных пялец. 

Подробнее см. в разделе Создание 
собственных пялец. 

 
5 Нажмите кнопку Edit Hoop (Изменить   
     пяльцы) для изменения существующих  
      пялец. 

Подробнее см. в разделе Редактирование 
собственных пялец. 
 

6 Нажмите кнопку Delete Hoop (Удалить  
     пяльцы) для удаления существующих  
      пялец. 

Подробнее см. в разделе Удаление пялец. 
 

7 Нажмите кнопку ОК. 
 
 
 
Настройка опций 
автоаппликации 
 
Выберите команду Options (меню Settings) для 
настройки опций автоаппликации.   
 
 
Используйте функцию Auto Applique для 
создания всех вышивок, которые требуются для 
замкнутого объекта аппликации. Опции, 
определяющие одинарные или сложные 
контуры, а также положение выхода пялец, 
настраиваются в диалоговом окне Options. См. 
также раздел Создание замкнутого объекта 
аппликации. 
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Как настроить опции автоаппликации 
1  Выберите Settings > Options и затем 

закладку Applique. 
 
 На этой вкладке имеются две панели – 

Boundaries и Frame Out. 

 
2  Выберите требуемую опцию 
Boundaries (Контуры): 
 

• Одинарный (Single): 
Используется, если создается 
одиночный замкнутый объект 
аппликации. 

• Сложный (Multiple): 
Используется, если создается 
несколько замкнутых объектов 
аппликации. 

 
3  Выберите требуемый способ вывода 
пялец (Frame Out) 

• Автоматический (Automatic): 
При выборе этой опции 
положение вывода пялец 
назначается автоматически. 

• Ручной (Manual): При выборе 
этой опции положение вывода 
пялец маркируется как часть 
процесса оцифровывания. 

• Положение под 
покрывающими стежками 
(Place Under Cover Stitches): 
Если выбрана эта опция, 
положение вывода пялец 
определяется местом 
последнего прокола иглы перед 
тем, как произойдет выход 
пялец. 

 
4  Щелкните по OK. 
 
Настройка опций удаления 
перекрытий 
 
Выберите команду Options (меню Settings) 
для настройки опций удаления перекрытий.   
 
 
 
 
 
 

Используйте функцию Remove Overlaps 
для удаления подстилающих слоев 
вышивки. Благодаря этому сокращается 
количество стежков и предотвращается 
скопление ненужных вышивальных 
стежков.  См. также раздел Удаление 
подстилающих стежков. 
 
Как настраивать опции удаления 
подстилающих стежков 
1  Выберите Settings > Options и затем 

закладку Remove Overlaps. 
 
 Появится диалоговое окно Options> 

Remove Overlaps.   

 
 
2  В поле Cutting Overlap введите 

требуемое значение перекрытия. 
 

 
Перекрытие 0,5 мм Перекрытие 
1,5 мм 
 
3  Нажмите кнопку OK. 
 
Настройка общих опций 
 
BERNINA Embroidery Software позволяет 
настраивать различные общие установки, 
управляющие автосохранением проектов, 
определения положения указателя мыши на 
экране, а также отображением единиц 
измерения. 
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Установка функции автоматического 
сохранения 
 
Выберите Options (меню Settings) для установки 
опций автосохранения и создания резервных 
копий. 
Сохраняйте свою работу автоматически с 
регулярными интервалами, используя функцию 
Auto Save (Автосохранение) для защиты от 
потери при сбое аппаратных или программных 
средств.  
Резервная копия файла создается каждый раз 
при сохранении проекта. Проект сохраняется в 
папке BACKUP программы BERNINA Embroidery 
Software. Копия имеет то же имя, что и 
оригинальный файл, но с расширением BAK. 
 
Внимание: Резервные копии файлов остаются в 
папке BACKUP до тех пор, пока вы не удалите 
их. Чтобы эта папка не занимала слишком много 
места на жестком диске, регулярно удаляйте 
ставшие не нужными резервные файлы. 
 
Как установить опцию автосохранения 
1 Выберите закладку Settings > Options > 
General. 
 

 
2 Проставьте флажок в окошке Save Design 
(Сохранять проект) 
3 Введите в поле Auto Save Period интервал 

автосохранения в минутах. 
4 Нажмите кнопку ОК. 
 
Интерпретация положения указателя 
мыши 
Значения X и Y показывают горизонтальное (X: 
horizontal) и вертикальное (Y: vertical) расстояние 
указателя от относительной или абсолютной 
отметки. Значение L – это длина линии, 
соединяющей указатель с предыдущей точкой, а 
A – это угол наклона этой линии по отношению к 
горизонтали. 
 
 

 
 
Отрицательное значение величины X означает, 
что вторая точка расположена слева от первой 
точки, в том время как отрицательное значение 
величины Y означает, что вторая точка 
находится ниже первой. Отрицательные 
значения углов означают, что угол больше 180°, 
например, угол -60° равен углу 300°.  
 

      
 
Совет: Вы можете измерять расстояния на 
экране, пользуясь величинами в статусной 
строке. Подробнее см. в разделе  
Измерение расстояний на экране. 
 
 
Настройка опций отображения 
положения указателя мыши 
 
Выберите команду Options (меню Settings) для 
установки опций отображения положения 
указателя мыши.  
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Когда вы перемещаете мышь, положение 
указателя отображается в статусной строке в 
нижней части экрана. Вы можете факультативно 
отображать положение указателя относительно 
последней оцифрованной точки или точки 
стежка или как абсолютное значение от первой 
точки укола иглой в проекте. 
 
Как настраивать опции отображения 
положения указателя мыши 
1 Выберите закладку Settings > Options > 
General. 
 

 
 
2 Выберите Relative (Относительную) или 
Absolute (Абсолютную) установку указателя.  

◄ Relative: показывается положение 
указателя относительно последней 
оцифрованной точки или точки стежка. 
Полезно во время оцифровывания или 
редактирования стежков. 

◄ Absolute: показывается положение 
указателя в абсолютных единицах от 
первой точки укола иглой в проекте. 
Полезно для проверки соответствия 
проекта имеющейся площади.  

3 Нажмите кнопку ОК. 
 
 
Установка других общих опций 
Вкладка Special > Options > General дает 
возможность активировать следующие функции: 

• Функцию Closest Join во время 
оцифровывания 

• Отображение всплывающей подсказки 
при использовании команды Measure  

• Скрытие свойств объекта 
• Группировка проектов при открытии и 

вставке 
 
Как устанавливать другие общие опции 
 
1  Выберите закладку Settings > Options > 
General. 
 

 
2  Выберите одну или несколько этих опций: 

• Apply Closest Join while digitizing 
(Применение Closest Join во время 
оцифровывания): Функция Closest 
Join (по умолчанию) автоматически 
рассчитывает замкнутое соединение 
между объектами во время 

оцифровывания. Если эта функция 
деактивирована, все вновь 
оцифровываемые объекты соединяются 
методом As Digitized. Подробнее см. в 
разделе Оцифровывание замкнутых 
контуров. 

 
    

 
 

• Show Measure Tooltip (Показывать 
всплывающую подсказку 
измерений):. во всплывающей 
подсказке показывается во время 
измерений на экране показывается 
длина и угол наклона. Подробнее см. в 
разделе  
Измерение расстояний на экране.  
 

• Hide object properties (Скрытие 
свойств объекта): Выбор этой функции 
означает автоматическое закрытия окна 
Object Properties при открытии 
диалогового окна Effects и наоборот. 
Подробнее см. в разделе Доступ к 
свойствам объекта. 
 

• Group Designs on Open and Insert 
(Группировка проектов при открытии 
и вставке): При выборе этой опции 
проект автоматически группируется при 
первом открытии или вставке в другой 
проект. Благодаря этому облегчается 
перетаскивание в нужное положение без 
опасения случайной отмены выделения.  
Это особенно удобно при работе с 
проектами, расположенными справа или 
сверху существующих элементов 
проекта. Подробнее см. в разделе  
Работа с файлами проектов. 

 
3   Для подтверждения щелкните по кнопке ОК. 
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ЧАСТЬ II 
 

ОСНОВНЫЕ ТЕХНИКИ 
ОЦИФРОВЫВАНИЯ 

------------------------------------------ 
 

 
 

Основные техники оцифровывания 
 
В BERNINA Embroidery Software вы составляете проекты из базовых форм, или 
"вышивальных объектов". Наподобие рисованных объектов, вышивальные объекты 
обладают определенными характеристиками, или "свойствами", такими как цвет, 
размеры, положение и т.п. Они обладают также специфичными для вышивок 
свойствами, такими как тип и плотность стежков. 
 

Оконтуривающие и заполняющие стежки 
 
В этом разделе поясняется, как выбирать основные типы оконтуривающих и 
заполняющих стежков, а также изменять настройки стежков для получения наилучших 
результатов.Основными рассматриваемыми здесь оконтуривающими стежками 
являются одинарные и тройные, гладьевый и краеобметочный. Основные 
заполняющие стежки - это гладьевый и простегивающий стежки. Подробнее см. раздел 
Оконтуривающие и заполняющие стежки 
 

Методы оцифровывания 

В этом разделе описывается, как оцифровывать объекты основными способами 
оцифровывания. Кроме того, объясняется, как подогнать настройки оцифровывания 
для получения лучших результатов. Подробнее см. раздел  
Методы оцифровывания. 
 
 
Цвета ниток и таблицы ниток 
 
В этом разделе описывается, как выбирать цвета из цветовой палитры. Здесь также 
поясняется, как определять свои собственные цвета ниток и таблицы. 
Подробнее см. Раздел Цвета ниток и таблицы ниток 
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Свойства объекта и шаблоны. 
 
В этом разделе поясняется, как можно изменять свойства объекта в вашем проекте, а 
также как применять, создавать и сохранять стили и шаблоны в BERNINA Embroidery 
Software. Подробнее см. в разделе Свойства объекта и шаблоны. 
 

Повышение качества вышивания 
В этом разделе рассматриваются настройки ткани, стабилизация ткани 
стабилизирующими стежками и компенсация растяжения. Кроме того, описывается 
сохранение длинных стежков, настройка закрепляющих стежков и установка 
начальных и конечных точек. Подробнее см. в разделе  
Повышение качества вышивания 
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ГЛАВА 8 
 

 
ОКОНТУРИВАЮЩИЕ И 

ЗАПОЛНЯЮЩИЕ СТЕЖКИ 
------------------------------------------- 
 
 

Все вышиваемые объекты BERNINA Embroidery Software 
имеют определенные настройки или "свойства". 
Некоторые свойства, такие как размер и позиция, 
являются общими для всех. Другие являются 
специфичными для данного типа объекта. Наиболее 
важным свойством является тип стежка. Каждый раз, 
когда вы создаете или модифицируете объект, стежки 
генерируются в соответствии с взаимодействующим 
типом стежка. Такие настройки, как шаг и длина стежков, 
также могут быть приспособлены к требованиям. 
 
Типы стежков подразделяются на два больших типа – 
"Оконтуривание" и "Заполнение".  
Оконтуривающие стежки, как следует из их названия, 
служат для оконтуривания или обрамления и для 
прорисовки деталей. Заполняющие стежки применяются 
для заполнения крупных форм и "цветных блоков" 
проекта. Типы оконтуривающих и заполняющих стежков 
определяются во время создания вышивальных форм, 
но вы можете изменять их на любой стадии. 
 
BERNINA Embroidery Software предоставляет разнообразные методы оцифровывания 
или "инструменты" для создания объектов вышивки. Для создания вышивальных 
объектов эти инструменты применяются совместно с различными типами стежков. 
 
В этом разделе поясняется, как выбирать основные типы оконтуривающих и 
заполняющих стежков, а также изменять настройки стежков для получения наилучших 
результатов. 
Основными рассматриваемыми здесь оконтуривающими стежками являются 
одинарные и тройные, гладьевый и краеобметочный. Основные заполняющие стежки - 
это гладьевый и простегивающий стежки. См. также раздел Указания для опытных 
пользователей. 

 

Выбор или изменение стежков 
 
BERNINA Embroidery Software 
предоставляет вам несколько основных 
типов оконтуривающих и заполняющих 
стежков. Для специального использования 
предназначены "художественные" стежки и 
стежки, имитирующие ручное вышивание.  

При создании объекта всегда используется 
последний из выбранных типов стежка. Вы 
можете изменить его на любой стадии. 
 
Совет: Задавайте значения стежка путем 
изменения текущих свойств в диалоговом окне 
Object Properties (Свойства объекта) перед 
началом оцифровывания. Подробнее см. в 
разделе  
Свойства объекта и шаблоны. 
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Выбор оконтуривающих стежков 
 
 

Щелкните по Outline (панель 
Stitch & Color) для выбора 
оконтуривающих стежков. 
 
Используйте Single для тонких 
контурных линий. 
 
Используйте Triple для толстых 
контурных линий. 
 
Используйте Satin для 
добавления толстой контурной 

                             линии к большим формам. 
 
Используйте Blanket для создания эффекта 
"гребенки" в длинных узких валиках.  
 
BERNINA Embroidery Software  предлагает 
основные одинарные, тройные, гладьевые и 
краеобметочные оконтуривающие стежки, а 
также возможности оконтуривания узорными и 
"рукодельными" стежками. Вы можете изменить 
их на любой стадии.  
 
 
 
 
 
 
 
Как выбрать оконтуривающий стежок 
1  При выделенном или не выделенном объекте 

щелкните по значку Outline, чтобы открыть 
выпадающее меню. 

 

 
2  Из открывшегося списка выберите тип 

стежка. Выбранный тип стежка будет 
применен к выбранному объекту или 
объектам. Будут использованы текущие 
настройки. 

 
Совет: Используйте стебельчатый стежок 
(Stemstitch) и стежок "назад в иголку" 
(Backstitch) для получения декоративного 
контура. Можно использовать также 
оконтуривание цепочкой узоров (Pattern Run). 
Подробнее см. в разделах Оконтуривание и 
заполнение рукодельными стежками. и 
Узорные штампы, контуры и заполнения. 
 
 
 
 
 
 
 
 
 
 

Выбор заполняющих стежков 
 
Щелкните по Fill (панель Stitch & Color) 
для выбора заполняющих стежков. 

 
Используйте Satin для узких 
колонок и форм. 
 
Используйте Step для 
заполнения крупных форм  

                            с нерегулярными контурами. 
 
BERNINA Embroidery Software предлагает 
основные гладьевые и простегивающие 
заполняющие стежки, а также орнаментные, 
узорные и рукодельные заполняющие стежки. 
Вы можете изменить их на любой стадии.  
 
 
 
 
 
 
 
 

Как выбрать заполняющий стежок 
1  При выделенном или не выделенном объекте 
щелкните по значку Fill, чтобы открыть 
выпадающее меню. 
 

 
 
2  Из открывшегося списка выберите тип 

стежка. Выбранный тип стежка будет 
применен к выбранному объекту или 
объектам. Будут использованы текущие 
настройки. 

 
Совет: Используйте оконтуривающие стежки 
Fancy, Pattern и Craft Stitch для получения более 
выраженных эффектов. Подробнее см. в 
разделах Эффекты художественных 
стежков, Оконтуривание и заполнение 
узорами и Оконтуривание и заполнение 
рукодельными стежками. 

Выберите 
оконтуривающий 
стежок 

Выберите 
заполняющий 
стежок 
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Создание контуров одинарным 
и тройным стежком 
 
Используйте инструменты Single (Одинарный 
контур)  и Triple (Тройной контур) для 
оцифровывания линий одинарными или 
тройными стежками. Инструмент Single 
располагает вдоль оцифровываемой линии 
одинарный ряд стежков. Инструмент Triple 
повторяет каждый стежок три  раза для создания 
более толстой линии.  Эти инструменты обычно 
используются для добавления обрамления к 
проекту. 
 
                  Длина стежка  

 
Примечание: Вы не сможете увидеть на экране 
различие между одинарным и тройным 
оконтуривающим стежком, так как 
дополнительные стежки перекрывают друг 
друга. Чтобы проверить, вышивается ли объект 
тройным стежком, нужно обойти объект по 
стежкам. Подробнее см. в разделе Обход по 
стежкам. 
 
Создавать контуры одинарным и 
тройным оконтуривающим стежком 
 

Щелкните по Outline (панель Stitch 
& Color) для выбора 
оконтуривающих стежков. 

 
Используйте инструменты Single (Одинарный 
контур)  и Triple (Тройной контур) для 
оцифровывания линий одинарными или 
тройными стежками. Щелчками левой и 
правой кнопкой мыши создаются базисные 
точки – соответственно угловые точки и 
точки кривой. 
 
Как создавать контуры одинарным и 
тройным оконтуривающим стежком 
 
1  Щелкните по значку Outline и выберите 

из выпадающего меню Single или Triple 

 

 
Примечание: Контур создается с 
принятыми по умолчанию настройками 
одинарных или тройных стежков. Длину 
стежка можно выбрать до или после 
оцифровки. Подробнее см. в разделе 
Настройка длины одинарных или 
тройных стежков. 
 
2  Выберите инструмент оцифровки и 

оцифруйте открытую или закрытую 
форму. Подробнее см. в разделе  
Методы оцифровывания.  

 
 
 
 

Примечание: Инструмент Block Digitizing 
(Оцифровывание блока) для 
оконтуривания использовать нельзя. 
 
 
Настройка длины одинарных или 
тройных стежков 

 
Щелкните по Object Properties 
(панель General), чтобы выбрать 
настройки стежков. 

 
Вы можете изменить длину стежка в 
диалоговом окне Object Properties до или 
после оцифровки. 

Выберите Triple 
или Single   
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Как для одинарных, так и для тройных стежков 
длина стежка устанавливается для 
приспособления к оцифровываемой форме. 
Если в объекте имеются кривые малого радиуса, 
выбирайте небольшую длину стежка. Для 
сокращения количества стежков на пологих 
кривых увеличивайте длину стежка. 

 
слишком мало стежков        стежки располагаются  
для воспроизведения кривой   на кривой более 
                                                           плотно 
 
Как настроить длину одинарных или тройных 
стежков 
 

1  Щелкните дважды или щелкните правой 
кнопкой по объекту с оконтуриванием 
одинарным или тройным стежком. 

 Откроется закладка Outline Stitch > Single or 
Triple диалогового окна Object Properties 
(Свойства объекта). 
 
 
 
 

 
Выберите  
Single или 

Triple 
Введите 
длину  
стежка 

 
 

Совет: Вы можете предварительно, до 
оцифровки выбрать настройки стежков. 
Щелкните по значку Object Properties, чтобы в 
любое время открыть диалоговое окно.  
 

2  Выберите Single или Triple из списка Stitch 
Type, чтобы при необходимости изменить тип 
стежка. 

 

3  В поле Stitch Length введите длину стежка. 
 При малом радиусе кривой уменьшите длину 

стежка, например до 1,8 мм, чтобы стежки 
плотнее располагались на кривой. 

 

Совет: Вы можете имитировать ручную вышивку 
одинарными или тройными оконтуривающими 
стежками, установив длину стежка на 4,0 мм. См. 
также раздел Оконтуривание и заполнение 
рукодельными стежками. 
 

4  Щелкните по Apply (Применить) 

 

Создание контуров стежком 
гладьевого валика 
Гладьевый стежок (Satin stitch) может быть 
использован для оконтуривания или заполнения. 
Он хорошо подходит для вышивания узких 
гладьевых валиков и форм, когда длина каждого 
стежка соответствует ширине валика или 
формы. Отрегулируйте плотность стежков, 
назначив фиксированный шаг стежков, или 
выберите инструмент Auto Spacing 
(Автоматический шаг), который будет 
рассчитывать требуемый интервал между 
стежками. 
 
 

    
    
    
    
  
           
 
 

Щелкните по Outline (панель Stitch 
& Color) для выбора 
оконтуривающих стежков. 

 

Как создать контур гладьевым стежком 
1  Щелкните по значку Outline и выберите  

Satin.  

 
 
Примечание: Контур создается с принятыми по 
умолчанию настройками гладьевого стежка. Шаг 
и длина стежка могут быть выбраны до или 
после оцифровки. Подробнее см. в разделе  
Подгонка стежка гладьевого валика по шагу 
и ширине. 
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2  Выберите инструмент оцифровки и 

оцифруйте открытую или закрытую форму. 
Подробнее см. в разделе Методы 
оцифровывания.  

 
Примечание: Инструмент Block Digitizing 
(Оцифровывание блока) для 
оконтуривания использовать нельзя. 
 
 
Подгонка стежка гладьевого валика по 
шагу и ширине. 
 

Щелкните по Object Properties 
(панель General), чтобы установить 
длину и шаг стежков. 

 
Шаг стежка – это расстояние в 
миллиметрах между двумя точками укола 
иглы на одной и той же стороне строчки. 
При изменении настройки шага стежков 
(Stitch Spacing) изменяется плотность 
оконтуривающих гладьевых стежков. Чем 
больше шаг стежков, тем меньше из 
плотность. Чем меньше шаг стежков, тем 
выше их плотность. Длина стежка 
определяет толщину контура. См. также 
раздел  
Применение автоматического 
интервала для оконтуривания 
гладьевым стежком. 
 

 
Длина гладьевого стежка   Шаг гладьевого стежка 
 
Как подгонять стежок гладьевого валика 
по шагу и ширине 
 

1 Дважды щелкните или щелкните 
правой кнопкой мыши кнопкой мыши 
по оконтуриваемому объекту. 

 
 
 
 
 
 
 
 

 Откроется закладка Outline Stitch  
    (Оконтуривающий стежок) диалоговое  
     окна Object Properties (Свойства  
     объекта) – Satin  
 
 
 
 

 
 
 

Выберите 
Manual,  
чтобы 

изменить шаг  
стежков 

 
Введите значения 

шага  
стежка и 
ширины 
строчки 

 
 
Совет: Вы можете предварительно, до 
оцифровки выбрать настройки стежков. 
Щелкните по значку Object Properties, 
чтобы в любое время открыть диалоговое 
окно. 
 
2  Выберите опцию Manual (Вручную). 
 Будет активировано поле Stitch Spacing  
     (Шаг стежка). 
 
Примечание: Если выбрана опция Auto 
Spacing, то поле Stitch Spacing (Шаг стежка) 
не активно. Подробнее см. в разделе 
Применение автоматического интервала 
для оконтуривания гладьевым стежком. 
 

3  В поле Stitch Spacing (Шаг стежка) введите 
нужное значение. 

◄ Для увеличения плотности стежков 
введите меньшее значение. 

◄ Для уменьшения плотности стежков 
введите большее значение. 

 

             

 
     Шаг стежка 0,6 мм             Шаг стежка 1,0 мм 
4  В поле Satin Width (Ширина гладьевого  
     валика) введите нужную величину. 
 
5  Щелкните по Apply. (Назначить) 
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Слева гладьевый валик выполнен по центру 
Справа - со смещением 
Ромбом отмечена базисная точка 

 
Совет: При широком контуре, 
выполняемым гладьевым валиком, длина 
некоторых стежков может превышать 
возможности конкретной вышивальной 
машины. При применении функции Satin 
Special программа BERNINA Embroidery 
Software уменьшает длину гладьевых 
стежков до допустимой величины. См. 
также раздел Разбивка длинных стежков 
гладьевого заполнения. 
 
Применение автоматического интервала 
для для оконтуривания гладьевым 
стежком 

 
Щелкните по Object Properties 
(панели General), чтобы применить 
функцию Automatic Spacing. 

 
При малой ширине контура стежки 
располагаются плотно, поэтому требуется 
меньше стежков для покрытия ткани. Если 
контур очень узкий, стежки должны быть 
менее плотными, поскольку слишком 
большое количество уколов иглой может 
повредить материал.  
Инструмент Automatic Spacing 
(Автоматический интервал) 
приспосабливает шаг стежков 
соответственно ширине гладьевого валика. 
Для изменяющейся ширины объекта 
функция Automatic Spacing изменяет шаг 
стежков, чтобы обеспечить оптимальную 
плотность стежков. См. также Подгонка 
стежка гладьевого валика по шагу и 
ширине. 
 
Как применить автоматический интервал 
для гладьевого валика. 
1  Дважды или правой кнопкой мыши  
     щелкните по оконтуриваемому объекту. 
 Откроется закладка Outline Stitch 

(Оконтуривающий стежок) диалоговое 
окна Object Properties (Свойства 
объекта) – Satin 

 
 
 

Выберите  
Automatic 

 
 
 
 
 
2  Выберите Automatic. 
 
 
 
 
 

 
3  Щелкните по Apply. 

 
Включена функция Auto Spacing         
Выключена функция Auto Spacing  
 
Совет: При широком контуре, 
выполняемым гладьевым валиком, длина 
некоторых стежков может превышать 
возможности конкретной вышивальной 
машины. При применении функции Satin 
Special программа BERNINA Embroidery 
Software уменьшает длину гладьевых 
стежков до допустимой величины. См. 
также раздел Разбивка длинных стежков 
гладьевого заполнения. 
 

Настройка смещения 
оконтуривающих стежков гладьевого 
валика  
 

Щелкните по Object Properties (панель 
General), чтобы настроить смещение 
стежка. 

 
По умолчанию стежки располагаются по оси 
оцифровываемой линии. Однако вы можете 
сместить стежки от средней линии. 
 

Как настроить смещение 
оконтуривающих стежков гладьевого 
валика  
1  Дважды или правой кнопкой мыши щелкните 
по оконтуриваемому объекту. 
 Откроется закладка Outline Stitch 

(Оконтуривающий стежок) диалоговое окна 
Object 
Properties 
(Свойства 
объекта). – 
Satin  
 
 

 
Выберите Center или Offset 
 
 
 

2  Выберите опцию смещения:  Center (по 
центру) или  Offset (со смещением) 
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Выберите стежок 
Blanket  

Совет: Просмотрите, как сместятся стежки при 
выделении объекта, затем нажмите инструмент 
Reshape (Изменение формы). 
3  Щелкните по Apply. 

Создание контуров 
краеобметочным стежком 
 
Краеобметочный стежок (Blanket stitch) 
используется для создания длинных, узких 
колонок с "гребенчатым" эффектом. Он часто 
применяется для обшивки аппликаций. Игла 
протыкает обе стороны колонки, а затем 
протыкает вторую сторону еще раз, прокладывая 
продольную нитку. Краеобметочные стежки 
обычно более открыты, чем стежки гладьевого 
валика. 

 
 
Совет: Задавайте значения стежка путем 
изменения текущих свойств в диалоговом окне 
Object Properties (Свойства объекта) перед 
началом оцифровывания. Подробнее см. в 
разделе  
Свойства объекта и шаблоны. 
 
Как создавать контуры краеобметочным 
стежком 

 
Щелкните по Outline (панель Stitch 
& Color) для выбора 
оконтуривающих стежков. 

 
 
Используйте краеобметочный стежок (Blanket 
stitch) для создания длинных, узких контуров с 
"гребенчатым" эффектом. 
 
Как создать контур краеобметочным стежком 
1  Щелкните по значку Outline и выберите из 

выпадающего меню Blanket. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Примечание: Контур создается с принятыми по 
умолчанию настройками краеобметочного 
стежка. Шаг и длина стежка могут быть выбраны 
до или после оцифровки. Подробнее см. в 
разделе Подгонка краеобметочного стежка  
по шагу и ширине. 
 

2  Выберите инструмент оцифровки и 
оцифруйте открытую или закрытую форму. 
Подробнее см. в разделе  
Методы оцифровывания. 

 

 
Примечание: Когда открытая (не 
замкнутая) форма вышивается в 
направлении слева направо, декоративные 
стежки ориентированы вниз. Когда форма 
вышивается в направлении справа налево, 
декоративные стежки ориентированы вверх.  
Когда замкнутая форма вышивается по 
часовой стрелке, декоративные стежки 
ориентированы внутрь. Если же против 
часовой стрелки – то наружу. См. раздел  
Создание замкнутого объекта 
аппликации 
. 
 
 
Настройка шага краеобметочного 
стежка 

 
Щелкните по Object Properties (панель 
General), чтобы установить шаг стежков. 

 
Вы можете отрегулировать длину стежка и 
интервал между стежками (шаг стежка). 
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шаг стежка 

 
 
                    
                  

длина стежка 
 
Как настроить шаг и длину  
краеобметочного стежка 
1  Дважды или правой кнопкой мыши щелкните 
по оконтуриваемому объекту. 
 Откроется закладка Outline Stitch 
(Оконтуривающий стежок) диалогового окна 
Object Properties (Свойства объекта) – Blanket.  
 
 
 
 

Введите 
шаг  

и длину 
стежка 

 
 
Совет: Вы можете предварительно, до 
оцифровки выбрать настройки стежков. 
Щелкните по значку Object Properties, 
чтобы в любое время открыть диалоговое 
окно. 
 
2  В поле Stitch Spacing (Шаг стежка) введите 
нужное значение. 
 
Это значение соответствует расстоянию в 
миллиметрах между перпендикулярными 
стежками. 

 
Шаг: 1,0 мм    Шаг: 3,5 мм   Шаг: 2,0 мм 
 
3  В поле Blanket Width (Длина 
краеобметочного стежка) введите нужное 
значение. 

 
Длина стежка: 2,5 мм      Длина стежка: 5 мм                      
 
4  Щелкните по Apply. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Регулировка смещения 
краеобметочного стежка 
 

Щелкните по Object Properties (панель 
General), чтобы настроить смещение 
краеобметочного стежка. 
 

По умолчанию стежки располагаются по оси 
оцифровываемой линии. Однако вы можете 
сместить стежки от средней линии. 
 
1  Дважды или правой кнопкой мыши щелкните 
по оконтуриваемому объекту. 
 
 Откроется закладка Outline Stitch  

(Оконтуривающий стежок) диалогового окна 
Object Properties (Свойства объекта). 

 
Выберите Center или 

Offset   
 
 
2  Выберите опцию смещения:  

◄ Center (по центру) 
◄ Offset (со смещением) 

 
Совет: Просмотрите, как сместятся стежки 
при выделении объекта, затем нажмите 
инструмент Reshape (Изменение формы). 

 
3  Щелкните по Apply. 
 
Создание заполнения 
гладьевым стежком 
 
Гладьевый заполняющий стежок хорошо 
подходит для вышивания узких гладьевых 
валиков и форм, когда длина каждого стежка 
соответствует ширине валика или формы. 
Гладьевые стежки почти параллельны, причем 
каждый второй стежок имеет небольшой наклон. 
Поскольку, как правило, уколы иглой не 
прерывают заполнение, гладьевые 
заполняющие стежки создают 
высококачественный глянцевитый эффект.  
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Совет: Если форма слишком широка, стежки 
могут быть рыхлыми и не обеспечить должное 
покрытие материала. Если нужно увеличить 
размер проекта, используйте функцию Satin 
Special. Благодаря этому длина стежка будет 
увеличиваться автоматически при увеличении 
проекта. 
 

Создание заполнения гладьевым 
стежком 

Щелкните по Fill (панель Stitch & Color) 
для выбора заполняющих стежков. 
 

 

Для создания узких контуров и форм 
используйте гладьевый заполняющий стежок 
 

Как создать заполнение гладьевым стежком 
1  Щелкните по значку Fill и выберите из 

выпадающего меню Satin. 
 

 
 
Примечание: Объект заполнения создается с 
принятыми по умолчанию настройками 
заполняющего гладьевого стежка. Шаг стежка 
можно выбрать до или после оцифровки. 
Подробнее см. в разделе  
Регулировка шага гладьевого 
заполняющего стежка. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2  Выберите инструмент оцифровки и 
оцифруйте закрытую форму. Подробнее см. в 
разделе Методы оцифровывания. 

 
 
 

Примечание: Инструмент Open Object 
(Открытый объект) для заполнения 
использовать нельзя. Подробнее см. в разделе 
Инструментальные средства 
оцифровывания. 
 
 

Регулировка шага гладьевого 
заполняющего стежка 
 

Щелкните по Object Properties (панель 
General), чтобы установить шаг 
гладьевых стежков. 

 
Шаг стежка – это расстояние в миллиметрах 
между двумя точками укола иглы на одной и той 
же стороне колонки. При малой ширине колонки 
стежки располагаются плотно, поэтому 
требуется меньше стежков для покрытия ткани. 
Если колонка очень узкая, стежки должны быть 
менее плотными, поскольку слишком большое 
количество уколов иглой может повредить 
материал. См. также  
Сохранение длинных стежков функцией 
Auto Jump. 
 

 Шаг 
гладьевого 
стежка  

 
 
 
Ширина 

 
 
Изменение плотности стежков гладьевого 
заполнения производится путем установки шага 
стежка в диалоговом окне Object Properties. Чем 
больше интервал, тем меньше плотность 
стежков. Чем меньше интервал, тем выше 
плотность стежков.  

Выберите  
стежок Satin
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Как регулировать шаг гладьевого 
заполняющего стежка 
1  Дважды или правой кнопкой мыши щелкните 
по заполняемому объекту. 
 Откроется закладка Outline Stitch 

(Заполняющий стежок) – Satin  диалогового 
окна Object Properties (Свойства объекта). 

 
 
 
 
 
 
 

Выберите  
 «Manual“ 

 
 
Совет: Вы можете предварительно, до 
оцифровки выбрать настройки стежков. 
Щелкните по значку Object Properties, чтобы 
в любое время открыть диалоговое окно. 
 
2  Выберите опцию Manual (Вручную). 
3  Введите в поле Stitch Spacing требуемый шаг 
стежка. 

◄ Для увеличения плотности стежков 
введите меньшее значение. 

◄ Для уменьшения плотности стежков 
введите большее значение. 

      
        Шаг стежка 1,0 мм     Шаг стежка 1,8 мм 
 
4  Щелкните по Apply (Назначить). 
 

 
Применение автоматического 
интервала для гладьевого 
заполнения 
 

Щелкните по Object Properties (панель 
General), чтобы установить 
автоматический интервал для гладьевых 
стежков. 

 
Функция автоматического интервала регулирует 
шаг гладьевых стежков в соответствии с 
шириной колонки. См. также Сохранение 
длинных стежков функцией Auto Jump. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Как применить автоматический интервал 
для гладьевого заполнения 
1  Дважды или правой кнопкой мыши щелкните 
по заполняемому объекту. 
 Откроется закладка Outline Stitch 

(Заполняющий стежок)- Satin  диалогового 
окна Object Properties (Свойства объекта). 

 
 
 
 
 
 

 
 

Выберите  
Automatic 

 
 
 

 
2  Выберите Automatic. 
 

Автоматический 
интервал 
 

Ручной выбор интервала 
 

        
Различный интервал 
в зависимости от 
формы объекта 

Интервал остается 
одинаковым для всего 
объекта 

 

3  Щелкните по Apply (Назначить). 
 

Разбивка длинных стежков гладьевого 
заполнения. 
При широкой форме, заполняемой гладьевым 
стежком, длина некоторых стежков может 
превышать возможности конкретной 
вышивальной машины. При применении 
функции Satin Special программа BERNINA 
Embroidery Software уменьшает длину гладьевых 
стежков до допустимой величины. Кроме того, 
проколы иглой распределяются в произвольном 
порядке, так что они не образуют линии в 
середине формы. 
 

 

В то время как стежок Satin Special используется 
главным образом для предотвращения 
формирования слишком длинных стежков в 
широких формах, он может также 
использоваться как альтернатива заполнения 
простегивающим стежком. Стежки Satin Special 
выглядят в большей мере "атласными" и хорошо 
подходят для образования мягких линий и 
меньшей глубины заполнения. Заполнение 
простегивающим стежком, напротив, является 
плоским и может создавать неожиданные узоры 
с кривыми малого радиуса. См. также раздел 
Сохранение длинных стежков. 
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Как разбивать длинные стежки гладьевого 
заполнения. 
 
1  Дважды левой или один раз правой кнопкой  
      мыши щелкните по заполняемому объекту. 
 Откроется закладка Fill  Stitch - Satin  

диалогового окна Object Properties (Свойства 
объекта). 

 
 
 
 

 
Выберите  

„Satin special“ 
 
 
2  Выберите Satin Special. 

 
Функция Satin Special   Функция Satin Special  
Включена      выключена 
 
 
3  Щелкните по Apply (Назначить). 

 

Создание заполнения 
простегивающим стежком 
 
Различные типы стежков подходят для 
различных форм. BERNINA Embroidery Software 
предлагает основные гладьевые и 
простегивающие заполняющие стежки, а также 
орнаментные и рукодельные заполняющие 
стежки. Эти стежки доступны из панели 
инструментов Stitch & Color (Стежок и Цвет). 
Имеется также выделенная для этого панель 
Craft Stitch (Рукодельные стежки). 

            
Заполнение простегивающими стежками состоит 
из рядов прямых стежков, подходящих для 
заполнения больших объектов нерегулярной 
формы. Стежки располагаются в обратном и 
прямом направлениях поперек заполняемой 
формы. Заполнение может быть однородным 
или узорчатым. Вы можете сделать выбор из 
различных образцов. Вы можете также 
регулировать шаг и длину стежков. 
 
 

 
 
 
Примечание: С заполняющими 
простегивающими стежками вы можете 
выбирать узоры, образуемые уколами иглы. По 
умолчанию предлагается узор (№ 1), 
предназначенный для создания плоской и 
гладкой текстуры, сходной с поверхностью 
шерстяной ткани. См. также раздел Применение 
узоров простегивающих стежков. 
 
Создание заполнения простегивающими 
стежками 

Щелкните по Fill (панель Stitch & Color) 
для выбора заполняющих стежков. 
 

 
Используйте тип стежка Step (Простегивающий 
стежок) для создания крупных и/или 
неправильной формы фигур.  
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Как создать заполнение простегивающим 
стежком 
1  Щелкните по значку Fill и выберите из 

выпадающего меню Step. 
 

 
 
 
Примечание: Объект заполнения создается с 
принятыми по умолчанию настройками 
заполняющего простегивающего стежка. Шаг и 
длина стежка могут быть выбраны до или после 
оцифровки. Подробнее см. в разделе 
Регулировка шага и длины 
простегивающего заполняющего стежка. 
 
2  Выберите инструмент оцифровки и 

оцифруйте закрытую форму. Подробнее см. в 
разделе Методы оцифровывания.  

 
 
 
 
 
 
 
 

Примечание: Инструмент Open Object 
(Открытый объект) для заполнения 
использовать нельзя. Подробнее см. в разделе 
Инструментальные средства 
оцифровывания. 
 
Регулировка шага простегивающего 
заполняющего стежка 
 

Щелкните по Object Properties (панель 
General), чтобы установить шаг 
заполняющих стежков. 

 
Для простегивающих стежков плотность 
определяется расстоянием между рядами 
стежков.  
 
 
 
 
 
 
 

 
Настройка интервала – это расстояние между 
двумя передними рядами. См. также 
Сохранение длинных стежков функцией 
Auto Jump. 
 
   шаг стежка 
    
 

длина 
стежка 

вперед 
 
назад 
 
Вы можете также назначить длину 
заполняющего простегивающего стежка. Она 
незначительно изменяется, благодаря чему на 
краях фигуры не образуются мелкие стежки. 
 
Как регулировать шаг и длину 
простегивающего заполняющего стежка 
 
1  Дважды или правой кнопкой мыши щелкните 
по заполняемому объекту. 
 Откроется закладка Fill Stitch – Step  
диалогового окна Object Properties (Свойства 
объекта). 
 
 
 
 
 

 
Введите 

шаг и 
длину 
стежка 

 
 
Совет: Вы можете предварительно, до 
оцифровки выбрать настройки стежков. 
Щелкните по значку Object Properties, чтобы в 
любое время открыть диалоговое окно. 
 
2  В поле Stitch Spacing (Шаг стежка) введите 
новое нужное значение. 
 Это значение соответствует расстоянию 
между каждым передним рядом стежков. 

◄ Для увеличения плотности стежков 
введите меньшее значение. 

◄ Для увеличения плотности стежков 
введите меньшее значение. 

           
Шаг стежка: 1,2 мм   Шаг стежка: 0,7 мм 
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3  В поле Stitch Length (Длина стежка), введите 

требуемое вам значение. 
 
         

 
Длина стежка: 5,0 мм    Длина стежка: 2,0 мм 
 
4  Щелкните по Apply (Назначить). 
 
 
Выбор узоров простегивающих 
стежков 
 
 

Щелкните по Object Properties (панели 
General), чтобы выбрать узор 
простегивающего стежка. 

 
 
С заполняющими простегивающими стежками 
вы можете выбирать узоры, образуемые 
уколами иглы. По умолчанию предлагается узор 
(№ 1), предназначенный для создания плоской и 
гладкой текстуры, сходной с поверхностью 
шерстяной ткани. 
       

 
Имеются на выбор другие виды узоров. 
Поэкспериментируйте, чтобы найти наилучший 
узор для своего проекта. Подробнее см. в 
разделе Образцы заполнения 

простегивающими стежками. 
 
Как выбирать узоры заполнения 
простегивающими стежками 
1  Дважды или правой кнопкой мыши щелкните 
по заполняемому объекту. 
 
Откроется закладка Fill Stitch – Step окна Object 
Properties (Свойства объекта). 
 
 
 
 
 
Выберите узор 

заполнения 
 
 
 
2  Выберите узор. 
 Появится обзор образцов узоров. 
 

 
3  Щелкните по Apply (Принять). 
 

    



Глава 9: Методы оцифровывания 

BERNINA® Вышивальное ПО Версия 6 97

ГЛАВА 9 
 

 
МЕТОДЫ ОЦИФРОВЫВАНИЯ 

------------------------------------------- 
 
 
 

В BERNINA Embroidery Software вы составляете проекты 
из базовых форм, или "вышивальных объектов". Процесс 
создания вышивальных объектов на экране называется 
"оцифровыванием". Как и при создании проектов в 
графических программах, используют различные 
инструментальные средства оцифровывания. 
Инструментальные средства оцифровывания в BERNINA 
Embroidery Software подобны инструментам рисования с 
той лишь разницей, что конечным результатом является 
вышивальный, а не рисованный объект. 
 
Наподобие рисованных объектов, вышивальные объекты 
обладают определенными характеристиками, или 
"свойствами", такими как цвет, размеры, положение и т.п. 
Они обладают также специфичными для вышивок 
свойствами, такими как тип и плотность стежков. 
Наиболее важным свойством объекта вышивки является 
тип стежка. Различные типы стежков подходят для 
разных форм. Подробнее см. в разделе  
Оконтуривающие и заполняющие стежки. 
 
Свойства объекта определяются во время оцифровывания, но они могут быть на 
любой стадии изменены. При создании объекта вышивки вы можете принять 
предлагаемые по умолчанию настройки для отдельного метода оцифровывания или 
же применить другие настройки. Принимаемые по умолчанию стандартные настройки 
хранятся в шаблоне проекта. Вы можете также определить "текущие" свойства, 
которые будут влиять на все объекты, создаваемые в текущем проекте. Подробнее см. 
в разделе Свойства объекта и шаблоны. 
В настоящем разделе описывается, как оцифровывать объекты основными способами 
оцифровывания. Кроме того, объясняется, как подогнать настройки оцифровывания 
для получения лучших результатов.
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Инструментальные средства 
оцифровывания 
Различные методы оцифровывания, или 
"инструментальные средства", приспособлены для  
создания различных форм или элементов проекта. 
 
Методы оцифровывания подразделяются на две 
большие категории – оконтуривание и 
заполнение.Совет: Рисованные объекты могут 
быть преобразованы в объекты вышивания с 
использованием инструмента BERNINA 
Embroidery Software Magic Wand (Волшебная 
палочка). Подробнее см. в разделе 
Оцифровывание Волшебной палочкой, 
 

Выбор инструмента оцифровывания 
Используйте инструмент Open Object 
(панель Digitize) для оцифровывания 
линий. 
 

Используйте инструмент Closed Object 
(панель Digitize) для оцифровывания 
фигур неправильной формы. 
 

Используйте инструмент Circle/Oval 
(панель Digitize) для оцифровывания 
окружности или овала. 
 

Используйте инструмент Rectangle 
(панель Digitize) для оцифровывания 
квадрата или прямоугольника. 
 

Используйте инструмент Block Digitizing 
(панель Digitize) для оцифровывания 
колонок. 

 
Методы оцифровывания подразделяются на две 
большие категории – оконтуривание и заполнение. 
BERNINA Embroidery Software предоставляет 
различные инструментальные средства для 
оцифровывания образов – Open Object 
(Незамкнутой объект), Closed Object (Замкнутый 
объект), Block Digitizing (Оцифровывание блоков), 
Circle/Oval (Окружность/Овал) и Rectangle 
(Прямоугольник). Инструмент Open Object 
используется для создания оконтуривающих 
фигур. Инструмент Block Digitizing используется 
для оцифровывания колонок с изменяющейся 
шириной и углом вышивания. Инструменты Closed 
Object, Circle/Oval, Rectangle используются для 
создания заполняющих или оконтуривающих 
фигур. 
 

Базисные точки и контрольные точки 
После выбора инструмента вы оцифровываете 
фигуры одним и тем же способом, намечая 
"базисные точки" по контуру следующим образом: 
◄ щелкните левой кнопкой мыши для отметки 

угловой точки  
◄ щелкните правой кнопки для отметки точек 

кривой линии   
 

 

 

 
 
 
 
 
 
 
В общем случае вы намечаете базисные точки, 
если: 
◄ изогнутый контур изменят кривизну, 
◄ контур имеет углы, 
◄ контурная линия изменяется от прямой до 

кривой. 

 
Базисные точки, намеченные вами при 
оцифровывании фигуры, становятся 
"контрольными точками" выбранного объекта. 
Контрольные точки, появляющиеся на контурах 
объекта, используются для редактирования или 
"преобразования" объектов. Такие действия могут 
включать изменение формы, изменения размеров, 
межсимвольного интервала, изменения точек 
входа и выхода. 
 
Узлы изменения формы имеют разную цветовую 
маркировку, угловые точки – желтые квадраты, 
точки кривой – бирюзовые кружки, а точки угла 
наклона стежков – оранжевые квадраты. Точки 
входа объекта показываются зелеными ромбами, 
точки выхода – красными крестами. 
Точки входа и выхода всего проекта обозначаются 
соответственно небольшим зеленым кружком и 
маленьким красным крестом. 
 
Примечание:  Большинство контрольных точек 
может быть добавлено, удалено или 
преобразовано в точки угла или кривой. Некоторые 
контрольные точки имеют специфичные функции и 
не могут быть удалены, например маркеры точек 
входа. См. также Изменение формы и правка 
объектов. 
 
Метод соединения 
Функция Closest Join (Самое короткое 
соединение) автоматически рассчитывает 
кратчайшее соединение между объектами, 
экономя ваше время, требуемое для нахождения 
точек входа и выхода- 
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. При активации (по умолчанию) все вновь 
оцифруемые объекты соединяются этим 
способом. Если эта функция деактивирована, все 
вновь оцифровываемые объекты соединяются 
методом As Digitized (По мере оцифровки). Это 
означает, что они соединяются от точки выхода 
последнего оцифрованного объекта к точке входа 
нового объекта. Если функция Closest Join 
отключена, вы имеете возможность назначать 
точки входа и выхода при оцифровке замкнутых 
объектов. Подробнее см. в разделе Настройка 
общих опций. 
 
 

Вверху: опция Closest Join включена;  
внизу - выключена 
 
Переключение между методами 
оцифровывания заполнения и контура 
 

Используйте инструмент Outline 
(панели Stitch and Color) для 
оцифровывания линий. 
 
Используйте инструмент Fill 
(панель Stitch and Color) для  

                             оцифровывания фигур. 
 
Вы можете быстро переключаться с заполняющего 
стежка на оконтуривающий стежок, используя 
инструменты Fill (Заполнение) и Outline 
(Оконтуривание). См. также Оконтуривающие и 
заполняющие стежки. 
 
Как переключаться между методами 
оцифровывания заполнения и контура 
◄ Выберите инструмент оцифровывания и 

затем перед оцифровыванием нажмите 
значок Fill или Outline. 

Оцифровывание открытых 
фигур 

 
Используйте инструмент Open Object 
(панель Digitize) для оцифровывания 
открытых фигур. 

 
 

Используйте инструмент Open Object 
(Незамкнутый объект) для оцифровывания 
открытых фигур одинарным/тройным рядом 
различных стежков. Инструмент Open Object 
располагает ряд стежков вдоль оцифровываемой 
линии.  С этим инструментом можно использовать 
только оконтуривающий стежок. Этот инструмент 
обычно используется для добавления обрамления 
к проекту. 
При создании объектов используйте левую и 
правую кнопки мыши для отметки базисных точек, 
образующих контур. Щелчком левой кнопку 
вводятся угловые точки, щелчком правой кнопки – 
точки кривой.  

 
         
 
                    

    Незамкнутый объект 
 
 
Как оцифровывать открытые фигуры 
 
1  Выберите тип стежка Outline  
2  Щелкните по Open Object (Незамкнутый 

объект). 
3  Оцифруйте фигуру, наметив базисные точки 

вокруг ее контура. 
◄ Щелкайте левой кнопкой мыши для ввода 

угловых точек. 
◄ Щелкайте правой кнопкой мыши для ввода 

точек кривой.  

 
Совет: Следуйте указаниям в строке состояния, 
помогающим при оцифровывании. Если вы 
ошиблись, нажмите клавишу Backspace, чтобы 
удалить последнюю базисную точку, и затем 
продолжайте оцифровывание или нажмите 
клавишу Esc, чтобы удалить все точки и начинать 
заново.  
 
4  Нажмите Enter для завершения работы. 
 
Примечание: Если вы хотите замкнуть объект, 
используйте комманды Arrange > Close Object > 
... 
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Указав в опциях, какую замыкающую линию 
использовать: прямую (straight) или кривую 
(curved). 
 

 

Оцифровывание замкнутых 
фигур 
 

Используйте инструмент Closed Object 
(панель Digitize) для оцифровывания 
нерегулярных замкнутых фигур. 

 
Оцифровывайте сложные фигуры инструментом 
Closed Object (Замкнутый объект). При создании 
объектов используйте левую и правую кнопки 
мыши для отметки базисных точек, образующих 
контур. 

 
Замкнутая оконтуривающая кривая   Заполненный  
                                                         замкнутый объект 
 
Как оцифровывать замкнутые кривые 
1  Выберите Outline (Оконтуривание) или Fill 

(Заполнение). См. также Выбор или 
изменение стежков. 

2  Щелкните по Closed Object (Замкнутый 
объект). Оцифруйте контур фигуры, наметив 
базисные точки вокруг контура фигуры. 

 
◄ Щелкайте левой кнопкой мыши для ввода 

угловых точек. 
◄ Щелкайте правой кнопкой мыши для ввода 

точек кривой. 
 
Совет: Следуйте указаниям в строке состояния, 
помогающим при оцифровывании. Если вы 
ошиблись, нажмите клавишу Backspace, чтобы 
удалить последнюю базисную точку, и затем 
продолжайте оцифровывание или нажмите 
клавишу Esc, чтобы удалить все точки и начинать 
заново.  
 
 
 
 
 
 
 
 

3  Закройте контур фигуры. 
◄ Чтобы закрыть контур тем же типом 

базисной точки, который был использован в 
конце оцифровывания, - т.е. точкой угла 
или кривой, - просто нажмите клавишу 
Enter. 

◄ Чтобы закрыть контур другим типом 
базисной точки, наметьте последнюю точку 
над первой и нажмите клавишу Enter. 

      
  

 
 
 
 
 
 
                          Объект закрыт автоматически 
 
4  Повторите несколько раз, если необходимо 

создать несколько объектов. 
 
Примечание: По умолчанию объекты 
соединяются методом Closest Join. Если эта 
функция деактивирована, все вновь 
оцифровываемые объекты соединяются методом 
As Digitized. Это означает, что вам нужно 
назначать точки входа и выхода, следуя указаниям 
строки состояния. Подробнее см. в разделе 
Настройка общих опций.  
См. также раздел Изменение точек входа и 
выхода. 

 
 
 
 
 
 
 
 
 
 
 

5  Нажмите клавишу Esc, чтобы отменить 
выделение инструмента. 
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Оцифровывание колонок с 
изменяющейся шириной 
 

Используйте инструмент Block Digitizing 
(панель Digitize) для оцифровывания 
колонок с изменяющейся шириной и углом 
вышивания. 

 
Используйте инструмент Block Digitizing 
(Оцифровывание блоков) для оцифровывания 
колонок с изменяющейся шириной и углом 
вышивания. Оцифрованные пары базисных точек 
определяют контур, а линии, соединяющие эти 
пары, определяют углы вышивания. 
 
Как оцифровывать колонку с 
изменяющейся шириной. 
1  Выберите тип стежка Fill (Заполнение). См. 

также Выбор или изменение стежков. 
2   Щелкните по значку Block Digitizing. 
3  Оцифровывание колонки отметкой базисных 

точек на противоположных сторонах колонки. 
◄ Щелкайте левой кнопкой мыши для ввода 

угловых точек. 
◄ Щелкайте правой кнопкой мыши для ввода 

точек кривой. 
 Наметьте пару точек в том месте, где меняется 

контур и где вы хотите изменить угол стежка. 
 

 
 
Постепенное изменение угла    Угол наклона  
                                               стежков остается постоянным 
                                                          наклона стежков     
                                  
Совет: Парные контрольные точки не обязательно 
должны быть одного и того же типа. Например, 
одна точка может быть угловой, другая – 
находиться на кривой линии.  
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

Разные типы контрольных точек в одной паре  
 
Совет: Если вы ошиблись, нажмите клавишу 
Backspace, чтобы удалить последнюю базисную 
точку, и затем продолжайте оцифровывание. 
 
4  После окончания оцифровывания линии, 
нажмите Enter. 
 
5  Повторите несколько раз, если необходимо 

создать несколько объектов. По умолчанию 
объекты соединяются методом Closest Join. 
Если эта функция деактивирована, все вновь 
оцифровываемые объекты соединяются 
методом As Digitized. Это означает, что вам 
нужно назначать точки входа и выхода, следуя 
указаниям строки состояния. Подробнее см. в 
разделе Настройка других общих опций. 
См. также раздел Изменение точек входа и 
выхода. 

 
Совет: Если вы используете метод As Digitized, 
вы можете выбирать, пропустить или включить 
последний стежок. Например, если соединяются 
два объекта, сохраните или пропустите последний 
стежок, так чтобы точка выхода находилась вблизи 
того места, где вы начнете следующий объект. 
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◄ Нажмите Enter, чтобы сохранить 

последний стежок и поместить точку 
выхода в последней оцифрованной вами 
базисной точке  

 
начало       начало 

 
                                      конец 
 

◄ Нажмите клавишу пробела, чтобы 
пропустить последний стежок и разместить 
точку выхода на противоположной стороне 
колонки. 

                                               
начало           конец  начало 

 
6  Нажмите клавишу Esc, чтобы отменить 
выделение инструмента. 
 

Оцифровывание окружностей и 
овалов 
 

Используйте инструмент Circle/Oval 
(панель Digitize) для оцифровывания 
окружностей и овалов. 

 
Оцифровывайте окружности и овалы несколькими 
щелчками мыши. Для окружностей и овалов вы 
можете использовать любой тип заполняющих или 
оконтуривающих стежков. 
 

 
Одинарные стежки Стежки 

гладьевого 
валика 

Краеобметочные  
стежки 

 
Простегивающие 
стежки 

Узорные стежки Орнаментные  
стежки 

 
 

Как оцифровывать окружность или овал 
1  Выберите Outline (Оконтуривание) или Fill 

(Заполнение). См. также Выбор или 
изменение стежков. 

2  Щелкните по значку Circle/Oval 
(Окружность/Овал) 

3  Оцифровывание окружности или овала. 
◄ Щелкните для отметки центра окружности 

или овала. К указателю мыши 
присоединится контур окружности. 

◄ Перемещайте указатель мыши до тех пор, 
пока контур не достигнет требуемых 
размеров, затем щелкните мышью, чтобы 
наметить базисную точку радиуса. Эта 
точка отмечает также точку входа стежка. 
Угол наклона стежка может быть 
перпендикулярным к линии, соединяющим 
точку центра и базисную точку радиуса. 

◄ Для создания окружности нажмите Enter. 
◄ Для создания овала щелкните еще раз, 

чтобы наметить точку второго радиуса, и 
нажмите Enter. 

                     Центр                        Центр 
          
 
 
 
 
 
 
 
 
 
 
 
              
             
                               Нажмите Enter           Нажмите Enter 
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Оцифровывание квадратов и 
прямоугольников 

 
Используйте инструмент Rectangle 
(панель Digitize) для оцифровывания 
квадратов и прямоугольников. 

 
Оцифровывайте квадраты и прямоугольники 
несколькими щелчками мыши. Для квадратов и 
прямоугольников вы можете использовать любой 
тип заполняющих или оконтуривающих стежков. 
 

 
Одинарные стежки Стежки 

гладьевого 
валика 

Краеобметочные 
стежки 

 
Простегивающие 
стежки 

Узорные стежки Орнаментные 
стежки 

 
Как оцифровывать квадрат и 
прямоугольник. 
1  Выберите Outline (Оконтуривание) или Fill 

(Заполнение). См. также Выбор или 
изменение стежков. 

2  Щелкните по значку Rectangle 
(Прямоугольник). 

2  Оцифровывание квадрата и прямоугольника. 
◄ Щелкните, чтобы наметить один из углов 

прямоугольника. 
◄ Перетаскивайте указатель мыши до тех пор, 

пока контур не достигнет требуемого размера. 
◄ Щелкните еще раз, чтобы определить место 

противоположного угла 
прямоугольника/квадрата. 

 
 

◄ Для создания квадрата удерживайте нажатой 
клавишу Ctrl во время перетаскивания мыши.  
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ГЛАВА 10 
 

 
ЦВЕТА НИТОК И ТАБЛИЦЫ НИТОК 

------------------------------------------- 
 

 
 

При оцифровывании вы выбираете в окне проекта цвета 
ниток из палитры цветов для каждого создаваемого 
объекта. Цветовая палитра содержит набор цветов ниток, 
специфицированный для каждого проекта. Эта цветовая 
схема представляет собой фактические цвета ниток, с 
которыми будет вышит проект. 
 
Для каждой цветовой схемы вы можете выбрать цвета из 
фирменных таблиц ниток, содержащих диапазон цветов, от 
различных производителей ниток или выбрать другие 
нитки. Для экономии времени при настройке новых 
цветовых схем вы можете создать собственные таблицы ниток, используя наиболее 
части применяемые цвета. Вы можете добавлять, редактировать и удалять нитки из 
таблицы ниток или переименовывать или удалять сами таблицы. В BERNINA 
Embroidery Software вы можете искать нужные вам нитки по различным критериям. 
 
В этом разделе описывается, как выбирать цвета из цветовой палитры. Здесь также 
поясняется, как определять свои собственные цвета ниток и таблицы. 
 

 

Изменение цвета ниток 
 
Новые объекты оцифровываются с 
использованием выбранного цвета в цветовой 
панели. Вы можете изменить цвет перед каждым 
оцифровыванием. Если нужного вам цвета нет в 
цветовой палитре, вам может потребоваться 
добавить его. Подробнее см. в разделе 
Добавление собственных цветов в таблицу 
ниток. 

 
                            

Текущий цвет 

 
Примечание: Вследствие различий в 
характеристиках мониторов и видеокарт 
компьютера цвета, отображаемые на экране, 
следует считать приблизительными. Нитки 
должны быть всегда подобраны 
соответствующей физической цветовой карте.
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Выбор нового текущего цвета 
 

 Используйте Color (Цвет)  
(панель Stitch and color) для 
выбора текущего цвета. 

 

 
При оцифровывании нового объекта он 
автоматически принимает цвет, выбранный в 
цветовой палитре. Это "текущий" цвет. 
 
Как выбрать новый текущий цвет 
1  Отмените выделение всех объектов. Текущий 

выбранный (по умолчанию) цвет 
показывается на панели с направленной вниз 
стрелкой. 

 
 
2  Щелкните по стрелке около значка Color на 

панели Stitch & Color. 
 
3   Выберите цвет из цветовой палитры. Этот 
цвет становится текущим для всех новых 
объектов. 
 
Изменение цвета выбранных 
объектов 
 
Изменить цвет одного или нескольких 
выбранных объектов в вашем проекте можно в 
любое время. 

 
 
 
 
 
 
 
       
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Как изменить цвет выбранного объекта 
1  Выберите объект (или объекты), цвет 
которого вы хотите изменить. 

      
Выберите цвет из цветовой палитры 

 
 
2  Щелкните по стрелке около значка Color на 

панели Stitch & Color. 
 Откроется диалоговое окно Color Palette 

(Палитра цветов). 

 
3  Выберите цвет из цветовой палитры. 
 В выбранном объекте цвет изменится сразу  
     же. 
 
 

Подбор цветов ниток 
 
В BERNINA Embroidery Software вы можете 
вручную найти нужные вам нитки по различным 
критериям. Приведение в соответствие цвета 
нитки позволит вам найти и изменить цвет нитки, 
основанный на близком соответствии с одной 
или несколькими таблицами ниток. 
Функция Color Wheel позволяет вам 
изменять цвета по всему проекту и 
автоматически сопоставляет их цветам 
таблицы ниток. 
 
Совет: Опция Thread Chart > Print (Таблица 
ниток > Печать) позволяет распечатать список 
ниток в таблице ниток как справка для 
приобретения ниток. Подробнее см. в разделе 
Распечатка таблиц ниток. 

Щелкните, чтобы 
открыть цветовую 
палитру Щелкните, чтобы 

открыть цветовую 
палитру 
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Поиск типов ниток 
 
Для поиска нитки выберите Thread Colors из 
меню Settings. 
 
Вы можете найти нитку по коду или описанию в 
диалоговом окне Thread Colors (Цвета ниток) и 
добавить ее к выбранным цветам проекта. В 
представленных таблицах приводятся марки 
фирменных ниток, поддерживаемых BERNINA 
Embroidery Software.  В каждой таблице дается 
диапазон цветов различных ниток. 
Отображаются код, марка и описание каждого 
цвета, так что вы можете легко найти требуемые 
нитки в специализированных магазинах. Вы 
можете найти цвета по оттенку или по номеру. 
Выберите таблицу ниток для марки ниток, 
имеющихся у вас дома, или ту таблицу, цвета 
которых вам больше всего нравятся.  
 
Примечание: Вы можете также создать 
собственные таблицы ниток, в том числе 
содержащие нитки разных производителей. См. 
также раздел Создание пользовательских 
таблиц ниток. 
 
 
Как найти тип нитки 
1 Выберите Settings (Настройки) > Thread 

Colors (Цвета ниток) или щелкните по 
Thread Colors в диалоговом окне Color 
Palette . 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 Откроется закладка Thread Colors 
диалогового окна Design Properties (Свойства 
проекта). 
 
 
 
 

Выбор 
цвета 

заднего 
фона             

 
 
 
 

 Выбор 
таблицы 

ниток 
                   

Подбор 
кода 

             
Ввод 

поисковой 
строки 

   
 

                                                              Выбор кода нитки 
 
Совет: Измените фон кнопкой BKG в верхней 
части панели Threads in Design. Подробнее см. 
в разделе Изменение фона. 
 
2  Выберите таблицу ниток, чтобы включить в 

поиск из списка Thread Charts (Таблицы 
ниток). 

3  Выберите функцию поиска – Code (Код) или 
Description (Описание). 

 Код – это идентификационный номер цвета 
нитки в бренде. 

4  В поле Search (Поиск)  введите первые 
несколько символов требуемого кода или 
описания. 

 Система разыщет наиболее близкое 
соответствие и отобразит его в списке цветов 
нитки. 

 
5  Выберите цвет на панели  Threads in Design 

и щелкните по Assign или дважды щелкните 
по нитке. 

6  Щелкните по Apply, чтобы увидеть любые 
изменения в окне проекта.  

7  Щелкните по OK, чтобы закрыть окно.. 
 
Примечание: Выбранные настройки цвета 
применяются только к текущему проекту и 
являются частью "свойств проекта". В таком 
виде они сохраняются вместе с проектом. 
 
 

Щелкните по 
Thread Colors
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Подбор ниток из различных таблиц 
 

Для подбора ниток из различных таблиц 
выберите Thread Colors (меню Settings). 
 

Используйте команду Match, чтобы привести в 
соответствие выбранный цвет проекта с текущей 
таблицей ниток. Как вариант: опция Match & 
Assign All приводит все цвета проекта в 
соответствие с наиболее подходящими нитками 
и автоматически их заменяет.  
 

Вы можете также использовать этот метод для 
изменения цвета всех объектов. Например, 
изменить светло-зеленый цвет всех объектов на 
темно-зеленый цвет. 
 

Как подбирать нитки из различных 
таблиц 
1  Выберите Settings (Настройки) > Thread 

Colors (Цвета ниток) или щелкните по 
ссылке в диалоговом окне Color Palette . 

 

 Откроется закладка Thread Colors 
диалогового окна Design Properties 
(Свойства проекта). 

На панели Threads in Design (Нитки в проекте) 
отобразятся все цвета, использованные в 
проекте. 
 

 
 
 
 
   

      Выбор 
цвета для 
подбора 

  
           

 Выбор 
таблицы 

ниток 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2  Выберите цвет для подбора из списка 
Threads in Design 
 
3  Выберите таблицу из списка Thread Chart 

(Таблица ниток). 
 
 Будет активирована кнопка Match. 
 

 
4  Щелкните по кнопке Match. 
 В верхней части списка цветных ниток 

высветится наиболее подходящая нитка. 
5  Щелкните по кнопке Assign или дважды 

щелкните по нитке. Выбранный цвет в списке 
Threads in Design заменен наиболее 
подходящим цветом нитки. 
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6  Повторяйте эту операцию до тех пор, пока не 
будут подобраны все цвета, которые вы 
хотите использовать в проекте. 

 

       
Оригинальные  Оранжевый цвет  Назначен  

      цвета проекта    заменен желтым  другой 
                                                                      зеленый цвет 
 
 
Совет: Как вариант, просто щелкните по кнопке 
Match & Assign All. Наиболее подходящие нитки 
из выбранной таблицы для каждого цвета 
найдены и назначены автоматически. 
7  Щелкните по Apply, чтобы увидеть любые 

изменения в окне проекта.  
8  Щелкните по OK, чтобы закрыть окно.. 

 
Изменение цветов всего проекта 
Функция Color Wheel позволяет вам 
изменять цвета по всему проекту и 
автоматически сопоставляет их цветам 
таблицы ниток (если они определены). Если 
программа BERNINA Embroidery Software не 
может найти подходящего совпадения, она 
добавляет в палитру новые цвета, которые 
надо будет вручную сопоставить тем или 
иным ниткам (можно также использовать 
функцию Match & Assign All). Основная 
задача этой функции – создать новый 
цветовой вариант вышивки, чтобы 
«освежить» старый образец или 
приспособить его под другую ткань.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Чтобы изменить цвета проекта 
1 Выберите объекты, которые вы хотите 
изменить, или весь образец в целом. 
 

 
 
2 Выберите функцию Color Palette на 
панели стежков и цветности Stitch and 
Color Bar с помощью кнопки Color. 
 

 
3 Выберите функции Color Wheel. 
Откроется диалоговое окно функции Color 
Wheel. 
 

 
 
4 С помощью регуляторов Оттенка (Hue) и 
Яркости (Brightness) создайте нужную 
цветовую гамму и нажмите OK. 
Образец изменит свои цвета. Если 
соответствующие цвета имеются в таблице 
цветов ниток, они будут автоматически 
сопоставлены. В противном случае, 
программа BERNINA Embroidery Software 
добавит неопознанные цвета к палитре. 
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Нажмите для 
изменения 
таблицы ниток 

 
 
5 Сопоставить неопознанные цвета и те или 
иные нитки можно вручную или с помощью 
функции Match & Assign All. См. раздел 
Подбор ниток из различных таблиц- 

Изменение таблиц ниток 
 

Обновление существующих таблиц ниток путем 
изменения характеристик ниток или удаления 
отдельных ниток. Вы можете также 
переименовывать или удалять таблицы ниток. 
 

Примечание: Таблицы ниток, встроенные в 
BERNINA Embroidery Software, предоставляют 
большой набор цветных ниток различных 
производителей. К сожалению, эти таблицы не 
могут быть вполне адекватными, так как 
производители часто изменяют ассортимент, 
удаляют одни нитки и заменяют их новыми. По 
этой причине вы можете сами модернизировать 
таблицы, обновляя собственные таблицы ниток.   
 

Изменение характеристик нитки 
Изменение кода, бренда или описания 
существующей нитки. 
 

 
Как изменить характеристики нитки 
1  Выберите Settings (Настройки) > Thread 

Colors (Цвета ниток)  или щелкните по 
ссылке в диалоговом окне Color Palette . 

 Откроется закладка Thread Colors 
диалогового окна Design Properties 
(Свойства проекта). 

 
 

2  Щелкните по Create/Modify (Создать/ 
Модифицировать). 

    
 Откроется диалоговое окно Modify Thread  
      Chart (Изменение таблицы ниток). 
 

 
 

 
 
 
3  Из списка Name (Имя) выберите таблицу для 

изменения. 
4  Из списка Threads (Нитки) выберите нитку 

для изменения. 
5  Щелкните по Edit (Редактировать). 
 Откроется диалоговое окно Edit Thread 

(Редактировать нитку). 
 

 
 
6  Скорректируйте при необходимости код, 

бренд и детали описания для цвета нитки 
 Код – это идентификационный номер цвета  
      нитки  в бренде. 
 

Выбор таблицы ниток 

Выбор нитки для изменения          Нажмите для изменения  
                                                          цвета нитки 
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7  Щелкните по Mix, чтобы выбрать  

отображаемый цвет нитки. 
 Подробнее см. в разделе Смешивание 

ваших собственных таблиц ниток. 
8  Щелкните по ОК. 
 Новый цвет появится в списке Threads 

(Нитки). 
 

 
 
 
Смешивание ваших собственных 
цветов ниток 
Вы можете изменить цвет, который 
отображается для частичной нитки или создайте 
новые цвета ниток, используя диалоговое окно 
Color (Цвет). 
 

Как смешивать ваши собственные цвета 
ниток 
1  В диалоговом окне Add Thread (Доьавить 

нитку) или Edit Thread (Редактировать 
нитку). Щелкните по Mix (Смешать). 

◄ Подробнее см. в разделе Изменение 
характеристик нитки. 

◄ Подробнее см. в разделе Добавление 
собственных цветов в таблицу 
ниток.. 

 Откроется окно Color (Цвет).. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2  Из таблицы Basic colors (Основные цвета) 
выберите цвет, который ближе всего 
подходит к нужному вам цвету. 

3  Щелкните мышью и перетащите перекрестие 
нитей по спектру цветов, чтобы получить 
требуемый вам цвет. 

4  Передвиньте ползунок на правой стороне 
окна цветового спектра, чтобы 
отрегулировать яркость цвета. 

 В правом нижнем углу диалогового окна Color 
появятся значения HLS (Цвет-Яркость-
Насыщенность) и RGB (Зеленый, Красный, 
Синий). Введите эти значения для точного 
определения цветов. 

5  После смешивания требуемого цвета 
Щелкните по Add to Custom Colors 
(Добавить к пользовательским 
цветам). 

6  Щелкните по ОК. 
Новый цвет появится в окне просмотра Color  
(Цвет). 

 

Удаление ниток из таблиц 
 

Для удаления ниток из таблиц выберите Thread 
Colors (меню Settings). 
 

Вы можете легко удалить ненужные цветные 
нитки из таблицы ниток, используя диалоговое 
окно Modify Charts (Изменить таблицы). 
 

Как удалять нитки из таблиц 
1  Откройте диалоговое окно Modify Thread  
   Chart  (Изменение таблицы ниток). 
 Подробнее см. в разделе Изменение  

таблиц ниток . 
 
 

 
 

2  Из списка Name (Имя) выберите таблицу для 
изменения. 
3  Из списка Threads (Нитки) выберите нитку 
(или нитки) для удаления.  
• Для выбора нескольких идущих подряд 

объектов удерживайте нажатой клавишу 
Shift. 

• Для выбора нескольких объектов 
удерживайте нажатой клавишу Ctrl. 

 

4  Щелкните по Remove (Удалить). 
 Появится требование подтвердить удаление. 
5  Нажмите Yes (Да). 
 

Совет: Для удаления всех ниток из таблицы 
Щелкните по Clear All (Удалить все).
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Переименование таблиц ниток 
 
Для переименования таблиц ниток выберите 
Thread Colors (меню Settings). 
 
Для переименования таблиц ниток используйте 
диалоговое окно Modify Thread Chart (Изменение 
таблицы ниток). 
 
Совет: Выбирайте имена, которые помогут вам 
вспомнить, какая таблица вам требуется, или 
таким образом, чтобы наиболее часто 
используемые таблицы находились в верхней 
части списка. 
 
Как переименовывать таблицы ниток 
1  Откройте диалоговое окно Modify Thread 
Chart (Изменение таблицы ниток). 
 Подробнее см. в разделе  Изменение 
характеристик нитки. 

 
Выбор таблицы ниток   Нажать для изменения 
имени 
 
2  Из списка Name (Имя) выберите таблицу для 
изменения. 
3  Щелкните по Rename (Переименовать). 
 Откроется диалоговое окно Rename Thread 
Chart (Переименовать таблицу ниток). 
 

 
               Измените имя таблицы 
 
4  Введите новое имя для таблицы ниток, затем  

нажмите OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Удаление таблиц ниток 
 
Для удаления таблиц ниток выберите Thread 
Colors (меню Settings). 
 
Для удаления ненужных таблиц ниток 
используйте диалоговое окно Modify Thread 
Chart (Изменение таблицы ниток). 
 
Примечание: Соблюдайте осторожность при 
удалении таблиц ниток. Если вы удалите по 
ошибке нужную таблицу, то вам потребуется 
перезапустить BERNINA Embroidery Software, 
чтобы восстановить ее. 
 
Как удалять таблицы ниток 
1  Откройте диалоговое окно Modify Thread  

Chart (Изменение таблицы ниток). 
Подробнее см. в разделе Изменение  
таблиц ниток. 

 
Выбор таблицы ниток     Нажать 

для удаления  
выбранной таблицы 

2  Из списка Name (Имя) выберите таблицу для  
удаления. 

3  Щелкните по Delete (Удалить). 
 Появится требование подтвердить удаление. 
4  Нажмите Yes (Да). 
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Создание собственных таблиц 
ниток 
 
Для создания новых таблиц ниток выберите 
Thread Colors (меню Settings). 
 
Таблицы ниток – это списки предварительно 
определенных цветов ниток. Они могут быть 
основаны на фирменных таблицах ниток или на 
составленных вами таблицах. 
 
Совет: Опция Thread Chart > Print (Таблица 
ниток > Печать) позволяет распечатать список 
ниток в таблице ниток как справка для 
приобретения ниток. Подробнее см. в разделе 
Распечатка таблиц ниток.  
 
 
Создание новых таблиц ниток 
При создании таблицы ниток вы создаете набор 
цветов для использования в вашем проекте. 
Например, вы можете захотеть создать таблицу, 
содержащую нитки, которые уже имеются в 
вашей коллекции. В нее могут быть включены 
нитки разных производителей. Имея заранее 
рассортированный список в составленной вами 
таблице, вам будет легче подбирать цветные 
нитки к проекту из имеющихся у вас ниток. 
 
Как создать таблицу ниток 
1  Выберите Settings (Настройки) > Thread 

Colors (Цвета ниток)  или щелкните по 
ссылке в диалоговом окне Color Palette . 

 Откроется закладка Thread Colors 
диалогового окна Design Properties 
(Свойства проекта). 

 
 

 
 
 
2  Щелкните по Create/Modify Charts 
(Создать/Изменить таблицы). 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Откроется диалоговое окно Modify Thread Chart 
(Изменение таблицы ниток). 
 

Нажмите New 

 
    
3  Щелкните по New (Новый). 

Откроется диалоговое окно New Thread Chart  
(Новая таблица ниток). 

 

     
 
4  Введите имя таблицы и нажмите OK. 

 
Примечание: При присвоении имени для 
ваших собственных цветовых таблиц или 
отредактированных цветовых таблиц не 
используйте символы или знаки препинания, 
такие как запятые.  
Вы возвратитесь к диалоговому окну Modify 
Thread Chart. Новая таблица создана и 
готова для добавления цветов ниток. 
 

  
 
5  Щелкните по Add (Добавить), чтобы  

открыть окно Add Thread (Добавить нитку). 
Подробнее см. в разделе Добавление  
собственных цветов в таблицу ниток. 

     

Нажмите по 
Create/Modify для 
создания 
собственной 
таблицы ниток 

Введите имя  
таблицы 

Новая  
таблица  
создана 
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6  Щелкните по Copy From (Скопировать 

из), чтобы добавить цвета из существующей 
таблицы. 

 Подробнее см. в разделе Копирование 
цветов из таблицы в таблицу. 

7  Щелкните по ОК. 
Новая таблица создана и готова для  
использования. 

 
 
Копирование цветов из таблицы в 
таблицу 
Вы можете копировать цвета из одной таблицы 
ниток в другую для создания собственных 
таблиц из существующих цветов. 
 

Как копировать цвета из таблицы в 
таблицу 
1  Откройте диалоговое окно Modify Thread  

Chart (Изменение таблицы ниток). 
Подробнее см. в разделе Создание новых  
таблиц ниток. 

Выбор таблицы ниток 
   

 
             
         Нажмите Copy From  

2  Выберите таблицу из списка Thread Chart  
(Таблица ниток) > Name (Имя) 

3  Щелкните по Copy From… (Скопировать  
из …) 

 Откроется диалоговое окно Copy From. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
4  Из списка Name выберите таблицу ниток,  

содержащий цвет, который вы хотите 
копировать. 

5  Выберите цвет, который вы хотите 
копировать:. 

 
• Для выбора нескольких идущих подряд 

объектов удерживайте нажатой клавишу 
Shift. 

• Для выбора нескольких объектов 
удерживайте нажатой клавишу Ctrl. 

 
6  Нажмите OK. 
 Цвет будет скопирован в таблицу ниток и 

появится в конце списка. 
 
Добавление собственных цветов в 
таблицу ниток 
Вы можете добавлять цвета в таблицы ниток из 
других таблиц или самостоятельно смешанных 
цветов,  
 
Как добавить собственные цвета в 
таблицу ниток 
1  Откройте диалоговое окно Modify Thread 

Chart (Изменение таблицы ниток). 
Подробнее см. в разделе Создание новых  
таблиц ниток. 

2  Щелкните по Add, чтобы добавить  
собственные цвета. 
Откроется диалоговое окно Add Thread  
(Добавить нитку).  
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3  Смешайте отображаемый цвет нитки. 
 Подробнее см. в разделе Смешивание 

ваших собственных таблиц ниток. 
4  Введите код, бренд и опишите детали для  

нового цвета нитки.  
Код – это идентификационный номер цвета 
нитки в бренде. 

5  Щелкните по ОК.  
Новый цвет появится в списке Threads  
(Нитки). 
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ГЛАВА 11 
 

 
СВОЙСТВА ОБЪЕКТА И ШАБЛОНЫ 

------------------------------------------- 

 

 
 

Свойствами объектов вышивания определяются общие 
характеристики, такие как размер и положение, а также 
специфические вышивальные характеристики, такие как тип и 
плотность стежков. Специфичные настройки стежка определяют. 
каким образом будут воспроизводиться стежки при изменение 
формы, преобразовании или изменении размеров объекта. 
При создании объекта вышивки вы можете принять 
предлагаемые по умолчанию настройки для отдельного метода 
оцифровывания или же применить другие настройки. 
Принимаемые по умолчанию стандартные настройки хранятся в 
шаблоне проекта. Вы можете также определить "текущие" 
свойства, которые будут влиять на все объекты, создаваемые в 
текущем проекте. 
В этом разделе поясняется, как можно изменять свойства 
объекта в вашем проекте, а также как применять, создавать и сохранять стили и 
шаблоны в BERNINA Embroidery Software. 

 

 

Применение свойств объекта и 
управление ими 
 
BERNINA Embroidery Software сохраняет три 
набора свойств объекта: стандартный, 
текущий и существующий. 
 
Примечание: Некоторые свойства объекта 
могут быть модифицированы на экране; 
например, вы можете изменять свойства 
размера путем перетаскивания меток – 
манипуляторов выделения. Другие свойства, 
такие как шаг или длина стежка, изменяются в 
диалоговом окне Object Properties (Свойства 
объекта). 
 

Стандартные свойства объекта 
Стандартные свойства объекта являются 
свойствами, сохраняемыми в шаблоне проекта, 
и становятся начальными настройками, 
используемыми при создании нового проекта, 
основанного на этом шаблоне. 
 

Текущие свойства объекта 

 
 
 
 
 
Текущие свойства объекта – это настройки, 
используемые для создания новых объектов. До 
тех пор, пока вы не измените эти настройки, они 
остаются теми же, которые сохраняются по 
умолчанию в шаблоне. Вы, как правило, 
изменяете их для экономии времени при 
оцифровывании. Например, вы можете задавать 
настройку шага простегивающего стежка для 
использования специфичной плотности для 
новых создаваемых вами простегиваемых 
объектов. 
 
 
Примечание: Изменение затрагивает новые 
объекты, но не сам шаблон. Для применения 
изменений ко всем новым проектам, основанным 
на текущем шаблоне, вам нужно изменить 
стандартные (default), -- но не текущие 
(current) – настройки. 
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Свойства существующих объектов 
Свойства существующих объектов – это 
настройки, сохраняемые в каждом объекте в 
проекте.  
 

Настройка текущих свойств объекта 
 

 Используйте функцию Object Properties 
(панель General) для настройки свойств 
объекта. 

 
При изменении текущих (current) свойств 
объекта новые настройки автоматически 
применяются к любым новым объектам, 
создаваемым в текущем проекте.  
 

Как настроить текущие свойства объекта 
1  Выберите Object Properties (Свойства 
объекта)  - без предварительного выбора 
объекта.  
 
Откроется диалоговое окно Object Properties 
(Свойства объекта). 
 

 
Выберите 
закладку 

 

 

 

 
Измените 
настройки 

 

 

 

 

 

 
 Закладки отображены в верхней части 

диалогового окна Object Properties. Они 
обеспечивают доступ ко всем возможным 
настройкам свойств объекта. 

2  Щелкните по закладке, чтобы увидеть 
текущие настройки и изменить их по своему 
желанию. 
3  Щелкните по Apply. 
 

Изменение свойств выбранных 
объектов 
 
Вы можете изменять свойства выбранного 
объекта или объектов. Например, если вы 
увеличите проект, вы сможете захотеть вышить 
некоторые объекты с заполнением 
простегивающими , а не гладьевыми стежками, 
чтобы получить более полное покрытие. Если вы 
выбрали больше одного объекта, в диалоговом 
окне Object Properties будут активными только те 
закладки, в которых находятся настройки, 
действительные для всех выделенных объектов.  
  
 
 
 

 

 
 
Если выбранные объекты имеют различные 
текущие значения для одних и тех же настроек, 
соответствующее поле будет пустым. Если вы 
введете новое значения, оно будет применено 
для всех объектов. 
 
Примечание: Изменение свойств существующих 
объектов не затрагивает текущие или 
стандартные настройки, а также любые не 
выделенные в данный момент объекты. 
 

Как изменять свойства выбранных 
объектов 
1  Выберите объект или объекты, свойства 

которых вы хотите изменить. 
2  Дважды щелкните по объекту. 
 Откроется диалоговое окно Object Properties 
(Свойства объекта). 
3  Выберите нужную вам закладку и измените 
по своему желанию настройки. 
4  Щелкните по Apply. 
 
Изменение стандартных свойств 
объекта 
 

Вы можете изменять стандартные свойства 
объекта в любое время путем сохранения 
свойств объекта, с которым вы работаете с 
текущим шаблоном. Сохраняются только 
настройки для этого объекта. Другие свойства 
остаются с текущими настройками. Например, 
если вы делаете свойства выбранного 
гладьевого объекта стандартными, стандартные 
настройки Fancy Fill (Заполнение орнаментными 
стежками) не будут изменены. При сохранении 
изменений в шаблоне вы можете выбрать, какие 
из настроек относятся только к текстовому 
объекту или к другим типам объектов или же ко 
всем объектам.  
 
 

             
Применен стандартный шаг      Применено новое значение 

гладьевого стежка     шага гладьевого стежка 
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Примечание: Изменение затрагивают все новые 
проекты, создаваемые с этим шаблоном. Если 
вы хотите применить изменения к проекту, над 
которым вы работаете, измените текущие 
(current), но не стандартные (default) настройки. 
Подробнее см. в разделе Настройка текущих 
свойств объекта. 
 

Как изменять стандартные свойства 
объекта 
1  Выберите объект (или объекты), на основе 

которого вы хотите создать стандартные 
свойства. 

2  Дважды щелкните, чтобы открыть диалоговое 
окно Object Properties (Свойства объекта). 

 

 
            Измените настройки                      Щелкните по Save  
 

3  Выберите нужную вам закладку и измените 
по своему желанию настройки. 
 

4  Щелкните по Save to Template (Сохранить в  
шаблоне)  
Откроется диалоговое окно Save to  
Template. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
5  Выберите требуемую опцию: 
 

◄ Lettering (Текст): изменение настроек 
относится только к новым текстовым 
объектам. 
 

◄ Other Objects (Другие объекты): 
изменение настроек относится только к 
объектам, отличающимся от текста. 
 

◄ All objects (Все объекты): изменение 
настроек относится ко всем новым 
объектам. 

Появится сообщение о подтверждении. 
 

 
6  Щелкните по OK, чтобы обновить шаблон. 
Свойства объекта сохраняются в текущем 
шаблоне и будут применены к любым новым 
объектам в любом проекте, основанном на этом 
шаблоне.  
 
Примечание: Вы можете также создать новый 
шаблон, используя измененные свойства 
объекта в качестве стандартных. Подробнее см. 
в разделе Управление шаблонами проекта. 
 

Управление шаблонами 
проекта 
 
Шаблоны – это специальные файлы, 
используемые для сохранения стилей и 
стандартных, применяемых по умолчанию 
настроек. Используйте шаблоны, когда вы 
оцифровываете наиболее часто применяемые 
типы проектов, чтобы не устанавливать текущие 
свойства каждый раз заново. Например, шаблон 
может содержать стандартные объекты и 
образец текста. Он может просто содержать 
предпочитаемые настройки стежков, шрифт 
текста и его размер, в также набор цветов в 
качестве текущих свойств. Или в нем может быть 
задана специальная плотность стежков, 
компенсация стягивания или набор 
стабилизирующих стежков, подходящих для 
различных тканей. 
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Часто используемый цвет  
фона может быть сохранен в 
шаблоне 

 
 
 

Шаблон NORMAL является стандартным 
шаблоном, поставляемым с ПО BERNINA 
Embroidery Software. Он содержит текущие 
свойства объекта. Если необходимо, вы можете 
вернуться к оригинальному шаблону NORMAL 
после его модификации. Подробнее см. в 
разделе Возвращение к шаблону NORMAL. 
 

 
Создание шаблонов проекта 
 
Вы можете создавать шаблоны из проектов, 
содержащих требуемые объекты и свойства 
объектов. Просто сохраните в качестве шаблона 
проект или его элементы. Файлы шаблонов 
выглядят так же, как файлы проектов, но имеют 
расширение AMT. 
Будьте уверены в том, что вы выбрали имя для 
нового шаблона перед сохранением изменений. 
Если вы сделали изменения в ваших настройках 
Object Properties  кнопку Save To Template, -- 
то изменения будут сохранены в используемом 
шаблоне. Подробнее см. в разделе Изменение 
стандартных свойств объекта.  
 
Примечание: Вы не сможете непредумышленно 
перезаписать шаблоны. Каждый раз, когда вы 
создаете новый проект на основе шаблона, 
BERNINA Embroidery Software открывает 
дубликат шаблона. Когда вы сохраняете проект 
в первый раз, открывается диалоговое окно Save 
As (Сохранить как), так что вы можете сохранить 
шаблон под новым именем. 
 

Как создать шаблон проекта 
1  Начните новый проект или откройте 

существующий. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
2  Настройте по своему желанию свойства 

объекта, стили и эффекты. 
3  Добавьте объекты и текст, которые вы хотите 

сохранить в шаблоне. 
Например, вы захотите включить образец 
текста с использованием разных базовых 
линий. Просто перезапишите образец текста 
при использовании шаблона. Подробнее см. 
в разделе Применение базовых линий 
текста.  

4  Выберите File (Файл)> Save As (Сохранить 
как). 

 Откроется диалоговое окно Save As. 

 
 

5  Из открывшегося списка диалогового окна 
Save as выберите BERNINA Embroidery 
Software Templates  . 
BERNINA Embroidery Software автоматически  
откроет папку ..\Program 
Files\BERNINA\Embroidery Software 6 
\template 

     Шаблоны проектов должны сохраняться в 
этой парке, в противном случае они не 
появятся в списке шаблонов при создании 
нового проекта. 

6  Введите имя шаблона в поле File name (Имя 
файла). 

7  Щелкните по Save (Сохранить). 

Введите имя  
шаблона 

Выберите  
BERNINA  

Templates)
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Изменение шаблонов проекта 
 

Вы можете изменять шаблоны таким же 
образом, как нормальный проект. Изменения 
применимы только для будущего использования 
шаблона. Существующие проекты, основанные 
на измененном шаблоне, не затрагиваются. 
 

Примечание: Удаление шаблонов производится 
тем же путем, что и другие файлы ОС Windows, 
с использованием Проводника Windows. 
Шаблоны размещаются в папке ..\Program 
Files\BERNINA\Embroidery Software 6 
\template 
 

Как изменять шаблоны проекта 
1  Выберите File > Open. 
 Откроется диалоговое окно Open. 
2  Перейдите к папке the ..\Program  

Files\BERNINA\Embroidery Software 6  
\template 

3  Затем в открывшемся списке Files of type  
(Тип файлов) выберите   
BERNINA Embroidery Software 
Templates  

 Появятся имеющиеся файлы шаблонов. 
4  Выберите шаблон, который вы хотите 

изменить, и щелкните по Open (Открыть).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5  Измените, как вам требуется, свойства 
объекта, стили и другие настройки. 

 
         
 
 
 

 
6  Выберите File (Файл)> Save As (Сохранить  

как). 
 Откроется диалоговое окно Save As. 
 
 
 
 
 
 
 
 
 
 
 

7  Выберите папку ..\Program Files\ 
BERNINA\Embroidery Software 6\template 
 
8  Из открывшегося списка Save as type  

(Сохранить как тип) выберите  
BERNINA Embroidery Software  
Templates. 

 
9    Выберите шаблон и щелкните по Save. 
 Появится сообщение о подтверждении. 

 
Совет: Для создания нового шаблона, 
основанного на модифицированном 
шаблоне, введите новое имя файла и 
щелкните по Save. 

 
10 Щелкните по YES для подтверждения. 
 Измененный шаблон готов для 
использования. 
     

 
  Проект 1        Проект 2 

 
 

Текст, добавленный к 
шаблону, для отображения к 
каждом проекте 



Глава 11: Свойства объекта и шаблоны 

BERNINA® Вышивальное ПО Версия 6  120

 
Сохранение текущих свойств в 
шаблоне 
 
Вы можете просто сохранить текущие свойства 
объекта в текущем шаблоне. См. также 
Применение свойств объекта и управление 
ими. 
 
Как сохранить текущие свойства в 
шаблоне 
1  Откройте диалоговое окно Object Properties  

(Свойства объекта). 
◄ Для использования текущих свойства 

объекта отмените выделение всех 
объектов и затем нажмите на кнопку 
инструмента Object Properties (Свойства 
объекта). 

◄ Для использования свойств для 
конкретного объекта выберите объект и 
дважды щелкните по нему. 

2  Измените настройки свойств объекта, как вам  
требуется. 

3  Щелкните по Save To Template 
(Сохранить в шаблоне). 
 Появится сообщение о подтверждении. 
 

Примечание: В шаблоне сохраняются только 
текущие свойства объекта, но не объекты 
или другие настройки в проекте. 

4  Щелкните по OK, чтобы обновить шаблон. 
5  Щелкните по OK, чтобы возвратиться к окну 

проекта.  
 Новые настройки сохраняются в шаблоне, на 

основе которого был создан проект, и 
доступны для использования. 

 
Возвращение к шаблону NORMAL 
 
Если вы изменили шаблон NORMAL, 
поставленный с ПО BERNINA Embroidery 
Software, вы можете вернуться к его 
оригинальной версии. Первоначальная копия 
всегда сохраняется, так что шаблон NORMAL 
может быть восстановлен. 
 
Как возвратится к шаблону NORMAL 
1  Закройте BERNINA Embroidery Software. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2  Нажмите на панели задач Windows кнопку 
Пуск (Start) и выберите Программы (All 
Programs) > BERNINA Embroidery Software > 
Revert. 
Откроется диалоговое окно Revert to Factory  
Template (Возврат к оригинальному 
шаблону)  

 
 
 
                 

 Выбор 
шаблонов 

 
 
 

Примечание: Может потребоваться 1 или 2  
минуты для открытия диалогового окна. 

 
 
3  Выберите опцию Templates (Шаблоны) и 

щелкните по OK. 
 

 Оригинальные настройки шаблона NORMAL 
будут восстановлены. 

 
 

Нажать 
кнопку 
ОК 
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ГЛАВА 12 
 

 
ПОВЫШЕНИЕ КАЧЕСТВА 

ВЫШИВАНИЯ 
------------------------------------------- 
 

 
BERNINA Embroidery Software предлагает большое число 
настроек, позволяющих улучшить качество и внешний вид 
вышивки в окончательном виде. Используйте настройки ткани, 
так что машина будет учитывать тип ткани, на которой 
выполняется вышивка. Используйте функцию автоматической 
стабилизации ткани для сокращения опасности искажения 
вышивки вследствие стягивания материала. Настройте 
требуемую вам величину перекрытия путем изменения установок 
компенсации стягивания. Это особенно удобно, если вы 
вышиваете проект на материалах с различной степенью 
растяжения. 
При применении функции Auto Jump (Автоматический переход) 
вы можете сохранить длинные стежки в объектах, превратив их в 
серии переходов. По умолчанию начальные закрепляющие стежки автоматически 
вставляются в начале объектов, чтобы предотвратить распускание стежков. Вы 
можете выбирать или отменять функцию закрепляющих стежков для всего проекта 
или отдельных объектов. 
Используйте команду Auto Start and End, чтобы установить положение первого и 
конечного стежков проекта. Все эти функции входят в "свойства объекта" и могут 
быть применены, отменены или модифицированы в любое время. 
 
В этом разделе рассматриваются настройки ткани, стабилизация ткани 
стабилизирующими стежками и компенсация растяжения. Кроме того, описывается 
сохранение длинных стежков, настройка закрепляющих стежков и установка 
начальных и конечных точек.  

 
 

Регулировка настроек ткани 
 
BERNINA Embroidery Software позволяет 
изменять настройки ткани, так что машина будет 
учитывать тип ткани, на которой выполняется 
вышивка. Например, настройки ткани 
предусматривают компенсацию стягивания, 
пригодную для используемой вами ткани. 
Компенсация стягивания сохраняет ваш проект 
от появления пробелов между объектами. См. 
также раздел Компенсация стягивания 
ткани. 
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Настройки стежков для различных типов ткани 
сведены в следующей таблице.  
 

 
   

Шаг стежка (мм) Плотность 
материалов 

Материалы Компенс
ация 

стягиван
ия (мм) 

гладьевый 
стежок 
(ручная 

настройка)

гладьевы
й стежок 
(автомат. 
настройка

) 

простеги
вающий 
стежок 

стабилизир
ующий 
стежок 
зигзаг 

стабилизи
рующий 
простегив
ающий 
стежок  

Заводские 
настройки 

---- 0.200 0.4 001 0.45 3.0 3.0 

Легкий 
трикотаж 

футболки 0.250 0.37 0.02 0.40 3.0 2.5 

Трикотаж 
средней 
плотности 

спортивные рубашки с 
короткими рукавами 

0.250 0.37 0.02 0.40 3.0 2.5 

Плотный 
трикотаж 

хлопчатобумажные 
трикотажные рубашки 

0.350 0.36 -0.02 0.38 2.5 2.5 

Махровая ткань 
средней 
плотности 

полотенца 0250 0.36 0.02 0.38 1.5 1.8 

Плотная 
махровая ткань 

полотенца / купальные 
халаты 

0.250 0.36 -0.02 0.38 1.5 1.8 

Легкие ткани батист / хлопок / сатин 0.200 0.38 0.03 0.40 3.0 2.8 
Средние ткани хлопок / муслин / 

полиэфир 
0.200 0.38 00 0.40 2.5 2.5 

Тяжелые ткани джинсовые ткани / 
парусина / твил 

0.200 0.38 -0.01 0.40 2.5 2.5 

 
Примечание: Новые настройки будут 
применены ко всем объектам в проекте, 
исключая текстовые объекты. Подробно см. в 
разделе Компенсация стягивания ткани. 
 
Как настраивать параметры ткани 
1 Выберите Edit (Редактировать) > Select All  

(Выбрать все). 
 Будет выделен весь проект. 
2 Выберите Settings (Настройки) > Fabric  

Settings(Настройки ткани).. 
Откроется диалоговое окно Fabric Settings  
(Настройки ткани). 
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3 Выберите тип ткани из списка Fabric Type 
(Тип ткани). 
4 Выберите для использования стандартные 

настройки или тонкую настройку для 
использования собственных значений. 
◄ Use Standard Settings (Использовать 

стандартные настройки): Изменения 
будут выполнены в соответствии с 
выбранным вами типом ткани. 

◄ Настройка параметров: Введите 
значения для тонкой настройки. Значение 
больше 100 увеличит интервал между 
стежками. Значение меньше 100 
уменьшит интервал между стежками. В 
некоторых случаях будет отрегулирована 
также компенсация стягивания. 

 
    

 
Плотный трикотаж,   Плотный трикотаж,  
настройка 150 %    настройка 75% 

 

5  Щелкните по ОК. 
Выбранные настройки ткани применяются ко  
всем объектам проекта. 

 

 

Стабилизация ткани 
стабилизирующими стежками 
 

Для улучшения качества вышивки вам нужно 
добавить стабилизирующие стежки. 
Стабилизирующие стежки способствуют 
стабилизации ткани и сокращают опасность 
искажения вышивки вследствие стягивания 
материала. Они также обеспечивают 
"объемность" вышивки и предотвращают 
погружение стежков в мягкие ткани. Без 
применения стабилизации ткани слои 
вышивальных стежков выглядят плоскими. Они 
не только выглядят плоскими, но и часто сквозь 
них просматривается ткань подложки. 
Начинающие пользователи могут попытаться 
увеличить плотность стежков, но более 
эффективным является правильное применение 
стабилизации ткани. 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

Применение автоматической 
стабилизации ткани 
 

Используйте инструмент Auto Underlay     
(панель General) для упрочнения и 
стабилизации проектов вышивки 
автоматически выполняемыми 
стабилизирующими стежками. 

 

Функция стабилизация ткани Auto Underlay 
генерирует стабилизирующее простегивание 
объектов в соответствии с установками, 
выбранными в диалоговом окне Effects 
(Эффекты). Вы можете заранее установить 
функцию Auto Underlay, чтобы обеспечить 
стабилизацию ткани для всех вновь 
создаваемых объектов вашего проекта. 
Настройки стабилизации ткани сохраняются для 
каждого объекта таким же образом, как и другие 
свойства объекта. Следовательно, они 
регенерируются при любом изменении размеров 
или формы объекта. 
 
 

Как применять автоматическую 
стабилизацию ткани 

1 Щелкните правой кнопкой мыши по 
значку Auto Underlay (Автоматическая 
стабилизация ткани)  
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Откроется диалоговое окно Effects - Underlay. 
 
Стабилизирующие 
стежки 
автоматически 
генерируются  
для новых объектов  
 
 
 

 
 
2  Выберите Use automatic underlay settings 

for new objects (Использовать настройки 
автоматической стабилизации для новых 
объектов), если  эта функция еще не 
выбрана. 

 
Внимание: При использовании этой опции, 
программа BERNINA Embroidery Software 
всегда пересчитывает автоматические 
установки, даже если вы сохранили в 
шаблоне собственные настройки. См. также 
раздел Применение выборочной 
стабилизации. 
 
3  Щелкните по Apply (Применить) 
 
Стабилизирующие стежки автоматически 
генерируются для любых новых объектов и всех 
выбранных объектов.   
Как для новых, так и для выбранных объектов 
автоматически генерируемые стабилизирующие 
стежки основываются на текущих свойствах. 

 
Оцифровка блока 
простегивающими стежками – 
стабилизация простегивающими  
стежками 
 
Замкнутая кривая 
простегивающими стежками – 
стабилизация простегивающими 
стежками 
 
Оцифровка блока стежками 
зигзаг – стабилизация стежками 
зигзаг 
 
 
 
Замкнутая кривая гладьевыми 
стежками  
– стабилизация простегивающими 
стежками 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Применение выборочной 
стабилизации 
 

Используйте инструмент Auto Underlay 
(панель General) для упрочнения и  
стабилизации проектов вышивки 
автоматически выполняемыми 
стабилизирующими стежками. 

 
Функция стабилизация ткани Auto Underlay 
генерирует стабилизирующее простегивание 
объектов в соответствии с установками, 
выбранными в диалоговом окне Effects 
(Эффекты). Вы можете заранее установить 
функцию Auto Underlay, чтобы обеспечить 
стабилизацию ткани для всех вновь 
создаваемых объектов вашего проекта. 
 
Как применять выборочную стабилизацию 
ткани 
 
1  Щелкните по Auto Underlay, чтобы 
активировать эту функцию. 
 
Совет: Чтобы выполнить настройки до 
оцифровки, щелкните правой кнопкой по Auto 
Underlay для доступа к диалоговому окну Effects 
> Underlay. 
 

2  Создайте замкнутую фигуру - окружность или 
квадрат. Подробнее см. в разделе  
Методы оцифровывания. 

 Объект оцифровывается с использованием 
текущих настроек Auto Underlay. 
 

3  Если вы хотите изменить настройки 
стабилизирующих стежков, выберите объект 
и щелкните правой кнопкой по Auto Underlay. 
Откроется диалоговое окно Effects > 
Underlay. Эта закладка дает возможность 
выбрать одинарные стабилизирующие 
стежки и комбинацию первого и второго вида 
стежков. 

 
 
 
 
 

 
 
 
 
 
4  Выберите Apply Underlay 1 и вид 

стабилизирующего стежка из списка.. 
 

Выберите 
первый тип 

стабилизации 
и вид стабилизи-
рующего стежка 
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Тип стабилизации, который вы должны выбрать, 
определяется его назначением.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Примечание: Не все типы 
стабилизирующих стежков применимы для 
всех выбранных объектов. 
 

5  Настройте длину стежка и ширину полей. 
Подробнее см. в разделах Настройка 
параметров стабилизирующих 
стежков с обходом по краю, 
Настройка параметров 
стабилизирующих стежков зигзаг и 
Установка ширины полей зоны 
стабилизации ткани. Как только вы 
выберете опцию Apply Underlay 1, 
становится активным окошко опции 
Apply Underlay 2.  Все типы 
стабилизирующих стежков, доступные 
для Underlay 1, доступны также и для 
Underlay 2.  

 

 
 
Выберите 
второй тип  
стабилизации 
и вид 
стабилизирующего стежка  
 
 
6  Для усиленной стабилизации выбирайте 

второй тип.  
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
Можно использовать любую комбинацию 
стабилизирующих стежков 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Внимание: Однако вы должны 
использовать простегивающий стежок 
только один раз, т.е. не рекомендуется 
использовать его в Underlay 1 и Underlay 2. 
 
 

7  Щелкните по Apply (Применить) 
Новые или выделенные объекты 
используются с новыми настройками. 
 
8   Для сохранения ваших настроек, 
нажмите Save To Template (сохранить в 
шаблон). См. также раздел Сохранение 
текущих свойств в шаблоне. 
 
9   Выберите опцию Use automatic underlay 
settings for new objects (использование 
автоматических настроек для новых 
объектов), если она еще не была выбрана 
ранее. 
 
Внимание: При использовании этой опции, 
программа BERNINA Embroidery Software 
всегда пересчитывает автоматические 
установки, даже если вы сохранили в 
шаблоне собственные настройки. См. также 
раздел Применение автоматической 
стабилизации ткани. 
 

Выбраны 
стабилизирующие  
стежки зигзаг 
 
Выбраны простегивающие  
стабилизирующие стежки  
 

 
Выбраны двойные  
стабилизирующие стежки  
зигзаг 
 
Выбраны 
стабилизирующие  
стежки с обходом по краю 
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Настройка параметров 
стабилизирующих стежков с 
обходом по краю 
  

Щелкните правой кнопкой мыши по  
Auto Underlay (панель General) для 
изменения настроек  

   автоматической стабилизации. 
 
Функция Edge Walk (Обход по краю) располагает 
стежки по краям объекта. Настройте длину 
стежка для стабилизирующих стежков типа Edge 
Walk, чтобы обеспечить вписывание 
стабилизирующих стежков в криволинейные 
формы и чтобы эти стежки не были заметны в 
окончательной вышивке. 
 
Примечание: Настройки стабилизирующих 
стежков типа Edge Walk сохраняются отдельно и 
не воздействуют на настройки покрывающих 
стежков. 
 
Как настраивать параметры 
стабилизирующих стежков с обходом по 
краю 
 
1  Выберите  сделать ли настройки текущими 
или применить их к выбранным объектам. 

• Нажмите Esc, чтобы убедиться, что ни 
один объект не выделен. 

• Или же выберите один или несколько 
объектов, чтобы применить к ним 
настройки.  

 
2  Щелкните правой кнопкой по значку Auto 

Underlay (Автоматическая стабилизация 
ткани). 
Откроется диалоговое окно Effects >  
Underlay. 

 
 
 
 
 
Выберите   
Edge Walk  
 
 
3 Проставьте флажок в окошке Apply Underlay 

1 выберите Edge Walk в качестве типа 
стабилизирующих стежков.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4 Введите специфичную длину стежка.  
  

               
Длина стабилизирующего    Длина стабилизирующего  
стежка Edge Walk: 1,5 мм    стежка Edge Walk: 3,5 мм  
 

5  Щелкните по Apply.  
     Новые или выделенные объекты  
      используются с новыми настройками. 
 
Настройка параметров 
стабилизирующих стежков зигзаг и 
двойной зигзаг 
 
  

Щелкните правой кнопкой мыши по 
Auto Underlay (панель General) для 
изменения настроек автоматической  

             стабилизации. 
 
Используйте стабилизирующие стежки зигзаг и 
двойной зигзаг для стабилизации широких 
колонок. Вы можете установить длину 
стабилизирующих стежков Zigzag (Зигзаг) и 
Double Zigzag (Двойной зигзаг). 
Стабилизирующие стежки Double Zigzag 
подходят только для контуров или букв, 
выполняемых гладьевым валиком. 
 
Примечание: Настройки стабилизирующих 
стежков зигзаг сохраняются отдельно и не 
оказывают влияния на настройки покрывающих 
стежков зигзаг. 
 
Как настроить параметры 
стабилизирующих стежков зигзаг и 
двойной зигзаг 
 
1  Выберите  сделать ли настройки текущими 

или применить их к выбранным объектам. 
• Нажмите Esc, чтобы убедиться, что ни 

один объект не выделен. 
• Или же выберите один или несколько 

объектов, чтобы применить к ним 
настройки.  

2  Щелкните правой кнопкой по значку Auto 
Underlay (Автоматическая стабилизация 
ткани). 
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Откроется диалоговое окно Effects > Underlay. 
 
 

Выберите 
Zigzag  

или Double 
Zigzag 

 
 
 
3 Проставьте флажок в окошке Apply Underlay 

1 и выберите Zigzag или Double Zigzag в 
качестве типа стабилизирующих стежков.  

4 Введите требуемую длину стежка. 
5  Щелкните по ОК. 
      

 
Длина стежка зигзаг:: 5 мм   Длина стежк :зигзаг:: 2,5 мм 

 
Длина стежка двойной зигзаг::  Длина стежка двойной зигзаг:: 

7 мм        3,5 мм 
5  Щелкните по Apply.  
 
Установка ширины полей зоны 
стабилизации ткани 
  

Щелкните правой кнопкой мыши по 
Auto Underlay (панель General) для 
изменения настроек автоматической 
стабилизации. 

 
Поле стабилизации ткани – это расстояние 
между контуром объекта и краем зоны 
стабилизации ткани.  
 
 
Увеличивайте ширину этого поля, чтобы не 
допустить выхода стабилизирующих стежков за 
пределы контура покрывающих стежков. 

п

о
л
е
 
з
о
н
ы
 
с
т
а

Как установить ширину поля зоны 
стабилизации 
 
Выберите, сделать ли настройки текущими 
или применить их к выбранным объектам. 

• Нажмите Esc, чтобы убедиться, что ни 
один объект не выделен. 

• Или же выберите один или несколько 
объектов, чтобы применить к ним 
настройки.  

Щелкните правой кнопкой по значку Auto 
Underlay (Автоматическая стабилизация 
ткани). Откроется диалоговое окно Effects > 
Underlay. 
 
 
 
 
 
Выберите  
тип поля 
 
   
 
2 Из открывшегося списка выберите тип поля 

(Margin)    
                       
Нормальное 

 
 
 
 

Среднее 
 
 
 
 

Широкое 
 

 
 
 
 4 Щелкните по Apply. 
 
Новые или выделенные объекты используются с 
новыми настройками. 
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Компенсация стягивания ткани 
 

Используйте  кнопку Object Properties 
(панель General), чтобы выбрать 
настройки компенсации стягивания. 

 
Вышивальные стежки втягивают ткань внутрь во 
время прокола иглой. Это может вызвать 
сморщивание ткани и образование пробелов в 
вышивке. Формы окончательной вышивки 
становятся несколько уже и длиннее, чем она 
выглядели на экране. Функция компенсации 
стягивания учитывает это явление путем 
"перекрытия" контуров заполняемых форм на тех 
сторонах, в которые втыкается игла. 
Применяйте автоматическую компенсацию 
стягивания к объектам в проекте до или после 
оцифровывания.  
 

Компенсация стягивания 
 

 

Оцифрованный контур 
 Расчетный контур 

 

Величина перекрытия, требуемая для 
компенсации стягивания, зависит от ткани, на 
которой вы намерены вышивать. 
Поэкспериментируйте с тканями, которые вы 
хотите использовать, и посмотрите, подходит ли 
выбранная величина компенсации. Для 
ориентировки можно использовать данные 
приводимой ниже таблицы.  
 
Ткань Компенсация стягивания 

(мм) 
тик, хлопок 0.1 
футболка 0.2 
шерсть, трикотаж 0.25 - 0.3 
текст 0.2 - 0.3 
 
Вы можете также отрегулировать величину 
компенсации ткани, чтобы подогнать ее к 
подготовленной для вышивания ткани, выбрав 
Settings > Fabric Settings. Подробнее см. в 
разделе Регулировка настроек ткани. 
 

Совет: Применяйте стабилизирующие стежки и 
соответствующие нижние и верхние прокладки, 
чтобы дополнительно уменьшить эффект 
стягивания ткани. Подробнее см. в разделе 
Стабилизация ткани стежками. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Как применять автоматическую компенсацию 
стягивания ткани 
1  Выберите,  сделать ли настройки текущими 

или применить их к выбранным объектам. 
• Нажмите Esc, чтобы убедиться, что ни 

один объект не выделен. 
• Или же выберите один или несколько 

объектов, чтобы применить к ним 
настройки.  

2  Щелкните по значку Object Properties 
 Откроется диалоговое окно Object 
Properties. 
3  Щелкните по кнопке Effects (Эффекты) и 
выберите вкладку Others (Другие). 
4  Проставьте флажок в окошке Pull 
Compensation (Компенсация ткани). 
 

 
             Выберите  
Pull Compensation 
 
 
 
 

5  Щелкните по Apply (Применить) 
 Новые или выделенные объекты 
используются с новыми настройками. 
 

                 

 
Компенсация стягивания    Компенсация стягивания  
ВКЛЮЧЕНА       ВЫКЛЮЧЕНА 
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Совет: Функция Pull Compensation 
(Компенсация стягивания) по умолчанию 
устанавливается на 0,2 мм. Эта величина 
подходит для большинства проектов. Однако 
для применения с автоматической оцифровкой 
рекомендуется 0,4 мм. 
 

6  Введите при необходимости величину 
перекрытия (в миллиметрах). 

Компенсация 0,2 мм        Компенсация 0,5 мм 
 

7  Щелкните по Apply (Применить) 
 Новые или выделенные объекты 

используются с новыми настройками. 
 

Совет: Щелкните по Save To Template 
(Сохранить в шаблоне) перед закрытием 
диалогового окна, чтобы сохранить настройки. 
Сохраненные настройки будут применены ко 
всем новым проектам, основанным на текущем 
шаблоне. Подробнее см. в разделе Свойства 
объекта и шаблоны. 

Сохранение длинных стежков 
функцией Auto Jump 
  

Используйте  кнопку Object Properties 
(панель General), чтобы настроить 
функцию Auto Jump 

 

Вышивальные машины способы выполнять 
стежки максимальной длины, определяемой 
ограничениями самой машины по перемещению 
пялец. Если длина стежка превышает это 
ограничение, то длинный стежок подразделяется 
не несколько мелких стежков. Это может 
повлиять на внешний вид вышивки, особенно 
гладьевого застила. При применении функции 
Auto Jump (Автоматический переход) вы 
можете сохранить длинные стежки, превратив их 
в серии переходов. См. также раздел Разбивка 
длинных стежков гладьевого заполнения. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
макс. длина стежка 

      
длинный стежок разбит на несколько коротких  
стежков-переходов 

 
Для создания узких колонок с большей 
выпуклостью, чем при нормальном гладьевом 
заполнении, применяйте Auto Jump в сочетании 
с подходящими стабилизирующими стежками с 
установленной максимальной длиной на 
небольшое значение, например 6 мм. При 
коротких покрывающих стежках разбивка их 
переходом делает их рыхлыми и, таким образом, 
они более эффективно приподнимаются над 
тканью. Подробнее см. в разделе 
Стабилизация ткани стежками. 
 
Автоматический переход может быть 
использован с оцифровываемыми вручную 
стабилизирующими стежками. Эта функция 
может быть использована также для создания 
эффекта стежки, например, при ее применении к 
заполненным гладьевым застилом формам, 
покрываемым сверху переходными или 
узорными стежками.  
 
Функция Auto Jump сохраняется в свойствах 
объекта и по умолчанию отключена.  Вы можете 
изменять ее настройки в любое время для 
выбранных или заново созданных объектов в 
диалоговом окне Object Properties. Настройки 
Auto Jump могут быть приспособлены к 
заполняющему стежку, оконтуривающему 
гладьевому стежку и оконтуривающему 
обметочному стежку. 
 
Как применять функцию Auto Jump 
 
1  Выберите,  сделать ли настройки текущими 

или применить их к выбранным объектам. 
• Нажмите Esc, чтобы убедиться, что ни 

один объект не выделен. 
• Или же выберите один или несколько 

объектов, чтобы применить к ним 
настройки.  

2  Щелкните по значку Object Properties 
 Откроется диалоговое окно Object  
      Properties. 
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3  Щелкните по кнопке Effects (Эффекты) и 
выберите вкладку Others (Другие). 
 
Выберите Auto 

Jump  
Введите макс. 
длину стежка  

и длину 
переходного 

стежка 
 

 
4 Проставьте флажок в окошке Auto Jump и 

нажмите кнопку Apply. 
 
длинные переходные стежки 

 

    
                               БЕЗ переходных стежков 
 
5 В поле Maximum Stitch (Макс. стежок), 

введите максимально допустимую длину 
стежка. К стежкам, длины которых превышает 
максимально допустимую, будет применена 
функция Auto Jump. 

            
    Макс. длина стежка: 10 мм      Макс. длина стежка: 12,1 мм 
 

Установите максимальную длину стежка на 
величину, превышающую самый длинный 
гладьевый заполняющий стежок, который вы 
хотите применять в своем проекте, в 
противном случае некоторые гладьевые 
стежки будут разбиты на два или больше 
стежков. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
6  В поле Jump Length (Длина переходного 
стежка)  введите длину каждого переходного 
стежка. 

         
Длина переходного стежка: 7 мм   Длина переходного стежка: 4 мм 
  
Совет: Короткие переходные стежки 
увеличивают время вышивания, но 
способствуют более плавному движению пялец 
поперек проекта. 
 
7  Щелкните по Apply. 
 Новые или выделенные объекты 
используются с новыми настройками. 
 
Совет: Щелкните по Save To Template 
(Сохранить в шаблоне) перед закрытием 
диалогового окна, чтобы сохранить настройки. 
Сохраненные настройки будут применены ко 
всем новым проектам, основанным на текущем 
шаблоне. Подробнее см. в разделе Свойства 
объекта и шаблоны. 
 

Соединение объектов вышивки 
 
Объекты проекта связываются 
соединительными стежками. Они принимают 
форму "переходных стежков" или "переходов" и 
отображаются в режиме Design View но не 
видны в режиме Artistic View. В идеале требуется 
так планировать вышивку, чтобы 
соединительные стежки позже перекрывались 
другими элементами проекта. Если 
соединительные стежки не перекрываются, то 
после вышивания проекта они должны быть 
обрезаны. 
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Соединительные стежки генерируются 
автоматически, но вы можете изменить 
последовательность вышивания, чтобы свести к 
минимуму число обрезок. Вы можете даже 
изменять положение начальной и конечной 
точек, но Функция Closest Join (по умолчанию) 
автоматически рассчитывает замкнутое 
соединение между объектами во время 
оцифровывания.  Подробнее см. в разделе  
Настройка других общих опций. 
 
Переходные стежки 
Переходные стежки автоматически 
добавляются, когда игле нужно перейти между 
сегментами внутри объектами. 
 
Они всегда перекрываются покрывающими 
стежками, но иногда могут быть заметны. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
   

 
Переходной стежок Строчка переходного      Начальная точка 

стежка видна          изменена, 
                       переходных  
                                     стежков НЕТ 

   
Длина переходных стежков сводится к минимуму 
при подгонке начальной и конечной точек 
следующих друг за другом объектов. Вы можете 
вручную изменять положение начальной и 
конечной точек методом As Digitized, но 
функция Closest Join (по умолчанию) 
автоматически рассчитывает замкнутое 
соединение между объектами во время 
оцифровывания.  
Подробнее см. в разделе Настройка других 
общих опций. 
 
 

Проходные стежки 
 

При выполнении проходного стежка пяльцы 
перемещаются от одной части проекта к другой 
без прокола материала иглой. Нитки проходного 
стежка, как правило, необходимо обрезать. 
Соединительные проходные стежки 
отображаются в режиме Stitch View пунктирной 
или сплошной линией. Сплошная линия 
используется для коротких переходов. 
Пунктирные линии используются при  длинном 
(более 12,1 мм) переходе.  

Соединительные стежки 
As Digitized 

Соединительные стежки 
Closest Join 

В режиме Artistic View 
соединительные стежки не 
видны 
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При изменении цвета линия будет 
штрихпунктирной. 
 

           
Короткий переход: сплошная линия 

           
 Длинный переход: пунктирная линия 

 

                
Изменение цвета: штрихпунктирная линия. 

 

При длинных проходных соединительных 
стежках игла протыкает материал через каждые 
7 мм. Из-за этого машина останавливается 
несколько раз во время медленного 
перемещения пялец к следующей точке прокола 
иглой.   
 

Примечание: По умолчанию длина проходного 
соединительного стежка та же, что установлена 
для функции Auto Jump. 
 

Начальные / конечные закрепляющие 
стежки 
 

Начальные и конечные закрепляющие стежки 
являются дополнительными стежками, 
добавляемыми до и после переходов и 
изменений цвета, чтобы нитки можно было 
обрезать без распускания стежков . 
 
Начальные закрепляющие стежки 

 
 
 
Конечные 

закрепляющие 
стежки 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Начальные закрепляющие стежки автоматически 
назначаются в начальной точке объекта, если 
длина соединительного стежка больше 2 мм, а 
также после смены цвета.  При гладьевом 
заполнении они вставляются внутри объекта на 
втором рабочем стежке. Подобным же образом 
конечные закрепляющие стежки вставляются 
перед соединительными стежками или перед 
сменой цвета. 
 
 
Закрепление стежков  

в начале объекта 
 
 
 
 
 
Совет: Обойдите проект по одному стежку, 
чтобы проверить наличие начальных и конечных 
закрепляющих стежков. Подробнее см. в 
разделе Обход по стежкам. 
 
 
Настройка закрепляющих стежков 
 
 

Используйте  кнопку Object Properties 
(панель General), чтобы делать 
настройки 

 

 
По умолчанию начальные закрепляющие стежки 
вставляются в начале объектов, чтобы 
предотвратить распускание стежков. Однако 
имеются исключения, когда во веем проекте нет 
начальных закрепляющих стежков или когда их 
нет в выбранных объектах, например текстовых. 
BERNINA Embroidery Software дает возможность 
изменять настройки начальных/конечных 
закрепляющих стежков. Это может 
потребоваться, например, при "реверсной 
вышивке", при которой в шпульку заправляются 
толстые нитки. Для этого конечные 
закрепляющие стежки могут не потребоваться. 
Можно обойтись без конечных закрепляющих 
стежков также и при вышивании специальными 
"креативными нитками.  В таких случаях вы 
можете отключить функцию закрепляющих 
стежков и защитить вышивку от распускания, 
обрезав нитку и продев ее на иннанку. См. также 
раздел Изменение точек входа и выхода. 
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Как настраивать закрепляющие стежки 
1  Два способа доступа к окну управления Tie-

In/Off (Начальные/Конечные 
закрепляющие стежки): 
• Для настройки текущих установок 

проекта щелкните по Object Properties 
или выберите Settings > Object 
Properties, чтобы открыть диалоговое 
окно Object Properties. 

• Для настройки отдельного объекта или 
объектов дважды щелкните правой 
кнопкой по объекту(ам), чтобы открыть 
диалоговое окно Object Properties.  

 
2  Выберите вкладку Tie-In/Off. 

На этой вкладке имеется две панели – Tie In 
Before Object (Закрепление перед 
объектом) и Tie Off After Object 
(Закрепление после объекта, – которые 
позволяют включить или отключить эту 
опцию. 

 
Примечание: В существующих проектах, 
созданных в предыдущих версиях BERNINA 
Embroidery Software или в других программах, 
шаг настройки длины соединительных стежков 
может отличаться от принятых по умолчания 2 
мм. 
 
3  Настройка при необходимости функции Tie In 
Before Object. 

• При переключении на Off начальные 
закрепляющие стежки не вставляются 
как для внешних, так и для внутренних 
соединительных стежков. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• При включении (On) начальные 
закрепляющие стежки вставляются, 
если соединительный стежок перед 
объектом длиннее 2 мм. 

 
 
Закрепления  
двумя стежками 
 
 
 

 
4  Настройка при необходимости функции Tie 
Off After Object. 
• При переключении на Off конечные 

закрепляющие стежки не вставляются как 
для внешних, так и для внутренних 
соединительных стежков. 

• При включении (On) конечные 
закрепляющие стежки вставляются, если 
соединительный стежок перед объектом 
длиннее 2 мм. 

 
 
5  Выберите способ вставки конечных 
закрепляющих стежков 

• При первом способе закрепляющие 
стежки выполняются вдоль последнего 
стежка. 

• Второй способ – между двумя 
последними стежками.  

 

Первый способ лучше подходит для нетекстовых 
объектов, второй – для текстовых объектов. 
 

6  Щелкните по Apply (Применить) 
Настройки применяются для выделенных 
объектов, если объекты не выделены, то для 
текущих ствойств. 

Настройка автоматических 
начальных и конечных точек 
 

Перед вышиванием некоторые вышивальные 
машины потребуют от вас точно 
позиционировать иглу в месте первого прокола 
материала иглой. 

Выберите метод  
Tie Off 



Глава 12: Повышение качества вышивания 

BERNINA® Вышивальное ПО Версия 6  134

 
Используйте команду Start and End (Начало и 
Конец), чтобы определить первый и конечный 
стежки проекта.  
 
Как настроить автоматические 
начальные и конечные точки 
1 Выберите команду Arrange > Start and End. 
 Откроется диалоговое окно Start and End. 
 

 
 
Выберите 
метод 
начальной 
точки иглы  
 
 
 
 
 
 
 
 
Выберите 
метод 
конечной 
точки иглы  
 
 
 
 
 
 
 
 

 
2 Выберите метод Start Needle Position 
(Начальная точка иглы) 
 

◄ First Stitch of Design (Первый стежок): 
начальная точка является первым 
стежком проекта. 
 

◄ Auto Start at (Автоматическая 
начальная точка в): Maintain 
Automatically (Поддерживать 
автоматически): начальная точка 
автоматически устанавливается с 
назначенной точки проекта. Выберите из 
предложенных опций:. 
 

 
 
 
 

◄ Digitize Start Needle Position 
(Определить начальную точку): вам 
будет предложено ввести начальную и 
конечную точку. 

 
 

       
Начальная точка:   Начальная точка:  
Первый стежок:    Auto Start 
Конечная точка:    Конечная точка:  
Последний стежок   Auto End, центр проекта 

   проекта 
  
3 Выберите метод End Needle Position 
(Конечная точка) 
 

◄ Last Stitch of Design (Последний 
стежок): последняя точка является 
последним стежком проекта. 
 

◄ Auto End at (Автоматическая 
последняя точка в): Maintain 
Automatically (Поддерживать 
автоматически): последняя точка 
автоматически устанавливается с 
назначенной точки проекта. 
 

◄ Digitize End Needle Position 
(Определить конечную точку): вам 
будет предложено ввести конечную 
точку. 
 

4  Проставьте флажок в Maintain Automatically 
(настройка по умолчанию), чтобы  
автоматически поддерживать начальную 
и/или конечную позицию иглы. 

 
5 Щелкните по ОК. 
 Соединительные стежки будут вставлены по 

необходимости перед первым и после 
последнего стежка проекта. 

 
 

 
 
Выберите начальную 
точку 
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ЧАСТЬ III 
 

ОЦИФРОВЫВАНИЕ ПО 
ХУДОЖЕСТВЕННОМУ 

ОРИГИНАЛУ 
------------------------------------------ 

 
 
 
 
Рисунок в растровом или векторном формате может быть загружен, скопирован или 
отсканирован в ПО BERNINA для использования в качестве оцифровываемого 
оригинала или трафарета.  
 

Оцифровывание с оригиналом 
 
В этом разделе описывается, как подбирать подходящие рисунки для целей 
оцифровывания, а также, как сканировать их в ПО BERNINA. Кроме того, поясняется, 
как оцифровывать рисунки, используя оригинал-трафарет, и как отображать их на 
экране и скрывать во время оцифровывания. 
Подробнее см. в главе Оцифровывание с оригиналом. 
. 
 

Обработка изображений для автоматического оцифровывания 
В этом разделе описывается, как подготавливать изображения для автоматического 
оцифровывания. Здесь также объясняется, как подготавливать оконтуренные и не 
оконтуренные изображения. 
Подробнее см. в главе Обработка изображений для автоматического 
оцифровывания 
 

Автоматическое оцифровывание 
В этом разделе описывается, как автоматически преобразовывать растровые 
изображения в проекты вышивки. Здесь также объясняется, как автоматически 
оцифровывать формы, используя Magic Wand и Auto Digitizer. 
Подробнее см. в главе Автоматическое оцифровывание.  
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ГЛАВА 13 
 

 
ОЦИФРОВЫВАНИЕ С ОРИГИНАЛОМ 

------------------------------------------- 
 
 

 
 

Электронный рисунок в растровом или векторном 
формате может быть загружен, скопирован или 
отсканирован в BERNINA Embroidery Software для 
использования в качестве оцифровываемого оригинала 
или трафарета. Можно также импортировать также 
текстурированный фон, чтобы увидеть, как будет 
выглядеть вышивка на реальной ткани. Может быть 
использован почти любой рисунок – фотография, 
журнальные иллюстрации, графические файлы и даже 
образцы ткани. 
 
Из ПО BERNINA Embroidery Software вы можете открыть 
изображения в графических программах MS Paint, Corel PHOTO-PAINT® Essential 4 
или Paint Shop Pro™. Обновленные таким образом изображения автоматически 
реимпортируются в ПО BERNINA Embroidery Software. 
 
В этом разделе описывается, как подбирать подходящие рисунки для целей 
оцифровывания, а также, как сканировать их в ПО BERNINA Embroidery Software. 
Кроме того, поясняется, как оцифровывать рисунки, используя оригинал-трафарет, 
и как отображать их на экране и скрывать во время оцифровывания. 

 

Использование оригиналов-
трафаретов 
 
Оригиналы могут быть использованы в качестве 
трафарета при ручном оцифровывании. 
Альтернативно функции полуавтоматического и 
автоматического оцифровывания BERNINA 
Embroidery Software могут конвертировать 
растровые рисунки в проекты вышивки. В общем 
случае оригиналы-трафареты помогают вам: 
◄ Оцифровывать объекты вручную.  

Калькировать контуры и линии по 
трафарету, используя подходящий 
инструмент оцифровывания. Подробнее см. 
в разделе Методы оцифровывания. 
 

◄ Автоматическое оцифровывание контуров 
производится функцией Magic Wand 
(Волшебная палочка).  
Вы выбираете контур и Magic Wand 
автоматически определяет требуемые 
стежки. 
 

◄ Автоматическое оцифровывание сложных 
рисунков производится функцией Auto 
Digitizer.  
Вы выбираете изображение и Auto Digitizer 
автоматически определяет контуры и стежки, 
требуемые для оцифровывания проекта. 
Подробнее см. в разделе Оцифровывание 
функцией Auto Digitizer. 
 

 Оцифровывание фотографий производится 
функцией PhotoSnap.  
Вы снова выбираете изображение и 
PhotoSnap автоматически определяет 
контуры и стежки, требуемые для 
оцифровывания проекта. Подробнее см. в 
разделе  
Оцифровывание  с помощью Photosnap. 
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Художественный оригинал может быть 
импортирован в BERNINA Embroidery Software 
как векторных, так и в растровых форматах. 
 
◄ Векторные графики: Они состоят из 

контуров, которые могут быть цветными и 
могут иметь цветное заполнение. Векторные 
контуры остаются тонкими и чистыми даже 
при большом коэффициенте увеличения, так 
что они могут оцифровываться достаточно 
точно. 
 

◄ Растровые рисунки: Они состоят из цветных 
точек, или пикселей. При увеличении на 
малой площади контуры становятся 
разорванными и отображаются как серий 
цветных квадратиков, или пикселей. 

 
Для создания высококачественной вышивки вам 
нужно подобрать подходящий рисунок.  В 
BERNINA Embroidery Software вы можете 
назначит общие свойства, такие как размер и 
положение. Вы можете также расположить и 
трансформировать рисунок таким же образом, 
как проекты вышивки.  
 
Предупреждение: поставляемые с 
программой образцы рисунков и вышивок 
могут использоваться только для личных 
нужд. Их нельзя продавать или как-либо 
использовать в коммерческих целях. 
Изменение формата образца – например, 
преобразование аппликации в вышивку – 
авторских прав на рисунок не отменяют.   
 
Векторные графики 
Векторные графики могут быть загружены в 
BERNINA Embroidery Software для 
использования в качестве оцифровываемых 
трафаретов. Они автоматически конвертируются 
в растровые изображения. 
      

 

Рисунок                             После оцифровывания инструментом  
                                                   Magic Wand  
 
 
 
 
 
 
 
 
 
 
 
 

 
Растровые рисунки 
 
Растровые изображения могут быть загружены 
или отсканированы в BERNINA Embroidery 
Software для использования в качестве 
оцифровываемых трафаретов. Как для ручного, 
так и для автоматического оцифровывания 
лучше всего подходят "чистые" рисунки, иногда 
рассматриваемые как карикатуры или шаржи. 
Такие рисунки имеют ограниченное количество 
чистых цветов, которые в свою очередь имеют 
четко очерченные контуры. Идеальными 
являются рисунки: 
 
◄ четко определенные, когда каждая фигура 

выполнена пикселями одного и того же 
цвета. 
 

◄ четко разделенные на блоки, когда каждая 
фигура имеет "вышиваемый" размер, по 
меньшей мере 1 кв. мм. 
 

◄ сохраненные с насыщенностью цвета по 
меньшей мере 256 цветов (8 бит) или 
предпочтительно миллионами цветов (16 
бит). (При загрузке изображений в BERNINA 
Embroidery Software насыщенность цвета 
автоматически сокращается до 256 цветов 
или меньше.) 

 
Совет: После загрузки в BERNINA Embroidery 
Software вы можете изменять размеры и 
трансформировать растровые изображения. 
Однако, если нужно изменить размеры или 
повернуть изображение, то лучше делать это во 
время сканирования. Последующее изменение 
размера может разрушить изображение. 
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Поддерживаемые графические форматы  
 
Программа BERNINA Embroidery Software 
поддерживает значительное количество 
графических форматов, как векторных, так 
и растровых: 
 

 
 
Примечание: Полное перечисление 
графических форматов можно найти в 
разделе руководства пользователя 
CorelDRAW® Essentials 4 User Guide,  
которое можно найти в разделе меню 
Windows Start > Programs. Также можно 
использовать экранную систему помощи 
Help в графическом режиме Graphics. 
 
Автоматическое оцифровывание 
Функции автоматического оцифровывания 
BERNINA Embroidery Software -- Auto Digitizer и 
Magic Wand – обеспечивают наилучшие 
результаты с изображениями, которые можно 
найти в библиотеке графических файлов или 
которые создаются по эскизам в пакете 
графических программ. Подробнее см. в 
разделах Автоматическое оцифровывание 
функцией Magic Wand и Оцифровывание 
функцией Auto Digitizer. 
 
Функции автоматического оцифровывания могут 
работать с изображениями из других источников, 
но они требуют большей или меньшей 
подготовки. Это объясняется тем, что наиболее 
доступные изображения не выполнены в чистых 
цветах. Сканирование вызывает шумы (помехи), 
в то время как графические программы 
выполняют "сглаживание", чтобы улучшить 
качество печати изображения. 
Автоматическое оцифровывание менее 
эффективно с фотографическими 

изображениями, которые могут содержать много 
размытых цветов и сложных форм. Однако на 
фотографиях вы можете обработать формы, 
которые вы хотите вышить, удалив ненужные 
детали. Альтернативно можно использовать 
PhotoSnap для создания проектов вышивки из 
отсканированных фотографий.  
 
Отсканированные изображения 
Изображения, отсканированные с бумажных 
оригиналов или 
существующих вышивок 
обычно содержат 
множество "шумовых" 
помех. В то время как 
они могут быть 
использованы для 
автоматического 
оцифровывания,     Изображение,  
                                                             содержащее помехи сканирования 
опять-таки, более лучшие результаты 
получаются при использовании относительно 
чистых изображений, содержащих блоки с 
чистыми цветами. Как правило, в эту категорию 
входят логотипы и простые рисунки, 
отсканированные с визитных карточек, шапок 
фирменных бланков, книг, журналов и т.п.  
Загрязненные изображения обычно требуют 
подготовки, заключающейся в уменьшении 
количества цветов и повышении резкости 
контуров. Подробнее см. в разделе Обработка 
изображений для автоматического 
оцифровывания. 
 
 
Изображения со сглаженными 
цветовыми переходами  
Сглаживание цветовых переходов – это 
программная техника, комбинирующая 
существующие цвета шахматным 
расположением пикселей. Она обычно 
используется для имитации цветов, 
смешиваемых из изображаемой гаммы. 
 

     
блоки со сглаженными 

цветовыми переходами 
 
Наподобие "загрязненных" изображений, 
изображения со сглаженными цветовыми 
переходами перед использованием требуют 
уменьшения количества цветов. Однако имейте 
в виду, что в то время как программное 
обеспечение отлично работает при обработке 
сглаженных цветовых переходов с четко 
определенными контурами, оно мало подходит 
для работы с изображениями, не имеющими 
четких контуров. Подробнее см. в разделе 
Обработка изображений для 
автоматического оцифровывания. 
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Изображения со сглаженными контурами 
Сглаживание контуров – это 
программная техника, 
подобная сглаживанию 
цветовых переходов, которая 
используется для смягчения 
жестких контуров, если 
цветовые блоки пересекаются. 
Она создает сглаженные 
контуры путем "размывания"         Сглаженные контуры 
пикселей при соединении цветов. 
Если техника размывания сознательно 
используется для размывания контуров, то 
перед автоматическим оцифровыванием 
следует увеличить их резкость. Подробнее см. в 
разделе Обработка изображений для 
автоматического оцифровывания. 
 
     

Сканирование изображений в 
BERNINA Embroidery Software 
 
Если у вас имеется готовое изображение, вы 
можете отсканировать его сканером, 
совместимым с протоколом TWAIN, используя 
сканирующие функции BERNINA Embroidery 
Software. Важно правильно отсканировать ваше 
изображение, если вы намерены использовать 
одну из функций автоматического 
оцифровывания; качество отсканированного 
изображения повлияет на качество 
окончательного проекта вышивки. 
 

 
Хорошее изображение:  Плохое изображение 

хорошее качество вышивки: плохое качество вышивки 
 
Подготовка оригинала для 
сканирования 
Для создания проекта вышивки, в большей или 
меньшей степени, вам не требуется каждая 
деталь изображения. Вы используете "структуру" 
изображения в большей мере, чем тонкие 
детали текстуры и цвета. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Для упрощения оригинала вы можете накрыть 
его калькой и перенести на нее только наиболее 
существенные контуры и линии, которые будут 
заполнены стежками. При сканировании 
наложите на кальку с эскизом лист белой 
бумаги. 
 

          
оригинальный рисунок  вычерчены требуемые детали 

 
Блестящие поверхности, такие как глянцевые 
фотографии, не могут быть хорошо 
отсканированы. Их следует накрывать 
чертежной калькой. Если оригинал имеет очень 
светлые цвета, обведите контуры тонким 
черным фломастером. 
 
Разрешение сканирования 
 
Для большинства сканеров требуется вводить 
информацию о требуемом разрешении 
сканирования. Величина разрешения 
определяет количество точек на дюйм (dpi), 
используемых для создания отсканированного 
изображения.  Чем выше разрешение, тем чище 
изображение, но тем больше файл. Для 
оцифровывания используйте изображения, 
отсканированные с разрешением не выше 300 
dpi. Разрешения 72 dpi (разрешение экрана) 
обычно вполне достаточно. В общем случае, чем 
меньше оригинал и/или чем больше в нем 
деталей, тем выше должно быть разрешение. 
Для ориентировки можно использовать данные 
следующей таблицы. 
 
Тип оригинала Разрешение 

сканирования 
Визитные карточки, 
шапки фирменных 
бланков 

150 - 300 dpi 

Выполненные вручную 
эскизы 

150 - 300 dpi 

Фотографии и образы 150 - 300 dpi 
Штриховые рисунки 72 - 150 dpi 
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Цветовой режим 
 
Для большинства сканеров требуется также 
вводить информацию о требуемом цветовом 
режиме. Вначале определите, с каким 
изображением вы имеете дело – со штриховым 
рисунком (черно-белым), эскизом, цветным 
рисунком, черно-белой или цветной 
фотографией, - а затем выбирайте подходящий 
режим. Черно-белый режим создает файлы 
наименьшего размера. Цветные фотографии и 
режим градации серой шкалы создают 

изображения с 256 цветами, сохраняемые в 
файлах подобного размера. Режимы ‘RGB’, ‘True 
Color’ (‘Истинный цвет’) или  ‘миллион цветов’ 
создают изображения с 16,7 млн цветов, 
сохраняемые в файлах наибольшего размера. 
Пользуйтесь приводимой ниже таблицей, чтобы 
определить, какой из режимов вам нужен для 
вашего оригинала. 
 
Примечание: Обратите внимание, что в вашем 
сканере могут использоваться другие 
обозначения режимов. 

 
Вид оригинала Пример Описание Рекомендуемый 

цветовой режим * 
Количество 
цветов в 
отсканированно
м изображении 

Штриховой рисунок 

 

Два цвета – обычно 
черный и белый 

Черно/белый рисунок 
Штриховой рисунок 

2  
2 

Эскиз/Набросок 

 

Рисунок или эскиз с 
градацией серого 

Градация серого 
Штриховой рисунок 

256  
2 

Черно-белая 
фотография 

 

Градация серого Черно/белое фото 
Градация серого 

256  
256 

Цветная фотография 

 

Много цветов Цвет RGB  
Цветное фото 

16 миллионов 
256 

Цветной рисунок 

 

Два цвета или больше Цвет RGB  
Миллионы цветов 
Цветной рисунок 

16 миллионов 
16 миллионов 
2 - 256 

 
* Различные ПО сканеров используют различные обозначения для одних и тех же режимов. 
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Советы по сканированию 
 
◄ Не сканируйте штриховые рисунки в режиме 

градации серого; в таком режиме 
получаются размытые кромки. 

◄ Цветные иллюстрации лучше сканировать в 
режиме RGB (миллион цветов), чем в 
режиме 256 цветов. Вы не сможете заметить 
различия на экране. В действительности, 
изображение в 256 цветов может выглядеть 
лучше изображения RGB. Однако BERNINA 
Embroidery Software конвертирует все 
изображения в 256 или меньше цветов при 
загрузке. Программа использует 
дополнительную информацию для создания 
лучшего изображения, чем если бы оригинал 
был отсканирован в режиме 256 цветов. 

 

    
   Отсканировано в режиме    Отсканировано в режиме  
   256 цветов       RGB (миллион цветов) 
◄ Не сканируйте цветные изображения в 

режиме CMYK, поскольку этот режим 
используется для изображений, которые 
должны быть распечатаны и в которых 
имеются цвета, отличающиеся от палитры 
RGB. 

◄ Если требуется изменить размер 
изображения, то делайте это во время 
сканирования. Последующее изменение 
размера может разрушить изображение. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Повышение четкости 
 
Некоторые программы сканирования позволяют 
применять функцию повышения четкости 
отсканированного изображения. Эта функция 
компенсирует легкое размывание 
отсканированного изображения, обусловленное 
различиями между цветами оригинала. Функция 
повышения четкости выделяет эти различия, 
которые делают края изображения более 
определенными. При этом количество деталей 
изображения не увеличивается, они лишь 
становятся более различимыми. В общем случае 
используйте функцию повышения четкости для 
изображений с хорошо выделенными контурами. 
Не используйте ее для изображений, не 
имеющих контуров. 
 
     

 
Отсканировано с      Отсканировано без 
повышением четкости     повышения четкости 
 

 
Импорт изображений в ПО 
BERNINA Embroidery Software 
Растровые рисунки и векторные графики разных 
форматах могут быть отсканированы  или 
«загружены»  в BERNINA Embroidery Software 
для использования в качестве оцифровываемых 
трафаретов.  
После загрузки в BERNINA Embroidery Software 
вы можете изменять их  размеры и 
трансформировать. Однако, если нужно 
изменить размеры или повернуть изображение, 
то лучше делать это во время сканирования.  
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Последующее изменение размера может 
разрушить изображение.  
 

 
   отсканированный рисунок     автоматически оцифрованный  
                                                                  рисунок 
 
Предупреждение: имеющиеся в программе 
рисунки,  графические вставки и образцы 
вышивок могут быть использованы только в 
личных целях. Продажа или какое-либо их 
коммерческое использование не 
допускается. Изменение формата образца – 
например, преобразование аппликации в 
вышивку – авторских прав на рисунок не 
отменяют. 
 
Сканирование рисунка 
 

Для загрузки, 
редактирования и 
сохранения рисунков в 

качестве фона для вышивок, используйте режим 
Art Canvas. Для сканирования рисунков и 
сохранения их в программе BERNINA Embroidery 
Software  используйте функцию Scan Picture (на 
панели изображений Image toolbar). 
 

Используйте функцию Scan Picture 
(меню Picture) для сканирования в 
BERNINA Embroidery Software. 

 
Вы можете сканировать непосредственно в 
BERNINA Embroidery Software для 
использования в качестве оцифровываемых 
трафаретов.  
Сканирующие функции BERNINA Embroidery 
Software позволяют вам использовать 
большинство совместимых с протоколом TWAIN 
сканеров. Вы можете использовать любое ПО 
сканера, если оно способно сохранять 
изображения в одном из совместимых 
форматов. 
 
Примечание Вы можете также сканировать в 
ваш собственный текстурированный фон, чтобы 
увидеть, как будет выглядеть вышивка на 
реальной ткани. Ткани могут быть 
отсканированы, чтобы получить полный 
отцентрованный фон вашего проекта или фон в 
виде небольших образцов, расположенных, как 
плиточная кладка, заполняющая экран. См. 
также Изменение фона. 

Как сканировать рисунок 
1  Установите ваш сканер. 
 Подробнее см. в разделе Настройка 

сканера. 
2  Подготовьте оригинал для сканирования 
 Подробнее см. в разделе Подготовка 

оригинала для сканирования. 
3  Создайте новый файл или откройте проект, в 

который вы хотите загрузить 
отсканированный рисунок. 

4  Нажмите кнопку Art Canvas. 
5  Нажмите кнопку Scan Picture (Сканировать 

рисунок). 
 Откроется ваша программа сканирования. 
6  Выберите режим сканирования и 

разрешение. 
 Подробнее см. в разделах Разрешение 
сканирования и Цветовой режим. 
 

Совет: Если вы сканируете ткань для фона, 
установите сканирование на 256 цветов, 100 
% и 72 dpi. Такие настройки позволят 
получить файл небольшого размера, который 
будет хорошо отображаться на экране, не 
занимая много места на жестком диске или в 
памяти компьютера. 

 
7  Просмотрите изображение в программе 

сканирования. 
8  Выберите зону сканирования и отсканируйте 

изображение. 
9  Сохраните рисунок в совместимом 

графическом формате в папке My Designs. 
 Подробнее см. в разделе Оцифровывание с 
оригиналом 
 

Примечание: Отсканированные оригиналы 
являются растровыми изображениями и 
должны сохраняться отдельно от файлов 
проектов или они будут удалены при 
закрытии проекта. Подробнее см. в разделе 
Сохранение оригиналов в отдельных 
файлах. 
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Загрузка рисунков 
 

 Используйте режим Art 
Canvas для загрузки, правки и 

сохранения рисунков в качестве оригинала для 
оцифровывания. 
 

 Используйте функцию Load Picture 
(меню Picture) для загрузки изображения 
в качестве оцифровываемого  

               трафарета. 
 
Вы можете загружать растровые изображения в 
различных форматах для использования в 
качестве оцифровываемых трафаретов. 
Подробнее см. в разделе Оцифровывание с 
оригиналом. 
 
Примечание: При загрузке в BERNINA 
Embroidery Software векторные рисунки 
конвертируются в растровые изображения. 
 
Как загружать рисунки 
1  Выберите режим Art Canvas. Нажмите кнопку 

Load Picture (Загрузить рисунок). 
 Откроется диалоговое окно Import. 
 
Выберите папку 

 
Выберите требуемый формат 

 
2  Выберите папку из списка и выберите тип 

файла из списка Files of Type (например, 
BMP). 
 
 
 

 

 
3  Выберите файл, который вы хотите загрузить 

и нажмите кнопку Import. 
4 Расположите рисунок в окне проекта 
Design Window как вам надо. 
5 Воспользуйтесь одной из автоматических 
функций преобразования, или используйте 
рисунок в качестве фона для оцифровки: 

• Преобразуйте векторную графику в 
формат вышивки.  См. раздел 
Оцифровка векторной графики. 

• Преобразуйте растровую графику в 
формат вышивки.  См. раздел 
Автоматическое оцифровывание 

• Перейдите в режим Embroidery 
Canvas и используйте 
импортированный рисунок в 
качестве фона для оцифровки. См. 
раздел  Методы оцифровывания. 

 
Примечание: Если вы не можете 
просмотреть загруженный рисунок, 
проверьте, активна ли иконка Show Picture. 
См. раздел Отображение или скрытие 
оригинала. 
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Просмотр графических вставок 
Программа CorelDRAW® Essentials 4 
поставляется с набором графических вставок и 
рисунков, которые можно использовать в 
качестве фона для оцифровки вышивок или 
прямо преобразовать в вышивки. См. раздел 
Преобразование векторных рисунков в 
вышивки 
 
Для просмотра графических вставок 
1 Войдите в папку  CorelDRAW® Essentials 4 с 
помощью меню Windows Start > Programs. 
 

 
 
2 Откройте папку Clipart. 
 

 
3 Найдите в папке интересующее вас 
изображение. 
 
Примечание: Чтобы открыть рисунок в 
программе BERNINA Embroidery Software, 
вам придется воспользоваться функцией 
Art Canvas. См. раздел  Загрузка 
рисунков. 
 
Совет: Возможно, удобнее будет 
скопировать всю папку CorelDRAW® Clipart 
В раздел меню My Designs - 
Embroidery Software 6. 
 
 
 

Редактирование 
импортированных 
изображений 
Как при ручной, так и при автоматической 
оцифровке вам может потребоваться 
кадрировать изображение перед оцифровкой. 
Вы можете сделать это в ПО Embroidery Software  
или же с использованием других графических 
программ. Иногда вам может потребоваться 
сохранить оригиналы в виде отдельных файлов 
после сканирования или кадрирования. 
Совет: Как для ручного, так и для 
автоматического оцифровывания лучше всего 
подходят "чистые" рисунки, иногда 
рассматриваемые как карикатуры или шаржи. 
Сканирование вызывает шумы (помехи), в то 
время как графические программы выполняют 
"сглаживание", чтобы улучшить качество печати 
изображения. См. также Подготовка 
изображений для автоматического 
оцифровывания. 
 
Кадрирование изображений для 
оцифровывания 
 
BERNINA Embroidery Software позволяет вам 
кадрировать изображения перед 
использованием.  
 

Перед использованием растрового рисунка для 
целей оцифровывания обрежьте его, чтобы 
удалить ненужные детали и сэкономить время, 
требуемое для обработки. 
 
Как кадрировать изображения для 
оцифровывания 
1  Отсканируйте или загрузите изображение, 

которое вы хотите использовать. Подробнее 
см. в разделе Импорт изображений в 
BERNINA. 

 

2  Выберите изображение и  инструмент 
кадрирования. 
◄ Выберите Edit > Crop Image > Rectangle, 
чтобы обрезать изображение в форме 
прямоугольника. 
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◄ Выберите Edit > Crop Image > Oval, чтобы 
обрезать изображение в форме овала. 
                     
◄ Выберите Edit > Crop Image > Heart, 
чтобы обрезать изображение в форме 
сердца. 
 

 
              
 
 

 
 
 
 

◄ Выберите Edit > Crop Image > Star, чтобы 
обрезать изображение в  форме звезды. 

 
 
 
 
 
 
 
 

◄ Выберите Edit > Crop Image > Curve, 
чтобы обрезать изображение в произвольной  
      форме.  

 
◄ Наметьте точки, чтобы создать форму 
обрезки вокруг нужной вам части 
изображения и нажмите Enter. 
 
 
 
 
 
 
 
 
 
 
 
 
Совет: Используйте указания в строке 
подсказки. BERNINA Embroidery Software 
кадрирует зону внутри кадрирующего прямо- 
или многоугольника. Этот процесс может 
занять определенное время. 

 
 

Изменение формы кадрированных 
изображений 

 
 Нажмите Reshape Object (Изменить 
форму объекта) на панели Edit, чтобы 
кадрировать изображение в  

             произвольной форме. 
 

После обрезки изображения вы можете 
изменить форму и трансформировать 
контуры кадрирования таким же образом, как 
вы изменяете форму и трансформируете 
текстовые объекты. Вы можете также 
использовать этот инструмент для 
перемещения контуров кадра. Подробнее см. 
в разделе Изменение формы текста. 

 
 
Как изменять форму кадрированных 
изображений 
1  Кадрируйте изображение. Подробнее см. в 

разделе Кадрирование изображений для 
оцифровывания. 

 
2  Выберите изображение. 
             

 
 
 
 
 
 
 
 
 
 
 
3  Нажмите 

кнопку Reshape Object. 
На изображении отобразится контур обрезки 
с контрольными точками изменения формы. 
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4  Переместите контрольные точки, чтобы 
изменить форму и нажмите Enter, затем 
Esc, чтобы завершить операцию. 

 
    
 
 
 
 
 
 
 

Редактирование изображений в 
пакете графических программ  
 

Загружайте, 
редактируйте и 
сохраняйте рисунки в 
качестве фона для 
оцифровки вышивок с 
помощью всех 
графических функций 
пакета CorelDRAW® 
Essentials 4. Эта программа 
позволяет также 
преобразовывать 
векторную графику и 
векторные тексты в 
объекты вышивания. 

 
 Используйте функцию Touch Up Picture 
(меню Image), чтобы редактировать 
изображение в пакете графических  

               программ. 
 
Из BERNINA Embroidery Software вы можете 
открыть изображение в другой графической 
программе, которое поможет улучшить 
отсканированное вами изображение. Можно 
удалить фон, залить цветом определенные зоны 
или контуры, заполнить пробелы, добавить или 
усилить контуры. Обновленные таким образом 
изображения автоматически реимпортируются в 
BERNINA Embroidery Software. 
Имеется много графических программ, которые 
помогут вам улучшить отсканированное 
изображение. Наиболее простой из них является 
программа Paint. Она входит в пакет приложений 
ОС Windows и может работать со многими 
форматами или цветовыми преобразованиями. 
Наиболее сложными являются 
профессиональные программы, такие как 
программа Corel Photo Paint Essential 4.. Такие 
программы могут делать почти все, но они 
слишком дорогие для использования от случая к 
случаю. Отличным компромиссом является 
программа Paint Shop Pro, которая обладает 
многими функциями программ высшего уровня, 
но намного меньше стоит. 

Как редактировать изображения в пакете 
графических программ  
1  Отсканируйте или загрузите изображение, 

которое вы хотите использовать. Подробнее 
см. в разделе Импорт изображений в 
ПО BERNINA Embroidery Software. 
 

2  Выберите изображение в режиме Art Canvas.  
 

Используя 
графическую 
программу,  
чтобы вырезать 
часть, которую 
нужно вышить 

 
 
 
 
 
 
3  Нажмите кнопку Touch Up Picture (Отделка 

рисунка. 
 Изображение откроется в программе Corel 

PHOTO-PAINT Essentials 4. 
 
 
4  Отредактируйте изображение при 

необходимости. 
 
 
 
 
кадрирование 
изображения 
 
 
 
 
 
 
 
удаление фона  
 
 
 
 
 
 
 
 
добавление контуров 
 
 
 
 
 

 
5 Выберите File (Файл) > Update Design1 

(Обновить проект Design1). 
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 Изображение отобразится в BERNINA 
Embroidery Software на заштрихованном 
фоне. Это означает, что оно все еще открыто 
в графической программе. 

 
 
 
изображение все 
еще открыто  
в графической 
программе 
 
 
 
 
 
 
 
Примечание: Выберите File > Exit & Return 
<Filename>, чтобы выйти из графической 
программы и увидеть обновленное изображение 
в BERNINA Embroidery Software. 
Заштрихованный фон исчезнет. 
 
Совет: Если вы хотите сохранить графическую 
программу открытой, выберите File > Close 
после завершения обновления изображения. 
 
 
Сохранение оригиналов в отдельных 
файлах 

 
 Загружайте, 
редактируйте и 
сохраняйте рисунки в 
качестве фона для 
оцифровки вышивок с 
помощью всех 
графических функций 
пакета CorelDRAW® 
Essentials 4. IЭта 
программа позволяет также 
преобразовывать 
векторную графику и 
векторные тексты в 
объекты вышивания. 

 
 

Используйте функцию Save Picture 
(меню Image) для сохранения оригинала 
в отдельном файле. 

 

Все изображения, показываемые в окне Design 
Window при сканировании, вставке из буфера 
или загрузке с жесткого диска, сохраняются 
совместно с вышивальным проектом в файлах 
формата .ART. После правки в BERNINA 
Embroidery Software или других графических 
программах вы сможете сохранить изображение 
в отдельном файле. 
 
 
Как сохранять оригиналы в отдельных 
файлах. 
1 Отсканируйте или загрузите рисунок, 
который вы хотите использовать. См. 
раздел  Импорт изображений в ПО 
BERNINA Embroidery Software. 
2 Оставаясь в режиме Art Canvas, 
выберите рисунок. 

 
3 Нажмите иконку Save Picture (сохранить 
рисунок). Откроется диалоговое окно 
экспорта (Export dialog). 
 
      Выберите папку 

 
Введите имя файла 
                               Выберите требуемый формат 
 
4  В поле Save In (Сохранить в) выберите 

папку, затем выберите формат из списка 
Save as Type.  

5  Введите новое имя файла и нажмите Export.  
 

При сохранении проекта ссылка обновляется, 
чтобы можно было использовать новый файл 
с изображением. 

 
Примечание: Этот файл не относится к файлам 
формата .ART. Любые дальнейшие изменения в 
нем не отображаются во встроенном 
изображении. 
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ГЛАВА 14 
 

 
ОБРАБОТКА ИЗОБРАЖЕНИЙ ДЛЯ 

АВТОМАТИЧЕСКОГО 
ОЦИФРОВЫВАНИЯ 

------------------------------------------- 
 

 
BERNINA Embroidery Software поддерживает 
автоматическое и полуавтоматическое 
оцифровывание растровых изображений. Качество 
результирующего проекта в значительной мере 
зависит от типа и качества оригинального 
изображения. Чтобы сделать растровые изображения 
более пригодными для автоматического 
оцифровывания, BERNINA Embroidery Software также 
обладает возможностями обработки изображений и 
связи с графическими программами. 
В этом разделе описывается, как подготавливать 
изображения для автоматического оцифровывания.  
 
Здесь также объясняется, как подготавливать оконтуренные и не оконтуренные 
изображения. 

 

Подготовка изображений для 
автоматического 
оцифровывания. 
 
Перед применением автоматического 
оцифровывания вам часто требуется улучшить 
или "очистить" оригинал. Для эффективной 
работы инструментов Auto Digitizer и Magic Wand 
требуются изображения с чистыми цветами. Вы 
можете улучшить изображение как 
инструментами редактирования растровых 
образом в графических программах, так и 
инструментами обработки изображений, 
входящими в BERNINA Embroidery Software. В 
действительности программное обеспечение не 
позволит применить Auto Digitizer, пока 
изображение не будет должным образом 
обработано. 
 

Оконтуренные и не оконтуренные 
изображения 
Перед подготовкой изображения вам нужно 
узнать, с каким типом изображения вы имеете 
дело.  Для целей автоматического 
оцифровывания изображения делятся на две 
категории – оконтуренные и не оконтуренные. 
Оконтуренные изображения в идеале имеют  

 
сплошной черный контур вокруг каждой цветной 
зоны. Не оконтуренные изображения в идеале 
состоят из сплошных цветовых зон. 
Оконтуренные и не оконтуренные изображения 
требуют различных методов подготовки. 
 

   
Изображение с контурами   Изображение без контуров 

 
 
Очистка изображения 
На практике очистка отсканированных 
изображений может выполняться одним или 
комбинацией из нескольких технических средств: 

◄ сокращением количества цветов 
◄ добавлением или акцентированием  
      контуров 
◄ удалением "шума", сглаживанием  
     цветовых переходов или контуров 
     удалением ненужных деталей 
◄ кадрированием секций 
◄ удалением фона
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Снижение цветности 
 
Иногда изображение выглядит достаточно 
четким, но во время сканирования или в 
графической программе к нему добавляются 
дополнительные цвета. Снижение цветности 
означает уменьшение фактического количества 
цветов изображения для устранения ненужных 
деталей и приведения каждого блока к единому 
цвету. Снижение цветности вызывает также 
очистку изображения с удалением шума 
(нежелательных крапинок) и сглаживанием 
переходов между пикселями, если это 
необходимо. Это, в свою очередь, сводит к 
минимуму число обрезок и изменений цветов, 
требуемых в окончательном проекте вышивки. 
Снижение цветности в не оконтуренных и  
изображениях выполняется инструментом Image  
Preparation (Подготовка изображения). 
 
Снижение цветности следует применять лишь в 
том случае, если потеря детали не приведет к 
искажению форм изображения. Перед 
снижением цветности цветовые зоны 
изображения (см. рисунок внизу) содержат много 
цветов. После снижения цветности каждая зона 
окрашена единым цветом. Детали сохраняются. 

   
 

 

 

 

 
 
 

      изображение до снижения   изображение после снижения 
цветности        цветности 

 
Если у вас отсканированные изображения, 
убедитесь, что они отсканированы правильно. 
Подробнее см. в разделе Сканирование 
изображения в программу BERNINA 
Embroidery Software. 
 

Изображение отсканировано   Изображение отсканировано  
в цветовом режиме RGB    в режиме 256 цветов 
 
 
Повышение четкости контура 
 
Повышение четкости контура означает более 
четкое определение контуров, ограничивающих 
определенные цветовые блоки или формы 
оригинала. Эти контуры могут быть 
расплывчатыми уже в оригинале или сделаться 
нечеткими в процессе сканирования. Повышение 
четкости контуров важно для автоматического 
оцифровывания, поскольку программе 
становится легче идентифицировать 
определенные зоны, которые становятся 
объектами вышивки в окончательном проекте. 
Примечание: Функция повышения четкости 
контуров работает только в том случае, если в 
изображении имеются черные или темные 
контуры. 

      
      
Изображение до повышения         Изображение после повышения 
     четкости контуров                       четкости контуров 
 

Некоторые изображения имеют сплошные 
контуры, но они могут быть расплывчатыми или 
незавершенными. Поэтому такие контуры 
должны быть выправлены инструментами 
подготовки изображений BERNINA Embroidery 
Software или графических программ. Подробнее 
см. в разделе Редактирование изображений в 
пакете графических программ. 
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Фильтрация шума 
Фильтрация шума означает восстановление 
сплошных цветовых блоков оригинала в 
отсканированном изображении. Это достигается 
слиянием различных цветовых оттенков в 
сплошной цвет. Фильтрация шума важна для 
автоматического оцифровывания, поскольку 
программе становится легче идентифицировать 
определенные цветовые зоны, которые 
становятся объектами вышивки в окончательном 
проекте. Эта функция очищает также размытые 
или пестрые цветовые зоны . 
 

      
    Изображение до удаления   Изображение после удаления 
    шума, пестрый цвет            шума, сплошные цвета 
 

Инструменты подготовки изображений 
Используйте инструменты подготовки 
изображений для подготовки изображений к 
автоматическому оцифровыванию. Ваш выбор 
инструмента зависит от вида изображения. 
Имеются три инструмента: 
 

Обзор способов подготовки изображения 
 
Действие Оконтуренное 

изображение 
Не оконтуренное 
изображение 

Фотография 

Сканирование оригинала •  Сканирование в 
режиме RGB  

•  Повышение четкости  

•  Сканирование в 
режиме RGB  

•  Без повышения 
четкости  

Сканирование в режиме RGB  

Сканирование штриховых 
рисунков 

Сканирование в режиме 
двух цветов 

- - 

Отделка изображения в 
графической программе 

•  Обрезка 
•  Добавление или 
правка контуров 

•  Правка цветности 
•  Удаление шума 

•  Обрезка 
•  Правка форм 
изображения 

•  Правка цветности 
•  Удаление шума 

•  Обрезка 
•  Конвертирование в шкалу 
серого 

•  Удаление фона 
•  Осветление или затемнение
•  Регулировка контраста 

Использование инструмента 
Image Preparation в BERNINA 
Embroidery Software 

Позволяет 
отрегулировать 
светлость или темноту 
контуров.  
Автоматически:  
•  усредняет цветность 
каждого оконтуренного 
блока в единый цвет 

•  удаляет зазубрины в 
кривых линиях, шум и 
размывы цвета 

•  повышает четкость  
   контуров 

Позволяет снизить 
цветность до 
назначенного числа 
цветов: Автоматически:
•  сокращает каждый 
блок до единого цвета

•  удаляет зазубрины в 
кривых линиях, шум и 
размывы цвета 

•  удаляет цвета  
   меньшие, чем  
   назначенная область 

- 

Оцифровывание •  Вручную 
•  Инструментом Magic 

Wand 
•  Инструментом Auto 

Digitizer 

•  Вручную 
•  Инструментом Magic 

Wand 
•  Инструментом Auto 

Digitizer 

В программе PhotoSnap 
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Подготовка не оконтуренных 
изображений 
 

Используйте режим Art 
Canvas  для загрузки, 
правки и сохранения  

                                    рисунков в качестве  
                                    оригинала для  
                                    оцифровывания. 
 

Используйте режим Art 
Canvas  для обработки 
рисунка для  

                                    автоматического  
                                    оцифровывания. 

 
Используйте инструмент Image 
Preparation (панель Edit), чтобы понизить 
цветность и удалить шум  

            (нежелательные крапинки) из  
            изображения. 
 
Используйте инструмент Image Preparation – 
Reduce Colors для подготовки не оконтуренных 
изображений к автоматическому 
оцифровыванию. Инструмент автоматически 
уменьшает число цветных блоков в растровых 
изображениях, удаляя зазубрины в кривых 
линиях и шум. Вы можете позволить программе 
самостоятельно уменьшить число цветов или 
задать заранее их желаемое количество. 
Последнее полезно в том случае, если вы хотите 
согласовать цвета проекта с имеющимися у вас 
цветными нитками. 
 

Совет: В зависимости от качества 
отсканированного изображения вам может 
потребоваться выправить их вручную перед 
обработкой в BERNINA Embroidery Software. Вы 
можете сделать это, чтобы удалить фон, залить 
цветом определенные зоны или контуры, 
заполнить пробелы, добавить или усилить 
контуры. Подробнее см. в разделе 
Редактирование изображений. 
     

 
Использован инструмент            Оцифрованнное изображение 

 
Как подготавливать не оконтуренные 
изображения 
1  Отсканируйте или загрузите изображение, 

которое вы хотите использовать. Подробнее 
см. в разделе Импорт изображений в 
BERNINA Embroidery Software. 
 

2  Переходите в режим Art Canvas. Выберите 
изображение, при необходимости кадрируйте 
или подправьте изображение. Подробнее см. 
в разделе Редактирование 
импортированных изображений. 

 
3  Переходите в режим Embroidery Canvas и 

выберите изображение.  
 
 
 
 
 
 
 
 
 
 
 
4  Нажмите кнопку Image Preparation. 
 Откроется диалоговое окно Image Preparation 

(Подготовка изображения) 
 Изображение появится в панели просмотра. 
 

 
 
 
5  Проверьте, сколько цветов имеется в 

изображении. 
 Это число указывается в поле Available Colors 

(Наличные цвета). Если представляется, что 
цветов слишком много, то это может быть 
вызвано шумом. Подробнее см. в разделе 
Подготовка изображений для 
автоматического оцифровывания. 
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6  Введите нужное вам число цветов. 
 Вы можете принять число цветов, 

предлагаемое BERNINA Embroidery Software, 
или изменить его. 

   
Сокращено до 3 цветов Сокращено до 2 цветов 

 
7  Нажмите OK, чтобы принять изменения. 
 Изображение теперь готово для 

автоматического оцифровывания. Подробнее 
см. в разделе Автоматическое 
оцифровывание. 

Подготовка оконтуренных 
изображений 
 
 
 

Используйте режим Art 
Canvas  для загрузки, 
правки и сохранения  

                                    рисунков в качестве  
                                    оригинала для  
                                    оцифровывания. 
 

Используйте режим Art 
Canvas  для обработки 
рисунка для  

                                    автоматического  
                                    оцифровывания. 

 
Используйте инструмент Image 
Preparation (панель Edit), чтобы повысить 
четкость контуров и уменьшить шум в  

             оконтуренном изображении. 
  
Используйте инструмент Image Preparation – 
Outline Apperance   для подготовки 
оконтуренных изображений к автоматическому 
оцифровыванию. Этот инструмент 
автоматически повышает четкость контуров и 
уменьшает шум. Зоны, входящие в черный 
контур, окрашиваются в единый цвет. 
Повышение четкости контура облегчает 
программе распознавать определенные зоны 
изображения.  

 
 
Эти зоны становятся объектами вышивки в 
окончательном проекте. Используйте этот 
инструмент в тех случаях, когда контуры 
являются смазанными, зазубренными, 
расплывчатыми или неопределенными.  

    
 Изображение со единообразной, Оцифрованное изображение 
 сплошной цветностью 
 
Совет: В зависимости от качества 
отсканированного изображения вам может 
потребоваться выправить их вручную перед 
обработкой в BERNINA Embroidery Software. Вы 
можете сделать это, чтобы кадрировать 
изображение, удалить фон, залить цветом 
определенные зоны, заполнить пробелы, 
добавить или усилить контуры. Подробнее см. в 
разделе Редактирование изображений в 
пакете графических программ. 
 
Как подготавливать оконтуренные 
изображения 
1  Отсканируйте или загрузите изображение, 

которое вы хотите использовать. Подробнее 
см. в разделе Импорт изображений в 
BERNINA Embroidery Software. 
 

2  Переходите в режим Art Canvas. Выберите 
изображение, при необходимости кадрируйте 
или подправьте изображение. Подробнее см. 
в разделе Редактирование 
импортированных изображений. 

 
3  Переходите в режим Embroidery Canvas и 

выберите изображение.  

 
увеличенная зона 
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3  Нажмите кнопку Image Preparation. 

Откроется диалоговое окно Image Preparation 
(Подготовка оконтуренного изображения)  
 

 
 
 

Изображение появится в панели просмотра. 
В поле Available Colors (Наличные цвета) 
показывается число цветов в изображении. 
 

 
5  Перемещая движок, установите желаемую  
      контрастность контура. 

Этим будет вызван черно-белый просмотр 
обнаруженных контуров. 

 

 
 
 

 
 

Совет: Переместите движок вправо до тех 
пор, пока контуры не станут слишком 
темными, после этого медленно 
перемещайте движок влево. Остановитесь, 
когда в изображении будут показаны все 
контуры, как вам требуется. 
 
 

6  Нажмите Show Color Area (Показать 
цветную зону), чтобы увидеть 
обновленное изображение. 

 
               

  Движок перемещается влево,   Движок перемещается вправо, 
  контуры светлеют     контуры темнеют 
 
7  Нажмите OK, чтобы принять изменения. 

Изображение теперь готово для 
автоматического оцифровывания. 
Подробнее см. в разделе Автоматическое 
оцифровывание. 

 

 



Глава 15: Автоматическое оцифровывание 

BERNINA® Вышивальное ПО Версия 6 154

ГЛАВА 15 
 

 
АВТОМАТИЧЕСКОЕ 
ОЦИФРОВЫВАНИЕ 

------------------------------------------- 

 
Интеграция программ CorelDRAW® и BERNINA 
Embroidery Software обеспечивает возможность взаимо-
преобразования векторной графики и объектов 
вышивки. Инструмент преобразования Convert Vectors 
to Embroidery преобразует как контуры, так и 
заполнение векторных рисунков в контурные или 
заполняющие вышивальные стежки соответственно. 
Этот инструмент можно применять как для векторных 
графических изображений, так и для текстов. 
 
Инструмент Magic Wand (Волшебная палочка) полезен 
для создания объектов вышивки из отсканированных 
изображений, которые не требуют особых художественных эффектов или 
специфичных знаний в области вышивания. Это поможет вам сохранить больше 
времени на обработку в действительности сложных зон вашего проекта. 
Программа BERNINA Embroidery Software Auto Digitizer автоматически преобразует 
изображение в полностью оцифрованную форму с небольшими вашим 
вмешательством или совсем без вмешательства. Могут быть использованы 
различные формы оригинала – как растровые, так и векторные – и разнообразные 
уровни "участия" пользователя в процессе. 
Применяя Auto Digitizer, начинающие пользователи могут быстро и легко создавать 
несложные проекты. Равным образом, опытные пользователи могут повысить свою 
производительность при работе с простыми проектами. PhotoSnap используется 
для создания проектов вышивки по фотографиям и другим оригиналам.  
 
В этом разделе описывается, как автоматически преобразовывать векторную 
графику, а также растровые изображения в проекты вышивки. Здесь также 
объясняется, как преобразовывать фотографии в вышивки. 

 
Оцифровка векторной графики 
В программе BERNINA Embroidery Software 
имеются специальные функции для 
преобразования объектов векторной 
графики в объекты вышивки или текстовой 
вышивки. Фактически, можно легко 
преобразовать весь векторный графический 
объект в объект вышивки. При этом 
преобразовании, программа определяет 
оптимальные объекты и типы стежков для 
тех или иных форм, причем все это можно 
настраивать. Можно осуществлять и 
обратные преобразования – из вышивок в 
графику.  
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Предупреждение: рисунки, поставляемые 
вместе с программой, и образцы вышивки 
могут использоваться только для личных 
целей – т.е. они ни коим образом не могут 
использоваться в коммерческих целях. 
Изменение формата – превращение 
рисунка в образец вышивки или обратно – 
никоим образом не отменяет защиту 
авторских прав. 
 
Инструменты преобразования 
Имеются 3 инструмента для 
преобразования формата: 
• Преобразование векторной графики в 

образцы вышивки 
• Преобразование векторного 

графического текста в образцы вышивки 
См. раздел Преобразование текста в 
вышивку  
• Преобразование образца вышивки в 

векторный рисунок 
 
Инструменты Convert Vectors to 
Embroidery (Преобразование векторной 
графики в образцы вышивки) и  
Convert Text to Embroidery 
(Преобразование векторного графического 
текста в образцы вышивки) включаются с 
помощью кнопок на панели Art Toolbox в 
режиме Art Canvas. Инструмент Convert 
Selected Embroidery to Art Vectors 
(Преобразование образца вышивки в 
векторный рисунок) включается из панели 
редактирования (Edit) в режиме Embroidery 
Canvas. 
 
 
Ограничения возможности 
преобразования 
Есть определенные ограничения на 
возможность преобразования векторных 
рисунков из формата CorelDRAW® в 
образцы вышивок. Некоторые специальные 
изобразительные эффекты, такие как 
падающие тени, оконтуривание или 
полупрозрачность, в образцы вышивки 
преобразуются плохо, поскольку при 
вышивке воспроизвести такие эффекты 
сложно. 

 
Встроенный текст, а также заполнения типа 
Fountain или Mesh также не всегда 
воспроизводятся на вышивке адекватно. 
 

 
 
Тем не менее, программа BERNINA 
Embroidery Software будет стараться 
преобразовать векторный рисунок, даже 
если он имеет заполнение или 
оконтуривание. Но если соответствующий 
эффект на вышивке воспроизведен быть не 
может, программа преобразует рисунок в 
вышивку, сохраняя только точные цвета. 
Встроенный текст преобразуется скорее в 
объект рисунка вышивки, а не в текстовую 
вышивку.  
 
Совет: можно разбить ‘особые’ векторные 
рисунки на части с помощью команд 
Arrange >Break Apart в режиме Art Canvas. 
В большинстве случаев у вас что-то 
получится, но не обязательно в точности то, 
что вы хотели. 
 
Преобразование векторных рисунков в 
вышивки 

 
Для преобразование рисунков в 
заполнение или контуры стежков 

используйте функцию Embroidery (панель 
Art). 
 
Инструмент Convert Vectors to Embroidery 
(Преобразование векторной графики в 
образцы вышивки) преобразует заполнения 
и контуры отдельных векторных рисунков 
для заполнения или оконтуривания 
соответствующих стежков. Эту функцию 
можно использовать и для текстов. См. 
также Преобразование текста в 
вышивку. 
 
 
Примечание: Побитовые изображения не 
могут быть преобразованы в образцы 
вышивок с помощью инструмента Convert 
to Embroidery. Такие рисунки надо 
предварительно переработать. См. раздел 
Обработка изображений для 
автоматического оцифровывани.
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Преобразование векторной графики в 
образцы вышивки  
1 Перейдите в режим Art Canvas. 
2 Отсканируйте, загрузите или создайте 
рисунок и/или текст, который вы хотите 
использовать. См. раздел Импорт 
изображений в программу BERNINA 
Embroidery Software. 
 

 
 
3 Откройте инструмент преобразования 
рисунка в образец вышивки Convert to 
Embroidery. 
 
Программа BERNINA Embroidery Software 
автоматически переходит в режим 
Embroidery Canvas. Исходные объекты 
удаляются с экрана проекта. 
 

 
 

Преобразование образца вышивки в 
векторный рисунок 
 

Для преобразования  образца 
вышивки в векторный рисунок 
используется функция Convert 

Selected Embroidery to Art Vectors (панель 
редактирования). 
 
Новая функция преобразования  образца 
вышивки в векторный рисунок Convert 
Selected Embroidery to Art Vectors 
преобразует отобранные объекты образца 
вышивки в векторные рисунки.   
 
Для преобразования  образца вышивки в 
векторный рисунок  
1 Перейдите в режим Embroidery Canvas. 
 

 
 
2 Выберите один или более объект 
вышивки и/или текста и нажмите Convert 
Selected Embroidery to Art Vectors. 
Программа BERNINA Embroidery Software 
автоматически переходит в режим Art 
Canvas mode. Исходные объекты 
удаляются с экрана проекта. 
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Оцифровывание инструментом 
Magic Wand 
 
Инструмент Magic Wand (Волшебная палочка) 
используется для автоматического 
оцифровывания форм в растровых 
изображениях. 
 
Примечание: Даже если изображение кажется 
вам готовым для вышивания после загрузки в 
ПО, оно нуждается в обработке перед 
преобразованием. Программное обеспечение не 
позволит вам применить автоматическое 
оцифровывание без предварительной обработки 
изображения. Подробнее см. в разделе 
Обработка изображений для 
автоматического оцифровывания. 
 

Автоматическое оцифровывание 
заполнения 
 

Используйте режим Art 
Canvas для загрузки, правки 
и сохранения рисунков в 
качестве оригинала для 
оцифровывания.  
 

Используйте кнопку 
Embroidery Canvas для 
подготовки рисунков для 
оцифровывания . 
 

Используйте инструмент 
Magic Wand для  

                                   оцифровывания форм  
                                   изображения. 
 
 
Если вам нужно заполнить объект, то перед 
использованием Magic Wand (Волшебная 
палочка) выберите Fill Stitch (Заполняющие 
стежки) на панели инструментов Stitch and Color 
(Стежок и Цвет). Вам может потребоваться 
добавить стабилизирующие стежки к вашей 
вышивке. Подробнее см. в разделе Упрочнение 
и стабилизация ткани стабилизирующими 
стежками. 
 

Как оцифровывать заполненные формы 
инструментом Magic Wand 
 
1  Отсканируйте или загрузите изображение. 

Подробнее см. в разделе Импорт 
изображений в BERNINA Embroidery 
Software. 

 
Совет: Если вам не удается увидеть 
загруженное изображение, убедитесь в том, 
что функция Show Picture включена. 

 
2  Выберите Embroidery Canvas и нажмите  

кнопку Magic Wand.  

 
Эта кнопка доступна только тогда, когда на 
экране проекта имеется хотя-бы один 
побитовый (bitmap) рисунок. 

 
Загруженное изображение 

 
3 Щелкните мышью в области рисунка. 
Программа проверит, обрабатывался ли 
этот рисунок ранее, и при необходимости 
отобразит диалог подготовки рисунка 
(Image Preparation dialog).  См. раздел 
Обработка изображений для 
автоматического оцифровывания. 
 
4 С помощью функций панели стежков и 
цветов ниток (Stitch and Color Bar) вы 
можете изменить типы стежков и цвета 
ниток. См. раздел Подбор цветов ниток 
 
5 . Щелкните мышью в области рисунка. 
Будут сгенерированы соответствующие 
заполняющие стежки. 

 
щелкните на зоне    зона заполниться стежками 

 
 

Совет: Если вы хотите заполнить и 
оконтурить форму, то вам нужно создать два 
объекта, один с заполняющими стежками и 
второй с оконтуривающими стежками. 

 
6 Другие зоны вышивки заполняются и 
оцифровываются таким же образом. Можно 
поменять цвета ниток и типы стежков. 
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7 Чтобы закончить работу, выберите какой-
либо другой инструмент или нажмите 
кнопку Esc . 
8  Проверьте проект в окне Artistic View 
(Просмотр проекта). 
 

 
 
 
 
 
 

 
 

Примечание: Генерация стежков производится в 
соответствии с текущими настройками стежка. 
Возможно появление переходов, если длина 
стежка превышает установленные стандартные 
настройки.          

 
 
Автоматическое оцифровывание 
контуров  

   Используйте режим Art 
Canvas для загрузки, 
правки и сохранения 
рисунков в качестве 
оригинала для 
оцифровывания.  
 

Используйте кнопку 
Embroidery Canvas для 
подготовки рисунков для 
оцифровывания . 
 
Используйте инструмент 
Magic Wand для  

                                     оцифровывания форм  
                                     изображения. 
 
Если вам нужно оконтурить объект, то перед 
использованием Волшебной палочки (Magic 
Wand) выберите Outline Stitch (Оконтуривающий 
стежок). 
 
Как оцифровывать контуры 
автоматически 
1  Отсканируйте или загрузите изображение. 

Подробнее см. в разделе Импорт 
изображений в BERNINA Embroidery 
Software. 
 
Совет: Если вам не удается увидеть 
загруженное изображение, убедитесь в том, 
что функция Show Picture включена. 
Подробнее см. в разделе Отображение или 
скрытие оригинала. 

 
2  Выберите режим Embroidery Canvas и  

нажмите кнопку Magic Wand. 
 
Эта кнопка доступна только тогда, когда 

на экране проекта имеется хотя-бы один 
побитовый (bitmap) рисунок. 

 
Загруженное изображение 
 
3 Щелкните мышью в области рисунка. 
Программа проверит, обрабатывался ли 
этот рисунок ранее, и при необходимости 
отобразит диалог подготовки рисунка.   
См. раздел Обработка изображений для 
автоматического оцифровывания. 
 
4 С помощью функций панели стежков и 
цветов ниток (Stitch and Color Bar) вы 
можете изменить типы стежков и цвета 
ниток. См. раздел Подбор цветов ниток. 
 
5 . Щелкните мышью в области рисунка. 
Будут сгенерированы соответствующие 
оконтуривающие стежки. 

 

 
Щелкните по контуру      Оконтурено гладьевым стежком 

 
Совет: Если вы хотите заполнить и 
оконтурить форму, то вам нужно создать два 
объекта, один с заполняющими стежками и 
второй с оконтуривающими стежками. 

Оцифрованы все 
зоны 
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6  Оцифруйте таким же образом другие 

подлежащие оконтуриванию зоны, изменяя 
по необходимости цвет ниток и тип стежка. 

           

 
Цвет контура изменен   Изменен тип  

оконтуривающего стежка 
 
7 Чтобы закончить работу, выберите какой-
либо другой инструмент или нажмите 
кнопку Esc . 
 
8  Проверьте проект в окне Artistic View 
(Художественный Просмотр). 
           

 
Завершенный проект   Оцифрованы только контуры 

 
Примечание: Генерация стежков 
производится в соответствии с текущими 
настройками стежка. Возможно появление 
переходов, если длина стежка превышает 
установленные стандартные настройки. 

              
Ширина гладьевого валика:      Ширина гладьевого валика: 
2,5 мм с отдельными переходами         1,0 мм БЕЗ переходов 

Оцифровывание инструментом 
Auto Digitizer 
 
Обладая расширенными по сравнению с 
технологией Magic Wand функциями, инструмент 
Auto Digitizer распознает формы в оригинальном 
изображении и самостоятельно принимает 
решения о применении наиболее подходящих 
типов стежка. Также определяется 
последовательность вышивания на основе 
соединения. Изображение подвергается 
эффективной "пакетной обработке" для 
создания многих объектов вышивки, из которых 
состоит проект. Auto Digitizer позволит вам до 
некоторой степени контролировать, как 
преобразуется изображение во время 
преобразования. Вы можете пропустить 
выбранные цвета и назначить типы стежков. 
Создав проект, вы всегда можете выправить 
окончательный результат, используя 
имеющуюся технологию оцифровывания. 
Смотри также Методы оцифровывания. Не 
забывайте о применении стабилизирующих 
стежков, кроме того, вам может потребоваться 
изменить форму некоторых объектов. 
Подробнее см. в разделе Выбор 
стабилизирующих стежков. 
 
Примечание: Даже если изображение кажется 
вам готовым для вышивания после загрузки в 
ПО, оно нуждается в обработке перед 
преобразованием. Программное обеспечение не 
позволит вам применить автоматическое 
оцифровывание без предварительной обработки 
изображения. Подробнее см. в разделе 
Обработка изображений для 
автоматического оцифровывания. 
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Автоматическое создание проектов 
вышивки инструментом Auto Digitizer 
 

Используйте режим Art 
Canvas для загрузки, 
правки и сохранения 
рисунков в качестве 
оригинала для 
оцифровывания.  
 

Используйте кнопку 
Embroidery Canvas для 
подготовки рисунков для 
оцифровывания . 
 
Используйте инструмент 
Auto Digitizer для 
создания проектов 
вышивки 
непосредственно по 
импортированному 
изображению. 

 
По существу, создание проекта вышивки 
функцией Auto Digitizer заключается в том, что 
вам нужно выделить изображение, которое вы 
хотите преобразовать, и щелкнуть по нему 
инструментом Auto Digitizer. Однако имеются 
некоторые настройки, которые вы можете 
изменить, чтобы оптимизировать процесс 
преобразования для конкретных проектов. 
В одно и то же время можно выделить только 
одно изображение. Команда отменяется, если в 
выделенной зоне находится больше одного 
изображения. 
 
Примечание: При использовании Auto Digitizer 
выберите компенсацию стягивания (Pull 
Compensation), установленную на 0,4 мм. 
 
Как автоматически создавать проекты 
вышивки инструментом Auto Digitizer 
 
1  Отсканируйте или загрузите изображение. 

Подробнее см. в разделе Импорт 
изображений в BERNINA Embroidery 
Software. 

         
 
 
 
 
 
 
 

Загруженное изображение 
 

Совет: Если вам не удается увидеть 
загруженное изображение, убедитесь в том, 
что функция Show Picture включена. 
Подробнее см. в разделе Отображение или 
скрытие оригинала. 

2  Выберите режим Embroidery Canvas и  
нажмите кнопку Auto Digitizer. 
 

3 Щелкните мышью в области рисунка. 
Программа проверит, обрабатывался ли 
этот рисунок ранее, и при необходимости 
отобразит диалог подготовки рисунка 
(Image Preparation dialog).  См. раздел 
Обработка изображений для 
автоматического оцифровывания. 
 
 
4 Еще раз щелкните мышью в области 
рисунка. Откроется диалоговое окно Auto 
Digitizer. В верхней части окна появляется 
информация об изображении, включая размеры 
по высоте и ширине и количество цветов в 
изображения. 

 
 

 
 
 
Размеры проекта 
 
Количество 
цветных ниток 
 
 
Выбор опций 
вышивания 
 

 
Нажать для показа 
пропускаемых 
цветов 
 
 

 
5  Выберите типы стежков для заполнения и 
оконтуривания. См. разделы Настройка 
заполняющих стежков 
 и Автоматическое оцифровывание 
контуров. 
 
 
 
6  Нажмите кнопку Omitted Colors 
(Пропустить Цвета), чтобы выбрать цвета, 
исключаемые из процесса автоматического 
размещения стежков. В диалоговом окне 
отобразится список цветов изображения. Вы 
можете выбрать цвета, исключаемые из 
процесса обработки: 
 

◄ Для выбора нескольких цветов 
удерживайте нажатой клавишу Ctrl. 



Глава 15: Автоматическое оцифровывание 

BERNINA® Вышивальное ПО Версия 6 161

 
◄ Для выбора нескольких идущих подряд 
цветов удерживайте нажатой клавишу Shift. 

 
 
 
 
Выберите для 
пропуска 
 
 

 
7  Установите требуемы опции для 
контуров.  См. раздел Автоматическое 
создание контуров и границ. 
 
8  Нажмите кнопку ОК. 

Auto Digitizer преобразует изображение в 
объекты вышивки и генерирует стежки.   
   

 
Пропущен белый фон   Пропущены некоторые цвета 

 
9  Нажмите кнопку Show Artistic View на 
общей панели инструментов или нажмите 
клавишу быстрого вызова этой команды ‘T’. 
 

Программа подбирает цвета из 
существующей палитры. Если вам кажется, 
что в проекте конвертированные цвета на 
экране отображаются неправильно, 
проверьте, установлен ли ваш монитор на 16-
битовую насыщенность цвета, и убедитесь в 
том, что вы выбрали подходящую таблицу 
ниток. 
 

 
Настройка заполняющих стежков 
Auto Digitizer позволяет выбирать настройки 
заполняющих стежков. 
         

        
 
 
 
 
 
 
Как настроить заполняющие стежки 
• Отсканируйте или загрузите 

изображение. Запустите программу Auto 
Digitizer для автоматической оцифровки 
всего проекта. См. раздел 
Автоматическое создание 
проектов вышивки.  

• Щелкните клавишей мыши по 
изображению. 

  
  Откроется диалоговое окно Auto Digitizer. 
 
 
 
 
 
 
 
 
 
 
 
Выбор типа 
стежков 
 
Выбор стиля 
заполнения 
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Выберите из списка стиль заполняющих стежков. 
 

◄ Auto: программа выбирает сама 
наилучший тип стежка. 

◄ Step: простегивающий стежок – подходит  
        для большинства зон 
◄ Satin: гладьевый стежок – подходит для  
        узких выделяющихся зон. 

 
Примечание: Не используйте гладьевый 
заполняющий стежок для зон, в которых длина 
стежка превышает 7 мм. См. также Сохранение 
длинных стежков. 

         
Гладьевый заполняющий   Созданы переходные стежки 
стежок не подходит 

 
Выберите из списка стиль стежков. 

 
◄ Satin: гладьевый стежок – наиболее подходит 

для толстых линий или узких форм с 
изменяющейся шириной. 

◄ Double Run: двойной обход – наиболее 
подходит для тонкий линий. 

◄ Satin Line: гладьевый валик – наиболее 
подходит для толстых линий. 

 
• Нажмите кнопку ОК. 

 
 Auto Digitizer преобразует изображение в 

объекты вышивки и генерирует стежки.  

                 
В поле Details: Satin    В поле Details: Double Run 

 
Автоматическое создание контуров и 
границ 

 Для автоматического создания 
контуров и границ для 
импортированных в систему 
побитовых рисунков используется 

инструмент Auto Digitizer (панель 
оцифровки). 
 
Инструмент Auto Digitizer позволяет 
автоматически генерировать контуры во 
время преобразования рисунка. Это могут 
быть как контуры, отделяющие объекты, так 
и границы вокруг всего образца вышивки.  
Автоматическое оконтурирование можно 
использовать для создания заполненного 
фона для вышивок на проблемных тканях, 
имитации тени и т.п.. Можно выбрать цвет 
контура при преобразовании рисунка. Цвета 
и детали генерируемого объекта можно в 
любой момент изменить. 
 
Примечание: Если рисунок уже содержит 
контурные линии, использовать инструмент 
автоматического оконтурирования Add 
Outlines не рекомендуется. Это приведет к 
двойному оконтурированию. См. раздел  
Создание контуров и границ. 
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Чтобы автоматически создать контуры и 
границы рисунка: 
 
1 Отсканируйте или загрузите рисунок, 
который вы хотите использовать. См. 
раздел  Импорт изображений в ПО 
BERNINA Embroidery Software. 

 
Совет: Если загруженный рисунок не 
отображается, проверьте, включена ли 
кнопка Show Pictures . См. раздел 
Отображение или скрытие оригинала. 
 
2 Выберите режим Embroidery Canvas и 
откройте программу Auto Digitizer. 
Эта кнопка доступна только тогда, когда на 
экране проекта имеется хотя-бы один 
побитовый (bitmap) рисунок. 
 
3 Щелкните мышью в области рисунка. 
Программа проверит, обрабатывался ли 
этот рисунок ранее, и при необходимости 
отобразит диалог подготовки рисунка 
(Image Preparation dialog).  См. раздел 
Подготовка изображений для 
автоматического 
оцифровывания. 
 
4 Еще раз щелкните мышью в области 
рисунка. 

Откроется диалог программы Auto Digitizer. 
 

 
 
5 Проверьте опции добавления контуров 
(Add Outlines) и/или добавления границ 
(Add Border). 
• Для оконтурирования отдельных 

цветных блоков в исходном рисунке 
генерируются оконтуривающие стежки, 
с использованием механизма Run 
stitching. Эти стежки имеют те же 
свойства, что и для других деталей, 
генерируемых при преобразовании 
рисунка.   

• Линии границы генерируются как 
объекты гладьевого шитья с текущими 
настройками шага стежка и других 
свойств.  Границы ориентируются по 
часовой стрелке для согласованного 
шитья с другими объектами, такими, как 
аппликации.   
 

6 Из выпадающего списка выберите цвета 
ниток для контуров и нажмите OK. 
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Auto Digitizer преобразует изображение в 
объекты вышивки и генерирует стежки.  
 

 
Совет: Если хотите, вы можете пропустить 
выбор всех цветов рисунка и ограничиться 
только внешними контурами и/или 
границами. 

 

Оцифровывание фотографий 
функцией PhotoSnap 
 

 
Используйте режим Art 
Canvas для загрузки, 
правки и сохранения 
рисунков в качестве 
оригинала для 
оцифровывания.  
 

Используйте кнопку 
Embroidery Canvas для 
подготовки рисунков для 
оцифровывания . 
 

Функция PhotoSnap 
является техническим 
средством создания 
проектов вышивки  
непосредственно по 
фотографиям.  

 
Используйте изображения цветные или в 
градации серого. Изображения в градациях 
серого создаются из разных оттенков серых 
пикселей.  

 
Цветные изображения автоматически 
конвертируются в серые полутона при 
использовании PhotoSnap. 
 

 
 
 
Проекты PhotoSnap состоят из рядов гладьевых 
стежков с изменяющимся шагом. 
 
 
 
 
 
 
 
 
 
 
 
 
 

С добавлением бордюра и текста 
 
Совет: Для получения лучших результатов 
используйте изображения с хорошо 
выделенными формами или постоянно 
изменяющимися оттенками. 
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Как создать проекты вышивки по 
фотографиям 
1  Отсканируйте или загрузите изображение.  
      Подробнее см. в разделе Импорт 
изображений в BERNINA Embroidery Software. 
 
 
 
 
 
 
 
 
 
Совет: Если вам не удается увидеть 
загруженное изображение, убедитесь в том, что 
функция Show Picture включена. 
Подробнее см. в разделе Отображение или 
скрытие оригинала. 
 
2 В режиме Embroidery Canvas  щелкните по 

значку PhotoSnap и загрузите файл. 
BERNINA Embroidery Software выполнит 
генерацию стежков. Этот процесс может 
занять определенное время. 

 
3  Дважды щелкните левой кнопкой или 

щелкните правой кнопкой по проекту 
PhotoSnap. 
Откроется закладка PhotoSnap диалогового 
окна Object Properties (Свойства объекта). 

 

 
  Выберите нужное разрешение 
 
 
       

 
4  На панели Resolution (Разрешение) выберите 
требуемое разрешение: 

◄ Coarse = Грубое 
◄ Medium = Среднее 
◄ Fine = Тонкое 
Щелкните по Apply.  

 

 
Грубое     Тонкое 

 
5  На панели Background Fabric (Фон ткани) 

выберите нужную опцию. 
◄ Light = Светлый: применяется значение 

Max Width к наиболее светлой части 
изображения. 

◄ Dark = Темный: применяется значение 
Max Width к наиболее темной части 
изображения. 

                    

 
   Светлый фон    Темный фон 

Щелкните по Apply.  
 

Совет: Обычно выбираемая вами опция 
зависит от того, является ли ткань светлой 
или темной. 
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6  На панели Fill Angle (Угол заполнения) 

при необходимости выберите угол 
стежков и щелкните на Apply.  

                 

 
 
     Угол заполнения 0°   Угол заполнения 45° 
 
 7  На закладке Fill Stitch (Заполняющий стежок) 

выберите, если нужно, параметры стежка.  
 
 
 
 
 
 
 Выберите 
параметры 
стежка. 
 
 

 
Stitch Spacing (Шаг стежка): определяет 
плотность стежков – для увеличения плотности 
введите меньшее значение. 
 
Skew Angle (Угол перекоса): определяет угол 
наклона стежков по отношению к углу стежков 
заполнения. 
 

 
Угол стежков 
заполнения 45° 
Угол наклона 0° 

Угол стежков 
заполнения 45° 
Угол наклона 45° 

 
8  Щелкните по Apply, чтобы принять и 
изменения и по OK, чтобы закрыть окно. 
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ЧАСТЬ IV 
 

ИЗМЕНЕНИЕ ПРОЕКТОВ 
------------------------------------------ 

 
 
 
 
Вы можете быстро дополнять проекты путем дублирования и копирования 
существующих объектов. Также имеется возможность комбинировать проекты, 
вставляя содержимое одного файла в другой. 
 
Комбинирование и изменение последовательности объектов 
 
В этом разделе описывается, каким образом можно комбинировать объекты и проекты 
путем копирования и вставки, дублирования и вставки целых проектов и их элементов. 
Здесь же объясняется, как группировать и разгруппировать объекты, а также назначать 
последовательность объектов различными способами, включая функцию Color Film. 
Рассматривается также функция автоматического установление последовательности 
всего проекта. 
Подробнее см. в главе Комбинирование и изменение последовательности 
объектов 
 
Расположение и трансформация объектов 
 
В этом разделе описывается, как позиционировать и выравнивать объекты как 
интерактивными, так и цифровыми способами. Также рассматриваются способы 
изменения размеров, вращения и перекоса объектов. Кроме того, описываются 
различные способы перевода объектов в зеркальное отображение. 
Подробнее см. в главе Расположение и трансформация объектов. 
 
Изменение формы и правка объектов 
 
В этом разделе объясняется, как изменять форму объектов контрольными точками, 
изменять форму окружностей, устанавливать угол наклона стежков – включая сложные 
углы наклона – и изменять точки входа и выхода. См. также раздел Правка 
вышиваемых текстов. 
Подробнее см. в главе  Изменение формы и правка объектов 
 
 
Редактирование стежков 
 
В этом разделе объясняется, как выбирать и редактировать стежки. 
Подробнее см. в главе Редактирование стежков 
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ГЛАВА 16 
 

 
КОМБИНИРОВАНИЕ И ИЗМЕНЕНИЕ 
ПОСЛЕДОВАТЕЛЬНОСТИ ОБЪЕКТОВ 

------------------------------------------- 
 

BERNINA Embroidery Software позволяет легко создавать 
комбинации проектов и элементов проекта путем вставки 
содержания одного файла в другой. Вы можете также быстро 
добавлять к проектам существующие объекты путем их 
копирования или дублирования. Объединение в группу 
выделенных объектов или целых проектов используется для 
совместного перемещения, изменения размеров или 
трансформирования. Объекты вышивки в проекте образуют 
"последовательность вышивания". 
Первоначально объекты вышиваются в том порядке, в 
котором они были созданы. Однако имеется много способов изменения 
последовательности вышивания. Например, можно изменить положение 
выделенного объекта, вырезав его и вставив в другое место последовательности. 
Имеются также возможности выбора последовательности объектов способом "As 
Selected" ("Последовательность в порядке выделения") или как "Color Blocks" 
("Цветные блоки"). Вы можете также изменить последовательность объектов, 
используя инструмент Color Film. 
Функция Stitch Sequence (Последовательность вышивания) улучшает качество и 
эффективность вышивания, сводя к минимуму количество перезаправки пялец, 
замены цветных ниток и обрезки ниток.  Все существующие перекрытия 
сохраняются при этой операции. 
В этом разделе описывается, каким образом можно комбинировать объекты и 
проекты путем копирования и вставки, дублирования и вставки целых проектов и их 
элементов. Здесь же объясняется, как группировать и разгруппировать объекты, а 
также назначать последовательность объектов различными способами, включая 
функцию Color Film. Рассматривается также функция автоматического 
установление последовательности всего проекта. 

 

 

Комбинирование объектов 
 
Проект или объекты проекта можно копировать 
или вырезать и загружать в буфер обмена 
Windows для временного сохранения. 
Содержимое буфера обмена может быть 
вставлено любое число раз в один и тот же или в 
другой проект, до тех пор. Кроме того, объекты 
можно клонировать или дублировать без 
копирования в буфер обмена. См. также Выбор 
объектов. 

 

 

Вставка объектов 
 
Для комбинирования объектов выберите 
команду Insert Design (меню File). 
 
BERNINA Embroidery Software позволяет 
вставить один проект в другой.  
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Два или больше проектов могут быть затем 
сохранены в комбинированном проекте. 
Если вы вставляете один проект в другой, две 
цветовые палитры комбинируются. Цвета с 
одними и теми же значениями RGB 
автоматически идентифицируются как имеющие 
один и тот же цвет ниток. Если вы хотите 
сохранить их как отдельные цвета, то вам нужно 
изменить один или другой цвет перед слиянием. 

      
Как вставить проекты 
1 Откройте первый проект. 
2 Перейдите к позиции в последовательности 

вышивания, в которую вы хотите вставить 
проект. Подробнее см. в разделе Обход по 
стежкам.  

3 Выберите File (Файл) > Insert Design 
(Вставить Проект). 

 Откроется диалоговое окно Open. 
4 Из открывшегося списка Look In выберите 

папку, в которой сохраняется проект, который 
вы хотите вставить, и выберите требуемый 
формат из списка Files of type. 

5 Выберите файл с нужным вам проектом и 
нажмите Open. 

 Проект будет вставлен в текущую позицию 
иглы. 

6  Переместите второй проект в нужное вам 
положение. 

 Подробнее см. в разделе 
Позиционирование объектов 
перетаскиванием мышью. 

 
Совет: Чтобы гарантировать, что все 
объекты вставляемого проекта будут связаны 
между собой, сгруппируйте проект во время 
работы с ним. Подробнее см. в разделе 
Группирование объектов. 

 
7  Сохраните комбинированный проект под 

оригинальным или измененным именем. 
 

     
 
 
Копирование и вставка объектов 

 
Нажмите кнопку Copy (панель General), 
чтобы копировать выделенные 
объекты в буфер обмена. 
 

Нажмите кнопку Paste (панель 
General), чтобы вставить 
скопированные объекты в проект.   

 
Вы можете копировать объекты, чтобы 
создавать многократно воспроизводимые 
идентичные объекты или вставлять объекты из 
других проектов. См. также Установление 
последовательности объектов функцией 
Color Film. 
 
Примечание: Вы можете также удалять объекты 
из проекта, пользуясь командой Cut (Вырезать), 
и вставлять их обратно. Команды Cut и Paste 
изменяют последовательность вышивания в 
проекте. Подробнее см. в разделе Изменение 
последовательности вышивания объектов 
командами Cut и Paste.  
 
Как копировать и вставлять объекты 
1 Выделите объект (или объекты) для 

копирования. 
2 Нажмите кнопку Copy (Копировать). 

 



Глава 16: Комбинирование и изменение последовательности объектов 

BERNINA® Вышивальное ПО Версия 6 170

 
 Выделенный объект будет скопирован в 

буфер обмена. 
3 Перейдите к позиции в последовательности 

вышивания, в которую вы хотите вставить 
объект. Подробнее см. в разделе Обход по 
стежкам. Вы можете вставить объект между 
другими объектами в последовательности 
вышивания. 

4 Нажмите кнопку Paste (Вставить). 
      

 
Лепестки скопированы и вставлены 

 
Примечание: Объект будет вставлен точно в 
верхнюю часть оригинального объекта. 
Щелкните мышью и перетащите объект 
перед отменой выделения. Объект будет 
оставаться в буфере обмена и может быть 
неоднократно вставлен до тех пор, пока не 
последует следующая команда Copy 
(Копировать) или Cut (Вырезать).  
 
Внимание: Убедитесь в том, что имеется 
только одна копия объекта в одной и той же 
позиции. Если объект вставлен дважды в 
одну и ту же позицию, то он будет вышит 
дважды. 

        
Дублирование объектов 
 
Выберите команду Duplicate (меню Edit), чтобы 
дублировать выделенные объекты. 
 
Предпочтительнее дублировать объекты, чем 
копировать. При дублировании объекта он не 
копируется в буфер обмена. 
 

Этим вы сохраняете буфер обмена для вырезки 
или копирования других объектов. См. также 
Установление последовательности 
объектов функцией Color Film. 
 

     
 
Как дублировать объекты 
1 Перейдите к позиции в последовательности 

вышивания, в которую вы хотите поместить 
объект. Подробнее см. в разделе Обход по 
стежкам. 

 Вы можете поместить объект между другими 
объектами в последовательности 
вышивания. 

2 Выделите объект (или объекты) для 
дублирования. 

3 Выберите Edit > Duplicate. 
 Дублированный объект помещен 

непосредственно в верхней части 
оригинального объекта в назначенной 
позиции последовательности вышивания. Не 
забудьте щелкнуть мышью и перетащить 
объект перед отменой выделения. 

 
Клонирование объектов 
 

Для выбора и клонирования объектов 
используйте инструмент Select Object 
(панель Edit). 

 
Функция Quick Clone позволяет быстро 
дублировать выбранные объекты  
перетаскиванием в новое положение нажатой 
правой кнопкой мыши.  
 
Как клонировать объекты 
1  Выделите объект/ы. 
2  Удерживая нажатой правую кнопку мыши 

перетащите объект/ы в новое положение. 
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Контуры объекта/ов станут черными. У 
указателя мыши появится символ [+]. 

 
Щелкните правой   Перетащите объект 
кнопкой мыши 
 

Совет: Для точного позиционирования 
удерживайте нажатой клавишу Ctrl для 
перетаскивании вдоль оси X или Y. 
 

3  Отпустите кнопку мыши. 
В этой точке будет создан дубликат 
объекта/ов. 
 
Совет: Клонируйте этим же способом 
объекты в другом окне. Идентичная копия 
выделения создается в тех же координатах, 
что и в первом окне, независимо от того, в 
каком месте вы отпустите кнопку мыши.  

 
 
Группировка и разгруппировка 
объектов 
Вы можете объединить в группу выбранные 
объекты или весь проект, чтобы сохранять связи 
между объектами во время перемещения, 
изменения размеров и трансформации. 
BERNINA Embroidery Software различает понятия 
"разгруппирование" объектов и "разбивка" 
объектов. В общем случае объекты, которые 
были вами объединены в группу, для оцифровки 
должны быть "разгруппированы", чтобы получить 
доступ к компонентам объектов. Если вам нужно 
получить доступ к объектам, которые были 
сгруппированы во время системных операций, - 
например, при генерировании объекта открытой 
аппликации, - вам потребуется разбить объекты. 

 
Примечание: По умолчанию проекты 
автоматически группируются при открытии или 
вставке в другой проект. Подробнее см. в 
разделе Настройка других общих опций. 
 
Группировка объектов 

 
Щелкните по значку Group (панель 
Arrange), чтобы сгруппировать 
выделенные объекты. 
 

 
Вы можете объединить в группу выбранные 
объекты или весь проект, чтобы сохранять связи 
между объектами во время перемещения, 
изменения размеров и трансформации. 
Объединение в группу выделенных объектов или 
целых проектов используется для совместного 
перемещения, изменения размеров или 
трансформирования.  
 
Как сгруппировать объекты 
1  Выберите объекты для объединения в 

группу. 
2  Нажмите кнопку Group (Объединить в 

группу) или нажмите Ctrl + G.  
 

 
Выделение, 

перемещение или  
трансформирование 

сгруппированных  
объектов как единого 

объекта 
 
 
 

 
Выбранные объекты объединяются в группу. 
Группа может быть выделена, перемещена, 
изменена по размеру как единый объект. См. 
также разделы Расположение и 
трансформация объектов и Изменение 
формы и правка объектов. 
 
 
Разгруппирование объектов 
 

Щелкните по значку Ungroup (панель 
Arrange), чтобы разгруппировать 
выделенные объекты. 

 
 
Если вы завершили изменения в группе, вы 
можете разгруппировать их и работать 
индивидуально с каждым объектом. 
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Примечание: Вам нужно разгруппировать 
объекты, перед тем как устанавливать 
параметры вышивания в любом из 
индивидуальных объектов в группе. 
 
Как разгруппировать объекты 
1  Выберите группу объектов. 
2  Нажмите кнопку Ungroup (Разгруппировать). 
 

 
 
 

Разгруппированные  
объекты можно выделять  

индивидуально 
 
 
 

 
 
Объекты будут разгруппированы, и 
входившие в группу объекты можно будет 
выделять индивидуально. 

 
Разбивка объектов на компоненты 
 

Используйте инструмент Break Apart 
(панель Edit ), чтобы разделить 
монограммы, аппликации, тексты и  
элементы "черной вышивки" на отдельные 
компоненты. 

 
Инструмент Break Apart позволяет разбить 
объекты Advanced Applique на отдельные 
компоненты. 
Эта команда может быть также использована 
для монограмм, аппликаций, текстов и 
элементов "черной вышивки". Воздействие на 
эти объекты аналогично операции 
разгруппировки. 
 
Примечание: При сохранении в предыдущей 
версии ПО монограммы, аппликации, текстовых 
объектов, объектов "черной вышивки" они могут 
быть подвергнуты процедуре Break Apart по 
умолчанию. 
 
 
Как разделять объекты на компоненты 
 
1  Выберите объект, который вы хотите 

разделить - объект открытой аппликации, 
автоаппликации, текст или "черную вышивку". 

 
Команда Break Apart активирована.  

 
 
2  Щелкните по значку Break Apart или 

выберите Arrange > Break Apart. 
 

Объект будет разбит на исходные 
(первичные) компоненты вместо 
сгенерированного (вторичного) объекта.  

 

 
 
Эта операция разгруппирует открытый объект 
аппликации в группы компонентов – исходные 
(первичные) объекты, из которых были 
сгенерированы (вторичные) объекты. Она также 
создает объект авто-аппликации из каждого 
куска ткани в проекте. 
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Они не будут вышиваться. См. также раздел 
Оцифровывание для аппликаций. 
 

 
 
Эта операция разгруппирует объекты 
монограммы на составные группы компонентов – 
текстовый объект, орнаменты (каждый орнамент 
остается сгруппированным) и бордюры (также 
сгруппированные). См. также раздел Создание 
монограмм. 
 
Совет: Для модификации индивидуальных 
объектов, - например изменения 
последовательности вышивания бордюров 
монограммы, - используйте инструмент Color 
Film, чтобы разгруппировать объекты и изменить 
последовательность. 
 
 

Изменение 
последовательности 
вышивания объектов 
 
Объекты вышивки в проекте образуют 
последовательность вышивания. Первоначально 
объекты вышиваются в том порядке, в котором 
они создаются. Вы можете изменить положение 
выделенного объекта, вырезав его и затем 
вставив где-либо в последовательности. 
Имеются также возможности выбора 
последовательности объектов способом "As 
Selected" ("Последовательность в порядке 
выделения") или как "Color Blocks" ("Цветные 
блоки"). Вы можете также изменить 
последовательность объектов, используя 
инструмент Color Film. См. также Установление 
последовательности объектов функцией 
Color Film. 

 
Примечание: При работе с образцами 
вышивки вы должны помнить о 
последовательности прошивания объектов.  
Проверить эту последовательность можно, 
пройдя весь проект «стежок за стежком», 
или с помощью медленного 
прорисовывания его на экране. См. раздел  
Просмотр последовательности 
вышивания отдельных фрагментов. 
 
Изменение последовательности 
объектов вырезкой и вставкой 
 

Нажмите Cut (панель General), чтобы 
вырезать объект или объекты с 
помещение в буфер обмена. 
 
Нажмите Paste (панель General), чтобы 
вставить скопированные объекты в 
проект.  
 

Вы можете изменить последовательность 
объектов путем вырезания объекта из проекта и 
вставить его в другое место 
последовательности. Это не внесет изменений в 
физическое расположение объекта. 
 
Как изменять последовательность 
объектов вырезкой и вставкой 
1 Выделите объект (или объекты) для 

изменения последовательности. 
2 Нажмите кнопку Cut (Вырезать). 
 Выделенный объект будет удален из проекта 

и помещен в буфер обмена. 
 
 
    

 
Неправильная    Выделенный и вырезанный 
последовательность  объект будет изменен 

 
3 Перейдите к точке в последовательности 

вышивания, в которую вы хотите поместить 
объект. Подробнее см. в разделе Обход по 
стежкам. 

 Вы можете вставить объект между другими 
объектами в последовательности или 
"вмонтировать" вырезанный объект внутри 
другого объекта. 
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 Если текущее положение маркера иглы 

находится в конце проекта, объект будет 
вставлен в конце последовательности. 

 
4 Нажмите кнопку Paste (Вставить). 
    

 
Перейдите к концу проекта  Вставьте объект  

 
 Объект будет вставлен в конец проекта. 
 
 Примечание: Объект будет оставаться в 

буфере обмена и может быть неоднократно 
вставлен до тех пор, пока не последует 
следующая команда Copy (Копировать) или 
Cut (Вырезать).  

 
Изменение последовательности 
выделенных объектов 
 

Выберите команду Sequence As Selected (меню 
Arrange), чтобы изменить последовательность 
выделенных объектов. 
 

Вы можете изменить последовательность 
объектов путем их выделения в порядке 
требуемой последовательности вышивания. 
 
Как изменить последовательность 
выделенных объектов 
1 Выделите первый объект в диапазоне 

объектов, последовательность которых вы 
хотите изменить. 

2 Удерживая нажатой клавишу Ctrl, 
последовательно выберите объекты в 
порядке изменения последовательности.   

 

 Примечание: Выбирайте каждый объект в 
том порядке, в котором вы хотите их 
вышивать. 

3 Когда объекты еще остаются выделенными, 
выберите команду Arrange (Расположение) > 
Sequence As Selected (Последовательность 
в порядке выделения). 
 
 

 
 Теперь последовательность объектов будет 

соответствующей порядку их выделения 
справа от первого выделенного объекта. См. 
также Установление 
последовательности объектов 
функцией Color Film. 

 
      

 
   Неправильная     Правильная  
последовательность          последовательность 

Изменение последовательности 
объектов по цвету 
 
Выберите команду Sequence By Color (меню 
Arrange), чтобы изменить последовательность 
объектов по цвету. 
 

Вы можете изменить последовательность 
объектов по цвету. Таким образом, вы 
уменьшите количество цветовых переходов в 
проекте.  См. также Установление 
последовательности объектов функцией 
Color Film. 
 
Как изменить последовательность 
объектов по цвету 
1 Выберите объекты для изменения 

последовательности. 
2 Выберите команду Arrange > Sequence By 

Color. 
 Откроется диалоговое окно Sequence By 

Color (Последовательность по цвету) со 
списком цветов в выбранных объектах. 

      

 
3 Выберите цвет и нажмите Move Up 

(Переместить вверх) или Move Down 
(Переместить вниз), чтобы изменить его 
положение в последовательности.  
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4 Нажмите кнопку ОК. 

 

     
Черный цвет первый   Черный цвет последний 

 
Изменение последовательности 
объектов в начале или конце 
 
Выберите команду Sequence to Start (меню 
Arrange), чтобы поместить выделенный объект в 
начало последовательности вышивания.  
Выберите команду Sequence to End (меню 
Arrange), чтобы изменить последовательность 
выделенного объекта в конце 
последовательности вышивания.  
 
Вы можете изменить последовательность 
объектов, выделив их и расположив в начале 
или конце последовательности вышивания. См. 
также Установление последовательности 
объектов функцией Color Film. 
 
Как изменить последовательность 
объектов в начале или конце 
◄ Выделите объект. 
◄ Выберите команду Arrange > Sequence to 

Start. 
 Последовательность вышивания проекта 
изменяется при размещении выделенного 
объекта в начало последовательности. 
◄ Выберите команду Arrange > Sequence to 

End. 
 Последовательность вышивания проекта 
изменяется при размещении выделенного 
объекта в конец последовательности. 
 
Изменение последовательности 
объектов инструментом Color Film 

 
Щелкните по кнопке Color Film 
(панель General), чтобы можете 
изменить последовательность 
объектов путем изменения их 
положения в окне Color  

    Film. Перетаскивайте значки объектов  
    для изменения последовательности.  

 
Щелкните по кнопке Show Individual  
Objects (панель Color Film), чтобы 
просмотреть индивидуальные 
объекты в  порядке    

       последовательности вышивания.   
       Перетаскивайте значки объектов для  
       изменения   последовательности.  

 
Выберите команду Sequence As 
Selected (панель Color Film), чтобы 
изменить последовательность 
выделенных объектов. 
 
Выберите команду Sequence By Color 
(панель Color Film , чтобы изменить 
последовательность объектов по 
цвету. 
 
Выберите команду Sequence to Start 
(панель Color Film), чтобы поместить 
выделенный объект в начало 
последовательности вышивания.  
 
Выберите команду Sequence to End 
(панель Color Film), чтобы поместить 
выделенный объект в конец  
последовательности вышивания.  

 
Проекты создаются из индивидуальных 
вышивальных "объектов", сгруппированных 
функцией "color block". Они указываются в 
порядке вышивания в списке Color Film. 
Используйте эту возможность для оптимизации 
своего проекта путем вырезания, копирования, 
вставки, дублирования, удаления и изменения 
последовательности выбранных цветных блоков. 
В общем случае вы должны стремится к 
сохранению блоков с одним и тем же цветом а 
общей последовательности, чтобы свести к 
минимуму количество изменений цвета, обрезки 
ниток и перемещения пялец. После оптимизации 
цветовой последовательности вы сможете 
оптимизировать свой проект, проверив 
последовательность вышивания отдельных 
объектов. См. также раздел Просмотр и 
выделение цветных блоков. 
 
Примечание: Возможны случаи, при которых 
может потребоваться разбивать цвета, в 
особенности, если один из объектов находится 
около контура, поскольку контуры требуется 
вышивать поверх заполнения.  
 
Как изменить последовательность 
объектов инструментом Color Film 
• Нажмите кнопку Color Film. 

Откроется диалоговое окно Color Film, 
отображающее все цветные блоки в проекте 
в порядке последовательности вышивания. 
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Щелкните по цветному блоку 
удерживая кнопку 

Перетащите  цветной блок в 
новое положение 

Последовательные 
объекты одного цвета 
образуют единый цветной 
блок 

Все объекты, входящие в 
цветные блоки, 
показываются в 
последовательности 
вышивания 

 
• Перетащите выделенные объекты, чтобы 

изменить их расположение в 
последовательности вышивания  

     
 
Примечание: Функция Color Film 
синхронизирована с окном проекта. Она 
динамически обновляется в то время, когда вы 
выбираете, изменяете или удаляете объекты 
или создаете новый объект.  
 
◄ Щелкните по переключающей кнопке Show 

Individual Objects (Показать 
индивидуальные объекты), чтобы 
просмотреть индивидуальные объекты. Все 
объекты в пределах каждого цветного блока 
показываются в последовательности 
вышивания. 

 

 
 
◄ При необходимости используйте список для 

перетаскивания значков объектов и 
изменения последовательности. 
◄ Для выделения нескольких идущих подряд 

объектов удерживайте нажатой клавишу 
Shift. 

 
◄ Для выделения нескольких объектов 

удерживайте нажатой клавишу Ctrl. 
 
◄ Щелкните правой кнопкой мыши по списку, 

чтобы вызвать всплывающее меню. 
Используйте его при необходимости для 
вырезания, копирования или вставки 
объектов. 

 
◄ Используйте кнопку команды Sequence для 

изменения положения выбранных цветных 
блоков или индивидуальных объектов в 
последовательности вышивания.  
Каждая команда Sequence выполняет ту же 
функцию, что и идентичный пункт в меню 
Arrange, т.е. щелчок по значку Sequence By 
Color, если он активирован, вызывает 
открытие диалогового окна Sequence By 
Color. См. также раздел Установление 
последовательности объектов. 

 
 
Автоматическая 
последовательность 
вышивания всего проекта 
 
Щелкните по  Stitch Sequence (меню Arrange) для 
автоматического выбора последовательности 
вышивания, чтобы свести к минимуму число 
перезаправок пялец, обрезок нитки и изменений 
цветов.   
 
Функция Stitch Sequence (Последовательность 
вышивания) улучшает качество и 
эффективность вышивания, сводя к минимуму 
количество перезаправки пялец, замены 
цветных ниток и обрезки ниток.  При этой 
операции сохраняются все существующие 
перекрытия. Система анализирует проект и 
пересчитывает: 
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◄ перезаправки пялец (если требуется больше 

одного раза) 
◄ замену цветных ниток (общее число в 

текущем окне проекта) и 
◄ объекты, которые вышли за контуры пялец 

(если таковые имеются). 
 
Объединенные в группу объекты при операции 
Stitch Sequence не разгруппируются, но 
объектам разного цвета назначается 
оптимальная последовательности независимо от 
группировки. Однако монограммы и объекты 
открытой аппликации обрабатываются как 
отдельные объекты. Другими словами, их 
внутренняя последовательность не изменяется 
до тех пор, пока командой Break Apart они не 
будут разбиты. См. также  
Разбивка объектов на компоненты. 
 
Как назначить автоматическую 
последовательность всему проекту  
1  Откройте или создайте проект. 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
2  Выберите Arrange > Stitch Sequence. 

Система анализирует все выбранные 
объекты и рассчитывает оптимальное число 
перезаправок пялец, замен цветов и обрезок 
ниток. 

 

 
 
 
Примечание: Если ваш проект не размещается 
в текущих пяльцах, вы будете об этом 
предупреждены.  Вы сможете выбрать более 
крупные пяльцы или  использовать 
перезаправку. См. также Закрепление в 
пяльцах крупных проектов.  
 
3  Щелчком по кнопке Yes подтвердите 

предложенную оптимальную 
последовательность. 

 
Примечание: Командой Undo можно отменить 
изменение последовательности вышивания. 
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ГЛАВА 17 
 

 
РАСПОЛОЖЕНИЕ И 

ТРАНСФОРМАЦИЯ ОБЪЕКТОВ 
------------------------------------------- 
 
 

BERNINA Embroidery Software позволяет располагать и 
трансформировать объекты различными способами, как 
интерактивной, так и цифровой техникой. Позиционировать 
объекты можно перетаскиванием мышью, клавишами со 
стрелками или изменением свойств объекта. Для 
выравнивания объектов относительно друг друга имеются 
различные специальные инструменты. 
Изменять размеры объектов можно непосредственно на 
экране или заданием точных размеров или процентного 
изменения. Поворот, изменение наклона и зеркальное 
отображение объектов производится такими же 
средствами. 
Специальные инструменты позволяют дублировать и трансформировать 
вышивальные объекты, а также переводить их в зеркальное отображение и 
поворачивать по центральным осям.  
В этом разделе описывается, как позиционировать и выравнивать объекты как 
интерактивными, так и цифровыми способами. Также рассматриваются способы 
изменения размеров, вращения и перекоса объектов. Кроме того, описываются 
различные способы перевода объектов в зеркальное отображение. 

 

Позиционирование объектов 
Вы можете позиционировать объекты в окне 
проекта различными стандартными методами 
операционной системы MS Windows®, а том 
числе перетаскиванием мышью, а также 
клавишами со стрелками для "подталкивания" в 
требуемое положение. Вы можете также 
задавать точные координаты объекта, используя 
свойства объекта. 

 
Позиционирование объектов 
компьютерной мышью 
Наиболее простым способом перемещения 
объекта в вашем проекте является 
перетаскивание его мышью. Используйте 
клавиши со стрелками для "подталкивания" 
объекта к нужной позиции. 
 
Как позиционировать объекты 
перетаскиванием мышью 
1  Выберите объект/ы для перемещения. 
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2  Перетащите мышью объект в новое 
положение. 

 
 
 
Курсор в виде 
перекрести в центре 
объекта 
 
 
 
 
 

3  Для более точного позиционирования 
нажимайте клавиши со стрелками, чтобы 
"подтолкнуть" объект к требуемой позиции. 
Совет: Увеличьте масштаб изображения, 
чтобы было легче выполнять малейшие 
перемещения. Размеры объекта на экране 
изменяются в зависимости от текущего 
масштаба. Чем больше масштаб, тем на 
меньшее расстояние можно перемещать 
объект. 

 
Позиционирование объектов с 
использованием свойств объекта 
 
Вы можете позиционировать выбранные 
объекты по отношению к центру проекта вводом 
координат X:Y в диалоговом окне Object 
Properties (Выбор объекта). 
 
Как позиционировать объекты с 
использованием свойств объекта 
1  Выберите объект/ы для перемещения. 
2  Дважды щелкните по проекту, чтобы открыть 

диалоговое окно Object Properties, и 
выберите закладку General. 

     

 
 

                                    Введите новые координаты 
3  В полях Position введите новые координаты 

объекта. 
4  Нажмите кнопку Apply. 
 Центр объекта переместится в точку ч 

назначенными вами координатами. 

Выравнивание объектов 
 

Для выбора объекта используйте 
инструмент Select Object (Выбрать 
объект) на панели Design. 
 

Щелкните по значку Align Left 
Vertical (Выровнять слева по 
вертикали) на панели Arrange, 
чтобы выровнять объекты по их 
левым сторонам. 
Щелкните по значку Align Centers 
Vertical (Выровнять средние линии 
по вертикали) на панели Arrange, 
чтобы выровнять объекты по их 
средним линиям. 
 

Щелкните по значку Align Right 
Vertical (Выровнять справа по 
вертикали) на панели Arrange, 
чтобы выровнять объекты по их  

     правым сторонам. 
 

     Щелкните по значку Align Top 
Horizontal (Выровнять верхние 
стороны по горизонтали) на панели 
Arrange, чтобы выровнять объекты 
по их верхним сторонам. 
 

Щелкните по значку Align Centers 
Horizontal (Выровнять средние 
линии по горизонтали) на панели 
Arrange, чтобы выровнять объекты 
по их средним линиям. 
 

Щелкните по значку Align Bottom 
(Выровнять нижние стороны) на 
панели Arrange, чтобы выровнять 
объекты по их нижним сторонам. 
 

Щелкните по значку Align Centers 
(Выровнять центры) на панели 
Arrange, чтобы выровнять  
выделенные объекты по их 
центрам. 

 
BERNINA Embroidery Software позволяет 
выравнивать объекты, чтобы позиционировать 
их по отношению друг к другу. Вы можете 
выравнивать выбранный объект по левому, 
правому, верхнему или нижнему краю или по 
центру.  
 
Как выравнивать объекты 
1  Выберите объекты, которые вы хотите 
выровнять. 
2  Выберите объекты, которые вы хотите 
выровнять совместно. 
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Примечание: Объекты выравниваются с 
последним выбранным объектом. Если мы 
выделяем все объекты проекта клавишами 
Ctrl+A или командой "Выделить все", объекты 
выравниваются по последнему объекту 
последовательности. 
 
3  Щелкните по одному из значков 

выравнивания на панели Arrange 
(Расположение). 

 
                                                     Выравнивание по центрам 

 
 
                                                                 
 
 
                                                                                    
 
 
 
 
 
 
 
 
 

 
                                                                              по левому краю 

 
Изменение размеров 
объектов 
 
Вы можете изменять размеры объектов 
непосредственно на экране или заданием 
точных размеров или процентного изменения. 
При изменении размеров объекта изменяется 
количество стежков для сохранения интервала 
между стежками. 
 
Примечание: Возможность изменения размера 
и качество вышивки  в конечном счете зависит от  
 
 
формата первоисточника – ART Grade A, ART 
Grade B, ART Grade C или ART Grade D. Только 
проекты в "родном" формате ART Grade A 
содержат полный набор информации, требуемой 
для 100%-ного совершенства масштабирования 
и трансформации. Подробнее см. в разделе  
Форматы проектов вышивки. 

Изменение размеров объектов 
инструментом Scale by 20% Down/Up 

 
 Щелкните по значку Scale by 20% 
Down/Up (панель Edit), чтобы уменьшить 
размеры объектов на 20 %. Щелкните 

правой кнопкой мыши, чтобы увеличить размеры 
объектов на 20 %  
 
Используйте эту технику, если вы хотите быстро 
выполнить изменения, которые не требуют 
особой точности. 

            
уменьшение на 20 % оригинальный размер   увеличение на 20 % 
 
Как изменять размеры объектов 
инструментом Scale by 20% Down/Up 
1  Выделите объект/ы. 

Совет: См. раздел Выбор нескольких 
последовательно расположенных 
объектов для быстрого выделения 
нескольких или всех объектов проекта. 

2  Щелкните по значку Scale by 20% Down/Up. 
◄ Щелкните левой кнопкой мыши, чтобы 

уменьшить проект на 20 %. 
◄ Щелкните правой кнопкой мыши, чтобы 

увеличить проект на 20 %.  
 
 
Изменение размеров объектов 
перетаскиванием мышью 
 
Вы можете изменить высоту и ширину объекта 
или пропорционально изменять размеры 
объекта, используя маркеры – манипуляторы 
выделения. Изменяйте объекты индивидуально 
или выберите несколько объектов для 
одновременного изменения. 
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Как изменять размеры объектов 
перетаскиванием мышью 
1  Выберите объект/ы для изменения размеров. 
 Вокруг выделенного объекта появятся восемь 

меток – манипуляторов выделения. 
2 Перетащите мышью манипулятор, чтобы 

изменить размер объекта 
 
• Для пропорционального изменения 

высоты и ширины используйте угловые 
маркеры 

пропорциональное    изменение размеров 
изменение размеров    относительно центра 
 
Совет: По умолчанию размеры объектов 
изменяются пропорционально. Для изменения 
размера только по вертикали или горизонтально 
удерживайте при перетаскивании клавишу Ctrl. 
 
◄ Для изменения высоты используйте верхний 

средний или нижний средний маркеры. 
 
 
 
 
 
 
 
 

Изменение по вертикали 
 

 
◄ Для изменения ширины используйте 

средние боковые маркеры. 
 

 
 
 
 
 

Изменение по горизонтали 
 
Совет: Для изменения размеров относительно 
центра во время перетаскивания маркера 
удерживайте нажатой клавишу Shift. 

 
 

 

Изменение размеров в обоих направлениях 
 
Изменение размеров объектов с 
использованием свойств объекта 
Вы можете изменять высоту и ширину 
выбранных объектов или всего проекта, 
используя свойства объекта. 
 

Внимание: Если вы изменяете проект  или 
„expanded“ дизайн больше чем на 5 %, 
изменения плотности стежков может повлиять на 
качество вышивки проекта. См. также Форматы 
проектов вышивки. 
 

Как изменять размеры объектов с 
использованием свойств объекта 
1  Выберите объект/ы для изменения размеров. 
2  Дважды щелкните или щелкните правой 

кнопкой мыши по проекту, чтобы открыть 
диалоговое окно Object Properties, и 
выберите закладку General. 

3  На панели Dimensions (Размеры) измените 
размеры по своему выбору. Альтернативно: 

◄ введите точные значения высоты (Height) и 
ширины (Width) или  

◄ введите новые значения высоты и ширины в 
качестве процентного отношения к текущим 
размерам. 

 
 

Введите 
размеры  в виде 
абсолютных или 

процентных 
величинах 
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Совет: Отметьте галочкой выбор функции  
Proportional Scaling (пропорциональное 
масштабирование) для пропорционального 
масштабирования исходных объектов. 
 
4  Нажмите кнопку Apply. 

    
150%-ное   оригинальный 80%-ное уменьшение 
увеличение   размер    высоты 
высоты     140%-ное увеличение  

ширины 
 
Примечание: После изменения размеров 
размеры нового объекта устанавливаются на 
100 %.  

Вращение объектов 
Вы можете поворачивать объекты 
непосредственно на экране или назначив угол 
поворота. 
 
Вращение объектов 
перетаскиванием мышью 
При выделении объекта на его крайних точках 
появляются метки – манипуляторы выделения. 
Если вы щелкните по объекту еще раз, то эти 
метки преобразуются в маркеры вращения. 
 
Как поворачивать объекты 
перетаскиванием мышью 
1  Выберите объект/ы для поворота. 

Вокруг выделенного объекта появятся восемь 
меток – манипуляторов выделения. 

 
2  Щелкните по объекту еще раз. 
 На углах объекта появятся маркеры 

вращения, а в его центре отобразится 
местоположение анкера. 

       маркер наклона 

маркер вращения 
местоположение анкера 

первым щелчком    после второго щелчка 
отображаются    появляются маркеры вращения 
маркеры выделения 

 
 Внимание: Если второй щелчок последует за 

первым слишком быстро, откроется 
диалоговое окно Object Properties. 

3  При необходимости перетащите анкер 
вращения в другое положение. 

4  Щелкните по маркеру вращения и 
перетащите его по часовой стрелке или 
против часовой стрелки. Во время поворота 
появляется контур и перекрестие. 

     

 
Перетащите угол,   Перетащите анкера  Перетащите угол 
чтобы  повернуть   местоположение   чтобы повернуть 
объект вокруг анкера.       объект вокруг анкера. 
 
Вращение объектов инструментом 
Rotate CCW/CW 

 
Щелкните левой кнопкой/ правой кнопкой 
по значку Rotate 45 ° CCW/CW (панель 
Edit), чтобы повернуть объект или проект  

 на 45° в любом направлении. 
 
Используйте инструмент Rotate CCW/CW 
(Поворот против часовой стрелке/по часовой 
стрелке), чтобы поворачивать объекты на 45° в 
любом направлении. 
 
Как вращать объекты инструментом 
Rotate CCW/CW 
1  Выберите один или несколько объектов 

инструментом Select Object (Выбор объекта). 
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2  Щелкните по значку Rotate CCW/CW на 
панели инструментов.  
◄ Щелчок правой кнопкой – поворот на 45° 

по часовой стрелке. 
◄ Щелчок левой кнопкой – поворот на 45° 

против часовой стрелке. 
 
Вращение объектов с 
использованием свойств объекта 
 
Вы можете повернуть выбранные объекты путем 
ввода точного значения угла поворота в 
диалоговом окне Object Properties. 
 
Как вращать объекты с использованием 
свойств объекта 
1  Выберите объект/ы для поворота. 
2  Дважды щелкните /щелкните правой кнопкой 

по проекту, чтобы открыть диалоговое окно 
Object Properties, и выберите закладку 
General. 

3  В поле Rotate By (Повернуть на), введите 
требуемое вам значение угла поворота. 

4  Нажмите кнопку Apply. 
  
 
Введите 
угол 
поворота 
 
 

 

Перекос объектов 
Вы можете придавать объектам нужный угол 
перекоса непосредственно на экране или путем 
ввода угла перекоса в диалоговом окне Object 
Properties. 
 
Перекос объектов перетаскиванием 
мышью 
Вы можете перекосить объект относительно 
горизонтальной линии, щелкнув по маркеру 
перекоса и перетащим его на требуемый угол. 
 
 
 
 
 

 
 
 

Как перекосить объекты 
перетаскиванием мышью 
1  Выберите объект/ы для перекоса. Вокруг 

выделенного объекта появятся восемь меток 
– маркеров выделения. 

 
2  Щелкните по объекту еще раз. 
 Вокруг объекта появятся маркеры поворота и 

перекоса. Маркеры перекоса имеют форму 
ромба и появляются в средних точках 
верхнего и нижнего края объекта. 
 

Внимание: Если второй щелчок последует за 
первым слишком быстро, откроется 
диалоговое окно Object Properties. 

 
3  Перетащите маркер перекоса влево или 

вправо. 
 Объект будет перекошен в горизонтальном 

направлении. Контур и перекрестие покажут 
изменение формы объекта. 
 
 

Перетащите маркер 
перекоса  

влево или вправо. 
 

 
 
 
Перекос объектов с использованием 
свойств объекта 
Вы можете перекашивать выбранные объекты 
путем ввода точного значения угла перекоса в 
диалоговом окне Object Properties. 
 

Перекос на 30°  
с использованием  свойств объекта 
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Как перекашивать объекты с 
использованием свойств объекта 
1  Выберите объект/ы для перекоса. 
2  Дважды щелкните или щелкните правой 

копкой по объекту, чтобы открыть диалоговое 
окно Object Properties, и выберите закладку 
General. 

3  В поле Skew By (Перекос на), введите 
требуемое вам значение угла перекоса. 

4  Нажмите кнопку ОК. 
 
 
 
Введите угол 
перекоса 
 

 

Перевод объектов в 
зеркальное отображение 
 
Вы можете зеркально отображать объекты, 
переворачивая их по горизонтали или по 
вертикали, используя инструменты Mirror в 
диалоговом окне Object Properties (Свойства 
объекта). Специальные инструменты позволяют 
дублировать и трансформировать вышивальные 
объекты, а также переводить их в зеркальное 
отображение и поворачивать по центральным 
осям.  
 
 
 
 
 
 
 

Перевод объектов в зеркальное 
отображение с использованием 
инструментов Mirror Horizontal или 
Mirror Vertical 
 
Щелкните по кнопке Mirror Horizontal (панель 

Edit), чтобы перевернуть объект на 
горизонтальной оси. 
 
Щелкните по кнопке Mirror Vertical 
(панель Edit), чтобы перевернуть 
объект на вертикальной оси. 
 

 
Вы можете зеркально переворачивать объекты 
на горизонтальной или вертикальной оси, 
используя инструмент Mirror Horizontal или Mirror 
Vertical. 

 
Как переводить объекты в зеркальное 
отображение с использованием 
инструментов Mirror Horizontal или Mirror 
Vertical 
 
1  Выберите объект/ы для зеркального 

переворачивания. 
 
оригинальный объект      зеркальное отображение  

по горизонтали (X) 

 
зеркальное отображение   зеркальное отображение 
по вертикали (Y)    по горизонтали и вертикали (X и Y) 
 
2  Щелкните по значку Mirror Horizontal, чтобы 

перевернуть объект по горизонтали, или 
Mirror Vertical,  чтобы перевернуть объект по 
вертикали. 

 
Зеркальное переворачивание 
объектов с использованием свойств 
объекта 
Вы можете зеркально переворачивать объекты 
по горизонтали или по вертикали, используя 
диалоговое окно Object Properties (Свойства 
объекта). 
 
Как переворачивать объекты с 
использованием свойств объекта 
1  Выберите объект/ы для зеркального 

переворачивания. 
2  Дважды щелкните по объекту, чтобы открыть 

диалоговое окно Object Properties, и 
выберите закладку General. 

3  На панели Mirror выберите In X или In Y. 
◄ При выборе In X объект перевернется по 

горизонтали  
◄ При выборе In Y объект перевернется по 

вертикали. 
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Переворот по 
горизонтали 

 
Переворот по 

вертикали 
 

 
Совет: Проставьте флажки в обоих окошках, 
чтобы одновременно перевернуть объект по 
горизонтали и вертикали. 
4  Нажмите кнопку ОК. 
 
Зеркальное переворачивание с 
дублированием объектов 
 

Используйте инструмент Mirror 
Merge Horizontal (панель Arrange) 
для дублирования объекта по 
горизонтали. 
 
Используйте инструмент Mirror 
Merge Vertical (панель Arrange) для 
дублирования объекта по 
вертикали. 
 
Используйте инструмент Mirror 
Merge Horizontal/Vertical (панель 
Arrange) для дублирования объекта 
как по горизонтали, так и по  

     вертикали. 
 
Инструменты Mirror-Merge (Зеркальное 
переворачивание-Дублирование) позволяют 
дублировать и преобразовывать объекты и 
объединять их в единый объект.  

оригинальный проект 

             

Как зеркально переворачивать и 
дублировать объекты 
1  Выделите объект/ы. 

Примечание: Убедитесь в том, что исходный 
объект/ы разгруппированы, в противном 
случае при операции зеркального 
отображения с дублированием 
последовательность цветов не будет 
изменена. 

 
2 Выберите инструмент Mirror-Merge  

 
• Mirror-Merge Horizontal  

 
 
 
 
 
 
 
 

◄ Mirror-Merge Vertical       
         
 
 
 
 
 
 
 
 

◄ Mirror-Merge Horizontal/Vertical 
 

 
 
 
 
 
 
 
 

3 Переместите базисную линию в положение, в 
которое вы хотите добавить перевернутый 
объект и щелкните, чтобы наметить 
местоположение анкера. 

 Указатель мыши соединяется с базисной 
линией. При перемещении указателя вокруг 
объекта, зеркально перевернутый объект 
также перемещается. 

 Копия объекта помещается как зеркально 
перевернутое изображение оригинала. 
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Примечание: Если перевернутая копия 
перекрывает оригинальный объект, то 
появится вопрос, хотите ли вы объединить 
объекты. 

 
Создание венков 
 

Используйте инструмент Wreath 
(панель Arrange), чтобы многократно 
дублировать объекты вокруг 
центральной точки. 
 
Используйте инструмент Kaleidoscope 
(панель Arrange, чтобы расположить  
зеркально отображенные объекты  

      вокруг центральной оси. 
 

Инструмент Wreath (Венок) многократно 
дублирует объекты вокруг центральной точки. 
Инструментом Kaleidoscope (Калейдоскоп) 
работают совместно с инструментом Wreath для 
расположения зеркально перевернутых объектов 
вокруг центральной оси.  Поскольку объект 
зеркально переворачивается, функция 
Kaleidoscope действует только с четным 
количеством объектов.          

6-точечный венок с                6-точечный вен ок с  
отключенной функцией Kaleidoscope         включенной 

     функцией   
     Kaleidoscope 

 

 
Как создать венок 
1  Выделите объект/ы. 

Примечание: Убедитесь в том, что исходный 
объект/ы разгруппированы, в противном 
случае при операции зеркального 
отображения с дублированием 
последовательность цветов не будет 
изменена. 

2  Нажмите кнопку Wreath (Венок). 
3  Введите число точек венка.  
 
 Примечание: Для активирования функции 

Kaleidoscope вводите четные числа. 
4  Нажмите кнопку Kaleidoscope, если это 

необходимо. 
5  Переместите базисную линию к центру венка 

и щелкните, чтобы наметить местоположение 
анкера. 

 
 
 
 

Переместите 
указатель мыши  

для установления 
центральной точки. 

 

 
 
 
 
 
Совет: Удерживайте нажатой клавишу Ctrl, 
чтобы линий проходила под углом 45°. 

 

Указатель мыши соединяется с базисной 
линией. При перемещении указателя вокруг 
объекта, зеркально перевернутый объект 
также перемещается. 
Объекты копируются и размещаются вокруг 
центральной точки. 

 

Примечание: Если перевернутая копия 
перекрывает оригинальный объект, то 
появится вопрос, хотите ли вы объединить 
объекты. 

 
8-точечный венок с центром,  

намеченным ниже оригинального объекта 
      

 
 

8-точечный венок с центром, 
намеченным выше оригинального объекта 
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ГЛАВА 18 
 

 
ИЗМЕНЕНИЕ ФОРМЫ И ПРАВКА 

ОБЪЕКТОВ 
------------------------------------------- 
 
 

BERNINA Embroidery Software позволяет изменять 
форму объекта, угла стежков точки входа и выхода с 
помощью контрольных точек. Линии наклона стежков 
маркеры входа и выхода появляются вокруг выбранных 
объектов. Контрольные точки слегка различаются в 
зависимости от типа объекта. 
Рекомендуется перед началом изменения любого 
проекта сохранить его копию под новым именем и 
хранить оригинал для случая, если вы захотите 
отказаться от всех изменений и начать снова. 
В этом разделе объясняется, как изменять форму 
объектов контрольными точками, изменять форму 
окружностей, устанавливать угол наклона стежков – 
включая сложные углы наклона – и изменять точки входа 
и выхода. См. также раздел Правка вышиваемых текстов. 

 

Изменение формы объектов 
Вы можете изменять форму объекта, выбрав его 
инструментом Reshape Object (Изменение 
формы объекта) и перемещая, добавляя или 
удаляя контрольные точки на контуре. Для 
некоторых объектов вы можете также заменять 
угловые контрольные точки на контрольные 
точки кривых. 
Инструмент Reshape дает возможность изменять 
формы, не оказывая влияния на угол стежков. 
 
Примечание: Стежки всех объектов при 
изменении формы регенерируются. 
 

 
Просмотр и выбор контрольных 
точек 
 

 
Используйте инструмент Reshape 
Object (панель Edit) для просмортра 
контрольных точек выбранных  

                  объектов. 
 
Узлы изменения формы могут быть выбраны 
индивидуально или совместно для изменения 
положения или модификации. 
 
Просмотр и выбор контрольных точек 
 
1  Выделите объект. 
2  Нажмите кнопку Reshape Object (Изменение 
формы объекта). 
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Вокруг объекта появятся контрольные точки - 
узлы изменения формы.  
 

точка выхода 
 
 
контрольная 
точка кривой 
 
угловая 
контрольная 
точка 
 
 
точка входа 

 
 
3  Для выделения выполните одну из 
следующих операций: 

Выбранная контрольная точка изменения 
формы "подсвечивается". 

 
◄ Щелкните, чтобы выбрать отдельную  

контрольную точку. 

 
◄ Удерживая клавишу Ctrl, щелкните, 

чтобы выбрать несколько контрольных 
точек.  

 
◄ Щелкните и обведите ограничивающий 

прямоугольник вокруг группы 
контрольных точек, чтобы выбрать их. 

           

Изменение формы объектов с 
использованием контрольных точек 
 

Используйте инструмент Reshape Object 
(панель Edit) для изменения формы 
объекта. 

 
Вы можете изменять форму объекта, выбрав его 
инструментом Reshape Object (Изменение 
формы объекта) и перемещая, добавляя или 
удаляя контрольные точки на контуре. Для 
некоторых объектов вы можете также заменять 
угловые контрольные точки на контрольные 
точки кривых. 
 
Как изменять формы объектов с 
использованием контрольных точек 
1  Выделите объект. 
2  Нажмите кнопку Reshape Object (Изменение 
формы объекта). 
 Вокруг объекта появятся контрольные точки. 
 
3  Для создания дополнительных контрольных 

точек изменения формы на контуре: 
◄ щелкните левой кнопкой (Left-click), чтобы 

добавить угловую точку, 
◄ щелкните правой кнопкой (Right-click), 

чтобы добавить точку кривой. 
 

 
 
 
 
 
 
 
4 

 Выберите требуемые узлы изменения 
формы. Подробнее см. в разделе Просмотр 
и выбор узлов изменения формы. 
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Перетащите и нажмите Enter 

Выберите Delete  и нажмите Enter 

Выберите, нажмите  клавишу пробела   
и нажмите Enter 

Перемещение контрольных точек 
Вы можете перемещать контрольные точки, 
чтобы изменить форму контура. 
 
5  Определите новое положение выбранных 

узлов изменения формы, перетащите их 
вдоль контура и нажмите клавишу Enter.  

 

 
Совет: Используйте клавиши со стрелками 
для "подталкивания" выбранных узлов 
изменения формы. 

 
6  Нажмите Delete для удаления 

нежелательных узлов изменения формы и 
нажмите Enter. 

 
 
 
 
 
 
 
 
 
 
 
 

7  Нажимайте клавишу пробела, чтобы 
переходить от выбранных угловых точек к 
точкам кривой и затем клавишу Enter. 
 

 
Совет: Если вы сделали ошибку, нажмите 
Esc, чтобы отменить изменения, нажмите 
Esc еще раз, чтобы деактивировать 
инструмент Reshape Object.  

 
 
 
 
 

Примечание: Вы можете также настроить по 
своему желанию угол наклона стежков, как и 
изменять точки входа и выхода. Подробнее см. в 
разделах Подгонка углов наклона стежков и 
Изменение точек входа и выхода. 
 
8  Нажмите Esc для завершения. 
 
Изменение формы следующего или 
предыдущего объекта 
При правке объекта в режиме Reshape 
используйте клавишу табуляции (Tab) для 
быстрого перехода между объектами. См. также 
раздел Отмена выделения объектов. 
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Как изменять форму следующего или 
предыдущего объекта 
◄ Нажмите клавишу Tab для принятия всех 

изменений и перехода к следующему в 
последовательности вышивания объекту. 

 

 
 
◄ Нажатие клавиш Shift + Tab приводит к 

принятию всех изменений объекта и к 
переходу к предыдущему объекту. 

 
    
Сглаживание кривых 
 

Используйте функцию Reshape 
Object вместе с командой Edit > 
Smooth Curves, чтобы удалить 

лишние узлы изменения формы объектов 
вышивки. 
 
Векторные объекты и объекты вышивки 
имеют узлы изменения формы на контуре. 
На объектах, которые можно плавно 
вращать, программа может вставить сотни  
узлов изменения формы, что затрудняет 
работу с объектом. Команда Smooth 
Curves (сгладить кривые) позволяет 
применить к объектам вышивки функцию 
сглаживания кривых линий. 
 

 

Чтобы сгладить кривые линии 
1 Выберите объект (или объекты), для 
которых нужно выполнить сглаживание. 
 
Примечание: сглаживание применимо 
только к разгруппированным и выбранным 
объектам. Выбрать можно сразу несколько 
объектов. 
 
2 Нажмите кнопку  Reshape Object. 
На контуре объекта появятся узлы 
изменения формы. 
 
3 Выберите Edit > Smooth Curves. 
Откроется диалог сглаживания кривых 
линий Smooth Curves. 

 
 
4 В поле Precision (точность) укажите 
уровень точности сглаживания. От его 
значения зависит, насколько близко 
сглаженный контур будет повторять 
исходный образец. Чем выше уровень 
точности – тем меньше будет узлов 
изменения формы.  
 
 
5 Нажмите OK. 
 
 

Изменение формы объектов 
окружности 
 

Используйте инструмент Reshape Object 
(панель Edit) для изменения формы 
объектов окружности. 

 
 
Для объектов, созданных инструментом Circle 
(Окружность), изменение формы производится 
только контрольными точками. В таких объектах 
вы не можете добавлять, изменять или удалять 
контрольные точки. Объекты окружности можно 
преобразовывать из окружности в овал 
инструментом Reshape Object.  
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Объекты окружности имеют две контрольные 
точки изменения формы (используемые для 
изменения радиуса и ориентации объекта), 
центральную точку (используемую для 
изменения положения) и точку входа стежка. 

контрольная 
точка 
 
угол стежка 
 
контрольная 
точка 
изменения 
формы 
 
 

точка входа  точка центра  
   

Как изменять форму объектов 
окружности 
1  Выберите объект окружности и нажмите 
кнопку Reshape Object (Изменение формы 
объекта). 
 Вокруг объекта появятся контрольные точки. 
 
 
 Совет: Для перемещения окружности 

щелкните по контрольной точке в центре 
окружности и перетащите ее в новое 
положение. 

3  Щелкните по контрольной точке на контуре 
окружности и перетащите ее для изменения 
формы   контура. 

◄ Для изменения формы без изменения 
ориентации используйте контрольную 
точку на вершине объекта. 

 
 
 
 
 
 
 
 

 
 
◄ Для изменения формы и вращения 

объекта вокруг центральной точки 
используйте боковую контрольную точку. 

        
 

 
 

         
 
4 

 Нажмите Enter, чтобы принять изменения и 
клавишу Esc для окончания. 
 
 

Совет: Для изменения размера окружности 
без превращения ее в овал выберите ее 
инструментом Select Object (Выбор объекта) 
и используйте угловые маркеры выделения, 
чтобы изменить размер. 

 
 
 
 
 
Изменение 
размера с  
использованием 
угловых  
маркеров 
выделения 
 
 
 

 
 
Изменение формы цепочки 
узоров 
 

 
Используйте инструмент Reshape Object 
(панель Edit) для просмотра контрольных 
точек выбранных объектов. 

 
Форма цепочки узоров изменяется инструментом 
Reshape (Изменение формы) таким же образом, 
как вы изменяете форму текстовых объектов. 
Вы можете сделать цепочку узоров выше или 
уже, поворачивать цепочку узоров, перемещать 
индивидуальные узоры по базовой линии или 
изменять форму базовой линии. Вы можете 
поворачивать, наклонять и переводить в 
зеркальное отображение цепочку узоров таким 
же образом, как и другие объекты. 
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Как изменять форму цепочки узоров 
1  Выберите цепочку узоров и щелкните по 

значку Reshape. 
Вокруг объекта появятся узлы изменения 
формы.  

2  Перетащите контрольные точки изменения 
формы, чтобы изменить внешний вид 
цепочки узоров. 

 
 
 
 
 
 
 
 
 

3  Нажмите Esc для завершения. 
 

 
Подгонка углов наклона 
стежков 
 
Настройка угла наклона стежков зависит от типа 
объекта, с которым вы работаете. Для 
заполняемых объектов вы можете назначить 
угол наклона стежка для всего объекта. 
Альтернативно вы можете добавить сложные 
углы наклона стежков инструментом Stitch 
Angles. Вы можете также установить угол 
наклона стежка, используйте инструмент 
Reshape Object. 

 
Примечание: Вы можете изменить угол наклона 
стежков объекта окружности, перемещая точку 
ввода стежков. 
 
Подгонка углов наклона стежков  
 

Используйте функцию на панели 
стежков и цветов ниток Stitch and 
Color Bar > Add Stitch Angles для 
установки требуемых углов наклона 
стежков для замкнутых объектов с 
отверстиями или без.  
 
Используйте функцию на панели 
стежков и цветов ниток Stitch and 
Color Bar > Remove Stitch Angles 
для удаления углов наклона 
стежков для замкнутых объектов с  
поворачивающимися стежками. 
 

 
Вы можете изменить угол наклона стежка 
заполняемых объектов, используя свойства 
объекта. 
 

       
 
Примечание: Функция Remove Stitch 
Angles применяется к выбранным объектам 
с поворачивающимися стежками.  В 
результате остаются стежки с одним 
номинальным углом наклона. 
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Как подогнать углы наклона стежков с 
использованием свойств объекта 
 
1 Выберите замкнутый объект с 
поворачивающимися стежками или без них. 

 
2 При необходимости, воспользуйтесь 
функцией Remove Stitch Angles , чтобы 
привести углы поворота стежков к 
номинальному.  

 
3 Щелкните правой клавишей мыши по 
кнопке Add Stitch Angles. Откроется диалог 
свойств объекта Object Properties. Тот же 
результат получится, если два раза 
щелкнуть по объекту левой клавишей, или 
один раз правой. 
 
 

 
Введите требуемый угол наклона стежка 

 
4  Выберите закладку Stitch Angle (Угол 
наклона стежка).  

5  В поле Angle (Угол) введите требуемый угол 
наклона стежка. 
      

 
Угол: 90°       Угол: 0° 

 
6  Нажмите кнопку Apply. 
 
Добавление углов наклона 
стежков 
 

Используйте функцию на панели 
стежков и цветов ниток Stitch and 
Color Bar > Add Stitch Angles для 
установки требуемых углов наклона 
стежков для замкнутых объектов с 
отверстиями или без.  
Используйте функцию на панели 
стежков и цветов ниток Stitch and 
Color Bar > Remove Stitch Angles для 
удаления углов наклона стежков для 
замкнутых объектов с  
поворачивающимися стежками. 
 

Углы наклона стежков объектов с заполнением 
все модифицируются тем же способом. Сложные 
углы наклона стежков могут быть добавлены 
инструментом Stitch Angles.  
            

 
одинаковый угол наклона стежков    сложные углы наклона стежков 
 
В программе BERNINA Embroidery Software, 
функция добавления углов наклона стежков 
Add Stitch Angles может применяться к 
замкнутым объектам, имеющим: 

• Поворачивающиеся углы наклона 
стежков 

• Один общий угол наклона стежков, с 
отверстиями или без. 
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Совет: Инструментом Reshape (Изменить 
форму) вы можете добавить индивидуальные 
контрольные точки без воздействия на углы 
наклона стежков. Подробнее см. в разделе 
Изменение формы объектов. 
 
Как настраивать сложные углы наклона 
стежков 
 
Для добавления углов наклона стежков 
1 Выберите замкнутый объект с 
поворачивающимися стежками или без них. 
 

 
Примечание: если функция Stitch Angles 
применяется к объекту с эффектами 
заполнения типа Star Fill (заполнение 
звездами) или Wave Fill (заполнение 
волнами), эти эффекты будут удалены. 
 
2 При необходимости воспользуйтесь 
функцией удаления углов наклона стежков 
(Remove Stitch Angles), чтобы вернуться к 
текущему номинальному значению угла 
наклона. 
 
3  Щелкните по значку Stitch Angles. 
 Вам будет предложено ввести углы наклона 

стежков.  
 

 

 
Совет: если нажать кнопку Enter после 
включения функции Add StitchAngles, но 
линии наклона стежков не вводить, то они 
будут сгенерированы автоматически. Чтобы 
принять линии наклона – еще раз нажмите  
Enter . Чтобы отказаться от автоматически 
выбранных линий наклона нажмите 
пробел. Тогда будет использован один 
общий угол наклона. 
 
4 Назначьте такие углы наклона – точки 1 и 2 , 

чтобы стежки пересекали две стороны 
объекта. Убедитесь в том, что они не 
пересекают друг друга. 

 

 
Внимание: Новые линии стежков не должны 
пересекать существующие линии стежков, в 
противном случае появится сообщение об 
ошибке. Нажмите клавишу пробела Backspace 
для удаления. 
 
5  Вводите точки угла столько раз, сколько 

требуется для создания эффекта 
"переворачивания" заполнения. 
 

6  Нажмите Enter, чтобы принять изменения и  
     клавишу Esc для окончания. 
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измененные углы 
наклона стежков 

Стежки объекта оцифровываются заново с 
новыми углами. 

     

 
Совет: вы можете использовать функцию 
Reshape Object для настройки узлов 
изменения формы. См. раздел Подгонка 
углов наклона стежков на экране. 

 
 
Подгонка углов наклона стежков на 
экране 

 
Используйте инструмент Reshape Object 
(панель Edit) для установки угла 
наклона стежков выбранных объектов. 

 
Вы можете изменить угол наклона стежка 
объектов, используя функцию Reshape Object 
(Изменение формы объекта). 

 

Как подогнать углы наклона стежков на 
экране 
1  Выберите объект с заполнением. 
2  Нажмите кнопку Reshape Object (Изменение 

формы объекта). 
Узлы изменения формы отображаются 
вместе с линиями наклона стежков. 

 
 
 

3 Выберите узлы наклона стежков и 
нажмите Delete для удаления углов 
наклона. 
 

 
 
 Совет: При перемещении указателя мыши 

над точкой угла наклона на экране 
появляется всплывающая подсказка с углом 
наклона стежков выбранного объекта.  
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4 Захватите кнопкой мыши узел и 
передвиньте так, как требуется. 

 
 
5  Нажмите Enter, чтобы принять изменения и 

клавишу Esc для окончания. 
Объект будет вышит повторно с новыми 
углами. 

 
 Совет: Для установки точного угла наклона 

стежков используйте свойства объекта. 
Подробнее см. в разделе Подгонка углоа 
наклона стежка с использованием 
свойств объекта. 

 
 

Подгонка точек входа и выхода 
 

Используйте инструмент Reshape 
Object (панель Edit) для подгонки  
точек входа и выхода выбранных 
объектов. 

 
По умолчанию функция Closest Join (Самое 
короткое соединение) автоматически 
рассчитывает кратчайшее соединение между 
объектами, экономя ваше время, требуемое для 
нахождения точек входа и выхода. Вкладка 
Settings > Options > General позволяет при 
необходимости деактивировать эту функцию. 
Если эта функция деактивирована, все вновь 
оцифровываемые объекты соединяются 
методом As Digitized (По мере оцифровки). Это 
означает, что во время оцифровки вам будет 
предлагаться выбирать точки входа и выхода. 
Вы сможете изменять их в любое время 
инструментом Reshape Object. См. также 
Настройка других общих опций. 

 
Как изменять точки входа и выхода 
1  Выделите объект. 
2  Нажмите кнопку Reshape Object (Изменение 

формы объекта). 
 Появятся контрольные точки, включая точки 

входа и выхода. 
 

        точка выхода 
        точка входа 

 

длинный переходной  стежок 
 

 
Примечание: В объектах окружности 
появляется точка входа. 

3  Выберите точку входа или выхода, как вам 
нужно, и перетащите ее в другое положение 
на контуре объекта. 

 
4  Нажмите Enter, чтобы принять изменения и 
клавишу Esc для окончания. 
 

 точка выхода         точка входа 
   
 
Примечание: В объектах окружности угол 
наклона стежков перпендикулярен линии, 
соединяющей точку входа с центром окружности. 
Таким образом, при изменении точки входа 
стежка в объекте окружности изменяется угол 
наклона стежка. 
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